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SB/XA v6
The release notes in this section provide information about changes in SB/XA v6.

SB/XA v6.4.1 release notes
Build 6141
Release Date: April 2016
These release notes provide information about enhancements and fixes in SB/XA v6.4.1.

Windows 10 certification

All components of SB/XA are certified on Windows 10 as of v6.4.1.

XAML user data

You can expand the definitions of many elements of your application with the XAML User Data field,
added at v6.4.1. Available for screens, menus, dialog definitions, code tables, and button bars, XAML
user data allows you to pass more data between the server and the client for an application element
such as a screen.

You can put almost any kind of data in this field and interpret that data through a .NET custom
control, an addition to your XAML style that references this data, or some other Windows Presentation
Foundation process.

For more information about XAML user data, see "Expanding definitions with XAML user data" in the
Rocket SB/XA Developer's Guide.

You also can assign custom intuitive help processes to the elements of your application that use XAML
user data. For more information, see the UserData Tab documentation in the SB+ Control Parameters
section of Administering SB/XA.

New video help features

At v6.4.1, Rocket SB/XA offers integrated, context-sensitive video help built into the client.

You can access the entire SB/XA video documentation and help library from the General Help menu
(General Help → Video Help). You can also find context-sensitive video help within the tool, and you
can add your own video tutorials to your application.

To learn how to use the features, please see Video Help in Rocket SB/XA and Adding Video Help in
Rocket SB/XA.

Enhancements and fixes in SB/XA v6.4.1

The following issues were addressed in this release:

Key Release Notes Component/s

SBXA-12121 Previously, if you tried to apply a style name to an
editable combo box through @VALUE in a paragraph,
the style was not applied. This issue is fixed in v6.4.1.

XAML Styles

https://www.youtube.com/watch?v=4YLrCL26nYw
https://www.youtube.com/watch?v=9Q4sszEu0ME
https://www.youtube.com/watch?v=9Q4sszEu0ME
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Key Release Notes Component/s

SBXA-12605 You can expand the definitions of many elements
of your application with the XAML User Data field,
added at v6.4.1. Available for screens, menus, dialog
definitions, code tables, and button bars, XAML user
data allows you to pass more data between the server
and the client for an application element such as a
screen. You can put almost any kind of data in this field
and interpret that data through a .NET custom control,
an addition to your XAML style that references this
data, or some other Windows Presentation Foundation
process. For more information about XAML user data,
see "Expanding definitions with XAML user data" in the
Rocket SB/XA Developer's Guide. You also can assign
custom intuitive help processes to the elements of
your application that use XAML user data. For more
information, see the UserData Tab documentation in
the SB+ Control Parameters section of Administering
SB/XA.

XUI Form Designer

SBXA-12760 The number of available connections that can be made
simultaneously through the Communications Server
can be defined by setting the configuration parameter
"maxConcurrentSessions". In previous versions,
once the maximum was reached, any subsequent
connections timed out after five minutes, and the
user was provided with an error message that did not
indicate the reason the connection failed.

With a fix in v6.4.1, the Communications Server allows
one more connection than the defined maximum, and
the extra connection is used to provide the following
message: "The maximum number of connections to the
Communications Server has been reached. Please exit
and try again later."

This issue is related to SBXA-15298, in which an
enhancement was made to provide the extra
connection.

Communication Server,
XUI Rich Client

SBXA-12917 In previous versions, you were unable to connect with
authentication type SBXAUserNamePassword in certain
situations. This happened if you were using single sign-
on and you had a central configuration file with two or
more SB/XA Communications Server records. In this
situation, you received multiple prompts for credentials
followed by a blank window. This issue is resolved in
v6.4.1.

XUI Rich Client

SBXA-14701 In previous versions, if you were using
SBXAUsernamePassword authentication and entered
an incorrect SB password, you could not attempt
to re-enter credentials. This happened if you had a
central configuration file with two or more SB/XA
Communications Server records. This issue is fixed in
v6.4.1.

Installation /
Configuration, XUI Rich
Client
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Key Release Notes Component/s

SBXA-15151 With an enhancement in v6.4.1, you can produce
cleaner Excel versions of your reports. When you
choose Export to Excel for a QRD or RW report, you are
prompted whether you want to re-run the report for
Excel. If you choose Yes, the report tool removes extra
XPS formatting that is not needed in Excel. This process
generally produces cleaner Excel reports.

Printing / XPS / PDF /
HTML

SBXA-15155 With an enhancement in v6.4.1, when you use
CustomValidation authentication (UNIX-UniVerse NLS
platform), and the user's OS password has changed, the
new password is passed to the OS credential check and
then stored in the Single Sign-On credentials for that
application on the master server.

Communication
Server, Installation /
Configuration,
Internationalization
(NLS/Multi Language)

SBXA-15298 In previous versions, if the maximum number of
concurrent sessions for SB/XA Communications
Server was reached, the server stopped accepting
connections. Users received no warning or error
message, and nothing about the event was captured
in the logs. With a fix in v6.4.1, SB/XA Communications
Server automatically allows one more session
beyond the number of sessions specified in the
maxConcurrentSessions sessions property of the SB/
XA Communications Server configuration file. This extra
sessions is used to log an error and report an error to
the client when the maximum number of concurrent
sessions is reached. If the error occurs while the client
is trying to load the application list, a message is
displayed and the client must be closed. If the error
occurs when trying to connect after the loading of the
application list, a normal connection error is reported.

This issue is related to SBXA-12760.

Communication Server

SBXA-15479 In previous versions, you could not connect through
authentication type SBXAUserNamePassword if your
password contained special characters such as "ö".
This issue is fixed in v6.4.1. You can use these characters
now, but you must set the database code page correctly
in SB+ Control Parameters.

Admin Tools

SBXA-15501 In previous versions, the application selection screen
did not appear after login under certain circumstances.
If you used SBXAUserNamePassword authentication
and a central configuration file with two or more
Communications Server records, and the SB user had
multiple available applications, you were automatically
connected to the last active application. This issue is
resolved in v6.4.1.

XUI Rich Client

SBXA-15574 With an enhancement in v6.4.1, the default value for
maxConcurrentSessions in the SB/XA Communications
Server configuration file was increased from 100 to
600. You can increase the value to as many concurrent
sessions as you believe your middle tier computer will
support.

Communication Server
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Key Release Notes Component/s

SBXA-15581 At v6.4.1, the SSL libraries for SBClient were updated to
use OpenSSL release 1.0.1m.

Communications / File
Transfer

SBXA-15614 At v6.4.1, an IF condition was added so that the
message "SB.FT.MASTER(149) Master loop exit" only
appears in the application server logs if DEBUG logging
is activated.

Communications / File
Transfer

SBXA-15621 In previous versions, page breaks were not honored
when you ran a Query report to XPS Viewer. This
happened only on a UniVerse-UNIX platform, and only
when the SBSORT/SBLIST option was set to No. This
issue is fixed in v6.4.1.

Reporting (ARD/RW/
SMART.QUERY)

SBXA-15641 Previously, if you used the TU.SEND.TO.PRINTER
subroutine to send output to the XPS Viewer and then
printed the report to a physical printer, your margin
settings were not honored. This issue is fixed in v6.4.1.

Printing / XPS / PDF /
HTML

SBXA-15691 In v6.4.1, a new flag was added to the Styles tab of SB
+ Control Parameters. If you set the "Apply XUI Grid
paging to 'G' option grids" flag to Yes, XUI Grid Paging is
applied to all 'G' option grids. This setting overrides the
XUI Grid Paging flag in User Security Setup. For more
information, see the Styles tab documentation in the
SB+ Control Parameters section of Administering SB/XA
as well as the general XUI Grid Paging documentation,
found in the XUI Flags tab section of the user security
setup documentation in Administering SB/XA.

XUI Rich Client

SBXA-15695 With an enhancement in v6.4.1, session IDs now are
hashed in the creation of log file names, resulting in
shorter log file names.

XUI Rich Client

SBXA-15713 With an enhancement in v6.4.1, SB/XA offers integrated,
context-sensitive video help. The Field Definitions
screen has short video tutorials about four fields on
the screen. The tutorials explain how to use each field.
Each field with video help is marked by a watermark
video camera icon. The videos also can be found on the
new VideoHelp menu. More context-sensitive videos
are planned for future releases. You can also add your
own video tutorials to any field in your application. For
more information, see "Video help" in the Rocket SB/XA
Developer's Guide.

Form Controls (Radio/
Combo/Text/Label/
Toggle/Memo)

SBXA-15830 Previously, level one help for XUI Grid Paging in user
security setup was misleading. With a fix in v6.4.1, the
help message has been updated to clarify that the
setting in the screen definition overrides the setting in
user security setup.

GUI Forms/Functions,
Multivalue Grids, XUI
Rich Client

SBXA-15837 Previously, if you attempted to connect with
WindowsUserNamePassword authentication and
you did not have certificates set up correctly, you
received the uninformative message "The endpoint
with authentication mode." With a fix in v6.4.1, you
now receive an appropriate and informative message
specific to your situation.

Installation /
Configuration
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Key Release Notes Component/s

SBXA-15871 With an enhancement in v6.4.1, the process
CLEAN.SBHSTATE now clears the download image
cache at C:\Users\user\AppData\Roaming\Rocket
Software\SBXA\version_number\APPSBMP. Previously,
CLEAN.SBHSTATE cleared the download cache,
but not the download image cache. The same
functionality is also delivered in the XUI client by
clicking Options>Client Configuration>Clear Local
Cache.

GUI Forms/Functions,
XUI Browser Client, XUI
Rich Client

SBXA-15874 Links to video tutorials and help were added to the
General Help menu (General Help -> Video Help) at
v6.4.1. When you double-click the link for any video,
the video is displayed in an SB-encapsulated browser
window. Videos are hosted on YouTube, and you need
internet connectivity to access the videos.

Documentation, Menus

SBXA-15900 In previous versions, if you sorted an output-only grid
in XUI and then navigated through the grid, the client
crashed unless the controlling field's options were set
to CAIDE. The crash happened because the server was
erroneously adding a blank line at the end of the grid.
That blank line should only be added for an input grid,
and with a fix in v6.4.1, the blank line is no longer added
for output grids, and the crash no longer occurs.

Multivalue Grids

SBXA-15902 Previously, if you printed a report with 132 columns
from QRD or TU.SEND.TO.PRINTER, the report was not
properly condensed or printed correctly. This issue is
fixed in v6.4.1. A condensed font is used to display the
report correctly. This issue never affected RD reports.

Printing / XPS / PDF /
HTML, Reporting (ARD/
RW/SMART.QUERY)

SBXA-15906 In previous versions, if you tried to run a selection for
which the FilterSBXListSelectionStyle was defined, the
client sometimes crashed if the server was busy. This
issue if fixed in v6.4.1.

Intuitive Help, XAML
Styles

SBXA-15913 With an enhancement in v6.4.1, when you use the GC
process to generate BASIC code for a process, your
generated code is added to an LM(e) project. This only
applies if you have licensed SB/XA to work with Rocket
Aldon Lifecycle Manager.

Aldon Integration

SBXA-15914 With an enhancement in v6.4.1, the Guided Upgrade
process excludes remote file pointers when it builds the
Missing Files list in the REGEN.EXP step. Excluding these
pointers, which include things such as UniVerse NFS file
pointers, UniData NFA file pointers, and pointers to files
in accounts other then SB and SB.DEFN, can prevent
delays in the REGEN.EXP process. You can see which
remote file pointers were excluded by clicking F10-
Remote Log.

Installation /
Configuration
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Key Release Notes Component/s

SBXA-15919 In previous versions, if you used SB/XA with Rocket
Aldon Lifecycle Manager, the SB/XA SE editor and LM(e)
didn't always properly handle the files that you edited
in SE. With a fix in v6.4.1, the editor and LM(e) handle
these files correctly if you use the File Characteristics
screen (/HK.FILES) to specify which files contain BASIC
programs. For more information, see the Rocket SB/XA
Developer's Guide.

Aldon Integration

SBXA-15925 With an enhancement to the Guided Upgrade process
in v6.4.1, on UniData systems, locally and globally
cataloged programs are re-cataloged after compilation.

Installation /
Configuration

SBXA-15926 In previous versions, the Guided Upgrade would stop
building a list of missing files if the FILES record was not
present in xxCONTROL . With a fix in v6.4.1, the Guided
Upgrade now writes a missing files record and reports it
to you.

Installation /
Configuration

SBXA-15927 With an enhancement to the Guided Upgrade process
at v6.4.1, progress of the program compilation process
is displayed in the status bar.

Installation /
Configuration

SBXA-15928 Previously, the Guided Upgrade process was incorrectly
placing CTLG in the list of program files. This issue is
fixed in v6.4.1.

Installation /
Configuration

SBXA-15929 With an enhancement to the Guided Upgrade process in
v6.4.1, files not found in a system files record are listed
by default as belonging to the first system ID in your
system ID list. You can assign them to a different system
ID before running REGEN.EXP, but you do not need to
do so.

Installation /
Configuration

SBXA-15930 With an enhancement to the Guided Upgrade process
in v6.4.1, changes in upgrade status and REGEN.EXP
status are written more frequently to DMCONT
AccountName*UPGRADE. These writes allow your
upgrade progress to be saved progressively and ensure
that you don't have to repeat work if the process aborts
unexpectedly.

Installation /
Configuration

SBXA-15931 Previously, the Guided Upgrade unnecessarily
processed global files multiple times during REGEN.EXP
if there were multiple system ID's in the application
account. With a fix in v6.4.1, these files now are only
processed once, unless different global files are
specified for different system ID's.

Installation /
Configuration

SBXA-15932 With an enhancement to the Guided Upgrade process
at v6.4.1, you can review upgrade logs after the upgrade
is complete. Previously, you could review the logs for
each step as you went through the process, but the logs
were automatically deleted when you completed the
upgrade. Logs are no longer automatically deleted. In
xxLogs, you can review REGEN.EXP.LOG. In the VOC, you
can review COMPILE.ERRORS.LOG, GC.REMOVALS.LOG,
FILE.POINTERS.LOG, and REINSTATED.LOG.

Installation /
Configuration
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Key Release Notes Component/s

SBXA-15946 Previously, form cache information was not properly
shared between systems even if the "Share Form
Positions between Systems" flag was set to Yes. This
problem happened if the machine name was null and
the application name contained the account name
followed by an underscore. This issue is resolved in
v6.4.1.

XUI Rich Client

SBXA-16024 With an enhancement in V6.4.1, SB/XA delivers an
example style to highlight alternate rows in intuitive
help selection screens. MyARListBoxStyle.xaml is in
the installation media in Extra -> Xaml -> Themes.
You can add this style to an existing theme, specify
if for individual intuitive help lists, or add it at the
system level or instance level. For more information,
see "Styling intuitive help selection forms to highlight
alternate rows" in the Rocket SB/XA Developer's Guide.

XUI Rich Client

SB/XA v6.4.0 release notes
Build 6091
Release Date: December 2015
These release notes provide information about enhancements and fixes in SB/XA v6.4.0.

Performance improvements in SB/XA v6.4.0

Performance was the primary focus of SB/XA v6.4.0, and substantial performance improvements
were made in form load, grid load, report output, switching system IDs, and form deletion. You
can learn more about these enhancements by finding their associated Rocketrack numbers in the
“Enhancements and fixes in v6.4.0” table that follows. Among the issues specifically related to
performance are SBXA-11828, 14902, 15026, 15051, 15136, and 15249.

SB Support Account video demonstration

The SB Support Account, added at v6.4.0, helps you to perform issue replication and diagnose
problems in your application, and it also provides you with a suite of performance tests.

You can watch a short video demonstration at www.youtube.com.

Also see SBXA-15840 in the following table for more information.

Enhancements and fixes in SB/XA v6.4.0

The following issues were addressed in this release:

Issue Description Components

SBXA-847 In previous versions, in a multilanguage environment,
the language flag for a new user was not loaded when
you used /VU to switch the user ID. This issue is fixed in
v6.4.0.

Internationalization
(NLS/Multi Language)

SBXA-11262 In previous versions, if you clicked the scroll arrows to
navigate a non-grid multivalued field (G option) on a
GUI screen, the second line of the multivalue displayed
the wrong data. @CNT was corrupted. This issue is fixed
in v6.4.0.

Multivalue Grids

https://www.youtube.com/watch?v=43HjspSWRd4
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Issue Description Components

SBXA-11828 With an enhancement in v6.4.0, you can improve the
speed of form load by enabling form cache. With form
cache enabled, forms are cached when you open them.
If you close a form and then re-open it during the same
session, it loads more quickly because it is not being
created anew. The cache is cleared when you switch
systems or log off, and you can also clear it by running /
CLEAN.SBHSTATE. Form cache is now the default
setting for SB/XA, but you can disable it in SB+ Control
Parameters or in user flags. You also can choose to
disallow form cache for specific forms. For more
information on form cache, see the documentation
for the Enable Form Cache flag in the "XUI Parms tab"
section of the SB+ Control Parameters documentation
in Administering SB/XA.

XUI Rich Client

SBXA-12076 In previous versions, if a program running on SB/XA
Application Server closed unexpectedly, SB/XA Rich
Client closed. No error message was displayed, and
nothing was captured in the logs. With an enhancement
in v6.4.0, these types of errors result in an error
message being displayed in Rich Client before its
exit, and information is recorded in the logs for SB/XA
Communications Server and SB/XA Rich Client.

Installation /
Configuration

SBXA-12884 Previously, if you translated a menu definition, the
translated text was not automatically displayed. You
needed to run CLEAN.SBHSTATE or remove and then
add again the language code in order for the translated
text to be displayed. This issue is resolved in v6.4.0.

Internationalization
(NLS/Multi Language),
Menus

SBXA-13304 In previous versions, if you tried to edit a Report Writer
definition in the XUI client, you received a misleading
error message in certain circumstances. If you used
the /MP process for a Report Writer process, and then
clicked F6, you saw the following error message: XX
PROCESS NOT FOUND. This issue is resolved in v6.4.0;
the F6 option is no longer presented in the Modify
Process screen for Report Writer processes in the XUI
clients.

Reporting (ARD/RW/
SMART.QUERY)

SBXA-13323 Beginning in v6.1.0, the appearance of forms was
degraded when you decreased their size. This issue is
fixed in v6.4.0.

XUI Rich Client

SBXA-13637 In previous versions, running /DEBUG caused the XUI
client to crash if the central configuration file had
messageFromServerPriority set to Loaded. This issue is
fixed in v6.4.0.

XUI Rich Client
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Issue Description Components

SBXA-13983 Prior to v6.4.0, there was no mechanism in SB to
facilitate the use of SB.INPUT subroutine calls and
INPUT paragraph statements in a multilanguage
environment. An enhancement in v6.4.0 enables
the following mechanism for storing and displaying
different text based upon the multilanguage in
use: To translate text using the [Un] notation to
reference messages held in attribute n of xxCONTROL
MESSAGE, you must create a new file: xxCONTROL
MESSAGE.yy, where xx is the System ID and yy is the
language code.

Internationalization
(NLS/Multi Language)

SBXA-14088 Previously, if you used a client-side call such as a
background process, it sometimes caused the text in an
input field to disappear.

At v6.4.0, a new command to execute background
processes on the server was added to the client, and
the server code was adjusted in multiple places to run a
background process.

The new process does not disturb the current
input in progress. The new command is
SBCommands.ExecuteSBPlusBackgroundProcess
Command
It is called from C# client-side code as follows:
SBCommands.ExecuteSBPlusBackgroundProcess
Command.Execute(processName, SBPlus.Current)
where processName is the name of the process to run.
You can pass additional parameters to the process
by including them in the processName variable,
separated by commas. The additional parameters are
placed in the @PARAM variable. If none are specified,
@PARAM is set to "". Because SB/XA Rich Client
and SB/XA Application Server are busy during this
call, it should only be used for quick processes. The
background process is ignored (either by the client or
the Application Server) and not executed under the
following circumstances:

▪ SB/XA is not logged into a system

▪ The INIT.SYS process is run to create a new system

▪ Any of the license authorization screens are shown

▪ The security violation screen is shown

XUI Rich Client

SBXA-14170 In previous versions, the L: validation for the length
of data being entered in a field erroneously used the
LENDP function. With a fix in v6.4.0, the L: validation
now uses LEN.

Internationalization
(NLS/Multi Language)

SBXA-14223 In previous versions, if you made an entry in the
COMMON variable USER.DEBUG, and that entry was
not a cataloged program, the client crashed. With
an enhancement in v6.4.0, a validation added to
USER.DEBUG checks whether or not the entry in the
variable is a cataloged subroutine before making the
call.

Tech Support, XUI Rich
Client
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Issue Description Components

SBXA-14377 In certain circumstances in previous versions, the
Recalc function did not properly update totals on a
screen. This happened in GUI only, and only in a non-
grid multivalue. If you made changes to the data and
used Recalc, the total was not updated correctly. This
issue is fixed in v6.4.0.

GUI Forms/Functions

SBXA-14444 Previously, language code functionality was restricted
to uppercase language codes. You could enter a
lowercase language code in the language table
accessed in SB+ Control Parameters, but that lowercase
code failed validation when you tried to select it for
a user. With an enhancement in v6.4.0, you can use
lowercase language codes.

Internationalization
(NLS/Multi Language)

SBXA-14556 In previous versions, a problem occurred when you
displayed the results of selection processes. When you
highlighted a row, the text in the first column was black,
whereas the text in other columns was white. The black
text was difficult to read. This problem, which occurred
only in XUI, is fixed in v6.4.0. The text in the first column
is white.

Intuitive Help

SBXA-14727 Previously, the User Debug process failed to log some
calls to SB.PROCESS. This issue is fixed in v6.4.0.
Because "BEFORE","AFTER" logging calls were moved
to within SB.PROCESS, all calls to SB.PROCESS now are
logged.

Installation /
Configuration

SBXA-14806 In some circumstances in previous versions, users
inadvertently started simultaneous sessions of SB/XA
Rich Client. This happened when a user was set up for
autologin with one application defined. If you clicked
Connect on the Connect to Application screen while
the client was already in the process of autologin, two
sessions were started. After 10 minutes, the second
session timed out, and this caused the client to shut
down. This issue is resolved in v6.4.0; the Connect
button is disabled during autologin.

XUI Rich Client

SBXA-14833 With an enhancement in v6.4.0, you can opt to share
form position, size, and zoom between systems. On the
XUI Parms tab of SB Control Parameters, set the value
in the new Share Form Positions between Systems
flag to Yes to enable this functionality. When enabled,
the flag means that if you change the size, position,
or zoom of a form in one system, those changes apply
when you close the form and subsequently open it
again in another system. The default setting for this flag
is No.

XUI Rich Client
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Issue Description Components

SBXA-14879 Several improvements were made to the Guided
Upgrade process at v6.4.0. Introduced in v6.3.0, Guided
Upgrade helps you upgrade from v5.x to v6.x by
prompting you to take all of the necessary steps to
avoid upgrade problems. In v6.4.0, several unnecessary
screens were removed as redundant and processes
were automated. A new screen was added, allowing
you to easily identify and add missing files to their
appropriate system files lists during the REGEN.EXP
step. For more information, see "Guided Upgrade" in
SB/XA Getting Started.

Installation /
Configuration

SBXA-14902 With an enhancement in v6.4.0, you can improve the
loading speed of forms with grids. Using the screen
designer, you can enable XUI Grid Paging for an
individual grid by selecting the grid field and clicking
F5 -> F6.Addit to find the new XUI Grid Paging flag.
Enter a value greater than 0, for instance 25. Entering
25 causes SB/XA to download only the first 25 rows of
the grid when you open the screen containing that grid.
The next 25 rows of data are downloaded when you
navigate toward the end of the first 25 rows. You also
can enable grid paging for every grid with a flag in user
security setup. For more information, see the XUI Grid
Paging documentation in "The XUI Flags tab" in the
Administering SB/XA manual.

XUI Rich Client

SBXA-14907 In previous versions, if you removed a Language Code
in User Flags, the Outlook menu was not updated to
reflect the change. This issue, which occurred only in
XUI, is fixed in v6.4.0.

Internationalization
(NLS/Multi Language)

SBXA-14947 Setting the SB.CONTROL record attribute <15, 4>
to 1 limits mouse click functionality and inhibits F2
functionality in a dependent multivalue. Previously,
this prevented you from doing some things such as
editing a field's process on the F7 subscreen in the
screen designer. But with an enhancement in v6.4.0,
tools input screens ignore the flag so that you can use
the F2 key in subscreens.

GUI Forms/Functions

SBXA-14963 In previous versions, if you set the Automatically
delete log files flag to True in the SB/XA
Communications Server configuration, problems
sometimes occurred. The process sometimes
attempted to delete a log that was currently in use, but
such a deletion is not possible. In these situations, a
non-specific error message was displayed, and the user
was unable to log into the XUI client again until SB/XA
Communications Server was restarted. This issue is
resolved in v6.4.0.

Communication Server,
XUI Rich Client

SBXA-14964 In previous versions, using a style to place a button in a
grid could result in a client crash. This issue is resolved
by a change at v6.4.0.

XUI Rich Client
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Issue Description Components

SBXA-14965 Beginning in v6.3.0, in XUI only, the scroll arrow buttons
for a Memo field did not work in some circumstances.
The problem happened only with output-only Memo
fields, or with Memo fields on output-only screens. This
issue is fixed in v6.4.0.

XUI Form Designer

SBXA-14974 In previous versions, the RELEASE.LICENSES process
sometimes removed user sessions incorrectly,
depending upon the OS date format. This issue is fixed
in v6.4.0.

Installation /
Configuration

SBXA-14992 Previously, some information messages were captured
in logs even if you configured your system to log only
errors. This issue is fixed in v6.4.0.

XUI Rich Client

SBXA-15026 You can increase the speed of some SYS calls with an
enhancement in v6.4.0. Using new Suppress options 5,
6, and 7 with your SYS call, you can prevent refreshing
of the top-level menu during system changes, thus
increasing the speed of the system switch. For more
information, see "SYS,newsysid,Supr" in the SB/XA
Application Server Reference Manual.

XUI Rich Client

SBXA-15049 At v6.4.0, a date check was added for form position
cache to reduce the number of uploads to the form
position cache. A date stamp is generated by the server
and transferred to the client. When a new position
is sent to the server, the date stamp is returned to
the client to keep it up to date. The client position
cache is only reloaded on login, and only if the date
has changed, or when the client cache is cleared. This
also applies only when there are more than 500 form
positions cached, because upload speed is fast when
there are fewer positions cached.

XUI Rich Client

SBXA-15051 At v6.4.0, several optimizations were made to improve
the performance of form position cache:

▪ A redundant write to the local file index was
removed, and this change improves the speed of
adding a file to the index.

▪ The local file index now is pre-built for forms to be
updated in the form position cache.

▪ The unpacking of forms was optimized to save
memory allocations for SBString, and this
optimization improves speed.

XUI Rich Client

SBXA-15057 In previous versions, if you clicked F5.View Jobs on the
List Jobs screen, the report was not displayed. This
issue is fixed in v6.4.0, but only in character mode.

SBClient

SBXA-15064 Previously, the SBClientLogsForm was private and
therefore could not be custom-styled with XAML. At
v6.4.0, the form is public and can be styled.

XAML Styles

SBXA-15099 With an enhancement in v6.4.0, when LM(e) is called to
check out multiple items, the checkouts are combined
into one call. You are now only prompted once for
checkouts.

External Application
Integration
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SBXA-15136 With an enhancement in v6.4.0, you can increase the
speed of reports download by sending multiple pages
to the client at once. Use the new XPS Download Pages
flag to determine the number of pages downloaded
at a time in Report Definition reports and with
TU.SEND.TO.PRINTER. For more information, see the
XPS Download Pages documentation in "XUI Parms
tab" in the Administering SB/XA manual.

Printing / XPS / PDF /
HTML

SBXA-15145 In previous versions, changes to an SB user's password
were not properly logged in the Audit of Users Amended
report in all instances. This problem is fixed in v6.4.0;
password changes are properly logged.

Admin Tools

SBXA-15185 In previous versions, you sometimes received a warning
about an unassigned variable, particularly if you ran the
SE editor followed by /TCL, and also in SB.INFO. This
problem is fixed in v6.4.0.

XUI Rich Client

SBXA-15197 Navigation of tabbed forms was an area identified
by customers as not performing as well in the XUI
clients as it does in SBClient GUI. This difference
in performance has been removed due to the
implementation of form caching in the XUI clients and
improvements made in the XUI object manager.

XUI Rich Client

SBXA-15201 An optimization was made at v6.4.0 that increases the
performance of pre-processing of larger reports that
contain XML in TU.SEND.TO.PRINTER before they are
sent to the XPS viewer. This optimization is significant
only on a UniVerse-no NLS platform.

Printing / XPS / PDF /
HTML

SBXA-15249 An optimization at v6.4.0 improves the speed of form
deletion. The object manager now removes the items
so that new items with the same name can be created,
but it does not dispose of them immediately. Instead it
queues them for later disposal and disposes of them a
few at a time when the UI is not busy. This means that
when you close a form, it is queued for deletion, but you
do not have to wait for it to be deleted.

XUI Rich Client

SBXA-15321 Previously, if you used the SB Security API to create
a new user record, and the user record ID was the
same as an existing group record ID, you received the
following misleading error message: "RECORD ALREADY
EXISTS." This issue is resolved in v6.4.0.

Admin Tools, External
Application Integration

SBXA-15356 Previously, if you attempted to make an update
through the security API, and the update failed a
validation, the update did not take place. An update
to the audit log file did take place, however, when the
update should not have occurred. This issue is resolved
in v6.4.0.

Admin Tools
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SBXA-15357 Four enhancements were made to the LogViewer at
v6.4.0:

1. A new text filter allows you to display only lines of
interest.

2. New Copy to clipboard functionality allows you to
transfer data from LogViewer to the clipboard with
tab-separated columns so that it can be used in
further analysis in another program.

3. A new Timing column shows the time between
messages.

4. A new option allows you to display only time, and
not date.

XUI Rich Client

SBXA-15384 In versions 6.3.0 through 6.3.3, a missing TUINSERT
file pointer caused problems in the Guided Upgrade
process. This pointer has been added in v6.4.0.

Installation /
Configuration

SBXA-15386 You can easily add missing files to the system file list
in the Guided Upgrade process with an enhancement
in v6.4.0. On the REGEN.EXP tab in the Application
Upgrade screen, when you click F5.Missing Files, the
Missing Files screen is displayed. It allows you to enter
the appropriate system name for files listed as not
existing in any of the files lists for the current account.
For more information, see "Guided Upgrade" in the SB/
XA Getting Started guide.

Installation /
Configuration

SBXA-15387 At v6.4.0, page indicators were added for Guided
Upgrade screens with multivalue tables in character
mode. These page indicators help to make it clear when
there are additional pages of data.

Installation /
Configuration

SBXA-15388 In versions 6.3.0 through 6.3.3, the Guided Upgrade
process sometimes crashed when specific subroutines
were removed to facilitate the upgrade. The upgrade
process automatically removed subroutines to call
before or after SB.INPUT, but that caused a crash
because the flag indicating that a subroutine call
should be made was not also changed as part of the
Guided Upgrade. This issue is fixed in v6.4.0.

Installation /
Configuration

SBXA-15389 In v6.3.0 through v6.3.3, the Guided Upgrade process
failed because of a missing SAPROGS pointer. This
issue is fixed in v6.4.0. The pointer is created when the
Guided Upgrade process starts.

Installation /
Configuration

SBXA-15422 In previous versions, SB.REMOTE.PROCESS returned
the following message: RECORD CORRUPT! CONTACT
SYSTEM ADMINISTRATOR. This problem is fixed in
v6.4.0.

Process Definitions

SBXA-15439 In previous versions, the XUI client showed toggles in
grid rows as being selected when they actually were not
selected. This problem is fixed in v6.4.0.

Multivalue Grids

SBXA-15472 With an enhancement in v6.4.0, the Guided Upgrade
process now generates a list of program files that may
contain programs to be recompiled and populates a
table on the Compile tab with that list.

Installation /
Configuration
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SBXA-15473 An enhancement to the Guided Upgrade process in
v6.4.0 detects if Rocket Web Development Environment
is enabled in the SB/XA account that you are upgrading.
It it is, the Guided Upgrade prompts you with
instructions for what you must do to successfully
complete the upgrade.

Installation /
Configuration

SBXA-15505 In previous versions, if you created a screen in character
mode and then tried to open it in XUI for the first time
with no existing .GUI or .XUI screen definition, you
received a misleading error message, and the session
crashed. This problem is fixed in v6.4.0.

Character Screens, GUI
Forms/Functions, XUI
Rich Client

SBXA-15602 In versions 6.3.0 through 6.3.3, when @RECORD was
populated with data and then @REFRESH = -2 was
executed to display the data in a grid, only the first line
of data was displayed. This issue is resolved in v6.4.0.

XUI Rich Client

SBXA-15625 In v6.3.3, if you had no input fields on a screen after a
field defined as the 'R'ead Step, you received an error
message. This issue is fixed in v6.4.0.

Character Screens, GUI
Forms/Functions, XUI
Rich Client

SBXA-15768 In previous versions, processes that used an unnamed
COMMON variable resulted in a COMMON size mismatch
error. This problem is fixed in v6.4.0.

Aldon Integration

SBXA-15840 The SB Support Account, evolved from Rocket U2
Support's Issue Replication System, was added for
general availability in v6.4.0.

The SB Support Account helps you to solve problems in
your applications in two key ways: it automates much
of the work in the development and packaging of a
test case, and it also automates the work of comparing
crucial parameter files between different installations
of both SB+ and SBXA.

The SB Support Account also gives you a series of
utilities to test the performance of various elements
of your application. You also can use miscellaneous
utilities in the SB Support Account to overcome
common challenges in maintaining and upgrading your
application.

For a brief tutorial video, go to www.youtube.com.

For extensive documentation of these features, see
"Appendix H: SB Support Account" in Administering SB/
XA.

Installation /
Configuration

SB/XA v6.3.3 release notes
Build 5326
Release Date: July 2015
These release notes provide information about enhancements and fixes in SB/XA v6.3.3.

Enhancements and fixes in SB/XA v6.3.3

The following issues were addressed in this release:

https://www.youtube.com/watch?v=43HjspSWRd4


SB/XA v6.3.3 release notes

17

Issue Number Description Component

SBXA-747 With an enhancement in v6.3.3, you can control the
number of records you want to display when you run
a trial report. A new field, Sample size, was added
to the Report Parameters screen. You can enter 'A'
for Ask at runtime, or specify a number. For more
information, see "Setting report parameters" in the
SB/XA Developer's Guide.

Process Definitions

SBXA-840 In previous versions, if you enabled multilanguage and
set a language code in user flags, toggles no longer
worked correctly. This issue, which affected GUI and
XUI, is fixed in v6.3.3.

GUI Forms/Functions

SBXA-3211 Previously, if you used the User Security Setup screen
to delete the users DEMO and HELP, those users still
appeared in the ROOT tree. This issue is fixed in v6.3.3.

Admin Tools

SBXA-3219 In previous versions, a select process could be passed
a multivalued array that would then be used as the
selection list. If text had been entered prior to invoking
the selection process, it would automatically be used
to filter the values in the list. This functionality worked
in CHAR but was not being implemented in GUI and
XUI environments. This issue is fixed in v6.3.3.

GUI Forms/Functions,
Intuitive Help, XUI Form
Designer

SBXA-5098 In previous versions, when using the security API, if
you defined a keyboard timeout for a group but then
defined a different keyboard timeout for a user in that
group, a misleading error message about "invalid
input" was returned to the user. With a fix in v6.3.3, a
more meaningful error message is displayed in this
situation.

Admin Tools

SBXA-8078 In previous versions, auditing of user record creation
did not work completely in some circumstances. This
issue is resolved in v6.3.3.

Admin Tools

SBXA-8740 A new report variable, @RV.TOTALS.ONLY, was added
at v6.3.3. This gives the developer the ability access
the choice made by the user to the runtime question
"Totals Only Report (Y/N/G)" . For more information,
see "Special report variables in report definitions"
in the SB/XA Application Server Reference Manual,
as well as "Report Writer definitions" in the SB/XA
Developer's Guide.

Reporting (ARD/RW/
SMART.QUERY)

SBXA-9826 An enhancement in v6.3.3 allows you to close Rich
Client without the client first displaying the Connect to
Application dialog, as has been the default behavior. A
new flag, Show Application List on exit, was added to
the XUI Parms tab of SB Control Parameters to control
this behavior. For more information, see "SB+ Control
Parameters" in Administering SB/XA.

XUI Rich Client

SBXA-10135 In v6.3.3, two terms were changed in SB/XA licensing
screens in order to be consistent with standard Rocket
U2 terminology. "Reference Code" was changed to
"Configuration Code." "License Number" was changed
to "Authorization Key."

Installation /
Configuration
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SBXA-10587 In previous versions, the User Security Setup
screen inappropriately allowed you to override the
Application Hierarchy Mode flag. If the Application
Hierarchy Mode flag was set to Hierarchy no ripple
or Hierarchy with ripple, users should have been
able to access only those applications available
to their groups. But previously, in User Security
Setup, you could access applications that were
restricted for the group by using the intuitive help
key in the Valid applications field. With a fix in
v6.3.3, if Application Hierarchy Mode is enabled, the
intuitive help selection list in User Security Setup and
STANDALONE.SINGLE.SIGNON will present only those
applications available to the group.

Installation /
Configuration

SBXA-10648 At v6.3.3, the Physical Printer Name field was removed
from the XPS Parameters screen, and the W option
was removed from the intuitive help on the Disp Aux
Sel Screen field. The W option is not supported in XPS
Viewer.

Reporting (ARD/RW/
SMART.QUERY)

SBXA-11744 Previously, when a session failed to connect to the
application, the message returned was not specific in
indicating what step in the connection failed and what
parameters were used during the failed connection.
With an enhancement in v6.3.3, an improved error
message clarifies that it is the connection from SB/XA
Communications Server to SB/XA Application Server
that is failing. The message also provides details of the
account, server address, and user that were used to
attempt the connection.

Installation /
Configuration

SBXA-11748 In previous versions, a misleading error message
was returned if you attempted to configure SB/
XA Communications Server without all of the
correct permissions and settings. The previous
message included the line "Please log in as Windows
Administrator," but that statement was sometimes
not an accurate reflection of the problem. With a fix
in v6.3.3, a new error message includes the following
lines: "Please login as Windows Administrator while
connected to the Communication Server using
Authentication Type "Windows". If you still get this
message, you may also need to temporarily turn off
"User Account Control" in the Windows Control Panel.

Installation /
Configuration

SBXA-12217 Beginning in v6.2.1, the GUI client crashed and the XUI
client would hang in certain multilanguage situations.
This happened when you had input screens with
multiple tabbed screens and multivalue grids set
to display only one line. The GUI client crashed and
displayed the following error message: Couldn't
craete scrollbarclass object .....object name already
in use. 405 SBWIN_96_2*fieldname. The XUI client did
not crash, but the process would hang. This issue is
resolved in v6.3.3.

Internationalization
(NLS/Multi Language)
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SBXA-12693 On some platforms in previous versions, on the XUI
Parms tab of the SB Control Parameters screen, if you
pressed the intuitive help key on the "Reposition or
resize buttons in SD" field and then selected an entry
from the list, an error message was displayed. This
issue is resolved in v6.3.3.

Admin Tools

SBXA-12867 In previous versions, if you closed the navigation pane
in the client window, some forms subsequently were
incorrectly displayed outside the client window. This
issue is fixed in v6.3.3.

Menus, XUI Rich Client

SBXA-12954 Previously, the XUI client sometimes crashed on exit.
This occurred specifically if the exit process included a
confirmation dialog with buttons, and the buttons had
images on them. This issue is fixed in v6.3.3.

XUI Rich Client

SBXA-13092 In previous versions, users were unable to log into Rich
Client under very specific circumstances. The problem
occurred under the following circumstances:

▪ The system used a central configuration file

▪ The system used SBXAUserNamePassword
authentication

▪ The user was using signle sign-on

▪ The user had a default application specified

Under these circumstances, when the user attempted
to log into Rich Client, the connection to the
application failed. This issue is resolved in v6.3.3.

XUI Rich Client

SBXA-13098 In previous versions, the XUI client crashed if groups
and users were set up in a specific way. This happened
you created a user and a group that had the same
name, and the group was a child of a group other than
ROOT. Subsequently if you pressed the intuitive help
key on the User Id Code field in User Security Setup,
an incorrectly created tree was displayed, and the
XUI client crashed. The incorrect tree showed the new
group twice, as being a child of two groups. With a
fix in v6.3.3, the duplicate is not added to the tree, an
error is logged, and the crash is averted.

XUI Rich Client

SBXA-13180 In previous versions, SB/XA Communications Server
in time stopped accepting connections, because its
max number of concurrent connections was reached
inadvertently for various reasons. Several related fixes
in v6.3.3 resolve this issue.

Communication Server

SBXA-13181 In previous versions, intuitive help selection behaved
differently when you searched for screen definitions
as opposed to intuitive help selections for other
types of items. Only in screen definition searches
were you required to enter a ] after search text.
With a fix in v6.3.3, the intuitive help selection for
screen definitions now behaves the same as in other
selections.

Intuitive Help
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SBXA-13349 An enhancement in v6.3.3 allows easier styling of
Memo fields in XUI. Previously, you could not set a
default style for Memo fields. With this enhancement,
you can use a new Memo field on three different
screens to set default styles for Memo fields in SB
Control Parameters, Styles tab (See Administering SB/
XA), at the system level (HK.CONTROL, XUI Styles tab;
see SB/XA Developer's Guide), and in user flags. The
enhancement also includes new predefined styles for
Memo fields, similar to existing predefined styles for
other types of fields. See SB/XA Developer's Guide,
"XAML Styles and Themes."

XUI Rich Client

SBXA-13357 In previous versions in the XUI client, on a UniData-
Unix platform, fields on the Select Media screen were
displayed improperly. This issue is fixed in v6.3.3.

XUI Rich Client

SBXA-13412 In previous versions, any entry in the Option for
Remote Process field on the Define Dialog Box screen
(/DIALOG.DEFN) resulted in the following error
message: Non-numeric found when numeric required.
This issue is resolved in v6.3.3.

Process Definitions

SBXA-13438 With an enhancement in v6.3.3, the SB.CONTROL
record in DMCONT now is locked while you run the
SB.PARMS process.

GUI Forms/Functions,
XUI Rich Client

SBXA-13481 In previous versions, when utilizing the multilanguage
features of SB/XA, combo boxes in code table
definitions did not function correctly in some
circumstances. This happened when you had two
values, and one value used as an input code the same
value that the other used as an internal code. In that
case, when you selected a value, the wrong value was
stored in the record. This issue is resolved in v6.3.3.

Form Controls (Radio/
Combo/Text/Label/
Toggle/Memo), GUI
Forms/Functions, XUI
Rich Client

SBXA-13483 Previously, if you changed the size and screen position
of an HTML output window from a Report Writer
process, those changes did not apply the next time
the process was run. At v6.3.3, a key/checksum was
added so that the changed size and position of the
output window is loaded and saved in the same way
that other SB forms are saved. Now, if you alter the
size and position of the Report Writer process HTML
output window, those changes will remain in effect
the next time the process is run.

Reporting (ARD/RW/
SMART.QUERY)

SBXA-13580 In versions 6.2.5 and 6.2.6, the XUI client did not
respect your choices of colors for toggle objects, but
instead displayed the toggles with the default colors.
This issue is resolved in v6.3.3; the client now correctly
displays the specified colors.

Form Controls (Radio/
Combo/Text/Label/
Toggle/Memo), GUI
Forms/Functions, XUI
Rich Client
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SBXA-13607 Previously, changes in network configuration (such
as the address for SB/XA Communications Server
changing) caused client connections to fail. You
needed to restart SB/XA Communications Server
before successfully making a client connection. With
an enhancement in v6.3.3, SB/XA Communications
Server can detect such network changes and restart
a socket listener, making it unnecessary to restart the
server.

Communication Server

SBXA-13614 In previous versions, if you clicked on a numeric field
with a conversion code, the contents of the field were
not selected and highlighted as they should have
been. This issue is resolved in v6.3.3.

XUI Rich Client

SBXA-13623 Previously, if you had a code table defined with a
toggle, you received an error message when you used
Enter to move past that field. This happened only in
XUI. This issue is resolved in v6.3.3.

XUI Rich Client

SBXA-13968 In GUI mode, you can set multiple property
values in a grid with one SETATTR function
call, using the following syntax: ERR =
SETATTR("CtrlMVFld","ColHeadings","Col1,Col2,Col3,
Col4,Col5,Col6,Col7,Col8,Col9") ERR =
SETATTR("CtrlMVFld","ColWidths","10,20,30,
40,50,1,100,1,200") Previously, this syntax did not
work in the XUI clients. With a fix in v6.3.3, you can use
the same syntax for both client connection types.

XUI Rich Client

SBXA-14021 Previously, in some circumstances in GUI only,
subscreens could move on your monitor when you
called them repeatedly. They could eventually move
out of view and become inaccessible. This happened
only in the following circumstances:

▪ In the System Control Record, GUI Control tab,
Default GUI Toolbar points to a valid toolbar.

▪ In User flags, GUI Prefs, Center GUI Screens is set to
'N'.

▪ In User flags, GUI Prefs, Self-contained Forms is set
to 'N'.

This issue is resolved in v6.3.3.

GUI Forms/Functions,
SBClient

SBXA-14101 In previous versions, if you inserted a blank line in a
multivalue grid in XUI and then used the arrow keys
to move away from that blank line, the blank line
remained in the grid. This behavior differed from GUI,
in which moving away from the blank line resulted in
the blank line being deleted. With a fix in v6.3.3, the
XUI client now behaves like GUI, and the blank line is
deleted.

Multivalue Grids, XUI
Rich Client
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SBXA-14103 In previous versions, Autologin and Single Sign-On
sometimes did not work correctly. If you enabled
Autologin and set Auto OS to 'N' for a user, that user
should have been required to enter his or her OS user
ID and password on login. Instead, the user ID and
password were stored, and the user did not have to
enter them. This issue is fixed in v6.3.3.

Installation /
Configuration

SBXA-14117 In v6.3.3, SBClient now uses the 1.0.1m SSL libraries,
which address SSL v3 vulnerabilities related to the
POODLE bug.

Installation /
Configuration/ SBClient

SBXA-14126 In v6.3.0, if you sorted a column in a multivalue grid
in GUI, @CNT was not maintained correctly. This
prevented accurate drill-downs. This issue is fixed in
v6.3.3.

Multivalue Grids

SBXA-14145 Version 6.3.3 provides two new processes for deleting
SB/XA Application Server log files. You can enter
CLEAR.ALL.SERVER.LOGS at the Process Id prompt
to delete all SB/XA Application Server log files.
Alternatively, you can enter CLEAR.OLD.SERVER.LOGS.
When you enter CLEAR.OLD.SERVER.LOGS, you are
prompted to enter the number of days' worth of logs
that you want to keep, and all older logs are deleted.
For more information about logs and debugging, see
Administering SB/XA.

Admin Tools

SBXA-14176 In previous versions, a screen narrator for Windows 7
did not perform as well narrating XUI as it did the GUI
client. This issue is resolved in v6.3.3; screen narration
works as well for XUI as it does for GUI.

XUI Rich Client

SBXA-14303 In previous versions, SBClient did not work properly
when you used a second monitor to extend your
desktop. If you moved an SBClient screen to the
second monitor, buttons and toolbar items did not
respond when you clicked them. This issue is resolved
in v6.3.3.

GUI Forms/Functions/
SBClient

SBXA-14386 Previously, if you attempted to copy an XUI-only
screen from the XUI Screen Designer, the copy
sometimes failed because the Screen Designer was
attempting to copy a non-existent GUI or CHAR version
of the XUI screen with which you were working. If
you clicked F2.Accept in the Copy Screen Definition
window, no copy was made, but you did not see an
error message. With a fix in v6.3.3, the Screen To Copy
field in the Copy Screen Definition window now is
automatically populated with the .XD version of the
screen with which you are working, making it less
likely that you attempt to copy a non-existent GUI or
CHAR version of the screen.

XUI Form Designer
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SBXA-14409 Rocket SB/XA works with Rocket Aldon LM(e), but only
if you license SB/XA for use with LM(e). If you don't
have the LM(e) version of SB/XA and you try to run an
LM(e) feature from SB/XA, SB/XA returns the following
message: "LM(e) requires a licensed version of SB/XA."
In versions 6.3.0 through 6.3.2, however, the message
was not displayed if you ran LME.CONFIG or LME.INIT.
This issue is resolved in v6.3.3; if you attempt to run
LME.CONFIG or LME.INIT, you see the appropriate
error message.

External Application
Integration, SBClient

SBXA-14543 In v6.3.0, the HTML Parameters screen had incorrectly
displayed text and buttons. This issue is fixed in v6.3.3.

XUI Rich Client

SBXA-14554 In previous versions, in CHAR mode only, HEADING
statements in Selection Definitions were ignored. This
issue is resolved in v6.3.3.

Intuitive Help

SBXA-14586 In v6.3.0, in XUI only, G.USER.DATA was not populated.
This prevented checking of screen number in a series
of tabbed screens. This issue is resolved in v6.3.3.

XUI Rich Client

SBXA-14599 In v6.3.0, if you selected GUI as an output destination
in a QRD report, you received an error, or the client
crashed. This happened only in GUI mode. This issue is
resolved in v6.3.3.

Reporting (ARD/RW/
SMART.QUERY)

SBXA-14618 In previous versions, if you ran multiple copies of
Rich Client and multiple Communications Servers,
the clients sometimes did not connect to the correct
server. This issue is resolved in v6.3.3.

Installation /
Configuration, XUI Rich
Client

SBXA-14674 In previous versions, if a combo box was part of the
key in an output screen, you were unable to change
the value of the combo box. This issue is resolved in
v6.3.3.

Form Controls (Radio/
Combo/Text/Label/
Toggle/Memo)

SBXA-14675 Previously, when you ran the COLLECT.LOGS
process, a log collection directory was created in
the account in which you were working. With an
enhancement in v6.3.3, every installation of SB/XA has
an SBXALOGS file in the SB+ account, and pointers
are created from other accounts to this file. When
you run COLLECT.LOGS, the process creates and uses
sub-directories for each log collection within the
SBXALOGS file in the SB+ account.

Admin Tools

SBXA-14737 In previous versions, if you created and edited a screen
in GUI, and then deleted it, the .XUI and .XAML records
should have been deleted, but they were not. This
issue is resolved in v6.3.3.

GUI Forms/Functions

SBXA-14757 In previous versions, if you had tabbed screens that
included a '.' in the name, the first time you called
the screen from an output process, you received an
error telling you that the screen did not exist. This
happened only in XUI. This issue is fixed in v6.3.3.

XUI Form Designer

SBXA-14791 In previous versions, on an NLS platform only, function
keys that were designed to change the focus from one
field on a screen to another did not work. This issue is
fixed in v6.3.3.

Character Screens,
Internationalization
(NLS/Multi Language),
XUI Rich Client
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SBXA-14805 Some XUI client disconnects are caused by problems
that occur with SB/XA Communications Server
when a PC hibernates or sleeps, or the client loses
its connection for some other reason such as
switching networks. Previously, the reasons for these
disconnects were sometimes difficult to diagnose.
With an enhancement in v6.3.3, the client attempts
to connect to SB/XA Communications Server when a
channel fault occurs, and it reports the results of this
test in the Channel Fault dialog box. The client also
writes more specific information about these types of
disconnects to the client log files.

XUI Rich Client

SBXA-14826 When you resize and reposition forms on your
desktop, those new sizes and positions are supposed
to be stored and recalled the next time you open the
form. But in previous versions, changing the screen
definition caused your new size and position to be
discarded. This happened only in XUI. This issue is
fixed in v6.3.3; size and position are honored after a
change to screen definition, unless the change to the
definition requires a change to form size.

XUI Rich Client

SBXA-14827 In previous versions, if you changed the system ID
to an invalid entry in SBSYSMENU, you received no
warning. But subsequently when you next logged in,
the client crashed due to the invalid entry. With a fix in
v6.3.3, a new validation immediately warns you if you
make an invalid entry.

Menus

SBXA-14835 At v6.3.3, Transport Layer Security (TLS) was added to
the list of protocols for secure host connections with
SBClient. In the Edit SSL Property List window, you can
select TLS v1.1 and 1.2, as well as the existing SSL v3
and TLS v1.0. For more information, see "Configuring
the SSL Property List" in Administering SB/XA.

SBClient

SBXA-14858 In previous versions, if you changed the appearance of
a grid with SETATTR, performance suffered in XUI. This
issue is resolved in v6.3.3, and XUI grid performance is
superior to GUI in these circumstances.

Multivalue Grids, XUI
Rich Client

SBXA-14864 At v6.3.3, SSL libraries for SBClient were updated to
1.0.1m to address the FREAK vulnerability.

SBClient

SBXA-14878 In previous versions, in XUI mode on a Windows 8
platform, if you made changes to orientation or media
size in XPS Viewer, the changes were applied only to
the first page. This issue is resolved in v6.3.3.

Printing / XPS / PDF /
HTML

SB/XA v6.3.2 release notes
Build 5210
Release Date: March 2015
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These release notes provide information about enhancements and fixes in SB/XA v6.3.2.

Enhancements and fixes in SB/XA v6.3.2

The following issues were addressed in this release:

Note:  The v6.3.0 release notes and documentation state that the XUI clients require a 64–
bit machine, as this is the recommended platform. However, as the .NET Framework v4.5.1 is
supported on a Windows 7 32–bit machine, the XUI clients should function on a Windows 7 32–bit
machine.

Key Description Component/s

SBXA-12368 In previous versions, if a user was created with a null
password, the user was unable to log in using the XUI
clients until he or she had first logged in using a telnet
connection. This is resolved in both user security setup
and the security API in v6.3.2.

Admin Tools, XUI
Rich Client

SBXA-13068 Previously, using the arrow keys to navigate the calendar
did not change the month when moving from the last day
of one month to the first day of the next month, or from
the first day of one month to the last day of the previous
month. This occurred only in XUI. This issue is fixed in
v6.3.2.

XUI Rich Client

SBXA-14104 You can control the format of dates displayed in an SB/XA
NLS application by setting the locale on the user's Single
Sign On setup information. Previously, however, the
date format used in the intuitive help calendar and DATE
process was controlled by the Windows locale setting.
This was changed to use Single Sign On information in
v6.3.2.

Internationalization
(NLS/Multi
Language)

SBXA-14455 When you use the authentication method
CustomValidation, which is only supported for UniVerse
NLS on a Unix system, the user is not prompted for an SB/
XA password. This authentication method, introduced at
v6.3.0, does not use SB/XA passwords.

XUI Rich Client

SBXA-14511 Under certain circumstances in previous versions, it was
possible for the focus on your subscreen to be lost and
put on your main screen. This could hang your client if
you were unable to see any part of the subscreen because
it was behind the main screen. This occurred only on a
UniVerse NLS platform. This issue is fixed in v6.3.2.

XUI Rich Client

SBXA-14577 Previously, only on UniVerse NLS in XUI, if you set
@RTN.FLAG to a field name from a function key, the
cursor was not placed on the intended field. This issue is
fixed in v6.3.2.

Character Screens,
Internationalization
(NLS/Multi
Language), XUI
Rich Client

SBXA-14593 In v6.3.0 when CustomValidation authentication was
introduced, if you used a central config file, Rich Client
did not properly handle incorrect passwords. If the user
entered an incorrect password, Rich Client would hang
instead of prompting for the password again. This issue is
fixed in v6.3.2.

Installation /
Configuration, XUI
Rich Client
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Key Description Component/s

SBXA-14723 In the first iteration of CustomValidation authentication,
introduced at v6.3.0, if you entered an invalid username
or password, the client did not return a useful error
message. This issue is fixed in v6.3.2.

XUI Rich Client

SBXA-14801 Menu restrictions are set at the group level by specifying
the highlight letter of the allowed or disallowed restricted
option. Previously, if you set a different language code for
a user, the menu restrictions were sometimes not applied
correctly, because the highlight letter could be different.
This issue is fixed in v6.3.2.

Internationalization
(NLS/Multi
Language)

SBXA-14931 In previous versions, setting RECORD to null and
refreshing the screen did not clear the display of the fields
after the last multivalue field on the form. A change in
v6.3.2 resolves this issue, and all fields are now cleared.

GUI Forms/
Functions, XUI Rich
Client

SB/XA v6.3.0 release notes
Build 5106
Release Date: February 2015
These release notes provide information about enhancements and fixes in SB/XA v6.3.0.

Note:  A change in v6.3.0 requires you to have your Communications Server and XUI clients on a
64–bit machine. SB/XA now uses .NET Framework v4.5.1, which makes a 64–bit machine necessary
for these components.

Enhancements and fixes in SB/XA v6.3.0

The following issues were addressed in this release:

Key Description Component/s

SBXA-854 As of v6.3.0, when you install SB/XA Application Server,
several backups of the login proc are made: LOGIN_BACK,
LOGIN_BACK_date_counter.

Admin Tools

SBXA-1264 You can perform enhanced filtering and grouping in non-
input grids with an enhancement in v6.3.0. These features
allow you to distill the data in your grids in several new
ways. For more information, see the tutorial video at
www.youtube.com. Search for "SB/XA grid filtering and
grouping." Additionally, see the "Controlling field options"
table in the "Screen definitions" section of the SB/XA
Developer's Guide.

Multivalue Grids

SBXA-1608 Previously, if you had more than one tabbed sub screen,
and the first object on the second tabbed screen executed
a paragraph in the Process Before slot and that paragraph
executes a DISP 3 followed by an EXIT {Field Name} to a
field in the first tabbed screen, the XUI client went into an
endless loop. The second tabbed screen appeared briefly
and DISP 3, was displayed again and there was no way to
terminate the loop without closing the XUI screen. This
issue is resolved in v6.3.0.

XUI Rich Client
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Key Description Component/s

SBXA-3010 Previously, if you selected a toggle object from the object
palette in the form painter, and entered a field that did
not support this type of toggle, a message was displayed
indicating that the field did not support the toggle type.
If you then escaped and saved the screen, the screen
definition was corrupted. This issue is resolved in v6.3.0.

Character Screens

SBXA-8891 Previously, if a field in a grid referenced a footer field
to display information at the bottom of a column, and
that footer field was removed, the field did not work in
the grid. As of v6.3.0, validations and intuitive help have
been added when associating a field with a footer field.
Validations have also been added when removing a footer
field from the grid to prevent this problem if it is still
referenced by a field in the grid.

SBClient, XUI
Form Designer

SBXA-9233 Prior to v6.3.0, the XUI clients did not support vertical
toolbars. As of v6.3.0, vertical toolbars are supported in the
XUI clients.

Process
Definitions

SBXA-9358 Previously, if you used an expression with more than 35
operations, you were logged off the client. As of v6.3.0, this
limit has been extended to 70 operations.

SBClient

SBXA-11319 In previous versions, if you attempted to call an
InContextProcess from a custom control, the screen would
exit if you made the call from within a grid. This issue is
fixed in v6.3.0.

XUI Rich Client

SBXA-11421 With an enhancement in v6.3.0, you now can update
the license details with /LICENSE.RESET. For more
information, see "Relicensing" in Administering SB/XA.

Installation /
Configuration

SBXA-11608 The XUI clients do not support Type 3 menus. But with
an enhancement at v6.3.0, all Type 3 menus now have
an alternate menu with a .XUI suffix that the XUI clients
support. Thus any menu shipped with SB/XA can be
displayed in XUI.

Menus

SBXA-11612 Previously, if SBXA Communications Server was installed
on Windows 8 or 2012 and the c:\tmp directory exists,
the c:\tmp\app_tracelog.svclog file was populated with
tracing information. This file should not have been created
or populated on default installations. This issue is fixed in
v6.3.0.

Communication
Server

SBXA-11813 Previously, using /SYS,Sysid did not update the top-level
menu. This is resolved in v6.3.0.

Menus

SBXA-11880 Previously, if the connection to the SB/XA Communications
Server failed, a misleading error message was displayed:
"The SB/XA Communication Server version does not match
the SB/XA Server version." With a fix in v6.3.0, the following
message is now displayed if the connection process fails
to read the files on the server when attempting to retrieve
the version: "The SB/XA Application Server failed to read
the files necessary to return the correct version when
checking the SB/XA versions." The error logs will show if
this is caused by a missing DMCONT or a missing release
item on DMCONT,

Communication
Server,
Installation /
Configuration
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Key Description Component/s

SBXA-11923 Prior to v6.3.0, FIX.SBPLUS.POINTERS created a bad
pointer for DMTHEMES. This issue is fixed in v6.3.0.

Installation /
Configuration

SBXA-12033 With v6.3.0, SB/XA provides an array of new XAML style
examples and options for improving the look of your
intuitive help selection forms. You can use the new,
provided styles as they are delivered, or you can use the
examples as a basis to build your own styles. The new
styles provide smooth scrolling, an optional filter search,
and asynchronous data download. It yields improved
performance and user experience as you navigate the
returned data. For more information, see “Styles for
intuitive help selection forms” in the Developer’s Guide.

Multivalue Grids

SBXA-12235 In previous versions, if you attempted to start Rich Client
and SB/XA Communications Server could not be reached
(for instance if it was not started), the client would hang at
the splash screen. This issue is fixed in v6.3.0.

XUI Rich Client

SBXA-12327 In previous versions, if you sorted the data in a grid and
then clicked on a cell, @CNT was not properly updated for
your location within the grid. This problem, which affected
XUI and GUI screens, prevented drill-downs in sorted grids.
This issue is resolved for XUI only in v6.3.0.

Multivalue Grids

SBXA-12392 Previously, if a pre-run question was defined for a selection
process, and you then entered data into the field using
the selection process and pressed F3, the results were
inconsistent in instances where the data started with a
single quote. This issue is resolved in v6.3.0.

Intuitive Help

SBXA-12430 Previously, Rich Client crashed if you used COPY and CT
commands after accessing the SB+ command line with /
TCL. This issue is resolved in v6.3.0.

XUI Rich Client

SBXA-12474 In previous versions of the XUI clients, you were unable
to access the Windows printer selection dialog box in
auxiliary printing. The client only displayed the XPS printer
screen. With an enhancement in v6.3.0, you can access
the Windows printer selection dialog box. In the XUI client,
enter /USER.FLAGS, click the Display Aux Select Screen
field, and choose option W. After you select this option,
Aux appears in the "Output to" dialog when you output a
report. Click Aux to access the Windows printer selection
dialog box.

Printing / XPS /
PDF / HTML

SBXA-12546 In previous versions of the XUI clients, if a field contained
special characters and you tried to select an option from
the Action bar, the client crashed. This issue is fixed in
v6.3.0.

XUI Rich Client

SBXA-12661 Beginning in v6.2.1, some GUI output screens, specifically
those without an input field, did not honor the Esc key
when you tried to exit the screen. This issue is fixed in
v6.3.0.

Form Controls
(Radio/Combo/
Text/Label/
Toggle/Memo)

SBXA-12697 Previously, the XUI client did not properly honor specified
settings for the default position of the Intuitive Help
window. This issue is resolved in v6.3.0.

Process
Definitions, XUI
Rich Client
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Key Description Component/s

SBXA-12781 In versions 6.2.3 and 6.2.4, the navigation pane behaved
improperly in certain circumstances. If you used the
EMO navigation method, collapsed the navigation pane,
and closed the client, the navigation pane appeared
narrower upon restart of the client. The navigation pane
also resized improperly if you chose options such as Show
More Buttons or Show Fewer Buttons; again this happened
when you collapsed the navigation pane, closed the client,
and restarted. This issue is fixed in v6.3.0.

Menus

SBXA-12808 Previously, there was no way for users to reset expired
passwords when connecting to SB/XA from outside the
domain of the middle tier. This issue is resolved with a
new remote password rollover feature in v6.3.0. For more
information, see "Setting up remote password rollover" in
SB/XA Getting Started.

Communication
Server

SBXA-12866 With an enhancement in v6.3.0, you now have greater
flexibility to debug your applications in ways you
previously could not. The new COMMON variable
USER.DEBUG allows you to insert customized debugging
programs into your application. Your debugger can track
calls and processes that were not tracked by the existing
logs in SB/XA. Read more about this functionality in "Logs
and debugging" in Administering SB/XA.

XUI Rich Client

SBXA-12932 In v6.2.4, if you entered OFF at the TCL prompt, the
screen filled with special characters in a loop, effectively
hanging the client. This happened only on a UniVerse-UNIX
platform in XUI mode. This issue is resolved in v6.3.0.

XUI Rich Client

SBXA-12959 Beginning with v6.2.1, Rich Client sometimes crashed
during a file transfer operation. This issue is resolved in
v6.3.0.

XUI Rich Client

SBXA-12980 SB/XA Communications Server and the XUI clients now
use .NET Framework 4.5.1, and you will need this version
to run SB/XA. If you do not have .NET 4.5.1, you can get it
as a free download from the Microsoft product download
site. You also likely will still need some components
of .NET 3.5 that are not included in .NET 4.5 but are still
required by SB/XA. If you do not have these components,
you will be prompted to install them during SB/XA
installation or upgrade.

Communication
Server, SBXA
Services, XUI Rich
Client

SBXA-13031 Beginning with v6.2.3, when you used the EMO navigation
method with multiple sysid's, the Outlook menu
sometimes refreshed improperly after you changed the
sysid or theme. This issue is resolved in v6.3.0.

Menus

SBXA-13080 Previously, if a screen had the 'Accept Scr prompt' flag set
to 'Y' and there was a multivalue on the screen, and 'Use
Grids for Multivalued Fields' was set to No, then accepting
changes did not save the record. This issue is fixed in
v6.3.0.

Character Screens
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Key Description Component/s

SBXA-13084 Enhancements in v6.3.0 give you several new forms of
logging to help debug your application. You can use
the new COMMON variable DEBUG.LOGGING to initiate
logging on SB/XA Application Server. Additionally, new
WCF trace logging capability was added to the XUI clients.
Log messages from SB/XA Communications Server
were improved for better readability. Read more about
these features in the "Logs and debugging" section of
Administering SB/XA.

XUI Rich Client

SBXA-13114 In previous versions, if you resized screens in Rich Client
to 125 percent, objects sometimes displayed incorrectly.
Buttons and fields sometimes had a line or border around
them after the screen resize, and the bottoms of buttons
were sometimes cut off after the resize. This problem is
fixed in v6.3.0.

XUI Rich Client

SBXA-13116 Version 6.3.0 introduces a new authentication
method, CustomValidation, which is similar to
SBXAUserNamePassword but tailored to systems on
which the SB/XA administration server is on a UNIX
machine. CustomValidation works only on a UniVerse
NLS-UNIX platform. This option allows you to use your
UNIX operating system’s user name and password
scheme to validate your users as opposed to Windows
authentication. With CustomValidation authentication,
you can set up password rollover so that a user can change
his or her expired password. For more information, see
"CustomValidation authentication" in SB/XA Getting
Started.

XUI Browser
Client, XUI Rich
Client

SBXA-13135 Previously in the XUI clients, if you changed the System ID
and the theme, the top bar of the main window sometimes
did not correctly display the new System ID and theme.
This issue is fixed in v6.3.0.

Menus, XUI Rich
Client

SBXA-13171 Beginning with v6.2.4, in character mode in SBClient, if you
changed the value for the Allow Autologin flag on the SB
Control Parameters screen to Yes and saved the change,
the change was not honored. If you closed the SB Control
Parameters screen and opened it again, the value in Allow
Autologin remained null or No even if you had changed it
to Yes. These problems occurred only in character mode.
This issue is resolved in v6.3.0.

Admin Tools, Field
Definitions

SBXA-13237 In previous versions, XUI forms behaved differently from
GUI forms when you resized them in some circumstances.
They should have shown the same behavior. If you made
a GUI form smaller to hide content (such as a graph),
the graph was hidden from view and no scroll bars were
displayed on the form. But in XUI, if you made a form
smaller so that content was not visible on the form, scroll
bars were displayed. This issue is resolved in v6.3.0; XUI
now behaves like GUI, and no scroll bars are displayed.

Form Controls
(Radio/Combo/
Text/Label/
Toggle/Memo)
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SBXA-13291 Previously, the menu translation process did not always
warn you about duplicated letters when it should have.
While translating a menu definition, if you used the same
letter as the highlight letter for multiple options, the
system appropriately warned you that you had duplicated
a highlight letter -- but only in a translated option. If you
left a menu option untranslated, and you duplicated a
highlight letter in the untranslated option, the system did
not warn you about the duplicate letter. This issue is fixed
in v6.3.0.

Internationalization
(NLS/Multi
Language)

SBXA-13296 In v6.2, a performance improvement was made for normal
grids by applying SBField Style only to the grid field that
currently has focus. All other fields had a lighter display
style applied until they received focus. In v6.3.0, this
same approach has been applied to interleaved grids
that are displayed as a card view in the XUI clients. The
performance improvement in a small multivalued table
with a small number of rows may be small, but it continues
to increase as the number of columns and rows increases.

Multivalue Grids

SBXA-13315 With an enhancement in v6.3.0, you now can bypass the
XPS Printer in the XUI clients to perform direct auxiliary
printing. The new subroutine, TU.SEND.TO.RAW.PRINTER,
allows you to drive your physical printer at a lower level.
Read more about this subroutine in "PC Printer Control
API" in Client Programmer's Guide.

Printing / XPS /
PDF / HTML

SBXA-13340 In v6.2.5 and v6.2.6, if you chose Output Option while
defining an input process, you were then unable to gain
focus on a field by clicking on it. This occurred only in the
XUI clients. This issue is resolved in v6.3.0.

XUI Form
Designer, XUI Rich
Client

SBXA-13341 Previously, the use of a degree (°) symbol in data caused
corruption of the display of that data in a multivalued
grid in XUI and GUI. The display of the line containing
the degree (°) and any subsequent lines in the grid was
corrupted. This issue is fixed in v6.3.0.

Multivalue Grids

SBXA-13348 Previously, multivalued sets sometimes did not display
as grids when they should have. This happened only
when you set a language code, and only in GUI mode. This
happened particularly when you tried to include a grid and
a non-grid on the same screen or on linked screens; both
sets displayed as non-grids when one should have been a
grid. This issue is fixed in v6.3.0.

Internationalization
(NLS/Multi
Language),
Multivalue Grids

SBXA-13355 In v6.3.0, improvements were made to file transfer
reliability.

XUI Rich Client

SBXA-13377 In v6.3.0, the client SSL libraries have been updated to
use OpenSSL 1.0.1j. These libraries address problems
with the "heartbleed" bug, along with more general
enhancements and issues concerning SSL. The new
libraries are: u2libeay.dll version 1.0.1.101, product version
1.0.1j u2ssleay.dll version 1.0.1.101, product version 1.0.1j

Communications /
File Transfer
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SBXA-13500 In previous versions, the "Extra" folder in the installation
media did not contain a "BrowserClient" directory with the
files necessary for creating a ClickOnce deployment. These
files have been added in v6.3.0. For detailed instructions
on creating a ClickOnce deployment for the Browser Client,
consult the Tech Note in SB/XA-13102.

XUI Browser Client

SBXA-13535 In v6.2.6, problems occurred in some custom controls. A
button within a grid was supposed to execute a process,
but it it did not. This issue is resolved in v6.3.0.

XAML Styles

SBXA-13538 With an enhancement in v6.3.0, you can draw HTML
boxes by sending simple characters to the client. This
functionality previously was available only in SBClient; it
is now available in the XUI clients. For more information,
see the online help in any of the clients. Access General
Help>Technical Information>GUI Features>HTML Help.

XUI Rich Client

SBXA-13540 SB+ and SB/XA now offers a guided upgrade feature with
an enhancement in v6.3.0. You have the option of using a
wizard to identify and remove roadblocks to a successful
upgrade from v5.x to v6.3.0.

Installation /
Configuration

SBXA-13737 Previously, TU.FORM.SAVEDOS did not work in the XUI
clients. With an enhancement in v6.3.0, this functionality
works in XUI.

XUI Browser
Client, XUI Rich
Client

SBXA-13858 Previously, server errors were not captured if the debug
window was not running in XUI. As of v6.3.0, server errors
are captured in the client log file when the debug window
is not running.

Internationalization
(NLS/Multi
Language), XUI
Rich Client

SBXA-13859 In previous versions, you were unable to leave a user's
password blank in XUI while GUI and CHAR allowed you
to do so. In XUI, if you set up a new user with "Allow Null
Pwd" set to "Y" and "Set New Pwd Next Login" to set to
"Y," that user was prompted for a new password upon
login. The user was unable to leave the password blank in
XUI, while GUI and CHAR allowed the blank password. This
issue is fixed in v6.3.0; XUI now behaves the same as GUI
and CHAR.

XUI Rich Client

SBXA-13862 In versions 6.2.5 and 6.2.6, there were problems with
saving data in a grid. In XUI mode only, if you clicked the
Save button in a grid without first pressing Enter after
entering data, the change to the data was not saved.
Furthermore any process to be called after the field was
not called. This issue is resolved in v6.3.0.

Multivalue Grids,
XUI Rich Client

SBXA-13886 When you edit a paragraph in the full-screen editor in GUI
mode, you can exit the editor by pressing Alt+F4 or Ctrl+F4.
Previously, if you pressed Alt+F4 while editing a paragraph
in the XUI full-screen editor, the client crashed. If you
pressed Ctrl+F4, nothing happened. With a fix in v6.3.0,
pressing Alt+F4 no longer causes the XUI client to crash.
Pressing Ctrl+F4 still yields no result, but does not cause a
crash.

SE Screen Editor,
XUI Rich Client
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SBXA-13932 In previous versions, if you invoked intuitive help from a
button bar, the content of the COMMON variable @VALUE
was not passed to the intuitive help process. This problem
occurred only in XUI. This issue is fixed in v6.3.0.

Intuitive Help

SBXA-13937 In previous versions, if you updated a user's password for
single sign-on, the User Security Setup window incorrectly
displayed a 0 instead of a User ID in the Last Updated By
field. This happened only in the XUI client. This issue is
resolved in v6.3.0.

XUI Rich Client

SBXA-13948 As of v6.3.0, SB/XA now utilizes Xceed grid version 5.3.0. Multivalue Grids
SBXA-13964 Previously, numeric fields in grids were incorrectly

displayed with left justification in XUI grids. This issue is
fixed in v6.3.0; numeric values now are correctly displayed
with right justification.

XUI Rich Client

SBXA-13965 Previously, if you created a screen using the XUI screen
designer, you subsequently did not see the expected
options to edit that screen when running the /MP process.
You should have seen buttons F6 and F9 for editing the
screen and driver, but those buttons were not presented.
This issue is resolved in v6.3.0.

XUI Form
Designer, XUI Rich
Client

SBXA-14096 With an enhancement in v6.3.0, you have a new ability
to collect all of the log files pertaining to a given session
into one directory. This can help you to more quickly and
efficiently diagnose problems in your application. Log
files for SB/XA Application Server, SB/XA Communications
Server, and the XUI clients are written to different
locations. Previously, if you experienced a crash or other
problems in a session, you sometimes needed to look
in several different locations before finding the log that
detailed the problem. By running the COLLECT.LOGS
process, new in v6.3.0, you can save time and work.
For more information, see "Logs and debugging" in
Administering SB/XA.

Installation /
Configuration

SBXA-14235 The process LICENSE.INFO was modified at v6.3.0. With
this feature, you can display information about your
installation of SB/XA, such as the number of users and
whether your installation is authorized for such features as
SB/XA Services and Rocket Aldon LM(e).

Installation /
Configuration

SBXA-14271 In versions 6.2.2 through 6.2.6, toggles did not behave the
same in the XUI clients as they did in GUI. If a toggle had
a default value of 0, the toggle was checked in GUI, but
not in XUI. With a fix in v6.3.0, the XUI clients now behave
the same as GUI, and a default of 0 causes the toggle to be
checked.

XUI Rich Client

SB/XA v6.2.6 release notes
Build 4525
Release Date: July 2014
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These release notes provide information about enhancements and fixes in SB/XA v6.2.6.

Enhancements and fixes in SB/XA v6.2.6

The following issues were addressed in this release:

Issue number Description Components

SBXA-12121 Previously, if you tried to apply a style name to an editable
combo box through @VALUE in a paragraph, the style was
not applied. This issue is fixed in v6.2.6.

XAML Styles

SBXA-12518 In previous versions, if you edited a tabbed screen in XUI
mode, the output process that called that screen failed
the next time the screen was run. The error message
"processname.XD.VARS not found" was displayed. This issue
is resolved in v6.2.5.

XUI Rich Client

SBXA-13051 In versions 6.2.4 and 6.2.5, if you used SETATTR to change
the column heading for a grid, the new heading appeared
in the first row of the first column instead of the column
heading block. This occurred in XUI mode only. The issue is
fixed in v6.2.6.

XAML Styles

SBXA-13066 In previous versions, the XUI client sometimes crashed if you
used cursor keys to move from a grid to another field. SB/
XA displayed the following error message: "We apologize for
the inconvenience, but unfortunately an unexpected error
has occurred. The application will now exit. If the problem
persists, please contact your System Administrator." This
issue is fixed in v6.2.6.

Multivalue Grids,
XUI Rich Client

SBXA-13075 In previous versions, entering an invalid user name or
password caused SB/XA to prompt you for administrator
login credentials instead of returning a meaningful error
message. This occurred if your authentication type was set
to SBXAUserNamePassword and you entered an invalid user
name or password in the Connect to Application window in
Rich Client. With a fix in v6.2.6, SB/XA now returns an error
message regarding invalid user name or password instead of
displaying the administrator login window.

XUI Rich Client

SBXA-13086 In previous versions, entering an invalid user name or
password caused SB/XA to prompt you for administrator
login credentials instead of returning a meaningful error
message. This occurred if your authentication type was set
to SBXAUserNamePassword and you entered an invalid user
name or password in the Connect to Application window in
Rich Client. If you then proceeded to enter an invalid user
name in the administrator login window, SB/XA returned the
following error message: "The given key was not present in
the dictionary." The administrator login screen should not
have been displayed after the initial entry of an invalid user
name or password. With a fix in v6.2.6, SB/XA now returns
an error message regarding invalid user name or password
instead of displaying the administrator login window.

XUI Rich Client

SBXA-13088 In versions 6.2.3 through 6.2.5, if you used HK.CONTROL to
apply a default style to a multivalued field, the style was not
applied. This occurred only in the XUI client. This issue is
fixed in v6.2.6.

XUI Rich Client
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Issue number Description Components

SBXA-13091 In previous versions, the Browser Client was missing some
files necessary for creating a ClickOnce deployment. These
files have been added in v6.2.6. For detailed instructions
on creating a ClickOnce deployment for the Browser Client,
consult the tech note in SB/XA-13102.

XUI Browser Client

SBXA-13094 In previous versions, if you pressed the intuitive help key
on the Valid Applications field on the Single Sign-On tab in
User Security Setup, SB/XA returned an inappropriate error
message: "THE "//" SHORTCUT CANNOT BE USED WITH THE
ENO NAVIGATION MODE." This occurred when Application
Hierarchy Mode was set to Hierarchy no ripple, and no
applications were defined for the user's group. With a fix in
v6.2.6, a more appropriate error message is now displayed:
"NO APPLICATIONS AVAILABLE FOR THIS USER. NONE ARE
DEFINED FOR THE GROUP."

XUI Rich Client

SBXA-13122 A change in v6.2.3 caused the Defaults Up Front process
to behave differently. Consequently, Defaults Up Front
settings affected fields with existing data on a screen instead
of affecting only empty fields. In some cases, this change
caused previously functional screens to no longer work
properly. A fix at v6.2.6 causes Defaults Up Front to behave
as it did prior to v6.2.3.

GUI Forms/
Functions, Process
Definitions

SBXA-13163 Previously, text included in the counter on the progress
bar displayed in GUI but did not display in XUI. With a fix
in v6.2.6, the text now is displayed on the left side of the
progress bar in XUI.

XUI Rich Client

SBXA-13164 In v6.2.5, an XUI form would hang or close if the form
contained a field outside of the visible area on the form. This
issue is resolved in v6.2.6.

XUI Rich Client

SBXA-13193 In previous versions, excess grid refreshing caused
performance issues. Especially in instances where the three
tiers of SB/XA were distributed across three computers, the
grid sometimes flickered and caused delays when you tried
to move between fields. This issue is fixed in v6.2.6.

XUI Rich Client

SBXA-13211 Previously, if you pressed F3 and then Accept on a field in
an output process with tabbed screens, the client would
sometimes hang. This problem occurred in XUI mode only.
The issue is resolved in v6.2.6.

Intuitive Help, XUI
Form Designer,
XUI Rich Client

SBXA-13383 From SBClient version 6.2.4 through 6.2.5, if you set the
Auto Extend Field Length flag to No, the change did not
take effect in GUI mode. Auto extend was not disabled as it
should have been. This issue is resolved in v6.2.6.

GUI Forms/
Functions,
SBClient

SBXA-13389 In previous versions, third-level help did not display
correctly, in GUI and XUI mode, if a language code was set
for the user. This problem is fixed in v6.2.6.

Field Definitions,
Internation-
alization (NLS/
Multi Language)

SBXA-13404 In previous versions, toggles sometimes did not display
correctly when placed in a grid. This happened when the
toggle had a derived value, and another field in the grid had
the same derived value. This issue is fixed in v6.2.6.

XUI Rich Client
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SB/XA v6.2.5 release notes
Build 4509
Release Date: May 2014
These release notes provide information about enhancements and fixes in SB/XA v6.2.5.

Enhancements and fixes in SB/XA v6.2.5

The following issues were addressed in this release:

Issue number Description Components

SBXA-4678 In previous versions of the XUI clients, the Process Definition
menu did not display when you entered /PD. This issue
is fixed in v6.2.5. This will only resolve the issue in newly
created system ID's. In order to resolve the problem in
applications that have already been deployed, you will
need to copy the item PROCESSMENU from DMCONT to the
required xxMENUS or Global Menu files.

Menus

SBXA-9234 Entering F3 in a date field on a screen in the XUI client
causes a calendar window to display. In previous versions,
the month and year were aligned to the left in the title bar
of the calendar window. With a fix in v6.2.5, the month and
year now are centered.

Process
Definitions

SBXA-10465 SB/XA may present a security violation screen for a number
of reasons. Entering a valid response code in SBClient clears
the violation, but in previous versions, entering a valid
response code in Rich Client only yielded another violation.
This issue is fixed in v6.2.5.

XUI Rich Client

SBXA-11371 In previous versions, if you were in a System that was not
the default System ID and the theme was not the default SB/
XA theme, selecting the default theme placed you back in
the default System ID. Changing the theme should not have
changed the System. This issue is resolved in v6.2.5.

XAML Styles

SBXA-12191 You can change the icon for menu options in the SBExplorer
interface by right-clicking the name beside the icon and
selecting Change Icon in the context menu. In previous
versions, there was no one-click method to reset the icon.
With a fix in v6.2.5, the context menu in the XUI clients now
includes a Reset Icon option which allows you to revert to
the default icon.

Menus

SBXA-12295 In previous versions, it was possible to inadvertently
duplicate a highlighted letter while translating a menu
definition. The system did not return an error or warning. A
validation code was added at v6.2.5 that produces a warning
message if you duplicate a letter.

Internation-
alization (NLS/
Multi Language)

SBXA-12403 In previous versions, using the zoom function to increase or
decrease the size of a screen in the XUI clients caused the
function buttons on the screen to become blurry. This issue
is resolved in v6.2.5.

Process
Definitions, XUI
Rich Client
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Issue number Description Components

SBXA-12518 In previous versions, if you edited a tabbed screen in XUI
mode, the output process that called that screen failed
the next time the screen was run. The error message
"processname.XD.VARS not found" was displayed. This issue
is resolved in v6.2.5.

XUI Rich Client

SBXA-12560 Problems arose in previous versions if you created a screen
definition in GUI mode in SBClient and then edited the
screen definition in the XUI client. The SD.LOG process
should have been called when you made changes in XUI, but
it was not. This issue is resolved with a fix in v6.2.5.

XUI Form Designer

SBXA-12672 You can toggle the display of two sets of fields in GUI mode,
using a function key that calls SETATTR. In previous versions
of the XUI clients, attempts to use this functionality caused
incorrect display of the fields. This issue is fixed in v6.2.5.

XUI Rich Client

SBXA-12673 You can use a SETATTR command to change the size of a GUI
form. In previous versions, attempts to change the size of a
XUI form with SETATTR failed. This issue is fixed in v6.2.5.

XUI Form Designer

SBXA-12725 In previous versions, data did not display correctly in
interleaved grids when you used the scroll bar. You needed
to double-click a field in order to see its contents. This issue
is resolved in v6.2.5.

Multivalue Grids

SBXA-12820 In previous versions, when a language code was set for the
user, multivalued fields were not displayed in grids when
the Use Grids flag was set to Yes in the input process. This
occurred if the HK.CONTROL flag Use Grids for Multivalued
Fields was set to No. The input process flag should have
taken precedence, but it did not. This issue is resolved in
v6.2.5.

Multivalue Grids

SBXA-12923 If you opened a lowercase record name in the Screen Editor
(/SE), the /LIST.READU process reported record locks for
both a lowercase record name and an uppercase record
name. When you exited the editor, /LIST.READU released
the lock for the lowercase record name but still reported
a record lock for the uppercase record name. After a fix in
v6.2.5, the lock is released correctly when you exit the editor.

XUI Rich Client

SBXA-12933 In versions 6.2.3 and 6.2.4, in GUI mode only, problems
arose when using GUI.TEXT.ED,1 as a Process Before on a
multivalued field. Only the first line of text was displayed.
This issue is resolved in v6.2.5; all lines of text now display
properly.

GUI Forms/
Functions

SBXA-12965 In previous versions, only if you had a language code set,
problems arose when using a memo-type field for an output
process. All other fields on that screen subsequently were
displayed as memo-type fields. This issue is resolved in
v6.2.5.

Form Controls
(Radio/Combo/
Text/Label/
Toggle/Memo)

SBXA-13023 In previous versions, SBClient crashed if you chose File>Save
Configuration As and then clicked Cancel on the subsequent
dialog box. If you then chose File>Exit All, the client crashed.
This issue is resolved in v6.2.5.

SBClient
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SB/XA v6.2.4 release notes
Build 4434
Release Date: March 2014
These release notes provide information about enhancements and fixes in SB/XA v6.2.4.

What’s new in SB/XA v6.2.4

Automatic log file deletion

You can set up automatic clean-up of log files for the Communications Server and the XUI clients with
an enhancement in v6.2.4. User flags allow you to set SB/XA to automatically delete log files based on
age, number, or both. For more information about automatic log file clean-up, see “Cleaning up log
files” in Administering SB/XA. SBXA-8033

New paragraph editor

You can edit paragraphs more easily with an enhancement in v6.2.4. The XUI clients have a new color-
coded editor that makes paragraph editing more user-friendly. For more information, see “Editing
paragraphs in full-screen mode” in SB/XA Application Server Reference Manual. SBXA-386

Matrix in the XUI clients

The ability to use matrix definitions, long available only in SBClient, is now available in the XUI clients
as of v6.2.4. The matrix, similar to a spreadsheet, is ideally suited to applications like those related to
retail clothing. The matrix’s X coordinates, for example, might correspond to shirts of varying colors,
the Y coordinates denote different sizes, and the intersecting Z coordinates use a function to calculate
the price of that item. For more information about on matrix functionality, see “Matrix definitions
with XUI clients” or “Matrix definitions with SBClient” in SB/XA Application Server Reference Manual.
SBXA-4073

SB/XA Services — beta

With SB/XA Services, you can leverage your existing knowledge and investment in SB+ to drive new
types of applications. You can extend the reach of your SB/XA application to new devices, languages,
and frameworks. SB/XA Services is available as a minimally viable product in v6.2.4. In this first beta
release, you can call any non-interactive SB+ process with an HTTP interface. More functionality will
be added in future beta releases. You must be a participant in the beta program to enable and work
with SB/XA Services at v6.2.4. If you are interested in learning more or participating, contact Rocket U2
at u2askus@rocketsoftware.com. If you are a participant, you will receive beta documentation from
your SB/XA Services representative as well as a one-on-one session to help you get started.

Enhancements and fixes in SB/XA v6.2.4

The following issues were addressed in this release:

Issue number Description Components

SBXA-386 Version 6.2.4 introduces a new color-coded editor for user-
friendly editing of paragraphs in the XUI clients. For detailed
information, see "Editing paragraphs in full-screen mode" in
SB/XA Application Server Reference Manual.

Process
Definitions

mailto:u2askus@rocketsoftware.com
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Issue number Description Components

SBXA-4073 The ability to use matrix definitions, long available only
in SBClient, is now available in the XUI clients as of v6.2.4.
The matrix, similar to a spreadsheet, is ideally suited
to applications like those related to retail clothing. The
matrix's X coordinates, for example, might correspond to
shirts of varying colors, the Y coordinates denote different
sizes, and the intersecting Z coordinates use a function
to calculate the price of that item. For more information
on matrix functionality, see "Matrix definitions with XUI
clients" or "Matrix definitions with SBClient" in the SB/XA
Application Server Reference Manual.

XUI Rich Client

SBXA-8033 You can set up automatic clean-up of log files for the
Communications Server and the XUI clients with an
enhancement in v6.2.4. User flags allow you to set SB/XA
to automatically delete log files based on age, number, or
both. For detailed information, see "Cleaning up log files" in
Administering SB/XA.

Admin Tools

SBXA-9149 In previous versions of the XUI clients, some group
application security settings were not properly respected
by SB/XA. When an application was removed from the
list of applications available to users in a parent group,
users belonging to a child group still had access to that
application. As a result, extra work was required to set up
individual user security settings. With a fix in v6.2.4, SB/XA
properly respects group security settings.

XUI Rich Client

SBXA-11409 A flag on the SB Control Parameters screen, "Disallow //,"
previously was available on all platforms except UV/NLS
Unix. This flag was added to the SB Control Parameters
screen for UV/NLS Unix at v6.2.4. The // process is used by
developers who want to edit programs and immediately run
those programs in SB/XA. This ability generally is disallowed
for end users.

Documentation,
Process
Definitions

SBXA-12019 In previous versions of the GUI client, using SETATTR to
disable Bitmap images failed to dim the images. This issue is
resolved in v6.2.4.

SBClient

SBXA-12059 Problems arose in previous versions of the XUI clients when
multiple rows of choices in an auto-complete ComboBox
began with the same letter. For instance, if a user selected
the option in the second row, the client sometimes selected
the first-row option instead due to a faulty selection process
in the client. A fix in v6.2.4 resolves this issue.

GUI Forms/
Functions

SBXA-12106 In previous versions, problems could arise when working
with ComboBoxes in a grid. If you resized a grid column, the
ComboBox did not resize accordingly. With an enhancement
in v6.2.4, ComboBoxes now resize when you resize a grid
column.

Multivalue Grids

SBXA-12230 Under certain circumstances, in previous versions of the GUI
and XUI clients, data stored in OTHER.REC was erroneously
displayed in unrelated grid fields. This issue is resolved in
v6.2.4.

SBClient, XUI
Clients
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Issue number Description Components

SBXA-12232 Using the /PD.L > Data Transfer DOS to SB+ process to
transfer a file failed in previous versions if the file being
transferred was empty. This issue is resolved with a fix in
v6.2.4.

External
Application
Integration

SBXA-12237 Due to a font issue in previous versions of the XUI clients,
some characters such as a lowercase 'y' did not display
correctly in a grid. This issue is fixed in v6.2.4.

Multivalue Grids

SBXA-12276 In previous versions, creating users with null passwords
led to subsequent problems when those users tried to
run processes such as /SEC.USER.SETUP or any other
process that called the SH.VERIFY.USER routine. This issue is
resolved in v6.2.4.

Admin Tools

SBXA-12328 In versions 6.2.2 and 6.2.3, language translation for menus
sometimes failed in GUI mode in SBClient as well as the
XUI clients. If there was no Type 5 menu to regenerate,
translated menus did not properly display the translated
text in GUI or XUI. This issue is fixed in v6.2.4.

Internationalization
(NLS/Multi
Language)

SBXA-12354 SB/XA for UniVerse NLS honors locale information that
has been set up in UniVerse. In previous versions, there
was no way to set locale for an SB/XA user. This issue is
fixed for v6.2.4; the Locale prompt has been added to the
User Security Setup screen. An SB/XA user's locale is now
set correctly when an SB/XA session is connected by the
Communications Server.

Installation /
Configuration

SBXA-12453 The ability to access the SB+ command line from the XUI
clients (through the process /TCL) was added at v6.2.3,
but in some instances, that process led to a client crash.
Entering /TCL followed by the command WE VOC A caused
the client to crash. This issue is resolved in v6.2.4.

XUI Rich Client

SBXA-12470 In previous versions, XPS printing did not work for some
users because data was being truncated in the left column.
Changing the margin settings in the printer class and
updating the printer class definition did not resolve the
problem; the XPS Viewer did not honor the changes. This
issue is resolved in v6.2.4.

Printing / XPS /
PDF / HTML

SBXA-12480 Text did not display clearly in F3 Intuitive Help grid cells
in previous versions of the XUI clients. The text was not
centered vertically within the cell and appeared truncated.
This issue is fixed in v6.2.4.

Intuitive Help

SBXA-12531 In previous versions, using the /MESSAGE process to send
a message, with the Alert Recipients Immediately option
selected, improperly caused another process to start on
the Windows server. This problem was specific only to a
UniData-on-Windows platform. The issue is resolved in
v6.2.4.

Admin Tools

SBXA-12532 In previous versions of the XUI clients, subscreens
incorrectly displayed behind the previous screen instead of
in front of it. This happened only if the "Remove OK, Prev &
Next Buttons in Output Screen" flag was set to Yes on the SB
Control Parameters screen. This issue is resolved in v6.2.4.

XUI Rich Client
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Issue number Description Components

SBXA-12541 Grids were not used when they should have been in previous
versions under certain circumstances. If the "Use Grids for
Multivalued Fields" flag at the screen level was set to use
grids, the grids should have been used even if flags at the SB
Control Parameters level and HK.CONTROL level were set to
not use grids. The screen-level flag should have overridden
the others, but it did not in previous versions. This issue is
fixed in v6.2.4.

Process
Definitions

SBXA-12599 In previous versions of the XUI clients, a grid failed to pass
a value to the server in certain situations. If a selection
process was called from a field in a grid, and it accepted a
value to be used to filter the selection, the value was not
passed to the server. This issue is resolved in v6.2.4.

Multivalue Grids

SBXA-12698 In previous versions, changing the Intuitive Help Display
flag in GUI preferences for a user (/USER.FLAGS) caused the
intuitive help window to display incorrectly. It displayed too
many rows and ran off the bottom of the screen. This issue is
resolved in v6.2.4.

Process
Definitions, XUI
Rich Client

SBXA-12717 Group security restrictions for menu options were not
always correctly honored in previous versions of the XUI
clients. If menu options were restricted for a parent group,
members of the child group should not have had access
to those menu options; however, the restrictions were
not honored for Mainwin menu options under certain
circumstances. This issue is resolved in v6.2.4.

XUI Rich Client

SBXA-12723 XUI client crashes occurred in v6.2.3 when using the newly
implemented /TCL functionality. If you used /TCL to drop to
the SB+ command line and then used the Down Arrow key in
the SB/XA Admin Console window, selected a command and
pressed Enter, the client crashed. This issue is fixed in v6.2.4.

Admin Tools

SB/XA v6.2.3 release notes
Build 4369
Release Date: December 2013
These release notes provide information about enhancements and fixes in SB/XA v6.2.3.

What’s new in SB/XA v6.2.3

Enhanced form resizing

With version 6.2.3, you have new options for resizing, zooming, and working with forms in the XUI
clients. For detailed information, see “Sizing and zooming XUI forms” in the SB/XA Application Server
Reference Manual. SBXA-11216

New group application and security techniques

Version 6.2.3 introduces two new options for controlling group application and security settings.
For more information on Application Hierarchy Mode, see “SB Control Parameters: Security Tab” in
Administering SB/XA. For more information on the Don’t automatically add Group Applications flag,
see “Click the Single Sign-On tab.” in SB/XA Getting Started. SBXA-10586

TCL support in XUI clients
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With version 6.2.3, you now have the ability to access the SB+ command line by entering /TCL in Rich
Client or Browser Client. Previously this functionality was supported only in SBClient and not in the
XUI clients. For more information on accessing command lines, see “Navigation” in SB/XA Application
Server Reference Manual. SBXA-11670

Enhancements and fixes in SB/XA v6.2.3

The following issues were addressed in this release:

Issue number Description

SBXA-1727 In previous versions, problems arose when TCL.PCDUMP and TCL.PCLOAD
commands were run on a file containing an empty record. A change in v6.2.3
resolves this problem in CHAR and GUI mode. A problem may still exist in XUI
and will be addressed in a future release.

SBXA-4881 In recent versions, SBClient did not properly save the Join Lines and Append CR
settings on the clipboard setup. This issue is resolved in v6.2.3.

SBXA-10086 With a fix in v6.2.3, changing the Internat/American Date field in SB Control
Parameters (/SB.PARMS) no longer results in a reset of all values on the Main
tab. This issue was fixed for the UniVerse Windows environment in v6.2.2, and
has now been fixed for all other platforms.

SBXA-10538 An enhancement at v6.2.3 causes grids to change size when columns are hidden
with the SETATTR command. Previously when columns were hidden with
SETATTR, the grid size remained unchanged, leaving blank space.

SBXA-10586 Version 6.2.3 introduces new functionality with group applications and security.
In Application Hierarchy Mode, the Hierarchy no ripple option has been enabled.
You also have a new flag, Don't automatically add Group Applications. For
more information on Application Hierarchy Mode, see “SB Control Parameters:
Security Tab” in Administering SB/XA. For more information on the new flag,
Don’t automatically add Group Applications, see “Click the Single Sign-On tab.”
in SB/XA Getting Started.

SBXA-11140 In v6.2.3, the method for styling a grid has changed. Prior to v6.2.3, the grid cells
were styled as SBFields for both the content and editor style. Now, the content
style on the grid utilizes a TextBlock element to display the data. For further
details, see Tech Note SBXA-12142.

SBXA-11141 Version 6.2.3 provides a new set of internal help on XAML styles. In General Help,
expand the new XUI features branch to find the new XAML Styles help file. The
XAML Styles help is currently the only item in this new branch.

SBXA-11163 In previous versions, if you accidentally pressed F4 to delete a field in Screen
Designer in the XUI client, and then chose "No" to cancel the deletion, the client
improperly handled a subsequent F5 command to display field properties. This
issue is resolved in v6.2.3.

SBXA-11170 Custom themes have faster performance as of v6.2.3 due to a change in the way
SB/XA handles its default theme. As a result, users with existing custom themes
must remove from their theme definitions all merged dictionaries that reference
the SB/XA default theme. This applies only to users working with .NET 4.5. The
process for creating new custom themes remains unchanged from previous
versions, except users should not create merged dictionaries that reference the
SB/XA default theme.

SBXA-11216 You have greater control over sizing and zooming of XUI forms with an
enhancement at v6.2.3. New user flags and functionality allow proportional
zooming and resizing, global zoom, and other options. For detailed information,
see “Sizing and zooming XUI forms” in the SB/XA Application Server Reference
Manual.

https://www.rocketrack.com/browse/SBXA-12142
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Issue number Description

SBXA-11275 In previous versions, changing system ID with the command /SYS,Sysid in the
Rich Client erroneously failed to update the system ID in the title bar of the
Outlook menu and in the menu option. Version 6.2.3 corrects this issue.

SBXA-11277 The parameter "Load theme on SYS call" did not work properly in previous
versions. Changing this setting in SB Control Parameters did not produce the
intended change in the way themes were loaded when switching systems. This
issue is resolved in v6.2.3.

SBXA-11432 The XUI Screen Designer inappropriately downloaded the GUI version of screens
under certain circumstances rather than the XD version of the screen. This issue
is resolved in v6.2.3.

SBXA-11569 In previous versions, the loading of a report in XPS Viewer could not be
cancelled; users had to wait until the report finished loading. Version 6.2.3
resolves this issue.

SBXA-11584 Calling an HTML file in Rich Client with /HTML,filename failed in previous
versions, though it worked in GUI mode. This issue is resolved in v6.2.3.

SBXA-11587 The command SB.SROC.MAIN was generating an inappropriate "Uninitialized
Variable Used" error in previous versions. This issue has been resolved in v6.2.3.

SBXA-11616 In previous versions, SB/XA incorrectly returned an Unitialized Variable error
when executing a screen for the first time in the XUI client with the process
SB.GEN.DRIV. A fix in v6.2.3 resolves this issue.

SBXA-11631 In previous versions, using an @REFRESH command (set to @REFRESH = -2)
caused SETATTR to fail in changing colors on a grid in XUI mode. This issue is
resolved in v6.2.3.

SBXA-11641 In previous versions, using an @REFRESH command (set to @REFRESH = -2)
caused SETATTR to fail in changing colors on a grid in GUI mode. This issue is
resolved in v6.2.3.

SBXA-11670 With v6.2.3, you now have the ability to access the SB+ command line by
entering /TCL in Rich Client or Browser Client. Previously this functionality was
supported only in SBClient and not in the XUI clients. For more information
on accessing command lines, see “Navigation” in SB/XA Application Server
Reference Manual.

SBXA-11692 In XUI mode in previous versions, the days in the Calendar Lookup Box did not
update properly when scrolling from month to month. Version 6.2.3 resolves this
issue.

SBXA-11731 Scroll bars were displayed in incorrect locations on GUI screens in previous
versions. The scroll bars were displayed to the right of the ninth column in
a screen, even if there were more than nine columns. This occurred when
multivalue data was not being displayed in a grid, as set by the G option — Do
not use a Grid. With a fix in v6.2.3, the scroll bars now are displayed at the end of
the columns.

SBXA-11760 In previous versions, clicking on the status bar of the main client window
in XUI mode while a dialog box was being displayed caused the dialog box
to disappear behind the main window. This prevented you from entering a
response in the dialog box, effectively rendering the client unresponsive. This
issue is resolved in v6.2.3.

SBXA-11788 In previous versions, using the Test (F7) function key to test a button in Toolbar
Definitions in the Rich Client caused the client to crash. Version 6.2.3 resolves
this issue.
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Issue number Description

SBXA-11795 In previous versions, using @REFRESH = 2 on a field caused problems with radio
buttons and toggles in the XUI client. You had to click twice on any radio button
or toggle following a setting of @REFRESH = 2, once to gain focus on the object
and once to change its value. This issue is resolved in v6.2.3.

SBXA-11796 In previous versions, the grid footer field to display the sum of a column failed to
correctly display values in output screens (PD.O). This issue is resolved in v6.2.3.

SBXA-11816 Setting the page orientation to landscape in XPS Viewer did not correctly apply
the orientation setting to all pages in previous versions. This issue has been
resolved in v6.2.3.

SBXA-11825 Text did not always properly align within grid cells in XUI mode in previous
versions. This issue has been resolved as of v6.2.3.

SBXA-11847 In previous versions, setting a style in the style name field on the Dialog Box
Definition Tool failed to correctly implement the style at run time. Code has
been added in v6.2.3 to resolve this issue.

SBXA-11896 Closing a sub-screen while working with custom controls caused the main
screen to close in previous versions. This issue has been resolved in v6.2.3.

SBXA-11901 Version 6.2.3 addresses several issues regarding the application of predefined
label styles to screens in XUI mode. Previously, predefined styles failed to apply
after a screen was modified in the screen designer (/SD) of the XUI client. An
inconsistency with naming conventions between GUI mode and XUI mode is
now resolved. An issue still persists and will be addressed in a future release,
but a work-around is available for v6.2.3. To make sure label styles are applied
correctly on a XUI screen, call the field definitions (/FD) for a field containing a
styled label, call the additional parameters screen (F6), and manually add the
prefix "@FORM*" to a "Label Object Name" field.

SBXA-11911 In previous versions, Rich Client crashed when using a multivalue mark in a
display statement with option 9 (DISP 9). This issue is resolved in v6.2.3.

SBXA-11920 Running an output screen with the Enable Multi-language Support flag set to Yes
caused the client to crash in previous versions. The issue occurred when there
were two sets of multivalue fields on a screen, the screen did not use a grid, and
the second multivalue table had a window size of 1. This issue has been resolved
in v6.2.3.

SBXA-11936 In previous versions, keystrokes sometimes were inappropriately buffered and
then sent to the server from the XUI clients. This happened if a dialog box was
being displayed and you clicked on the main client window and pressed Esc. Any
subsequent keystrokes then were stored, and they were sent to the server once
the dialog box was closed. This issue has been resolved in v6.2.3.

SBXA-12023 Rich Client did not correctly apply settings from the central configuration file
in some instances in previous versions. This happened if you were running
the client without a central configuration file and then began running it
from a location that was using a central configuration file. In that instance,
it was possible for some values to be used from cache instead of from the
configuration file. This issue has been resolved in v6.2.3.

SBXA-12066 In previous versions, SBClient crashed because of a memory leak when screens
were repeatedly displayed. This issue has been resolved in v6.2.3.

SBXA-12071 In previous versions, the intuitive help key (F3) failed to list all valid applications
for a user on the Single Sign-On tab of the user security setup. This issue has
been resolved in v6.2.3.
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Issue number Description

SBXA-12089 In previous versions, problems arose when a user had a language specified in
Multi-language Support and chose the G option for the controlling multivalue
field. Multivalue sets were incorrectly displayed as grids. This issue has been
resolved in v6.2.3.

SBXA-12186 When you called a process from a custom control in previous versions, the
process name sometimes was corrupted. This issue is resolved in v6.2.3.

SBXA-12239 In v6.2.2, upgrading the SB/XA Application Server to a UniData-only database
incorrectly loaded directories for UniVerse, as well. This issue has been resolved
in v6.2.3.

SB/XA v6.2.2 release notes
Build 4231
Release Date: June 2013
These release notes provide information about enhancements and fixes in SB/XA v6.2.2.

What’s new in SB/XA v6.2.2

National Language Support in SB/XA for UniVerse NLS
At v6.2.2, the National Language Support (NLS) feature of the UniVerse database server is incorporated
in SB/XA for UniVerse NLS. With the complete functionality of NLS implemented in SB/XA, you have
the ability to internationalize SB-developed applications for a diverse customer base. For details, see
Chapter 8, “Setting up National Language Support in SB/XA for UniVerse NLS,” in the SB/XA Getting
Started guide. SBXA-8171

Ability to translate headings and buttons in XPS Viewer
With Multilanguage support enabled, the text of headings and buttons in the XPS Viewer can be
translated to an alternative language. For more information, see the description for this item in the
table below. SBXA-4072

Support for XPS output to Microsoft Excel
At v6.2.2, you can direct Report Writer, QRD, and TU.SEND.TO.PRINTER output to Microsoft Excel in the
XPS Viewer. SBXA-4557

Specifying the default system ID in ENO mode
As of v6.2.2, you can specify the system ID to be displayed by default for an account in ENO mode. A
new parameter named "Default System ID for ENO mode" has been added in the User Security Setup >
XUI Flags tab to support this functionality. SBXA-9634

Parameter to control initial size of documents in XPS Viewer
A new flag named Initial XPS Viewer Document Size controls the initial size of documents in the XPS
Viewer. For details, see the description for this item in the table below. SBXA-9989

Showing or hiding the Options menu in the XUI clients
At v6.2.2, the Options button in the SB/XA Browser Client or SB/XA Rich Client main window is shown
if the enableOptionsMenu property contains no value or is set to True in the centralized configuration
file. You can configure clients to hide the Options button by setting a property in the centralized
configuration file. For details, see the description for this item in the table below. SBXA-10110

New group security technique
SB/XA v6.2.2 contains a new field and a new flag reserved for future use as parameters for a group
security technique. The new field, named “Application Hierarchy Mode,” is in SB Control Parameters
(/SB.PARMS) > Security. The value in this field defines the way the user’s list of available applications
is populated and determines if an application added to a group is also automatically added to the
list of available applications for users who belong to the group or to its child groups. Only the default
setting of 0 (No hierarchy) is supported in v6.2.2. Do not change this value. The new flag, named “Don’t
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automatically add Group Application,” is in User Security Setup (/SEC.USER.SETUP) > Single Sign-On.
Only the default setting of Y (Do not automatically add group applications) is supported in v6.2.2. Do
not change this value. SBXA-10586

Enhancements and fixes in SB/XA v6.2.2

The following issues were addressed in this release:

Issue Number Description

SBXA-1682 When a XUI client loses a connection to SB/XA Communications Server due to
an electrical failure, the UniData or UniVerse telnet connection is dropped and
the license is released on the database server computer. However, in earlier 6.x
versions, if you ran the List Users Logged In (/LISTU) process in SB/XA, it showed
incorrectly that the SB license was in use. A fix to the SB/XA Communications
Server code resolves this problem in v6.2.2.

SBXA-3132 In the main window, the title bar color now indicates whether the window is in
focus. When the main window is not in focus, the title bar is light blue; when the
main window is in focus, the title bar changes to a darker blue.

SBXA-3619 In Field Definitions (/FD) > F5-Review, Page Down and Page Up did not display
the list of attributes correctly. The code was amended to resolve this problem in
v6.2.2.

SBXA-4072 With Multilanguage support enabled, the text of headings and buttons in the
XPS Viewer can be translated to an alternative language. In the translation (/
TRANSLATE) process, specify the alternative language, click XPS Text, and enter
the alternative language text in a table format. For details, see “Translating
headings and button labels in the XPS Viewer interface” in the SB/XA Reference
Manual.

SBXA-4381 In selection process definitions (/PD.S), the F5 Tag and Shift-F5 Untag options
are not supported in the XUI clients and have been removed from the XUI
interface at v6.2.2.

SBXA-4557 At v6.2.2, you can direct Report Writer, QRD, and TU.SEND.TO.PRINTER output to
Microsoft Excel in the XPS Viewer.

SBXA-4577 In previous versions, the ability to change the column width in intuitive help
grids was not supported in XUI mode. Two changes were implemented to
address this problem in v6.2.2:

▪ In the selection process definition (/PD.S), the F6.Addit button opens the
Additional Selection Parameters window, where you can specify the width of
each column in pixels for use in XUI mode.

▪ The Grid Cell Width parameter in the System Control Record (/HK.CONTROL)
> XUI tab is now applied to selection controls.

SBXA-4795 In XUI mode, if you clicked a button control and moved focus off of it before
releasing the mouse button, the button event was executed. This behavior has
been corrected in v6.2.2 and XUI mode now works the same as GUI mode: the
button event is executed only if the mouse button is released when the button is
in focus.

SBXA-5239 After pressing F3 in the Decimal Value for <Enter> Key field in the SB Control
Parameters (/SB.PARMS) > Keys tabbed page, the XUI client failed and did
not issue a message. With a fix in v6.2.2, the XUI client no longer fails in this
situation. In addition, if the Options > Configuration > Client Server Connections
> In development mode flag is set to True, a “not implemented” message is
displayed.
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Issue Number Description

SBXA-5314 Drop_shadow_depth properties were adjusted in the default SBXA theme and
vanilla theme so that fields no longer appear to overlap.

SBXA-7925 In both the Screen Designer (/SD in GUI mode) and the SB/XA Designer (/SD in
XUI mode), in screens containing an alphanumeric field with the GUI Object Type
set to Textclass, the field lost its label and was redisplayed in the wrong position
after the object type was changed to Memo. A fix was applied to the SB/XA
Designer in v6.2.2 so that the field no longer loses the label or changes position
after the object type is set to Memo. However, in GUI mode, the behavior
remains the same as in previous versions.

SBXA-8108 In XUI mode, if you attempted to insert multiple lines in a grid by using Ctrl
+ Insert, only one new line was added. The grid performance improvements
implemented in v6.2.2 correct this problem in the XUI clients.

SBXA-8171 Beginning with v6.2.2, the National Language Support (NLS) feature of the
UniVerse database server is incorporated in SB/XA for UniVerse NLS. With the
complete functionality of NLS implemented in SB/XA, you have the ability to
internationalize SB-developed applications for a diverse customer base. For
details, see Chapter 8, “Setting up National Language Support in SB/XA for
UniVerse NLS” in the SB/XA Getting Started guide.

SBXA-8486 In the screen editor (/SE) in XUI mode, the system failed when attempting
to perform a “Replace all” function on a selected word. This issue has been
resolved.

SBXA-8494 In the UniData for UNIX edition, inserting lines when editing a file from Admin
> Files > Update Processes > Edit a File caused SB/XA Rich Client to fail. A fix
prevents this problem in v6.2.2.

SBXA-8537 When the Self Contained Forms flag in the user security record was set to Y, a
DISP 9 message was displayed in all open windows, not just the current window,
in XUI mode. This behavior has been corrected in v6.2.2, and the message is
displayed only in the current window in XUI mode, the same as in GUI modes.

SBXA-8573 A new user created with no password and the Autologin flag set to 0 (Single
Sign-on disabled) was able to log on only once in XUI mode. When logging on
a second time, the client returned an error message, “The SB/XA user name or
password is incorrect.” This issue has been resolved in v6.2.2.

SBXA-8576 In SB/XA Rich Client, the Undo function did not cancel the latest changes to text
in the Screen Editor (/SE). With a correction in v6.2.2, the Undo function works as
designed in XUI mode.

SBXA-8682 When adding a new function key button on a form in the Screen Designer (/SD
in GUI mode) or the SB/XA Designer (/SD in XUI mode), the new button was sized
automatically and other buttons were repositioned to accommodate the new
button in both GUI and XUI modes. As of v6.2.2, the SB/XA Designer (/SD in XUI
mode) provides a flag, “Reposition or resize buttons in SD.” If the flag is set to
Yes, buttons are sized or repositioned automatically.

SBXA-8686 In v6.2.2, a "Disallow //" flag was added on the SB Control Parameters (/
SB.PARMS) > Main tab. When this flag is set to Yes, the "//" process, which
reloads the SB environment, is disallowed.

SBXA-8762 When multiple instances of SB/XA Communications Server were defined in the
common configuration file, the client connected to the wrong communications
service. The fix to a related issue also corrected this problem.

SBXA-8774 When viewing user and group security records, the tree structure was not shown
in SB/XA Rich Client. This functionality is implemented in v6.2.2.

SBXA-8986 Double-clicking on a hyperlink in XUI mode caused the client to fail. A code
change has resolved this problem in v6.2.2.
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Issue Number Description

SBXA-9090 In some circumstances, forms were disabled after they were edited and closed in
the SB/XA Designer (/SD in XUI mode). A fix resolves this issue in v6.2.2.

SBXA-9102 In the XA or vanilla theme in XUI mode, scroll bars were not displayed after
resizing the Properties window smaller so that not all lines were visible. A code
change corrects this behavior in v6.2.2, and scroll bars are displayed as expected
in the XUI clients.

SBXA-9103 Resizing the Properties palette also changed the size of the "..." button in the
SB/XA Designer (/SD in XUI mode). This behavior has been corrected.

SBXA-9104 In v6.2.0 or later, the Left, Top, Height, and Width properties were not validated
in the Properties palette of the SB/XA Designer (/SD in XUI mode), so negative
and oversize values were allowed. A validation routine was implemented to
prevent this problem in v6.2.2.

SBXA-9105 In the Font dialog box of the SB/XA Designer (/SD in XUI mode), "default_font" is
the default selection, but it could not be used as a valid value. With a fix in v6.2.2,
"default_font" can be used as a valid value, and any invalid value is interpreted
as "default_font".

SBXA-9112 In the SB/XA Designer (/SD in XUI mode), opening two forms and closing the
second form by clicking the X (Close) button caused the client to fail. The code
was amended to prevent this problem in v6.2.2.

SBXA-9131 Adding a saved function key set to a XUI screen definition caused the XUI client
to fail when the screen was run. With a code change in v6.2.2, a saved function
key set in a screen no longer causes client failure.

SBXA-9148 For SB/XAUserNamePassword authentication type only, if the OS User ID field
in the user security record is initially left blank and the user enters a value in the
User Name field at logon, the user name is saved to the OS User ID field in the
user security record.

SBXA-9153 Corrections to hover help and spelling of "Storage" were made in the Group
Security Setup (/SEC.GROUP.SETUP) form.

SBXA-9236 In tabbed forms in XUI mode, clicking on a subsequent tab before entering the
record key in the first tab briefly displayed an inaccessible subsequent tab and
then displayed the first tab. With a fix in v6.2.2, the inaccessible subsequent tab
is not displayed. The behavior is now consistent in XUI and GUI modes.

SBXA-9246 F3 intuitive help on a date field opens the Calendar window with today's date
highlighted. In previous versions, if you scrolled forward or back and returned to
the current month, today's date was no longer highlighted; if you pressed Enter
on today's date, the wrong date was returned. This issue has been resolved in
v6.2.2, and selections from the Calendar return the correct date.

SBXA-9399 For XPS.CLASS, add/insert/delete (AID) restrictions were implemented to
prevent inserting attributes in this printer class definition.

SBXA-9432 In the UniData for UNIX edition, the system was disconnected on clicking the XUI
Favs menu in Group Security Setup (/SEC.GROUP.SETUP). This issue has been
resolved in v6.2.2.

SBXA-9634 As of v6.2.2, you can specify the system ID to be displayed by default for an
account in ENO mode. A new parameter named "Default System ID for ENO
mode" has been added in the User Security Setup > XUI Flags tab to support this
functionality.

SBXA-9691 In SB Control Parameters (/SB.PARMS) > GUI Flags, pressing F3 in the Navigation
Method field and selecting the EMO navigation method returned an error. A fix
was applied to validate the EMO option in /SB.PARMS, preventing this error in
V6.2.2.
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Issue Number Description

SBXA-9692 In v6.2.0, the driver lines for "non-grid" grid fields were missing dependent field
information. The code was revised to correct this problem in v6.2.2.

SBXA-9753 A list of default styles is available in General Help > Technical Information >
Screen Default Styles.

SBXA-9771 At v6.2.2, if an icon is specified for a menu option in the menu definition (/MD >
F6-Addit > F5-MPX Parameter), the icon is displayed for the menu option when
the menu is displayed as a context menu.

SBXA-9849 In the List SB Users (/LISTU) window, the width of the process ID (PID) field was
increased to prevent truncating process IDs.

SBXA-9888 The XUI client failed when attempting to run the Admin > Media Commands >
Load File From Media function. A fix was applied to prevent this issue in v6.2.2.

SBXA-9989 A new flag named Initial XPS Viewer Document Size controls the initial size
of documents in the XPS Viewer. The XPS Viewer shows the full width of the
document if it is smaller than the screen size minus a margin. If the document is
wider than the screen size, minus a margin, this parameter determines whether
the document is shown at actual size with scroll bars or scaled down so the
width of the document fits the XPS Viewer.

SBXA-10011 With a change implemented in v6.2.2, Microsoft Outlook-style menus can display
more than three system IDs initially, and the number of system IDs last displayed
persists when you restart the client.

SBXA-10035 Arrow keys did not work reliably in combo boxes in XUI mode; they sometimes
did not function at all, and the only workaround was to use the mouse instead.
The behavior of arrow keys was corrected in v6.2.2.

SBXA-10045 Menu coordinates containing decimal values (such as 13,4.37) caused the XUI
client to fail. A fix was implemented in v6.2.2, and the XUI client disregards
decimal values without failing, the same as in GUI mode.

SBXA-10079 Query (/QRD) reports did not use the Printer Orientation or Stationery setting
from the report definition. For example, query reports were not displayed
in landscape mode when the Stationery field was set to Landscape in the
report definition (from F9-Addit > F7-XPS Parameters). This problem has been
corrected in v6.2.2, and query reports honor the settings in the report definition.

SBXA-10086 With a fix in v6.2.2, changing the Internat/American Date field in SB Control
Parameters (/SB.PARMS) no longer results in a reset of all values on the Main
tab.

SBXA-10090 The Process Name field in the Process Defn - Paragraph (/PD.P) window has
been extended to 60 characters to accommodate long process names.

SBXA-10092 Icons for systems IDs on Microsoft Outlook-style menus did not default to the
icons defined in MPX Parameters in the SBSYSMENU. With a code change in
v6.2.2, SB/XA checks the VOC SBSYSMENU for a defined icon for the system ID.

SBXA-10097 In the SB/XA Designer (/SD in XUI mode), a new field added to the form was
corrupted after changing the field name via the F5 option. This issue has been
resolved.
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SBXA-10110 At v6.2.2, the Options button in the SB/XA Browser Client or SB/XA Rich Client
main window is shown if the enableOptionsMenu property contains no value
or is set to True in the centralized configuration file. The Options button
provides access to a menu of configuration settings for the client and SB/XA
Communications Server. You can configure clients to hide the Options button
by setting a property in the centralized configuration file. To hide the Options
button, insert the following lines in the XML document:
<Property>
<Name>enableOptionsMenu</Name>
<Value>False</Value>
</Property>

SBXA-10114 Running a SAVE-LIST in a shell wrapper (/PD.H) process did not save the results
of a SELECT previously run by the shell wrapper process. A fix resolves this issue
in v6.2.2.

SBXA-10132 In field definitions (/FD) in the XUI clients, clicking on the main window when a
dialog box was displayed caused the client to fail if the dialog box was smaller
than the current form. A code fix was implemented to prevent this problem in
v6.2.2.

SBXA-10137 The calculator ( /CALC) process in the XUI clients was unable to multiply by a
negative number and returned an incorrect value. A fix was applied in v6.2.2 and
the calculator can handle negative values in XUI mode, as designed.

SBXA-10140 In v6.1.4 and later, special characters were not displayed correctly in F1 help.
This issue has been resolved.

SBXA-10147 The calculator (/CALC) process returned an error when performing calculations
with a result greater than 1000 if the region was Germany. This issue has been
corrected in v6.2.2.

SBXA-10165 With an enhancement in v6.2.2, toggles (check boxes) are positioned by default:
• Inside a grid, toggle objects are centered. • Outside a grid, toggle objects are
left-justified. You can override the default position with a custom XAML style.

SBXA-10173 With a fix applied to the shell wrapper process (/PD.H) in v6.2.2, the output of the
shell command is not displayed in GUI mode.

SBXA-10199 Using Alt-F4 to close a session in SB/XA Rich Client caused the client to close as
expected, but left the server session running. The code was amended to correct
this problem in v6.2.2.

SBXA-10202 When entering data in a selection process to narrow the results, the Select multi-
value window allowed entry of only one multivalue string. This issue has been
resolved in v6.2.2.

SBXA-10224 With a fix in v6.2.2, a null password is accepted in Security > Initialize Users
Password when the Allow Null Password option is switched on, as designed.

SBXA-10232 Clicking between multivalue grids in the same screen reloads the data in the
grid that is clicked. This resulted in a significant delay if the grid contained
a large number of rows. Grid improvements implemented in v6.2.2 increase
performance in the data reload.

SBXA-10234 Entry of the ° degree sign (Alt-248 on the keyboard) was supported in both XUI
and GUI modes, but the symbol was not displayed in data in the XUI client after
a REFRESH. A fix resolves this problem in v6.2.2, and the degree sign is displayed
as expected.

SBXA-10236 In the UniVerse edition, calling SB.ROC with special characters such as "44°"
caused the server to fail and the XUI client to shut down. A fix prevents failure in
this situation in v6.2.2.
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SBXA-10239 A derived field displayed an image in GUI mode, but not in XUI mode. The
process displayed the pathname of the file rather than the image in the XUI
client. This issue has been corrected in v6.2.2.

SBXA-10247 When using the ENO navigation method (SBExplorer with Microsoft Outlook-
style interface, without MainWin) with a custom theme in the XUI clients, the
following occurred: The menu turned gray. The icons, system ID, and description
were not displayed on the active tab. Right-clicking the menu for tabs no longer
worked. These behaviors have been corrected in v6.2.2.

SBXA-10250 In earlier versions, a user who received the "Record locked" message was
assigned the user name of the user who locked the record. The code was
amended to correct this problem in v6.2.2.

SBXA-10277 SBClient DLLs are copyright-branded with both the date and company name in
v6.2.2.

SBXA-10316 When using a custom help provider and the provider returned a value of False,
the message "No help available for focus" was displayed, and the client had to
be closed before proceeding. With a modification in v6.2.2, the client no longer
fails in these circumstances.

SBXA-10324 When attempting to add an account with an incorrect path, SB/XA returned
an error message, "COULD NOT OPEN A PATH TO PATH." The error message
text has been revised to, "THE PATHNAME DOES NOT POINT TO AN EXISTING
ACCOUNT."

SBXA-10374 In the SB/XA Designer (/SD in XUI mode), if you added a dependent mutivalue
field on a screen and placed an image in the field, the details of the image were
lost after saving the screen. When editing the screen, the multivalue image field
showed a blank field definition. This problem has been fixed in v6.2.2, and the
image details are saved as designed.

SBXA-10384 The "/" process command was not supported in ENO navigation (SBExplorer
with Microsoft Outlook-style interface, without MainWin) in XUI mode. After a fix
in v6.2.2, the “/” command works as expected in the ENO navigation method.

SBXA-10389 Images were not displayed correctly in grids: Grid updates did not refresh
images if no previous data had changed, and an individual image cell in a grid
did not load the image. Several fixes prevent problems with grid images in
v6.2.2.

SBXA-10391 In ENO navigation (SBExplorer with Microsoft Outlook-style interface, without
MainWin), running the /DATE process when only the menu was displayed caused
the XUI client to fail. A code fix prevents this problem in v6.2.2.

SBXA-10402 De-emphasizing a button bar icon on a tabbed screen did not work in SB/XA
Rich Client. The code was amended to fix this issue in v6.2.2, and icons are de-
emphasized in the button bar as designed.

SBXA-10421 In the ENO navigation method (SBExplorer with Microsoft Outlook-style
interface, without MainWin), entering “//” in any field caused SB/XA to fail. The
“//” shortcut is designed to return to the main menu, which is not used in ENO
mode. At v6.2.2, this shortcut is disabled in ENO navigation; entering // in any
field returns an error message, “THE '//' SHORTCUT CANNOT BE USED WITH THE
ENO NAVIGATION MODE.”

SBXA-10426 In Revision Control, revision reports can now be output to screen in the XPS
Viewer. Revision Control supports three output options: Screen, Printer, and
Listview.

SBXA-10439 As of v6.2.2, options and hot keys on a type 5 menu and its submenus can be
translated to an alternative language. For details, see "Translating a type 5
menu" in Chapter 3, "Main Tools," in the SB/XA Reference Manual.
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SBXA-10463 In the XUI clients, after calling a menu from a form, clicking on the form caused
the form to be displayed on top, obscuring the menu from view. This behavior
has been corrected so that XUI mode works the same as GUI mode: the action of
clicking the form when the menu is still open has no effect.

SBXA-10466 When running an input process in SB/XA Rich Client, if you tabbed past a
multivalued field with a default value, the value was displayed in both the
previous and current multivalued fields, corrupting data. The code was revised
to correct this problem in v6.2.2.

SBXA-10470 In ENO navigation method (SBExplorer with Microsoft Outlook-style interface,
without MainWin), if you set the 'Send Esc to Server on 'X' from Mainwin' flag to
Yes, pressing the X (Close) button in the upper right corner of the window did not
close the application. A fix was applied in v6.2.2, and the ENO method closes the
window when X is pressed and no other forms are showing.

SBXA-10497 When using the EMO navigation method, an incorrect system ID was sometimes
displayed when a screen was called from the Favorites folder. If you placed
menu items from different system IDs in the Favorites folder, the system ID at
the top of the main window was not always updated with the correct system
ID. With a correction in v6.2.2, the original system ID is restored after running a
process from the Favorites menu that is not in the current system.

SBXA-10523 Arrow keys did not work in F3 intuitive help selection lists in GUI mode when the
ListView Style Selects flag was set to N (No). The behavior of the arrow keys has
been corrected in v6.2.2, and these keys again work to scroll the list of values
when this flag is set to N.

SBXA-10526 Rectangle object properties were missing from the SB/XA Designer (/SD in XUI
mode). These properties were added in v6.2.2.

SBXA-10537 Improvements were implemented in v6.2.2 to support pasting data in excess of
20,000 characters from the Windows Clipboard to SBClient. Note that pasted
data is truncated to 64,000 characters.

SBXA-10541 In v6.2.1, an F3 lookup on screen names in /SD did not support narrowing the
search by entering characters. This issue was addressed in v6.2.2, and the search
narrowing feature now requires entering a right square bracket character "]"
after the search character. For example, enter B] to narrow the F3 search results
to entries beginning with the letter B.

SBXA-10586 SB/XA v6.2.2 contains a new field and a new flag reserved for future use as
parameters for a group security technique. The new field, named “Application
Hierarchy Mode,” is in SB Control Parameters (/SB.PARMS) > Security. The value
in this field defines the way the user’s list of available applications is populated
and determines if an application added to a group is also automatically added
to the list of available applications for users who belong to the group or to its
child groups. Only the default setting of 0 (No hierarchy) is supported in v6.2.2.
Do not change this value. The new flag, named “Don’t automatically add Group
Application,” is in User Security Setup (/SEC.USER.SETUP) > Single Sign-On.
Only the default setting of Y (Do not automatically add group applications) is
supported in v6.2.2. Do not change this value.

SBXA-10594 Using the modify process (/MP) to drill down from a process slot to the source
code in the SB/XA Designer (/SD in XUI mode) caused the XUI client to fail. A code
change was applied to prevent this problem in v6.2.2.

SBXA-10598 In the field definitions (/FD) process, calling the Other Elements option in the
Build Expressions window in GUI mode produced an error and failed to display
the elements. The code was amended to correct this problem in v6.2.2.



SB/XA v6.2.2 release notes

53

Issue Number Description

SBXA-10642 In the UniData edition, the record lock did not report the user correctly if the file
had a relative pointer in the VOC. This issue has been resolved in v6.2.2.

SBXA-10658 In some cases in XUI mode, the Process After slot of a toggle (check box) object
was not run. This occurred if the toggle was the last field on the screen and you
selected the check box and then clicked F2. A correction was made in v6.2.2, and
the Process After slot of a toggle runs in XUI mode, the same as in GUI mode.

SBXA-10670 ALT hot keys in subscreens did not work correctly in the XUI clients. If the main
screen called a subscreen and each had the same hot key associated with a
different function key, the function key from the main screen was called when
the subscreen was open and the user pressed the hot key. A fix prevents this
problem in v6.2.2.

SBXA-10682 In v6.2.1, multivalue fields in non-grids displayed values in the wrong fields in
GUI mode. The code was amended to correct this problem in v6.2.2.

SBXA-10684 An image field on any screen caused SB/XA Rich Client to fail. This issue has been
fixed.

SBXA-10694 In XUI mode, combo boxes on tabs did not load reliably. Default values were
displayed on first access of the tab, but not on subsequent access. Clicking the
combo box arrow displayed values multiple times. These combo box display
issues have been resolved in v6.2.2.

SBXA-10711 A change to the String property did not take effect in the SB/XA Designer (/
SD in XUI mode) until pressing Enter. Changes to properties are now reflected
immediately on the canvas.

SBXA-10713 A change to the Foreground property for a label in the SB/XA Designer (/SD in XUI
mode) had no effect. This issue has been fixed in v6.2.2.

SBXA-10718 In the User Security Setup (/SEC.USER.SETUP) > Custom tab, the Language Code
drop-down list did not contain values. If you pressed F3 for help and selected a
language code from the list, the code was not populated in the Language Code
field. In v6.2.2, the Language Code field is a text box, and selection of a value
from the F3 help list populates the Language Code field as expected.

SBXA-10731 When using Wyse terminal emulation in SBClient, screen attributes were lost
after saving and restoring the screen. A fix resolves this problem in v6.2.2.

SBXA-10733 A new verb, LENDP, has been added to the paragraph process (/PD.P) language
in the NLS edition. This verb returns the display length of a string/variable. The
syntax is X=LENDP(Y).

SBXA-10755 Scrolling to the bottom of a select window did not trigger a download of the next
packet of data as expected. This issue was resolved in v6.2.2.

SBXA-10773 In input processes running in XUI mode, the F3 intuitive help button was not
enabled when there was intuitive help on a field. With a correction in v6.2.2, the
F3 button is again enabled when intuitive help is available on a field.

SBXA-10776 If the user opened a lowercase record name in the Screen Editor (/SE), the /
LIST.READU process reported record locks for both a lowercase record name
and an uppercase record name. On exiting the editor, /LIST.READU still reported
a record lock for the uppercase record name. After a fix in v6.2.2, the lock is
released correctly on exiting the editor.

SBXA-10805 In SB/XA Rich Client, pressing the hot key for a function key to exit the window
did not display the Save Changes dialog box as expected. This issue has been
corrected in v6.2.2.

SBXA-10807 Using DISP 9 with the following syntax caused the XUI client to fail: DISP
9,"VALUE 1,":@AM:", VALUE 2,":@AM:", VALUE3" A fix prevents this problem in
v6.2.2.
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SBXA-10820 On AIX, setting a keyboard timeout in the group security record updates the user
security record, and this resulted in corrupting the group record. This issue has
been resolved in v6.2.2.

SBXA-10828 In some cases, calling a process that set REFRESH corrupted data on screen.
This problem occurred when focus was on a date field and the date field was
followed by a numeric field. On returning from the process that set REFRESH,
pressing Enter on the date field displayed the data incorrectly. A fix resolves this
issue in v6.2.2.

SBXA-10830 Date conversion was not applied when a process that sets @REFRESH was called
from a custom control. Specifically, this occurred when a process that sets
@REFRESH = "2" was called from a XAML custom control and focus was on a
date field followed by a numeric field. A fix was applied to resolve this problem
in v6.2.2.

SBXA-10944 The progress bar did not work after a DISP 9 message was displayed. This issue
has been resolved.

SBXA-10967 Support for the TU.GET.DEFAULT.PRINTER and TU.GET.PRINTER.LIST
subroutines has been implemented in the XUI clients.

SBXA-11345 A derived field displayed an image in GUI mode, but not in XUI mode. The
process displayed the pathname of the file rather than the image in the XUI
client. This issue has been corrected in v6.2.2.

SB/XA v6.2.1 release notes
Build 4118
Release Date: February 2013
These release notes provide information about enhancements and fixes in SB/XA v6.2.1.

What’s new in SB/XA v6.2.1

Components certified for Microsoft Windows editions
At V6.2.1, SB/XA Rich Client and SB/XA Communications Server are certified to run on Microsoft
Windows 8 and with Microsoft .NET Framework 4.5. For further information, see Tech Note
SBXA-10153. Additionally, SBClient is certified to run on Microsoft Windows 8. SBXA-9334

At V6.2.1, SB/XA Rich Client and SB/XA Communications Server are also certified to run on Microsoft
Windows Server 2012. For further information, see Tech Note SBXA-10154. Additionally, SBClient is
certified to run on Microsoft Windows Server 2012. SBXA-9979

SB/XA Designer help
V6.2.1 introduces the first iteration of SB/XA Designer help. The help covers tasks to create and update
XUI forms in the SB/XA Designer interface. The SB/XA Designer help is available as a compiled help
(CHM) file from the “View or install product documentation” link on the product setup menu. A PDF
version of the help is also available in the documentation set. SBXA-4944

Enhancements and fixes in SB/XA v6.2.1

The following issues were addressed in this release:

Issue Number Description

SBXA-33 As of V6.2.1, the F8-Compile process in the screen editor (/SE) displays a
message on successful completion.
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SBXA-408 Previously, changes to a user’s allowed menu options or changes to a menu
were not shown automatically in the SystemBuilder Explorer (SBX/MPX)
menu tree. With an enhancement in V6.2.1, the SBX/MPX menu tree refreshes
automatically.

SBXA-1206 In previous versions, the regenerate GUI default sets process (/REGEN.GDS)
returned a “Process not found” error if you specified more than one GDS process
to regenerate. This issue is resolved in V6.2.1, and the /REGEN.GDS process no
longer produces an error when regenerating multiple GDS processes.

SBXA-1307 After saving a multilanguage translation record for a label from the /TRANSLATE
process running in GUI mode, the multilanguage record was corrupted in some
cases. This problem occurred if you created a new account for a system ID and
did not update the system control record by running /HK.CONTROL. A code fix
was applied in V6.2.1, and updating the system control record for the newly
created account is no longer required.

SBXA-2976 A tool is provided in the Technical Support issue replication system to assist
you in building database phrases and updating the related field definition.
The tool parses the SB screen definitions and suggests controlling/dependent
relationships based on the multivalued information provided in the screen
definition.

SBXA-3697 Entering the field length as a negative number did not force an automatic
carriage return when the cursor reached the end of the field in XUI mode. A fix
was applied in V6.2.1, and the auto enter feature works as designed in all modes.

SBXA-4541 A table definition that uses the Allow Null option works only when you have a
value in the Input Code column. In version 6.2.1 a validation prevents you from
setting Allow Null to Yes and saving the record when the Input Code field for any
row is Null. A new process on the action bar, Id NULL Problems, reports on any
existing table definitions in which this problem may exist.

SBXA-4556 In V6.1.0 and later, screen sizes and positions were lost when the client cache
was cleared, and there was no parameter to control this behavior. In V6.2.0, a
flag to save screen size and position was added at the SB instance level in SB
Control Parameters (/SB.PARMS), at the system level in the System Control
Record (/HK.CONTROL), and at the user level in User Flags (/USER.FLAGS).

In addition, the following new processes have been created:

▪ CLEAN.MY.POSCACHE – Deletes the DMPOSCACHE item for the current user.

▪ CLEAN.POSCACHE – Prompts for the user whose cache is to be cleared.

▪ CLEAN.ALL.POSCACHE – Deletes DMPOSCACHE items for all users.

Note that after clearing the client cache, you must log off and log on again to
restore the server cache.

SBXA-4612 Character forms reserve line 22 as a status line; GUI and XUI forms do not have
this requirement. In GUI and XUI forms that are linked to a Character form, input
fields are now supported on lines 22 and lower.
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SBXA-4706 Multilanguage support has been implemented for right-click pop-up menus in
the SystemBuilder Explorer (SBX/MPX) menu tree in GUI and XUI modes. An MPX
Text screen has been added to the /TRANSLATE feature. It is accessed as the last
option after selecting the language. The new screen consists of four elements:

▪ The number of the attribute in MPX.TEXT to be translated.

▪ A display-only field indicating the language of the text that is being
translated.

▪ The text from the original MPX.TEXT item in DMCONT for this attribute.

▪ The translated text.

The MPX.TEXT item is created by this screen and stored in DMLANGUAGE.XX.
If you set a language code in user flags, the server reads MPX.TEXT from the
appropriate DMLANGUAGE.XX and sends it down to the client.

SBXA-4761 In SB/XA Rich Client, focus did not return to a field after pressing Alt-Tab to leave
the field and then pressing Alt-Tab again to return to the field. A fix was applied
in V6.2.1, and focus returns to the field as expected.

SBXA-4907 In the UniData edition, the /TU.UPLOAD process failed when the target file on
the host was a DIR-type file. This issue is resolved in V6.2.1.

SBXA-4944 V6.2.1 implements the first iteration of SB/XA Designer help. The help covers
tasks to create and update XUI forms in the SB/XA Designer interface. The SB/XA
Designer help is available as a compiled help (CHM) file from the “View or install
product documentation” link on the product setup menu. A PDF version of the
help is also available in the documentation set.

SBXA-5177 In the XUI clients, the intuitive help icon (magnifying glass) was available in the
toolbar when there was no intuitive help for the current field. This issue has
been corrected, and the icon is displayed as unavailable (gray) when help is not
available for the field.

SBXA-5238 Reports displayed in landscape orientation in the XPS Viewer changed to
portrait orientation when printed. To address this issue, the XPS code was
amended so that if the report’s page width exceeds the page height, the report
is printed in landscape orientation by default. You can override the default for
individual reports from the Preferences button in the Print dialog box.

SBXA-5267 In XUI mode, the Admin > Files > View File Data > List All File Names option
returned the list of file names in an error message format that was difficult to
read. The List All File Names function has been changed in V6.2.1 so it runs the /
HK.FILES.O process and displays the file names in a grid.

SBXA-5277 In previous versions, a problem occurred if you opened a session configured
to connect to one server, added a second configuration to connect to another
server, deleted the first configuration, created a new configuration with the
same name as the first configuration but connecting to a different server, and
deleted the second configuration. After closing and restarting SB/XA Rich Client
with the new configuration and testing the connection, the client returned an
error. A fix prevents this problem in V6.2.1, and the new configuration works as
expected.

SBXA-5286 In V6.1.2 and later, the Connect to Application field in SB/XA Rich Client
accepted any value and then connected to the last-connected application. The
code has been corrected in V6.2.1, and the Connect to Application field checks
the entered value against the user’s valid applications.

SBXA-5295 In cross-domain connections, entering incorrect logon credentials resulted in
an unhandled exception. With a code change in V6.2.1, the XUI client issues a
standard “Failed to connect” error.
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SBXA-5302 After changing the server name and the authentication type in SB/XA Client
Configuration > Communications Server Connections, the user name and
password were not updated in the SB/XA Communications Server Connection
window. A fix was applied in V6.2.1, and the user name and password are
updated for the associated server name and authentication type.

SBXA-5386 When upgrading from a UniData V6.x edition, the /SA.TRANSFER.SBPLUS
process always returned the error message, “The upgrade was not successful.
Do not delete the SB.OLD account.” As of V6.2.1, the text of the error message
has been clarified as follows: “Problems were encountered during the upgrade
process. Please review the messages above before removing .OLD accounts.”

SBXA-8054 In the XUI clients, the export configuration option has been enhanced at V6.2.1
to export a formatted document instead of one long line.

SBXA-8076 Changes made to the account restrictions in Group Security
Setup (/SEC.GROUP.SETUP) did not generate audit records in the
DMSECURITY.GROUP.AUDIT file. This issue has been corrected in V6.2.1, and the
audit records are generated as expected.

SBXA-8307 When deleting a table conversion from a field definition (/FD), attribute 19
of the .FieldName item was not removed correctly, and the remaining string
caused problems at run time. A fix corrects this issue in V6.2.1.

SBXA-8450 If you set up a report definition to print to the XPS printer on LETTERLAND
stationery by default and then changed to LETTER stationery at run time, the
report printed in landscape rather than portrait orientation. To address this
issue, a new screen available from Report Definitions (/PD.R) > F9-Additional >
F7-XPS Parameters captures XPS-specific printer parameters. These parameters
serve as a default for the report, and can be overridden at run time using the
selection screen.

SBXA-8461 In V6.2.1, the regenerate expressions (/REGEN.EXP) dialog box contains an Item
ID field in which the user can specify a single item to be regenerated.

SBXA-8543 Default print settings for Max Standard Cols/Rows and Max Condensed Cols/
Rows were missing from A4 and A4LAND stationery types. Default settings for
these parameters are now present in V6.2.1.

SBXA-8781 An SB screen returns all values, but SB.SMART.QUERY returned only the first
value of a multivalue field when using the following syntax:

(F("FileName",MV(FieldName))<POS(FieldName,value),-1>)

As a result, the data returned by an Access/Query report was incorrect. A fix
resolves this issue in V6.2.1, and SB.SMART.QUERY now returns all multivalue
data.

SBXA-8845 Automatically generated selection windows that returned only one column of
data calculated the required width of the column incorrectly and displayed a
window and grid that was not wide enough to show the data. A fix corrects this
problem in V6.2.1.

SBXA-8846 In the SB/XA Designer, clickingOptions > Place in Menu > Execute Now did not
open the Place in Menu Parameters window, where the user enters the process
type, name, and description. This problem has been resolved in V6.2.1, and the
window now opens as expected.

SBXA-8882 In the SB/XA Designer, clicking in a row of the Resequence Fields grid did not
highlight the selected row. A correction to the grid code prevents this problem in
V6.2.1.
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SBXA-8884 Accepting changes to a subscreen that was called from a GUI click process saved
the record. The code has been corrected so that changes to the subscreen are
accepted without saving the record.

SBXA-8910 The TU.PC.UPLOAD routine did not run in the XUI clients. V6.2.1 implements
support for TU.PC.UPLOAD in XUI mode, with certain restrictions:

▪ Options D, E, R, S, and T are not supported.

▪ Option H is implemented as the default.

▪ Separator Mode = 0 is not supported.
SBXA-8958 When the last object on a form was a toggle object that was hidden with

SETATTR, pressing F2 closed the form in XUI mode. With a fix in V6.2.1, the form
remains open after pressing F2 in XUI mode, the same as in GUI mode.

SBXA-9143 Clicking on a memo field in an output process (/PD.O) closed the form in the XUI
clients. The code has been amended to prevent this problem in V6.2.1.

SBXA-9193 On Linux AIX, the /PHYSICAL.PRINTER form was not correct, and attempting
to add a new stationary caused the XUI client to fail. This problem has been
resolved.

SBXA-9259 A blank row in a grid was not cleared if the user clicked rather than press Tab or
Enter to leave the row. With a correction in V6.2.1, the blank row is cleared as
expected.

SBXA-9282 If a report had more than 80 columns and the selected printer had a printer
class with no stationery types defined (such as DEFAULT.PRINTER and
DEFAULT.CLASS), the XUI client logged off. After a code fix, this problem no
longer occurs in V6.2.1.

SBXA-9293 V6.2.1 offers a new navigation method, ENO, for the XUI clients. ENO navigation
runs Microsoft Outlook-style menus without a horizontal menu at the top of the
client window.

SBXA-9315 In the XUI client, value marks were not inserted automatically when the text
wrapped onto a new line. The behavior of wrapping and inserting value marks
is controlled by the parameters passed to the GUI.TEXT.ED and INVOKE.TEXT.ED
processes. This issue has been corrected in V6.2.1.

SBXA-9325 If the IsAutoPositionEnabled property was set to True for the Store Client Form
Pos parameter, the location and size settings of custom forms were not honored
in XUI mode. This issue was addressed in V6.2.1, and the stored settings are
applied as designed.

SBXA-9326 When performing a binary file transfer, SB/XA Rich Client failed when
transferring a record that was locked. In V6.2.1, file transfer option K was added
to lock the directory type file for binary transfers.

SBXA-9334 At V6.2.1, SB/XA Rich Client and SB/XA Communications Server are certified to
run on Microsoft Windows 8 and with Microsoft .NET Framework 4.5. For further
information, see Tech Note SBXA-10153. Additionally, SBClient is certified to run
on Microsoft Windows 8.

SBXA-9352 In derived fields, a check box (toggle) that was selected in GUI mode was
displayed as not selected in the same record in XUI mode. A fix corrects this
problem in V6.2.1.

SBXA-9472 A problem occurred with a paragraph that used RTN.FLAG="{fldname}" to jump
to a specific field. When the paragraph process was called from a custom control
through ExecuteSBPlusProcessInContextCommand, focus jumped to the wrong
field. Changes to the code prevent this problem in V6.2.1.
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SBXA-9484 Toggles were left-justified in a column in XUI mode, but centered in GUI mode.
With a code change in V6.2.1, toggles are centered in a column in both modes.

SBXA-9486 The business intelligence process (/PD.BI) is supported in GUI and XUI modes
only. When attempting to run a /PD.BI process in Character mode in V6.2.0,
SB/XA returned the error, “DataVu reports can only be run in GUI or XUI.” The
message text has been changed to “Business intelligence reports can only be
run in GUI or XUI.”

SBXA-9489 When running an HTML process in the XUI clients, the web page was not
displayed until you resized the HTML window. This issue has been fixed in V6.2.1.

SBXA-9505 Label objects could not be hidden in the XUI clients. This issue has been
resolved.

SBXA-9510 In the XUI clients, if you attempted to replace an existing toolbar with another
toolbar, both the existing and new toolbars were displayed. V6.2.1 implements a
fix, and the existing toolbar is replaced by the new toolbar as expected.

SBXA-9521 In SB/XA Rich Client, fields in interleaved multivalue grids flashed or jittered
when displayed at a DPI setting of 125%. A fix resolves this issue in V6.2.1.

SBXA-9534 In previous versions, commas in grid column headings caused display problems
in GUI mode. V6.2.1 prevents using commas in grid headings and displays a
warning message, “Grid heading must not contain a comma.”

SBXA-9535 Default print settings for Max Condensed Cols/Rows were missing for A4 and
A4LAND stationery types. Default settings for this parameters are now present in
V6.2.1.

SBXA-9537 Memo fields with PARAM=2 did not have horizontal scroll bars and did not wrap
text. With a fix in V6.2.1, scroll bars and text wrapping work as expected.

SBXA-9539 In memo fields, when a vertical scroll bar was added, it changed the way text
was wrapped in XUI mode. To address this problem in V6.2.1, a vertical scroll bar
is always displayed in memo fields.

SBXA-9540 Job schedule definitions (/PD.J) phantom processes did not work unless you
set the Phantom Sleep Time parameter in SB Control Parameters (/SB.PARMS).
The code was amended in V6.2.1 so that job schedule phantom processes work
without a Phantom Sleep Time parameter.

SBXA-9545 In multivalued fields, the scroll bar position was incorrect in GUI mode. This
problem has been corrected in V6.2.1.

SBXA-9555 V6.2.0 implemented changes to the driver generation process for input screens
so that GUI drivers are generated only when running the screen in GUI mode,
and XUI drivers are generated only when running the screen in XUI mode.
However, scroll bars were generated using a different code path that also wrote
to the GUI and XUI drivers. When scroll bars were generated in XUI mode, they
were also written to the GUI driver item. This caused a problem because the
GUI item was no longer processed correctly before writing the driver. Further
changes to the driver processes correct this problem in V6.2.1.

SBXA-9559 At V6.2.1, the business intelligence process (/PD.BI) was added to the Process
Definitions menu.

SBXA-9575 A report with break fields either printed with footers after page breaks or caused
the XUI client to fail. This issue was resolved in V6.2.1.

SBXA-9578 V6.2.1 supports the ability to assign icons to Favorites and Group Favorites
folders in Microsoft Outlook-style menus.

SBXA-9579 In SB/XA Rich Client, database-level messages displayed in the debug window
contained repeating letters. A code fix prevents this display problem in V6.2.1.
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SBXA-9592 The spell check feature did not work as expected if a context menu with a
spelling suggestion list was active and the user right-clicked on a different
misspelling in the source file. SB/XA now performs a check when the context
menu is opened, and if a list of spelling suggestions exists, SB/XA cleans up the
existing list before generating a new list of suggestions.

SBXA-9599 In SB/XA Rich Client running on Microsoft Windows 7, combo boxes displayed
values out of position and fields jittered when using a DPI setting of 125%. A fix
resolves this issue in V6.2.1.

SBXA-9600 After resizing an F3 lookup window and closing it, the new window size is saved
and used the next time the user runs the F3 lookup. In previous versions, if the
user increased the depth of the F3 window, the window did not display more
rows of data the next time the user ran the lookup. With excess blank space at
the bottom of the F3 window, it was not apparent that there were more rows
of data on the next page. This issue was addressed in V6.2.1, and the F3 lookup
window now displays the correct number of rows based on the last-saved depth
of the window.

SBXA-9602 SB/XA V6.2.1 supports the ability to apply XAML styles to Microsoft Outlook-style
menus at the menu level.

SBXA-9603 A selection process (/PD.S) with a user subroutine call for indexing purposes
repeated datasets in the selection screen at run time in XUI and GUI modes. This
issue has been corrected in V6.2.1.

SBXA-9612 Hover help was out of sync with fields in the Group Security Setup (/
SEC.GROUP.SETUP) screen. A fix was applied to correct this problem in V6.2.1.

SBXA-9617 In previous versions, translated language text was not shown in the
SystemBuilder Explorer (SBX/MPX) menu tree. The code was amended in V6.2.1,
and translated text is displayed as designed.

SBXA-9633 In screens with an action bar, if the mouse pointer was positioned over the
action bar at run time, focus switched from the first input field to the action bar.
The same thing happened when rolling the mouse over the action bar. With a fix
in V6.2.1, focus remains at the input field until an action has been selected from
the action bar.

SBXA-9647 In V6.1.2 and later, running "HTML,https://....." did not open the target web
page. This problem has been corrected in V6.2.1, and an HTML call to an
“https://” address opens the web page as expected.

SBXA-9648 In V6.1.3 or later, field labels in a selection process (/PD.S) were not displayed in
Character mode. This issue has been resolved in V6.2.1.

SBXA-9652 Running subscreens in GUI mode and in XUI mode corrupted the GUI and XUI
drivers, requiring users to clear the drivers after every use. A code fix was applied
in V6.2.1, and subscreens run without problems in both modes.

SBXA-9655 Disabling a menu item in an input process definition (/PD.I) sets a property
of the item to visual=false in the XUI clients. In V6.1.4 or later, when running
the /PD.I process a second time in XUI mode, the disabled menu item was not
shown on the menu. In V6.2.1, you can create a custom theme to determine if a
disabled menu item is shown as dimmed or removed from the menu display. For
further information and an example theme, see Tech Note SBXA-9873.

SBXA-9682 In the XUI clients, multivalued fields with the /GUI.TEXT.ED in a process
slot caused problems with cursor positioning. When the user tabbed to a
multivalued field and started typing, the cursor was not positioned in the field,
but in the middle of the screen. A fix resolves this problem in V6.2.1.
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SBXA-9684 In query report definitions (/QRD) with the None - Execute Now option, the
report's CHDEFN record had no entry in field 16 and records were added or
modified in the DATA portion of the file in certain circumstances. The code was
amended to correct this issue in V6.2.1.

SBXA-9691 In SB Control Parameters (/SB.PARMS) > GUI Flags, pressing F3 in the Navigation
Method field and selecting the EMO navigation method returned an error. A fix
was applied to validate the EMO option in /SB.PARMS, preventing this error in
V6.2.1.

SBXA-9730 When using the EMO navigation method, the wrong system ID and description
were displayed in the title bar of the main window (MAINWIN). This issue was
addressed in V6.2.1, and the correct system ID and description are displayed in
EMO mode.

SBXA-9731 The following scripts are now bundled with the XUI clients so that they are
installed as part of a standard client installation:

▪ SBXAScriptControls.dll

▪ AxInterop.MSScriptControl.dll

▪ Interop.MSScriptControl.dll

When the clients run these scripts, they are no longer downloaded from the
server, improving performance.

SBXA-9732 In V6.2.0, the Recent Files list the user’s most recently opened items was missing
from the File menu in the SB/XA Designer. With a fix in V6.2.1, the Recent Files list
is populated as designed.

SBXA-9741 Shifted function keys and action bar selections did not behave correctly in the
XUI clients in V6.2.0. The code was corrected to resolve this problem in V6.2.1.

SBXA-9744 In Group Security Setup (/SEC.GROUP.SETUP), the Inhibit /Process Calls field
did not list all available options. This problem has been fixed in V6.2.1, and all
options are included in the list.

SBXA-9746 In the create file process (/CREATE.FILE) running in XUI mode, the File Name
field accepted more than one word and treated the second word as the file
type. In response, the XUI client returned an error, “File not created. Invalid type
entered.” A fix corrects this issue in V6.2.1.

SBXA-9747 In V6.2.0, a flaw in the SB/XA Designer prevented tabbing between fields when
creating or modifying a form. This problem has been fixed in V6.2.1, and tabbing
works as designed.

SBXA-9754 In the SBDEMO account, the /HK.LEVEL.PARA process did not consider
multivalued fields. A new version of the paragraph assigns different styles to
single-valued and multivalued fields, correcting this issue in V6.2.1.

SBXA-9757 In menu definitions (/MD), if you deleted a menu option, the corresponding MPX
parameters were not deleted. This issue has been resolved in V6.2.1, and the
associated parameters are deleted as expected.

SBXA-9769 In the XUI clients, default styles were displayed differently depending on the
Conversion Source. For example, the default style for mandatory input field was
displayed incorrectly if the Conversion Source was C (Character), but correctly
if the Conversion Source was G (GUI). In V6.2.1, the default styles are based on
ActualHeight and ActualWidth, and the default styles are displayed correctly
regardless of the Conversion Source.

SBXA-9780 When editing existing text in memo type fields in V6.2.0, the cursor jumped over
characters so they had to be retyped. The code was amended to correct this
problem in V6.2.1.
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SBXA-9791 With a setting of messagePriority=Loaded, valid values were not populated
in combo boxes on the first tab of a form. A fix was implemented in V6.2.1
to correct this behavior, and the list of values is displayed on the first tab as
designed.

SBXA-9792 With an enhancement in V6.2.1, SB/XA supports the ability to register a custom
help provider.

SBXA-9794 In V6.1.2 or later, the /SB.GEN.DRIV.O process issued an uninitialized variable
error when generating the driver for an output screen. A fix prevents this error in
V6.2.1.

SBXA-9814 Customers experienced problems using GET.LIST in Smart Query (/
SMART.QUERY) in V6.1.3 or later. On running the query, the results contained
the error “401 No Items Found.” This issue has been resolved in V6.2.1, and the
query returns data as expected.

SBXA-9821 In the XUI clients, calling SB.DISP from the ExecuteSubroutine in the
SBPlusClient API caused the client session to hang. If SB.DISP was called inside
a subroutine, InputState was changed to Dormant and was not restored to
WaitingForInput. The code was corrected to prevent these issues in V6.2.1.

SBXA-9822 In V6.1.3 or later, HTML reports ran very slowly in SB/XA Rich Client. The main
processing method that creates the HTML has been optimized in V6.2.1 to
dramatically increase the speed.

SBXA-9823 Running a XUI-only form with multilanguage enabled resulted in the following
error in the UniData for UNIX edition: “Filename formname can only be modified
in GUI mode.” A fix prevents this error in V6.2.1.

SBXA-9846 If you created a XUI form in the SB/XA Designer and generated a revision control
to contain the form, the revision control process produced an entry for a
Character counterpart of the XUI form, even though a Character version did not
exist. This issue has been corrected in V6.2.1, and the revision control process no
longer produces an invalid entry for a Character version of the form.

SBXA-9856 In V6.1.3 or later, when the Set New Password Next Login flag was set to Yes in
User Security Setup (/SEC.USER.SETUP), entering a new password at the next
login failed in the XUI clients. The new password entered by the user was not
validated. The code has been corrected to validate the new password in V6.2.1.

SBXA-9862 In forms containing a combo box with the drawable property set to 0, the combo
box is not visible. When the user pressed Tab or Enter from the previous field in
the form, the XUI client failed. This issue was resolved in V6.2.1, and advancing
the cursor to the combo box no longer causes the client to fail.

SBXA-9879 If you used arrow keys to advance through cells in a grid, the visual indicator of
focus (a broken border) was not placed on the correct cell and @CNT was not
updated correctly. The code was modified in V6.2.1 and @CNT now contains the
value of the field in focus at all times.

SBXA-9882 Clicking on a grid caused it to lose focus, and the visual indicator of focus (a
broken border) was no longer displayed in the current cell. The user had to tab
through the grid to see which cell was in focus. This problem has been resolved
in V6.2.1, and clicking on a grid does not cause a loss of focus.

SBXA-9895 In forms with a field on the same row as the prompt line (row 22 or 23), if the
user attempted to tab to that field, the field did not gain focus in GUI or XUI
mode. A change to the way the program processes columns and rows has
resolved this problem in V6.2.1, and focus is placed on the field as designed.

SBXA-9959 An incorrect log file was created during Test Connection process in the XUI
clients. With a modification in V6.2.1, this process no longer generates an invalid
log.
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SBXA-9975 In a tabbed screen created in GUI mode, the tabs were displayed correctly in the
XUI clients. However, in a tabbed screen created in XUI mode, the tabs were not
displayed in the XUI clients. This issue has been resolved, and a tabbed screen
can be created in GUI or XUI mode without causing tab display issues in either
mode.

SBXA-9979 At V6.2.1, SB/XA Rich Client and SB/XA Communications Server are certified to
run on Microsoft Windows Server 2012. For further information, see Tech Note
SBXA-10154. Additionally, SBClient is certified to run on Microsoft Windows
Server 2012.

SBXA-9983 In V6.2.0, images were not displayed in XUI forms created in the SB/XA Designer.
The tile and scale_bmp properties were implemented to correct this problem in
V6.2.1.

SBXA-9986 In the SB/XA Designer, users experience problems deleting a function key from
Options > Function Keys when shifted function keys were on the same line. This
issue has been corrected in V6.2.1.

SBXA-9994 When using the EMO navigation method, programs were closed when clicking
on a different system ID in a Microsoft Outlook-style menu. A fix resolves this
problem in V6.2.1.

SBXA-9995 Changes to the text and icons for system IDs on Microsoft Outlook-style menus
were sometimes lost when logging off or logging between system IDs. Changes
to the method of caching Microsoft Outlook-style menus on the client correct
this problem in V6.2.1.

SBXA-10019 A change to the processing of SYSTEM(14) and INPUT(-1) in UniBasic code at
UniData V7.2.12 caused SBClient file transfers to fail. Additional changes were
made at UniData V7.3.3 to support SBClient file transfer processes, and SBClient
V6.2.1 has been modified to run on all versions of UniData.

Note:  If you experience this problem in earlier versions of SBClient with UniData
V7.2.12, you can either upgrade to UniData V7.3.3, downgrade to an earlier
version of UniData, or refer to Tech Note SBXA-9449 for a resolution.

SBXA-10040 In an input screen (/PD.I) that contained a multivalued array built from work
variables, if one of the columns of the multivalued array contained a validation
that included @REFRESH = -2 in the Process After slot, data was placed in the
@RECORD, when it should have been placed only in the @WORK variable. This
resulted in data corruption. A fix was implemented to correct this issue in V6.2.1.

SBXA-10048 In the SystemBuilder Explorer (SBX/MPX) , if the user moved a menu item up or
down by pressing the F8-Move key in the Menu Definition window, the Heading
column in the corresponding SBX Parameters was not moved. This issue has
been corrected in V6.2.1.

SBXA-10050 In V6.2.0, customers experienced problems with labels on forms if the Process
Before Display slot contained a paragraph process that used SETATTR to set
attributes on the label. The code was amended to fix this issue in V6.2.1.

SBXA-10082 When running a Report Writer report via the /SB.REMOTE.PROCESS from a
UO.NET connection and work variables were defined in the header, the values
of the work variables were not displayed in the output. The work variable names
were displayed instead. This issue has been resolved in V6.2.1, and the values of
the work variables are displayed in the output as expected.
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SBXA-10088 In V5.5.x, when the /SB.REMOTE.PROCESS was passed an invalid SB password,
the process produced an “Invalid password” error message and returned to
the calling program. In the same scenario in V6.2.0, the /SB.REMOTE.PROCESS
displayed an “Access Denied” error message and did not return to the calling
program, but disconnected the session. The code was corrected in V6.2.1 so the
behavior is the same as that in V5.5.x.

SB/XA v6.2.0 release notes
Build 4056
Release Date: October 2012
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.2.0.

What’s new in SB/XA v6.2.0

SB/XA Designer
SB/XA V6.2.0 provides support for screen design in SB/XA Rich Client. Running the screen design (/SD)
process in SB/XA Rich Client opens the SB/XA Designer interface, where you can create forms for SB
developed applications in an intuitive design environment.

The functionality of the SB/XA Designer running on SB/XA Rich Client is nearly identical to that of the
Form Painter running on SBClient. Documentation specific to the SB/XA Designer will be available in
the future. In the meantime, refer to “SB Form Painter” in Chapter 7, “Graphical User Interface,” in the
SB/XA Reference Manual.

The SB/XA Designer relies on the capabilities of Microsoft .NET Framework and XAML code. Forms
created in SB/XA Designer make the best use of this technology and run in XUI mode only. When you
create new XUI forms in the SB/XA Designer, the tool does not create a GUI or Character counterpart.

For further details, see “SB/XA Designer” in SB/XA New Features. SBXA-4944

Integration with CorVu NG business intelligence reporting
CorVu NG provides a workspace for designing visually rich reports and deploying them to desktop,
web, and mobile users. SB/XA V6.2.0 leverages the power of CorVu NG with a business intelligence
process (/PD.BI) that runs a CorVu NG visual report or query against U2 data sources in SB/XA Browser
Client or SB/XA Rich Client. For further details about this feature, see “Business Intelligence Process
Definitions,” in Chapter 3, “Main Tools,” in the SB/XA Application Server Reference Manual. SBXA-4778

CorVu NG uses the UNNEST command to query U2 data sources in the XUI clients. The U2 SQL engine
requires phrase associations on related multivalue dictionary items to run the UNNEST command.
Some initial work is required to prepare data for the SB/XA interface to CorVu NG. For details on
using the data migration tool, refer to Tech Note SBXA-8205, “Issue Replication System,” on the U2
Knowledgebase. SBXA-5129

Styles for mandatory fields and intuitive help
SB/XA Browser Client and SB/XA Rich Client support XAML styles that define the appearance of
mandatory fields and fields with intuitive help. These styles give users a visual cue that an input field is
mandatory or that intuitive help is available for a field. SB/XA provides a number of predefined styles.
You can also write your own custom styles, or write paragraphs or expressions that contain the XAML
style name in the @VALUE variable. For details, see “Styles for mandatory fields and intuitive help,” in
Chapter 9, “XAML Styles and Themes,” in the SB/XA Application Server Reference Manual. SBXA-4946

Microsoft Outlook-style navigation
SB/XA now offers an option for navigating with Microsoft Outlook-style menus and folders in SB/
XA Browser Client and SB/XA Rich Client. The EMO navigation method presents the SBX Explorer as
a Microsoft Outlook-style interface along with the main window in the XUI clients. For details, see
“Microsoft Outlook-style navigation,” in SB/XA New Features. SBXA-4946
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Vanilla theme
SB/XA V6.2.0 introduces the VanillaSBPlusTheme, with a plain background, simple graphics, and fewer
bitmap effects to improve performance when running applications in the XUI clients from Remote
Desktop or on a computer with graphics rendering limitations. SB/XA Browser Client and SB/XA Rich
Client can be configured to detect conditions that decrease performance and automatically apply the
vanilla theme in place of the standard theme in response. For details, see “The vanilla theme option”
in Chapter 9, “XAML Styles and Themes,” in the SB/XA Application Server Reference Manual. SBXA-3446

Object code versioning
This version implements the ability to version SB/XA object code. The object code is now stamped
with the version number during the build process. This tool is designed to help technical support and
partners track patches at customer sites. For details on this feature, see “SB+ Release Info” in Chapter
5, “Admin Menu,” in Administering SB/XA. SBXA-8333

New features, enhancements, and fixes in SB/XA V6.2.0

The following issues were addressed in this release:

Issue Number Description

SBXA-1273 In the Password tab of the User Security Setup (/SEC.USER.SETUP) form, F1 help
was added for the Start Sys, Menu, Opt field.

SBXA-1351 F1 and F3 intuitive help were added for all fields in the Group Report Criteria
selection screen for the Group Details Report.

SBXA-1384 In the License Details (/SB.LICENSE) and Amend License Details (/
AMEND.LICENSE) forms, the Serial Number field no longer validates entries
containing nonnumeric characters. The serial number must be entered as an 8-
digit number.

SBXA-1534 V6.2.0 implements the following changes to printer defaults:

▪ In the Port Configuration (/TERM.CONFIG) > F9-Default screen, an XPS Printer
Name field has been added. The default setting for this field is XPS.PRINTER.

▪ In User Security Setup (/SEC.USER.SETUP) > Printers, the XPS printer name
entered in the XUI Printer ID field is used by the XUI clients. The Aux Printer
ID is now used only by SBClient. This allows you to have LOGICAL.PRINTER
as the Aux Printer ID and XPS.PRINTER as the XUI Printer ID. If no printer has
been specified, the XUI clients direct output to the XPS.PRINTER.

SBXA-1795 If you entered account restrictions for a security group and the accounts were
not restricted at the parent level, SB/XA did not return an error message. At
V6.2.0, an error message explains that if an account is not restricted in the
parent group, it cannot be restricted in a child group.

SBXA-1932 If you used the modify process (/MP) to retrieve a global process (such as a
paragraph or a selection process) and attempted to print the global process, the
Action bar generated a “No Items Present” status in GUI mode. A fix resolves this
issue in V6.2.0, and the global process can be selected and printed in GUI mode.

SBXA-2421 As of V6.2.0, the XUI version of the Who Are You? (/WHO) form is built from the
GUI version of the form, rather than the character version. This change in the
conversion source improves the positioning and alignment of fields on the XUI
form.
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SBXA-3006 In the procedure to create a field definition (/FD), the F6-Addit > Control/
Dep field did not validate entry of a phrase (type PH record). The Control/
Dep field allowed you to enter the name of an existing field definition as the
name of the multivalue association. In this case, no PH record was created
for an association, but field 7 of the field definition was updated to indicate
that an association existed, when it did not. After changes in V6.2.0, a phrase
entered in the Control/Dep field is validated to verify that it is not the name of an
existing phrase, preventing subsequent problems with creating the multivalue
association.

SBXA-3262 In SBClient, the SBZ transfer protocol failed in binary and hex modes in the
UniData edition on Windows. This issue was resolved in V6.2.0.

SBXA-3288 In previous versions, the Inhibit Logons screen did not validate user IDs entered
in the Non Inhibit Users field against DMSECURITY. As of V6.2.0, the program
performs validation checking on entries in this field and issues an error if the
user ID is not valid.

SBXA-3446 SB/XA V6.2.0 provides the optional VanillaSBPlusTheme, with a plain
background, simple graphics, and fewer bitmap effects to improve performance
when running applications in the XUI clients from Remote Desktop or on a
computer with graphics rendering limitations.

SBXA-3494 SA.TRANSFER.SBPLUS did not transfer the data from DMSECURITY.AUDIT and
DMSECURITY.GROUP.AUDIT files during the upgrade process. When these audit
files were not copied, SOX audit data was missing from the upgrade. This issue is
resolved in V6.2.0, and the audit file content is now copied in an upgrade.

SBXA-3585 When upgrading the UniData edition of SB/XA Application Server for Windows,
the installation script issued an error, “Unable to open pointer to old Sauser.”
This issue has been addressed in V6.2.0, so the SAUSER pointer to the old
account is a DIR type only if the old version is 6.0.0 or later.

SBXA-4541 In previous versions, if a field definition used a table definition as the conversion
code and the table definition had the Allow Nulls option set to Yes, the Input
Code column of the table had to contain a value before you could select
“<none>” and store a null value in the record. A code change corrects this
problem in V6.2.0.

SBXA-4572 A 32-bit version of the SBXAMAPIBridge component is provided to support
TU.MAPI messaging with the 32-bit version of Microsoft Office in SB/XA Browser
Client and SB/XA Rich Client.

In addition, a 64-bit version of the SBXAMAPIBridge component is provided to
support TU.MAPI messaging with the 64-bit version of Microsoft Office in SB/XA
Browser Client, SB/XA Rich Client, and SBClient.

The SBXAMAPIBridge.msi and SBXAMAPIBridge64.msi program files are
available in the SB/XA product download directory.

SBXA-4778 SB/XA V6.2.0 implements a business intelligence process (/PD.BI) that runs a
CorVu NG visual report or query against U2 data sources in SB/XA Browser Client
or SB/XA Rich Client.

SBXA-4871 The change password (/CHANGE.PWD) process did not validate the password
correctly in previous versions. This has been fixed.
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SBXA-4933 When running a QRD or Report Writer report and the output destination
was “A” for Ask, the printer defined in AUX Printer of User Security Setup (/
SEC.USER.SETUP) was displayed as the default. In V6.2.0, a new field “XPS
Printer ID” has been added in /SEC.USER.SETUP. In addition, a new field has
been added in Port Configuration (/TERM.CONFIG), allowing you to define a
default XPS printer systemwide. If both of these settings are left blank, the
printer for QRD and Report Writer reports defaults to XPS.PRINTER.

SBXA-4944 At V6.2.0, the SB/XA Designer provides support for screen design in SB/XA Rich
Client.

SBXA-4946 SB/XA V6.2.0 offers an option for navigating with Microsoft Outlook-style menus
and folders in SB/XA Browser Client and SB/XA Rich Client. The EMO navigation
method presents the SBX Explorer as a Microsoft Outlook-style interface along
with the main window in the XUI clients.

SBXA-5044 In the XUI clients, footer lines in Report Writer reports were not printed if the
output was directed to a physical printer, rather than the XPS Viewer. This issue
has been resolved in V6.2.0.

SBXA-5071 When running a process in GUI mode, F3 help returned values incorrectly after
sorting. A fix corrects this problem in V6.2.0.

SBXA-5075 SB/XA V6.2.0 implements enhancements to improve the performance of SB/
XA Browser Client and SB/XA Rich Client. Installing SB/XA Communications
Server now creates a Registry value for TcpAckFrequency in each TCP
interface, if it does not already exist, and sets the value to 1. Uninstalling
SB/XA Communications Server also removes any values that were set
during installation. For further details, see Tech Note SBXA-7943 on the U2
Knowledgebase.

SBXA-5129 A data migration tool is available to help you create multivalue phrase
associations that are required for CorVu NG queries. For details on using the
data migration tool, refer to Tech Note SBXA-8205, “Issue Replication System,”
on the U2 Knowledgebase.

SBXA-5167 When performing an F3 Select in a selection process in GUI mode, if you used the
icon at the bottom of the selection list in ListView to download the entire list and
then pressed the Esc key, the message “No Items Selected” was displayed. This
behavior has been corrected in V6.2.0 so that the message is displayed only if
you used the P option in the selection process.

SBXA-5222 Using PARAM 12 of the security API in a no-restrictions account returned an
error, “Record corrupt, take note before filing.” The code has been amended to
prevent an error in these circumstances in V6.2.0.

SBXA-5271 In input screens with a mandatory date field containing the syntax “P:
(*P484487)” in the Process After slot, an error occurred after the user entered
the “+1” key sequence, entered the date, and then pressed Tab. The error
message text, “Must enter something,” was confusing, because the date field
contained data. This issue has been corrected in the GUI and XUI clients, and the
conditions described here no longer trigger an error.

SBXA-5272 SB/XA Browser Client and SB/XA Rich Client now support XAML styles that define
the appearance of mandatory fields and fields with intuitive help.

SBXA-5312 When users created an account or ran FIX.SBPLUS.POINTERS in previous
versions, SB/XA did not add a VOC entry for TUBP and TUINSERT in the account.
The create and update processes have been enhanced in V6.2.0 to write these
VOC entries to the account.
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SBXA-5318 On Windows 7 computers, if the Control Panel > Region and Language >
Keyboards and Languages selections were set to Netherlands and Dutch, F3 and
XPS Viewer displays were corrupt and caused SB/XA to hang. Several fixes to
correct character conversions and a mismatch between the floating point string
format on SB/XA Application Server and the client correct this problem in F3 and
XPS displays.

SBXA-5338 In the UNIX edition, F3 intuitive help screens in XUI mode were displayed at
a small size, obscuring the help text. The code has been amended in V6.1.3,
resolving this display issue on UNIX systems.

SBXA-5347 On UNIX systems, the Available Disk Space dialog box displayed the availability
statistics incorrectly in the XUI clients. This issue has been resolved in V6.2.0.
Note that this dialog box is not implemented for Windows systems, and a “not
available” message is displayed.

SBXA-6829 In a selection process (/PD.S) that uses both option E (Display ensign heading
text in window) and option T (Display field names as lookup window title), the
process description heading conflicted with column headings in Character
mode. When the two options are used together in V6.2.0, only the T option is
applied in Character mode. This change does not affect GUI and XUI mode,
where the two options can be used together to display both types of headings.

SBXA-7902 Pressing the down arrow key on the controlling multivalue field when there was
a Process After slot resulted in various behaviors, depending on the version, the
presentation mode, and whether you used a grid.

GUI behavior:

▪ Grid – Process After was called when down arrow was pressed

▪ Non-grid – Process After was not called when down arrow was pressed

XUI behavior:

▪ 6.1.1 – Process After was not called when down arrow was pressed

▪ 6.1.2 – Process After was called when down arrow was pressed

To address this issue, a new option has been implemented in V6.2.0. You can
add the O option to the Process After slot so that the process is called only if the
data has changed or if you press Enter to leave the field.

SBXA-7906 An input screen with nothing but toggle fields behaved incorrectly in GUI mode.
When you executed an input screen with multiple toggle objects in the GUI client
and selected one toggle object, a second toggle object was also displayed as
though it had been selected. This issue has been resolved in V6.2.0.

SBXA-7986 In an input screen with a multivalued grid, the controlling multivalue field was a
derived field defined with six rows of data, but displayed only two rows of data
in the XUI clients. A section of code was revised to fix this problem in V6.2.0.

SBXA-7993 A “not found” error message was displayed when executing the primary
screen of two tabbed screens in XUI mode. When running the input screen
I*S7895*MT100.1, SB/XA returned the message, “MT101.1 not found,” before
the primary screen was displayed. The form screen was MT100.1, rather than
MT101.1 as indicated in the message.
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SBXA-7995 In an input screen with a multivalued grid, using the backslash character (\) to
delete a row and then clicking another column of the grid before pressing Enter
produced the following unexpected results:

▪ In character mode, the values in the deleted row were displayed in the
heading of the column you clicked, and pressing Esc (Escape) to exit had no
effect.

▪ In GUI mode, the data values for the column you clicked were displayed in
other columns, and pressing Esc to exit had no effect.

▪ In XUI mode, the row was deleted, but the grid was no longer in focus. If you
then clicked on the first column of the grid, the client returned an error and
the data in another column of the grid was corrupted.

Changes to grid controls correct these behaviors in character, GUI, and XUI
modes in V6.2.0.

SBXA-7999 In previous versions, an ActiveX control caused SBClient to fail. This issue is
resolved in V6.2.0.

SBXA-8021 A new field in SB Control Parameters (/SB.PARMS) enables you to specify the
number of seconds of delay for starting phantom processes. If you leave this
field blank, SB/XA uses the default value of 3 seconds.

SBXA-8039 If you defined an auxiliary (Aux) printer in Port Configuration (/TERM.CONFIG)
and specified a different Aux printer for a user in User Security Setup (/
SEC.USER.SETUP), the user’s Aux printer setting did not override the default Aux
printer setting for the port.

To address this issue in V6.2.0, the Port Configuration settings are used only if
no Aux printer is specified in the user security record. In addition, the fallback
printers have been changed. If no Aux printer is defined in the user security
record or in /TERM.CONFIG, the Aux printer defaults to LOGICAL.PRINTER
rather than DEFAULT.PRINTER. For XPS printing, the XPS printer defaults to
XPS.PRINTER.

SBXA-8094 In some cases, display fields in a multivalued grid did not display data in the XUI
clients. This issue has been corrected.

SBXA-8140 In grids containing (1) a controlling multivalue field with two input columns
and (2) a process to determine default values in the field definition for the input
column, the default values were not populated correctly. This issue has been
resolved in V6.2.0, and the default values are populated and displayed correctly
in the grid.

SBXA-8142 In SBClient, the /CHANGE.PWD process failed if the user attempted to change
the password on initial login. The password process failed due to two separate
problems in related areas:

▪ The passwords of users created in the GUI client in previous builds were
corrupted.

▪ The /CHANGE.PWD process encountered problems if the user’s original
password contained lowercase characters.

Both problems have been resolved in V6.2.0, and changing the password in
SBClient no longer produces an error.

SBXA-8179 After starting SB/XA Rich Client, the Connect to Application dialog box
sometimes returned the error, “Failed to get the list of applications.” The
connection routine has been corrected to prevent this error condition in V6.2.0.
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SBXA-8192 In V6.1.2, each server session from the XUI client attempted to read the socket
every two milliseconds (ms) when idle, resulting in high CPU utilization. In
V6.2.0, you can configure the socket time-out in SB Control Parameters (/
SB.PARMS) > Socket Options > Socket Timeout. In addition, the default value of
this time-out has been changed from 2ms to 1000ms. The default setting applies
if no value is specified in the Socket Timeout parameter in the /SB.PARMS
record.

SBXA-8210 When exporting the SB/XA client configuration, the debug path was not
exported along with the rest of the configuration details. In V6.2.0, the debug
path is included in the export.

SBXA-8264 With Smart Refresh enabled, paragraph statements were unable to start
phantom processes in XUI mode. This issue has been resolved.

SBXA-8272 With the Auto Accept Toggles flag set to Tab in SB Control Parameters (/
SB.PARMS), pressing Enter in a check box without selecting it produced an
“Invalid Code” error in XUI mode. A fix was applied in V6.2.0, correcting the
behavior in the XUI clients.

SBXA-8294 In GUI mode, if you pressed F3 in a numeric field with a comma separator, the
values were displayed incorrectly as zeroes. A fix resolves this problem in V6.2.0.

SBXA-8333 V6.2.0 supports the ability to version SB/XA object code. The object code is
now stamped with the version number during the build process. In addition,
the /SB.INFO process has been enhanced so the center part of the screen that
formerly displayed the Patch No and Date Applied fields now contains File, Item
ID, Version, Platform, Date, and Time fields from the stamping process. A file is
included in the list if its version number does not match the version number of
the installed product. With version stamping, object code patches to the SB/XA
Application Server can be easily detected and verified.

SBXA-8373 During login to SB/XA for UniData on the GUI client, an “unassigned variable”
message was displayed between input of user name and password. This issue
has been resolved.

SBXA-8378 The TU.FILE.INFO subroutine works only when run on the XUI clients. When
this host routine was executed on the character and GUI clients, it returned an
incorrect status code of 0, indicating that the file was found, even if the file was
not on the client computer. After a change in V6.2.0, running TU.FILE.INFO on
the character and GUI clients returns a status code of 1 and an error message
indicating that this host routine runs only on the XUI clients.

SBXA-8398 The SB/XA V6.2.0 splash screen and product setup menu are rebranded with the
purple graphic for Database Servers and Tools. The SBClient splash screens and
launchpad are also rebranded with the same graphic.

SBXA-8418 When calling phantoms from a paragraph (/PD.P) process, if the paragraph
process included a loop, some of the phantom processes did not run
successfully. This issue has been resolved.

SBXA-8421 The umask setting caused problems with file access in the SB/XA for UniData
edition on UNIX. This edition does not get umask settings from a user’s profile.
Instead, it uses the default setting in the startud script. To address the problem,
change the setting to umask=007 or umask=002 in the startud script.

SBXA-8480 In User Security Setup (/SEC.USER.SETUP) and Group Security Setup (/
SEC.GROUP.SETUP), the F3 intuitive help for the user ID or group ID did not
display users or groups in a tree hierarchy in GUI mode, as designed. A fix was
applied to display intuitive help in a tree format in GUI and Character modes.
Similar functionality was added in XUI mode, where intuitive help for the user ID
or group ID is now displayed in a standard grid.
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Issue Number Description

SBXA-8481 If you used SETATTR to set the G.EMPHASIZED attribute on a label that was
painted on a form, the label text was not de-emphasized when the label was not
in focus in XUI mode. A fix was applied in V6.2.0, and the label text is now de-
emphasized when the label is not in focus.

SBXA-8515 In forms with a GUI conversion source, @REFRESH=7 inserted spaces before
the SBValue in SB/XA Rich Client. A flag named “Trim Spaces from Fields” has
been added in SB Control Parameters (/SB.PARMS) > XUI Parms to correct this
problem in V6.2.0.

SBXA-8540 After a DISP message dialog box was displayed from an SB/XA screen, the
message dialog box disappeared from view and could not be accessed. The
only solution was to terminate the XUI session through the Task Manager.
A correction was applied in V6.2.0, and the message dialog box no longer
disappears from display.

SBXA-8541 A dialog box with option button text containing an ampersand (&) character
caused SB/XA Rich Client to fail. The code has been corrected, and the
ampersand can be used in option button text without problems in V6.2.0.

SBXA-8547 When using the GUI Text Editor (/GUI.TEXT.ED) in GUI mode, if a memo field
contained 465 characters or more, char(10) was not inserted between rows. The
code has been amended to correct this issue in V6.2.0.

SBXA-8582 Phantom processes did not run if the Inhibit Shell Access flag was set to Y
and the Inhibit /Process Calls flag was set to A in Group Security Setup (/
SEC.GROUP.SETUP). The code was enhanced to address this issue in V6.2.0.

SBXA-8633 A subroutine that used the Group Security API (SH.SEC.API) set the value of
the Inhibit Process Calls flag incorrectly. In addition, an error occurred if you
attempted to log in with the user ID of a member of the group that was just
updated through SH.SEC.API. Both of these problems have been resolved.

SBXA-8647 In Group Security Setup (/SEC.GROUP.SETUP), if the Inhibit Shell Access flag
was set to Y and the Inhibit /Process Calls flag was set to J, the settings were
incorrect after performing a LOGTO. A fix resolves this issue in V6.2.0.

SBXA-8697 The GUI text editor (/GUI.TEXT.ED) failed in XUI mode when value marks were
inserted in F3 intuitive help. The code has been amended to prevent this
problem in the XUI clients.

SBXA-8698 In an account with a least two system IDs, users were able to run a phantom
process only in the system ID in which the phantom was initiated. With an
enhancement in V6.2.0, phantoms run from any system ID in the account.

SBXA-8712 In UNIX editions running on SB/XA Rich Client, entering an invalid operating
system password produced an error in a .NET dialog box. After dismissing
the error dialog box, the SB/XA Login dialog box was displayed. The code was
corrected so the behavior is now the same as in Windows editions: the error is
returned in a Windows dialog box and the U2 Database Server Login dialog box
is displayed.

SBXA-8734 In the UniData edition, listing the APPLICATIONS attribute in DMSECURITY
produced an “Illegal attribute name” error. The code was corrected to prevent
this error in V6.2.0.

SBXA-8744 In XUI mode, if the input field just before a toggle field had a process in the
Process After slot and the paragraph contained @REFRESH=2, the toggle field
produced the error, “Invalid Code <Enter> Then try F3.” Fixes were applied to the
server code in V6.2.0 to prevent this error condition.
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SBXA-8763 When the clients were configured by using the common configuration file,
SBXAConfiguration.xml, they connected to an SB/XA Communications Server
other than the default. The code has been corrected in V6.2.0, and the clients
connect to the default SB/XA Communications Server specified in the common
configuration file.

SBXA-8773 In some cases, toggle controls (check boxes) could not be cleared in GUI mode.
This issue was corrected in V6.2.0, and check boxes can be cleared as expected.

SBXA-8776 The position of F3 selection screens was not saved in XUI mode. V6.2.0
implements multiple fixes to correct related problems, and the position
coordinates and column width in XUI selection screens are now stored for the
next use.

SBXA-8777 In GUI mode, the value in toggle control fields was saved incorrectly as 1 when
the check box was selected and 0 when cleared. The code has been corrected so
that values are saved as 0 when the check box is selected and 1 when cleared.

SBXA-8831 When using the EMX navigation method in SB/XA Browser Client, a process in the
Process After Display on SBMENU did not run. This issue has been resolved in
V6.2.0.

SBXA-8833 The GUI text editor (/GUI.TEXT.ED) failed in GUI mode when value marks were
inserted in F3 intuitive help. The code has been amended to prevent this
problem in GUI mode.

SBXA-8875 A flaw in the @REFRESH=2 variable caused incorrect data to be displayed in the
Update An Account (/UPDATE.ACCOUNT) form. The COMMON variable code has
been fixed to correct this problem in V6.2.0.

SBXA-8880 The SB.REMOTE.PROCESS encountered problems when attempting to save
file handles as part of preserving COMMON. In V6.2.0, SB.REMOTE.PROCESS no
longer attempts to save the file handles.

SBXA-8893 In SBClient, a toggle in a grid returned an error if it used a table definition with
three different values in the internal code, display text, and input code and
if Allow NULL was set to N in a validation. Both client and server code were
amended to prevent this error condition in V6.2.0.

SBXA-8894 The SB.DISP.BOXTEXT subroutine did not display text correctly if the tilde (~)
character was included in the string. In Character mode, the ~ character was
not printed and text was truncated at approximately 124 characters. In GUI
and XUI modes, the ~ character was not printed, but text was not truncated.
With a correction in V6.2.0, the ~ character is printed and the text is no longer
truncated.

SBXA-8940 In a process definition (/PD.P), if you used SETATTR to set the string property
of a button with a value that contained an ampersand (&) character, the &
character was displayed in XUI mode instead of being parsed as the flag for the
hot key. The code has been amended and the & character is interpreted as the
flag for a hot key, as designed.

SBXA-8944 Pressing Ctrl + End in a memo field with data caused SB/XA Rich Client to fail. A
fix was applied to correct this problem in V6.2.0.

SBXA-9004 If an input process (/PD.I) with the O (Output only) option contained a memo
field and a toolbar, selecting a button on the toolbar caused the XUI client to fail.
This issue has been resolved.

SBXA-9084 In the NoFocusContextMenu.xaml code, the messages “Put focus to field first
for context menu” and “Click to open or close menu tree” were hard-coded
in English and could not be translated to other languages. These two phrases
are now referenced in the sbplusstrings.de-CH.restext and sbplusstrings.en-
us.restext files so they can be translated.
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SBXA-9086 SB/XA Communications Server was unable to connect to SB/XA Administration
Server if the administration server computer was known only by its IP address.
SB/XA V6.2.0 has upgraded to a new UODOTNET.dll that recognizes the
computer’s IP address or host name.

SBXA-9108 In SBClient running on Microsoft Windows 7 or Windows 2008 x64, selecting
View > Clipboard Viewer returned the error “CreateProcess 'clipbrd.exe' failed.
error(2) - file not found.” The clipbrd.exe file is not supplied with Microsoft
Windows 7 or Windows 2008, so the View > Clipboard Viewer option has been
removed from the menu in SBClient.

As part of this change, a paragraph regarding the Clipboard Viewer has been
deleted from Chapter 1, “Introduction to SBClient,” in the Using SBClient
manual.

SBXA-9138 The SBClient device licensing dynamic link library (DLL) has been updated to
version 3.2.1.0.

SBXA-9199 In Report Writer reports output to DIFF, spaces were missing from custom
column headings that were painted in the report definition. A code fix corrects
this problem in V6.2.0.

SBXA-9207 If /VALIDATE.USER and /PASSWORD.VALIDATION functionality were set up
as documented in the Developer Zone article “How To Deploy SB+ Password
Validation,” the /CHANGE.PWD process failed to verify the new password. With
a correction in V6.2.0, the /CHANGE.PWD process verifies the new password as
expected. No change to the setup steps is required.

SBXA-9218 Check boxes (toggles) on a subscreen did not work correctly in a multivalue
group in GUI mode. This issue is resolved in V6.2.0.

SBXA-9239 With the Auto Extend Field Length flag set to N, Ctrl + End did not auto-extend
the field length in multivalued fields in XUI mode. A fix resolves this issue in
V6.2.0, and the auto-extend feature works as designed.

SBXA-9306 In the SBXA Documentation.chm file, the topic “Define an Assembly” contains
a correction. The line “This process includes uploading the assembly into the
xxResources file,” has been changed to “This process includes uploading the
assembly into the SAUSER file.” This .chm file is available in the Extra folder of
the product download directory.

SBXA-9410 In the XUI clients, the default Security option was changed from Message to
Transport at V6.2.0. To set the Security option, click Options > Configuration
in the client main window. In the SB/XA Client Configuration form, click the
Communications Server Connections tab and select an option from the Security
list.

SB/XA v6.1.4 release notes
Build 3427
Release Date: November 2012
These release notes provide information about enhancements and fixes in SB/XA v6.1.4.

What’s new in SB/XA v6.1.4

Performance enhancements for XUI clients
SB/XA V6.1.4 implements enhancements to improve the performance of SB/XA Browser Client and
SB/XA Rich Client. Installing SB/XA Communications Server now creates a Registry value in each TCP
interface. For further information, see this item in the notes that follow. SBXA-5075
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XPS mail class made public
The SBMailXPS class has been made public so that you can create templates from it. The
SBMailXPS.xaml file is available in the Extra folder in the product download directory. SBXA-9305

Enhancements and fixes in SB/XA v6.1.4

The following issues were addressed in this release:

Issue Number Description

SBXA-3494 SA.TRANSFER.SBPLUS did not transfer the data from DMSECURITY.AUDIT and
DMSECURITY.GROUP.AUDIT files during the upgrade process. When these audit
files were not copied, SOX audit data was missing from the upgrade. This issue is
resolved in V6.1.4, and the audit file content is now copied in an upgrade.

SBXA-4541 In previous versions, if a field definition used a table definition as the conversion
code and the table definition had the Allow Nulls option set to Yes, the Input
Code column of the table had to contain a value before you could select
“<none>” and store a null value in the record. A code change corrects this
problem in V6.1.4.

SBXA-4556 In V6.1.0 and later, screen sizes and positions were lost when the client cache
was cleared, and there was no parameter to control this behavior. In V6.1.2, a
flag to save screen size and position has been added at the SB instance level in
SB Control Parameters (/SB.PARMS), at the system level in the System Control
Record (/HK.CONTROL), and at the user level in User Flags (/USER.FLAGS).

In addition, the following new processes have been created:

▪ CLEAN.MY.POSCACHE – Deletes the DMPOSCACHE item for the current user.

▪ CLEAN.POSCACHE – Prompts for the user whose cache is to be cleared.

▪ CLEAN.ALL.POSCACHE – Deletes DMPOSCACHE items for all users.

Note that after clearing the client cache, you must log off and log on again to
restore the server cache.

SBXA-4572 A 32-bit version of the SBXAMAPIBridge component is provided to support
TU.MAPI messaging with the 32-bit version of Microsoft Office in SB/XA Browser
Client and SB/XA Rich Client.

In addition, a 64-bit version of the SBXAMAPIBridge component is provided to
support TU.MAPI messaging with the 64-bit version of Microsoft Office in SB/XA
Browser Client, SB/XA Rich Client, and SBClient.

The SBXAMAPIBridge.msi and SBXAMAPIBridge64.msi program files are
available in the SB/XA product download directory.

SBXA-4706 Multilanguage support has been implemented for the SystemBuilder Explorer
(SBX/MPX) menu in GUI and XUI modes. A new screen called MPX Text has been
added to the /TRANSLATE feature. It is accessed as the last option after selecting
the language. The new screen consists of four elements:

▪ The number of the attribute in MPX.TEXT to be translated.

▪ A display-only field indicating the language of the text that is being
translated.

▪ The text from the original MPX.TEXT item in DMCONT for this attribute.

▪ The translated text.

The MPX.TEXT item is created by this screen and stored in DMLANGUAGE.XX.
If you set a language code in user flags, the server reads MPX.TEXT from the
appropriate DMLANGUAGE.XX and sends it down to the client.
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Issue Number Description

SBXA-4853 If you used a centralized client configuration file to set up SB/XA workstations,
the default application was not set correctly. The fix to a related problem
corrects the issue of setting the default application in V6.1.4.

SBXA-4989 When the Reg No field in the Branch Car Enquiry screen was blank, SBClient and
the XUI clients returned Car Hire History details for the previous inquiry. This
issue is resolved in V6.1.4.

SBXA-5071 When running a process in GUI mode, F3 help returned values incorrectly after
sorting. A fix corrects this problem in V6.1.4.

SBXA-5075 SB/XA V6.1.4 implements enhancements to improve the performance of SB/
XA Browser Client and SB/XA Rich Client. Installing SB/XA Communications
Server now creates a Registry value for TcpAckFrequency in each TCP
interface, if it does not already exist, and sets the value to 1. Uninstalling
SB/XA Communications Server also removes any values that were set
during installation. For further details, see Tech Note SBXA-7943 on the U2
Knowledgebase.

SBXA-5267 In XUI mode, the Admin > Files > View File Data > List All File Names option
returned the list of file names in an error message format that was difficult to
read. The List All File Names function has been changed in V6.1.4 so it runs the
HK.FILES.O process and displays the file names in a grid.

SBXA-8028 If users tabbed or clicked the mouse quickly between fields in the XUI clients,
focus was lost and data was displayed in the wrong fields. A fix prevents this
problem in V6.1.4.

SBXA-8076 Changes made to the account restrictions in Group Security
Setup (/SEC.GROUP.SETUP) did not generate audit records in the
DMSECURITY.GROUP.AUDIT file. This issue has been corrected in V6.1.4, and the
audit records are generated as expected.

SBXA-8100 If a field has custom validation and is defined as a toggle inside of a grid, the XUI
clients did not display the field as a check box. This behavior has been corrected,
so the field is displayed as a check box in XUI mode, the same as in GUI mode.
However, be aware that the behavior of a toggle with custom validation is not
identical to that of a toggle without custom validation.

SBXA-8140 In grids containing (1) a controlling multivalue field with two input columns
and (2) a process to determine default values in the field definition for the input
column, the default values were not populated correctly. This issue has been
resolved in V6.1.4, and the default values are populated and displayed correctly
in the grid.

SBXA-8142 In SBClient, the /CHANGE.PWD process failed if the user attempted to change
the password on initial login. The password process failed due to two separate
problems in related areas:

▪ The passwords of users created in the GUI client in previous builds were
corrupted.

▪ The /CHANGE.PWD process encountered problems if the user’s original
password contained lowercase characters.

Both problems have been resolved in V6.1.4, and changing the password in
SBClient no longer produces an error.

SBXA-8151 In paragraph (/PD.P) processes, the G.FOREGROUND property did not work to
set the foreground color in XUI mode. A fix was applied to correct this problem in
V6.1.4.

SBXA-8157 If a hot key was defined for a radio button, Alt + hot key did not work to select
the radio button in XUI mode. This issue has been fixed.
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Issue Number Description

SBXA-8179 After starting SB/XA Rich Client, the Connect to Application dialog box
sometimes returned the error, “Failed to get the list of applications.” The
connection routine has been corrected to prevent this error condition in V6.1.4.

SBXA-8210 When exporting the SB/XA client configuration, the debug path was not
exported along with the rest of the configuration details. In V6.1.4, the debug
path is included in the export.

SBXA-8264 With Smart Refresh enabled, phantom processes could not be started in XUI
mode. This issue has been resolved.

SBXA-8272 With the Auto Accept Toggles flag set to Tab in SB Control Parameters (/
SB.PARMS), pressing Enter in a check box without selecting it produced an
“Invalid Code” error in XUI mode. A fix was applied in V6.1.4, correcting the
behavior in the XUI clients.

SBXA-8274 Changing the column heading in a grid did not work in versions 6.1.2 and 6.1.3.
The code has been amended to correct this problem in V6.1.4.

SBXA-8284 In an input screen (/PD.I) that executes two subordinate input screens, pressing
F2 quickly on the first subordinate screen returned the second subscreen
instead. This behavior has been corrected in V6.1.4, and the first subordinate
screen is displayed as expected.

SBXA-8294 In GUI mode, if you pressed F3 in a numeric field with a comma separator, the
values were displayed incorrectly as zeroes. A fix resolves this problem in V6.2.0.

SBXA-8421 The umask setting caused problems with file access in the SB/XA for UniData
edition on UNIX. SB/XA does not get umask settings from a user’s profile.
Instead, it uses the default setting in the startud or startunirpcd script. To
address the problem, change the setting to umask=007 or umask=002 in the
startud or startunirpcd script.

SBXA-8445 When a code table was used with a combo box, the stored data was not
displayed in XUI mode. This issue has been resolved in V6.1.4.

SBXA-8450 If you set up a report definition to print to the XPS printer on LETTERLAND
stationery by default and then changed to LETTER stationery at run time, the
report printed in landscape rather than portrait orientation. To address this
issue, a new screen available from Report Definitions (/PD.R) > F9-Additional >
F7-XPS Parameters captures XPS-specific printer parameters. These parameters
serve as a default for the report, and can be overridden at run time using the
selection screen.

SBXA-8464 In V6.1.3, if /USER.FLAGS > GUI Prefs > Center GUI Screens was set to Y, the
position of tabbed forms was not saved in the client cache. This issue has been
fixed in V6.1.4.

SBXA-8466 Combo boxes that used a code table containing the same value for both an
internal code and an input code returned the wrong value if you pressed Tab to
leave the field. This behavior has been corrected in V6.1.4.

SBXA-8480 In User Security Setup (/SEC.USER.SETUP) and Group Security Setup (/
SEC.GROUP.SETUP), the F3 intuitive help for the user ID or group ID did not
display users or groups in a tree hierarchy in GUI mode, as designed. A fix was
applied to display intuitive help in a tree format in GUI and Character modes.
Similar functionality was added in XUI mode, where intuitive help for the user ID
or group ID is now displayed in a standard grid.

SBXA-8481 If you used SETATTR to set the G.EMPHASIZED attribute on a label that was
painted on a form, the label text was not de-emphasized when the label was
not in focus. A fix was applied in V6.1.4, and the label text is now de-emphasized
when the label is not in focus.
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SBXA-8488 In selection processes (/PD.S), if a multivalued field had intuitive help, a
GUI.TEXT.ED process in the Process Before slot, and a paragraph in the Process
After slot that performed a REFRESH=2, the data in the multivalued field was
corrupted on pressing the X or Cancel button to leave the intuitive help selection
window. The code was amended in V6.1.4, and data is no longer corrupted on
exiting from intuitive help.

SBXA-8495 Using SETATTR to set the G.EMPHASIZED attribute on a column in a grid
did not work correctly in XUI mode. The multivalued field was enabled and
accepted updates. With a correction in V6.1.4, the multivalued field is disabled
as intended.

SBXA-8496 In tabbed forms, pressing F2 on the last tab saved and closed the form in GUI
mode, but displayed the next-to-last tab in XUI mode. The behavior has been
corrected in V6.1.4 so that pressing F2 on the last tab saves and closes the form
in all modes.

SBXA-8514 If you set the title property of a form in /SD > Form Properties and set the
description on the input process (/PD.I) record, the title property from the
GUIOBJECTDEFINITION was used in GUI mode, but the description from the /
PD.I record was used in XUI mode. The behavior in V6.1.4 is the same for GUI and
XUI clients:

▪ If you define a title in Form Properties, that title is used on the form.

▪ If you do not define a title in Form Properties, the description in the /PD.I is
used as the title of the form instead.

SBXA-8515 In forms with a GUI conversion source, @REFRESH=7 inserted spaces before
the SBValue in SB/XA Rich Client. A flag named Trim Spaces from Fields has
been added in SB Control Parameters (/SB.PARMS) > XUI Parms to correct this
problem in V6.1.4.

SBXA-8540 After a DISP message dialog box was displayed from an SB/XA screen, the
message dialog box disappeared from view and could not be accessed. The
only solution was to terminate the XUI session through the Task Manager.
A correction was applied in V6.1.4, and the message dialog box no longer
disappears from display.

SBXA-8541 A dialog box with option button text containing an ampersand (&) character
caused SB/XA Rich Client to fail. The code has been corrected, and the
ampersand can be used in option button text without problems in V6.1.4.

SBXA-8547 When using the GUI Text Editor (/GUI.TEXT.ED) in GUI mode, if a memo field
contained 465 characters or more, char(10) was not inserted between rows. The
code has been amended to correct this issue in V6.1.4.

SBXA-8556 On UNIX/Linux operating systems, entering an invalid password returned a
“Unable to connect to SB/XA” error message from Microsoft .NET in the XUI
clients. The fix to a related issue corrects this problem, and the XUI clients now
display the correct error message.

SBXA-8565 In input (/PD.I) processes that use the O option, fields should have been display-
only, but were editable. A fix was applied, resolving this problem in V6.1.4.

SBXA-8582 Phantom processes did not run if the Inhibit Shell Access flag was set to Y (Yes)
and the Inhibit /Process Calls flag was set to A (Prevent all / process calls from
inputs) in Group Security Setup (/SEC.GROUP.SETUP). You can now set the
Inhibit /Process Calls flag to the new option J (Prevent all / process calls from
inputs, except Job Schedule Definitions) to run phantom processes in this
situation.
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SBXA-8611 The /SB.REMOTE.PROCESS did not work when it was run from UniObjects,
preventing the ability to connect to SB developed applications from UniObjects.
A fix was applied in V6.1.4, and remote process calls from UniObjects run as
designed.

SBXA-8633 A subroutine that used the Group Security API (SH.SEC.API) set the value of
the Inhibit Process Calls flag incorrectly. In addition, an error occurred if you
attempted to log in with the user ID of a member of the group that was just
updated through SH.SEC.API. Both of these problems have been resolved.

SBXA-8639 Keyboard buffering caused problems with using hot keys for radio buttons in XUI
mode. This issue has been resolved.

SBXA-8646 Using SETATTR to set the G.EMPHASIZED attribute on a column in a grid gave
no visual indication that the column was disabled. In V6.1.4, the column is
displayed with a gray background to indicate that it is disabled.

SBXA-8658 The GUI text editor failed in XUI mode when using F3 intuitive help to populate a
field. This issue has been corrected in V6.1.4.

SBXA-8697 The GUI text editor failed in XUI mode when value marks were inserted in F3
intuitive help. The code has been amended to prevent this problem in the XUI
clients.

SBXA-8698 In an account with a least two system IDs, users were able to run a phantom
process only in the system ID in which the phantom was initiated. With an
enhancement in V6.1.4, phantoms run from any system ID in the account.

SBXA-8709 If a tabbed form was called from the Process At Start slot in SBMENU, the tabbed
form ran, but caused the XUI client to hang. This issue has been resolved in
V6.1.4.

SBXA-8712 In UNIX editions running on SB/XA Rich Client, entering an invalid operating
system password produced an error in a .NET dialog box. After dismissing
the error dialog box, the SB/XA Login dialog box was displayed. The code was
corrected so the behavior is now the same as in Windows editions: the error is
returned in a Windows dialog box and the U2 Database Server Login dialog box
is displayed.

SBXA-8727 In forms with multiple groups of radio buttons that used the same code table, if
you placed focus on one of the radio buttons and then used the hot key to select
one of the buttons, the button with that hot key was selected in all the groups of
radio buttons.

SBXA-8734 In the UniData edition, listing the APPLICATIONS attribute in DMSECURITY
produced an “Illegal attribute name” error. The code was corrected to prevent
this error in V6.1.4.

SBXA-8744 In XUI mode, if the input field just before a toggle field had a process in the
Process After slot and the paragraph contained @REFRESH=2, the toggle field
produced the error, “Invalid Code <Enter> Then try F3.” Fixes were applied to the
server code in V6.1.4 to prevent this error condition.

SBXA-8751 In multivalue grids with RTN.FLAG=S, values were displayed incorrectly when
pressing Return to advance though the grid in XUI mode. This issue is resolved in
V6.1.4.

SBXA-8763 When the clients were configured by using the common configuration file,
SBXAConfiguration.xml, they connected to an SB/XA Communications Server
other than the default. The code has been corrected in V6.1.4, and the clients
connect to the default SB/XA Communications Server specified in the common
configuration file.

SBXA-8773 In some cases, toggle controls (check boxes) could not be cleared in GUI mode.
This issue was corrected in V6.1.4, and check boxes can be cleared as expected.
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SBXA-8776 The position of F3 selection screens was not saved in XUI mode. V6.1.4
implements multiple fixes to correct related problems, and the position
coordinates and column width in XUI selection screens are now stored for the
next use.

SBXA-8777 In GUI mode, the value in toggle control fields was saved incorrectly as 1 when
the check box was selected and 0 when cleared. The code has been corrected so
that values are saved as 0 when the check box is selected and 1 when cleared.

SBXA-8831 When using the EMX navigation method in SB/XA Browser Client, a process in the
Process After Display on SBMENU did not run. This issue has been resolved in
V6.1.4.

SBXA-8833 The GUI text editor (/GUI.TEXT.ED) failed in GUI mode when value marks were
inserted in F3 intuitive help. The code has been amended to prevent this
problem in GUI mode.

SBXA-8875 A flaw in the @REFRESH=2 variable caused incorrect data to be displayed in the
Update An Account (/UPDATE.ACCOUNT) form. The COMMON variable code has
been fixed to correct this problem in V6.1.4.

SBXA-8879 The SBClient V6.1.4 launch screen is rebranded with the purple graphic for
Database Servers and Tools.

SBXA-8880 The SB.REMOTE.PROCESS encountered problems when attempting to save
file handles as part of preserving COMMON. In V6.1.4, SB.REMOTE.PROCESS no
longer attempts to save the file handles.

SBXA-8884 Accepting changes to a subscreen that was called from a GUI click process saved
the record. The code has been corrected so that changes to the subscreen are
accepted without saving the record.

SBXA-8893 In SBClient, a toggle in a grid returned an error if it used a table definition with
three different values in the internal code, display text, and input code and
if Allow NULL was set to N in a validation. Both client and server code were
amended to prevent this error condition in V6.1.4.

SBXA-8894 The SB.DISP.BOXTEXT subroutine did not display text correctly if the tilde (~)
character was included in the string. In Character mode, the ~ character was
not printed and text was truncated at approximately 124 characters. In GUI
and XUI modes, the ~ character was not printed, but text was not truncated.
With a correction in V6.1.4, the ~ character is printed and the text is no longer
truncated.

SBXA-8910 The TU.PC.LOAD routine did not run in the XUI clients. V6.1.4 implements
support for TU.PC.LOAD in XUI mode, with certain restrictions:

▪ Options D, E, R, and S are not supported.

▪ Option H is implemented as the default.

▪ Separator Mode = 0 is not supported.
SBXA-8940 In a process definition (/PD.P), if you used SETATTR to set the string property

of a button with a value that contained an ampersand (&) character, the &
character was displayed in XUI mode instead of being parsed as the flag for the
hot key. The code has been amended and the & character is interpreted as the
flag for a hot key, as designed.

SBXA-8944 Pressing Ctrl + End in a memo field with data caused SB/XA Rich Client to fail. A
fix was applied to correct this problem in V6.1.4.

SBXA-8958 When the last object on a form was a toggle object that was hidden with
SETATTR, pressing F2 closed the form in XUI mode. With a fix in V6.1.4, the form
remains open after pressing F2 in XUI mode, the same as in GUI mode.
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SBXA-9004 If an input process (/PD.I) with the O (Output only) option contained a memo
field and a toolbar, selecting a button on the toolbar caused the XUI client to fail.
This issue has been resolved.

SBXA-9071 Pressing F3 for help in memo fields caused text to be duplicated in XUI mode. A
fix corrects this issue in V6.1.4.

SBXA-9078 In input screens containing a grid with three columns of toggle objects, SB/XA
Rich Client failed and returned a nonrecoverable error. A fix has been applied to
prevent the XUI client from failing under these conditions in V6.1.4.

SBXA-9084 In the NoFocusContextMenu.xaml code, the messages “Put focus to field first
for context menu” and “Click to open or close menu tree” were hard-coded
in English and could not be translated to other languages. These two phrases
are now referenced in the sbplusstrings.de-CH.restext and sbplusstrings.en-
us.restext files so they can be translated.

SBXA-9086 SB/XA Communications Server was unable to connect to SB/XA Administration
Server if the administration server computer was known only by its IP address.
SB/XA V6.1.4 has upgraded to a new UODOTNET.dll that recognizes the
computer’s IP address or host name.

SBXA-9124 In input processes (/PD.I), check boxes (toggles) required two mouse clicks
to initiate the expected action in GUI and XUI modes. This behavior has been
corrected in V6.1.4, and one mouse click initiates the action.

SBXA-9138 The SBClient device licensing dynamic link library (DLL) has been updated to
version 3.2.1.0.

SBXA-9143 Clicking on a memo field in an output process (/PD.O) closed the form in the XUI
clients. The code has been amended to prevent this problem in V6.1.4.

SBXA-9147 If the defaultApplication property was set in the central client configuration file,
the user was not presented with a list of applications from which to select. With
a fix in V6.1.4, setting the defaultApplication property now works correctly and
the user can select from a list of valid applications.

SBXA-9193 On Linux AIX, the /PHYSICAL.PRINTER form was not correct, and attempting
to add a new stationary caused the XUI client to fail. This problem has been
resolved.

SBXA-9195 If the local cache index file was locked when starting SB/XA Rich Client, this
caused the client to fail. A fix corrects this issue in V6.1.4.

SBXA-9199 In Report Writer reports output to DIFF, spaces were missing from custom
column headings that were painted in the report definition. A code fix corrects
this issue in V6.1.4.

SBXA-9207 If /VALIDATE.USER and /PASSWORD.VALIDATION functionality were set up
as documented in the Developer Zone article “How To Deploy SB+ Password
Validation,” the /CHANGE.PWD process failed to verify the new password. With
a correction in V6.1.4, the /CHANGE.PWD process verifies the new password as
expected. No change to the setup steps is required.

SBXA-9218 Check boxes (toggles) on a subscreen did not work correctly in a multivalue
group in GUI mode. This issue is resolved in V6.1.4.

SBXA-9239 With the Auto Extend Field Length flag set to N, Ctrl + End did not extend the
field length in multivalued fields in XUI mode. A fix resolves this issue in V6.1.4,
and the auto-extend feature works as designed.

SBXA-9282 If a report had more than 80 columns and the selected printer had a printer
class with no stationery types defined (such as DEFAULT.PRINTER and
DEFAULT.CLASS), the XUI client logged off. With a code fix, this problem no
longer occurs in V6.1.4.
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Issue Number Description

SBXA-9305 The SBMailXPS class has been made public so that you can create templates
from it. The SBMailXPS.xaml file is available in the Extra folder in the product
download directory.

SBXA-9315 In the screen designer (/SD), value marks were not inserted in wrapped text in
memo fields in the XUI clients. This issue has been corrected in V6.1.4.

SBXA-9325 If the IsAutoPositionEnabled property was set to True for the Store Client Form
Pos parameter, the location and size settings of custom forms were not honored
in XUI mode. This issue was addressed in V6.1.4, and the stored settings are
applied as designed.

SBXA-9326 When performing a binary file transfer, SB/XA Rich Client failed when
transferring a record that was locked. In V6.1.4, file transfer option K was added
to lock the directory type file for binary transfers.

SBXA-9352 In derived fields, a check box (toggle) that was selected in GUI mode was
displayed as not selected in the same record in XUI mode. A fix corrects this
problem in V6.1.4.

SBXA-9457 When the list of values for intuitive help was derived from a QSELECT verb, the
column displaying the values was too narrow. The code was corrected in V6.1.4,
and the column width fully accommodates the list of values.

SBXA-9470 In versions 6.1.2 and 6.1.3, custom themes that added buttons or menus to the
XPS Viewer were unable to call SB processes. The code was amended in V6.1.4,
and process calls from the XPS Viewer again work as designed.

SBXA-9472 A problem occurred with a paragraph that used RTN.FLAG="{fldname}" to jump
to a specific field. When the paragraph process was called from a custom control
through ExecuteSBPlusProcessInContextCommand, focus jumped to the wrong
field. Changes to the code prevent this problem in V6.1.4.

SBXA-9489 When running an HTML process in the XUI clients, the web page was not
displayed until you resized the HTML window. This issue has been fixed in V6.1.4.

SBXA-9505 Label objects could not be hidden in the XUI clients. This issue has been
resolved.

SBXA-9506 Text objects could not be hidden in non-input fields. This issue has been
resolved.

SBXA-9510 In the XUI clients, if you attempted to replace an existing toolbar with another
toolbar, both the existing and new toolbars were displayed. V6.1.4 implements a
fix, and the existing toolbar is replaced by the new toolbar as expected.

SBXA-9537 Memo fields with PARAM=2 did not have horizontal scroll bars and did not wrap
text. With a fix in V6.1.4, scroll bars and text wrapping work as expected.

SBXA-9539 In memo fields, when a vertical scroll bar was added, it changed the way text
was wrapped in XUI mode. To address this problem in V6.1.4, a vertical scroll bar
is always displayed in memo fields.

SBXA-9540 Job schedule definitions (/PD.J) phantom processes did not work unless you
set the Phantom Sleep Time parameter in SB Control Parameters (/SB.PARMS).
The code was amended in V6.1.4 so that job schedule phantom processes work
without a Phantom Sleep Time parameter.

SBXA-9545 In multivalued fields, the scroll bar position was incorrect in GUI mode. This
problem has been corrected in V6.1.4.

SBXA-9592 The spell check feature did not work as expected if a context menu with a
spelling suggestion list was active and the user right-clicked on a different
misspelling in the source file. SB/XA now performs a check when the context
menu is opened, and if a list of spelling suggestions exists, SB/XA cleans up the
existing list before generating a new list of suggestions.
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SBXA-9633 In screens with an action bar, if the mouse pointer was positioned over the
action bar at run time, focus switched from the first input field to the action bar.
The same thing happened when rolling the mouse over the action bar. With a fix
in V6.1.4, focus remains at the input field until an action has been selected from
the action bar.

SBXA-9684 In V6.0.0 or later, if you used the Execute Now option after creating a Query
Report Definition (QRD), the QRD was incorrectly saved to the data file in
addition to xxDEFN. With a correction in V6.1.4, the QRD is saved only to xxDEFN
as designed.

SBXA-9731 The following scripts are now bundled with the XUI clients so that they are
installed as part of a standard client installation:

▪ SBXAScriptControls.dll

▪ AxInterop.MSScriptControl.dll

▪ Interop.MSScriptControl.dll

When the clients run these scripts, they are no longer downloaded from the
server, improving performance.

SB/XA v6.1.3 release notes
Build 3330
Release Date: June 2012
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.1.3.

What’s new in SB/XA v6.1.3

Log Viewer/Analyzer
At V6.1.3, SB/XA implements a Log Viewer/Analyzer that displays information on logs from the client,
SB/XA Communications Server, and SB/XA Application Server. This tool enables you to match up
logs from each tier and synchronize the entries in all logs. It provides critical information to help the
technical support team analyze errors and resolve customer issues. SBXA-7891

Applications added to Group Security
A new screen called from Group Security Setup (/SEC.GROUP.SETUP) allows you to define the
applications associated with a group. This usability enhancement saves administrators time in setting
up applications for large groups of users. SBXA-3442

Improvements to file transfer performance
This version implements improvements to the SB/XA file transfer protocol (XAFTP). The XAFTP method
has the following advantages:

▪ Performs downloads faster than any of the three protocols available in SBClient (FTP, SBZ, and
SMB), as demonstrated by our V6.1.3 tests.

▪ Transfers binary files.

▪ Requires no setup.

▪ Provides secure communication, using the same protocol as the XUI clients.

SBXA-4295

Autofill of user credentials
An Autofill flag has been added for each Single Sign-On (SSO) enabled application in the user’s SSO
record. When a user logs in to an SSO application for which the Autofill flag is set to Y (Yes), the user’s
operating system User ID is autofilled from the information in the SSO record. Autofill can simplify the
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user’s login and decrease the amount of time administrators spend helping users with login issues.
This feature is configurable for those who want tighter security and no autofill. SBXA-7917

Object code versioning
SB/XA V6.1.3 implements the ability to version SB/XA object code. The object code is now stamped
with the version number during the build process. This tool will help technical support and partners
track patches at customer sites. SBXA-8333

Feature to save form size and position
A flag to save screen size and position has been added in V6.1.3. When the client cache is cleared, the
size and position of forms can now be reloaded from the server, so users do not have to resize and
reposition their screens. SBXA-4556

Multilanguage capability added for SBX/MPX menu
Multilanguage support has been implemented for the SystemBuilder Explorer (SBX/MPX) menu in GUI
and XUI modes. SBXA-4706

Enhancements and fixes in SB/XA v6.1.3

The following issues were addressed in this release:

Issue Number Description

SBXA-1534 V6.1.3 implements the following changes to printer defaults:

▪ In the Port Configuration (/TERM.CONFIG) > F9-Default screen, an XPS Printer
Name field has been added. The default setting for this field is XPS.PRINTER.

▪ In User Security Setup (/SEC.USER.SETUP) > Printers, the XPS printer name
entered in the XUI Printer ID field is used by the XUI clients. The Aux Printer
ID is now used only by SBClient. This allows you to have LOGICAL.PRINTER
as the Aux Printer ID and XPS.PRINTER as the XUI Printer ID. If no printer has
been specified, the XUI clients direct output to the XPS.PRINTER.

SBXA-1850 In V6.0.0 and later, SBClient failed when attempting to print a string to the
auxiliary (Aux) device if the length of the string was 8192 characters (or any
multiple of 4096 characters). The code has been changed to append the null
value to such strings, correcting this problem in V6.1.3.

SBXA-2421 As of V6.1.3, the XUI version of the Who Are You? form is built from the GUI
version of the form, rather than the character version. This change in the
conversion source improves the positioning and alignment of fields on the XUI
form.

SBXA-2589 XUI user flags have been added to the User Security Setup (/SEC.USER.SETUP)
screen in V6.1.3. In character mode, these flags are available from /
SEC.USER.SETUP > F8-GUI Prefs > F5-XUI User Flags. In GUI and XUI modes, the
flags are on the XUI Flags tab.

SBXA-3006 In the procedure to create a field definition (/FD), the F6-Addit > Control/Dep
field did not validate your entry of a phrase (type PH record). The Control/
Dep field allowed you to enter the name of an existing field definition as the
name of the multivalue association. In this case, no PH record was created
for an association, but field 7 of the field definition was updated to indicate
that an association existed, when it did not. After changes in V6.1.3, a phrase
entered in the Control/Dep field is validated to verify that it is not the name of an
existing phrase, preventing subsequent problems with creating the multivalue
association.

SBXA-3288 In previous versions, the Inhibit Logons screen did not validate user IDs entered
in the Non Inhibit Users field against DMSECURITY. As of V6.1.3, the program
performs validation checking on entries in this field and issues an error if the
user ID is not valid.
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Issue Number Description

SBXA-3442 A new screen called from Group Security Setup (/SEC.GROUP.SETUP) allows
you to define the applications associated with a group. If no applications are
defined for the user in User Security Setup (/SEC.USER.SETUP), applications
in the group record are used. If the group record has no applications defined,
the applications in the parent group record are used. If the parent has no
applications defined, the next level is used, all the way back to the ROOT
group. If the ROOT group has no applications defined, all the records in
DMAPPLICATIONS are used.

SBXA-3585 When upgrading the UniData edition of SB/XA Application Server for Windows,
the installation script issued an error, “Unable to open pointer to old Sauser.”
This issue has been addressed in V6.1.3, so the SAUSER pointer to the old
account is a DIR type only if the old version is 6.0.0 or greater.

SBXA-4083 Field labels in the SB/XA Administration Server Connection dialog box have been
revised to provide a clearer description of the information required.

SBXA-4183 In SB/XA V6.1.2 or earlier, SMART.QUERY reports could not be exported to the
64-bit version of Microsoft Office 2010 running on Windows 7 64-bit operating
systems. The existing code has been revised and an alternative Windows API
function was added as a fail-safe to prevent this compatibility issue.

SBXA-4295 V6.1.3 implements improvements to the SB/XA file transfer protocol (XAFTP).
Our V6.1.3 tests demonstrate that the XAFTP method performs downloads
as fast or faster than the network copy (SMB) and FTP methods available in
SBClient. XAFTP outperforms SBClient SBZ transfers by a factor of 10 or greater,
and has the added advantage of supporting binary transfers.

SBXA-4376 In some fields, data was displayed out of position and was partially obscured by
the frame in GUI mode running on Windows 7. A fix resolves this issue in V6.1.3.

SBXA-4556 In V6.1.0 and later, screen sizes and positions were lost when the cache was
cleared, and there was no parameter to control this behavior. In V6.1.2, a flag
to save screen size and position has been added at the SB instance level in SB
Control Parameters (/SB.PARMS), at the system level in the System Control
Record (/HK.CONTROL), and at the user level in User Flags (/USER.FLAGS).

In addition, the following new processes have been created:

▪ CLEAN.MY.POSCACHE – Deletes the DMPOSCACHE item for the current user.

▪ CLEAN.POSCACHE – Prompts for the user whose cache is to be cleared.

▪ CLEAN.ALL.POSCACHE – Deletes DMPOSCACHE items for all users.

Note that after clearing the client cache, you must log off and log on again to
restore the server cache.

SBXA-4588 Auto-generated forms for entering criteria in a selection process (/PD.S) were
larger in XUI mode than the same forms in GUI mode. With a fix in V6.1.3, the XUI
form closely resembles the GUI form in size.

SBXA-4649 Two new ISBForm properties, IsDefaultFormLocation and IsDefaultFormSize,
have been added to indicate whether the form was sized based on client-side
parameters. These properties are set to a default of True and retain this value
until the user moves or resizes the form’s window, respectively. The location and
size properties are saved in the form location cache, so they survive closing and
reopening the SB/XA client. Note that SB/XA uses one zoom factor for all forms;
there is no property to set the zoom factor for an individual form.
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Issue Number Description

SBXA-4688 If two users were logged in and had a total of five GUI and XUI client sessions
open at the same time, running the /LISTU process returned an unclear
message, “5 SB+ Users Logged In, Max Number of SB+ Users 2.” The first
segment of the message text has been changed so it now reads, “5 SB+
Sessions.”

SBXA-4933 When running a QRD or Report Writer report and the output destination
was "A" for Ask, the printer defined in AUX Printer of User Security Setup (/
SEC.USER.SETUP) was displayed as the default. In V6.1.3, a new field “XPS
Printer ID” has been added in /SEC.USER.SETUP. In addition, a new field has
been added in Port Configuration (/TERM.CONFIG), allowing you to define a
default XPS printer systemwide. If both of these settings are left blank, the
printer for QRD and Report Writer reports defaults to XPS.PRINTER.

SBXA-4694 In V6.1.1 and 6.1.2, the File > Save As option did not function successfully for
HTML reports. This issue has been resolved in V6.1.3.

SBXA-4706 Multilanguage support has been implemented for the SystemBuilder Explorer
(SBX/MPX) menu in GUI and XUI modes. A new screen called MPX Text has been
added to the /TRANSLATE feature. It is accessed as the last option after selecting
the language. The new screen consists of four elements:

▪ The number of the attribute in MPX.TEXT to be translated.

▪ A display-only field indicating the language of the text that is being
translated.

▪ The text from the original MPX.TEXT item in DMCONT for this attribute.

▪ The translated text.

The MPX.TEXT item is created by this screen and stored in DMLANGUAGE.XX.
If you set a language code in user flags, the server reads MPX.TEXT from the
appropriate DMLANGUAGE.XX and sends it down to the client.

SBXA-5044 In the XUI clients, footer lines in Report Writer reports were not printed if the
output was directed to a physical printer, rather than the XPS Viewer. This issue
has been resolved in V6.1.3.

SBXA-5147 In SBDEMO, the Enquiries > Car Parts form was missing a column heading. The
heading is now displayed in V6.1.3.

SBXA-5167 When performing an F3 Select in a selection process in GUI mode, if you used the
icon at the bottom of the selection list in ListView to download the entire list and
then pressed the Esc key, the message “No Items Selected” was displayed. This
behavior has been corrected in V6.1.3 so that the message is displayed only if
you used the P option in the selection process.

SBXA-5168 In the release notes for V6.1.1, the description for SBXA-4858 has been updated
with an additional path to which SB/XA Communications Server is installed on
computers running Windows 2003 Server:

C:\Documents and Settings\Default User\Local Settings\Application Data
\Rocket Software\SBXAComServer.config

SBXA-5203 In report process definitions (/PD.R), if you specified paper size and orientation
values for a PDF report driver in the Direct to PDF tab, the values were not visible
after saving the report process definition. This problem has been resolved, and
these values are now saved and displayed as expected.

SBXA-5222 Using PARAM 12 of the security API in a no-restrictions account returned an
error, “Record corrupt, take note before filing.” The code has been amended to
prevent an error in these circumstances in V6.1.3.
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SBXA-5232 The error messages stemming from an incorrect endpoint were reversed for
the SBXAUserNamePassword and WindowsUserNamePassword authentication
types in V6.1.2. The message text has been corrected for both authentication
types in V6.1.3.

SBXA-5259 In V6.1.0 and later, fields defined as a record of type PH (phrase) performed no
validation and overwrote other record types. This issue has been fixed.

SBXA-5267 In XUI mode, the Admin > Files > View File Data > List All File Names option
returned the list of file names in an error message format that was difficult to
read. The List All File Names function has been changed in V6.1.3 so it runs the
HK.FILES.O process and displays the file names in a grid.

SBXA-5269 In output screens that had a label in the F3 function key slot, the F3 function
key was disabled in the XUI clients. The code has been amended to correct this
problem in V6.1.3.

SBXA-5271 In input screens with a mandatory date field containing the syntax “P:
(*P484487)” in the Process After slot, an error occurred after the user entered
the “+1” key sequence, entered the date, and then pressed Tab. The error
message text, “Must enter something,” was confusing, because the date field
contained data. This issue has been corrected in the GUI and XUI clients, and the
conditions described here no longer trigger an error.

SBXA-5281 In SBClient V6.1.2, deleting the default network configuration profile resulted in
a “Default Modem has changed” error. A section of code that checks the deleted
item has been amended, preventing this error in V6.1.3.

SBXA-5289 When using SBXAUserNamePassword authentication with SB/XA Browser Client,
if the navigation style was set to Window mode, the browser reverted to Page
mode after the user ended the session. This behavior has been corrected in
V6.1.3, and SB/XA Browser Client remains in Window mode, as designed.

SBXA-5290,
SBXA-7984

In V6.1.3, a Save Credentials check box is placed in the Connect to Application
dialog box under certain conditions. At the user’s first login, the Save Credentials
check box is not displayed. When the user logs in, the server is contacted and
the information is queried. If the user is allowed to save credentials, the Save
Credentials check box is displayed on subsequent logins. If the user has stored
credentials and the administrator later disables the user’s permission to store
credentials, the stored credentials are removed.

As part of this enhancement, a new flag called Local Storage of User IDs and
Passwords has been added to the user security record and to the group security
record (parameter <39,3>). If the Local Storage of User IDs and Passwords field
in the user security record is blank and the flag in the group record contains a
value, the value in the group record is sent with the user record to the client.

SBXA-5299 Type 3 (painted) menus are not supported in XUI mode. This is a permanent
restriction; there is no plan to add support for this functionality in the future.
However, in versions 6.1.0 and later, the XUI client failed if the application
attempted to display a Type 3 menu. This has been addressed in V6.1.3, so a
“Not Implemented” message is displayed when a Type 3 menu is encountered,
and after dismissing the error message, the user can continue working in the
client window.

SBXA-5301 In input screens displayed in the XUI clients, a horizontal scroll bar was added
automatically to grids when it was not necessary to scroll. A fix corrects this
problem with form rendering in V6.1.3.
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SBXA-5312 When users created an account or ran FIX.SBPLUS.POINTERS in previous
versions, SB/XA did not add a VOC entry for TUBP and TUINSERT in the account.
The create and update processes have been enhanced in V6.1.3 to write these
VOC entries to the account.

SBXA-5315 In V6.1.1 and 6.1.2, the regenerate expressions (/REGEN.EXP) process did not
regenerate default process (/PD.D) expressions. This issue has been corrected in
V6.1.3.

SBXA-5318 On Windows 7 computers, if the Control Panel > Region and Language >
Keyboards and Languages selections were set to Netherlands and Dutch, F3 and
XPS Viewer displays were corrupt and caused SB/XA to hang. Several fixes to
correct character conversions and a mismatch between the floating point string
format on SB/XA Application Server and the client correct this problem in F3 and
XPS displays.

SBXA-5333 When using a cross-domain connection, users experienced problems in
searching intuitive help if the grid was not in focus when the search was run or
if the F6 key was pressed repeatedly. These problems were attributed to timing
issues with cross-domain connections, and a fix addresses this in V6.1.3.

SBXA-5338 In the UNIX edition, F3 intuitive help screens in XUI mode were displayed at
a small size, obscuring the help text. The code has been amended in V6.1.3,
resolving this display issue on UNIX systems.

SBXA-5343 With terminal emulation set to Wyse 50, SBClient displayed selections in reverse
video beyond the defined boundaries. This behavior has been corrected.

SBXA-5347 On UNIX systems, the Available Disk Space dialog box displayed the availability
statistics incorrectly in the XUI clients. This issue has been resolved in V6.1.3.
Note that this dialog box is not implemented for Windows systems, and a “not
available” message is displayed.

SBXA-5370 In the User Security Setup (/SEC.USER.SETUP) screen, the “Last Updated by”
and “Date” columns allowed user input, contrary to the intended designed. In
V6.1.3, these columns are rendered as display-only and input is not allowed.

SBXA-5374 In the UniVerse for Windows edition, the User Security Setup (/SEC.USER.SETUP)
screen was missing the menu for copying a user. This menu has been reinstated
in the Windows edition in V6.1.3.

SBXA-5375 When the central configuration file defined multiple connections, the list of
applications was cached from the first connection. If you chose a connection
to another SB/XA Communications Server, the Connect to Application window
listed the applications for the first connection. The code has been revised in
V6.1.3, and the client presents the application list for the current connection.

SBXA-5383 In the SystemBuilder Explorer (SBX/MPX) menu, if you added a nonexistent
image as the icon for a menu item, the word “expanding” appeared instead
of the menu item. Double-clicking this word caused SB/XA to fail. V6.1.3
implements the following changes to address this issue: If an icon is invalid, the
menu now expands to a single entry saying “invalid icon.” If the user clicks this
entry, the action is ignored.

SBXA-5387 When users specified settings for Columns and Rows in the Maintain Stationery
Types dialog box, the cutoff point was incorrectly calculated on settings
from Printer Class, rather than on the stationery settings. The code has been
amended to calculate the cutoff point based on stationery settings in these
circumstances.
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SBXA-5388 In V6.1.2, the single Character for XPS Tags field in SB Control Parameters (/
SB.PARMS) > XUI Parms was redesigned as two XPS tag fields:

▪ Start Character for XPS Tags

▪ End Character for XPS Tags
If the end character is not defined, the setting defaults to CHAR(9).

The UniVerse for Windows edition implemented the two new fields in V6.1.2.
The UniData for Windows, UniData for UNIX, and UniVerse for UNIX editions
contained only one field, Character for XPS Tags. In V6.1.3, this enhancement
has been ported to all editions.

SBXA-7865 The description of terminal definition variable 3.8 was incorrect in general help
(/GENHELP) and in the SB/XA Reference manual, Appendix C. Variable 3.8 is the
value for the Mouse Enable sequence, as follows:

▪ On sequence: (27)_TM1(27)\(27)_TS0(27

▪ Off sequence: (27)_TM0(27)\(27)_TS1(27
SBXA-7871 On computers running Windows XP, rolling the mouse over the SBClient toolbar

displayed an empty box, sometimes consuming half of the desktop display
area. This was due to failure of a system call to find the correct font in which
to display hover help, which then caused the program to select a random font
family/size to determine the size of the hover help window. The program has
been amended in V6.1.3, and the hover help window is displayed as designed.

SBXA-7885 In memo fields, if the theme attempted to call a paragraph process with the
syntax SBCommands.ExecuteSBPlusProcessCommand.Execute(“P.KEEPALIVE”,
SBPlus.Current), the server code explicitly ignored the /process call. The XUI
clients are able to differentiate between a /process call and data in V6.1.3, and
paragraph processes are executed correctly in memo fields in XUI mode.

SBXA-7892 When an error required a change to the administration data, the error dialog
box was displayed behind the administration form. If you corrected the
administration details and attempted to log in, the session failed. Display of the
error dialog box has been changed so it is always on top of the administration
form, preventing this problem in V6.1.3.

SBXA-7891,
SBXA-7983

V6.1.3 introduces a Log Viewer/Analyzer that displays information on logs from
the client, SB/XA Communications Server, and SB/XA Application Server. This
tool enables you to match up logs from each tier and synchronize the entries
in all logs. The Log Viewer/Analyzer is available in the Extra folder on the SB/XA
V6.1.3 product CD image.

To enable this new feature, the logs for each tier were revised to pass the
required information to the Log Viewer/Analyzer tool.
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SBXA-7902 Pressing the down arrow key on the controlling multivalue field when there was
a Process After slot resulted in various behaviors, depending on the version, the
presentation mode, and whether you used a grid.

GUI behavior:

▪ Grid – Process After was called when down arrow was pressed

▪ Non-grid – Process After was not called when down arrow was pressed

XUI behavior:

▪ 6.1.1 – Process After was not called when down arrow was pressed

▪ 6.1.2 – Process After was called when down arrow was pressed

To address this issue, a new option has been implemented in V6.1.3. You can
add the O option to the Process After slot so that the process is called only if the
data has changed or if you press Enter to leave the field.

SBXA-7906 An input screen with nothing but toggle fields behaved incorrectly in GUI mode.
When you executed an input screen with multiple toggle objects in the GUI client
and selected one toggle object, a second toggle object was also displayed as
though it had been selected. This issue has been resolved in V6.1.3.

SBXA-7917,
SBXA-7985

A new field called Autofill has been added for each Single Sign-On (SSO) enabled
application in the user’s SSO record. When a user logs in to an SSO application
for which the Autofill flag is set to Y (Yes), the user’s operating system User ID
is autofilled from the information in the SSO record. Likewise, when SB/XA
prompts for the User ID, it is autofilled from the information in the SSO record.

To support this enhancement, Autofill flags have been added to the user
security record (/SEC.USER.SETUP) and to the group security record (/
SEC.GROUP.SETUP). The code that sends the user record to the client has been
amended so that if the Autofill flag in the user security record is blank and the
Autofill flag in the group security record contains a value, the value in the group
record is sent with the user record to the client.

SBXA-7952 Single Sign-On (SSO) did not work if the global AutoLogin flag was set to Y (Yes)
in SB Control Parameters (/SB.PARMS). The code has been fixed to prevent this
problem in V6.1.3.

SBXA-7969 In interleaved multivalue grids in the XUI clients, the separator lines between
columns were visible and looked confusing in overlapping columns of the grid. A
change has been applied in V6.1.3 so that column separators are now invisible.

SBXA-7977 The focus and data values were out of sync on slower systems when the user
pressed the left mouse button while hovering over one text box and released the
mouse button over another text box. A fix has resolved this issue.

SBXA-7986 In an input screen with a multivalued grid, the controlling multivalue field was a
derived field defined with six rows of data, but displayed only two rows of data
in the XUI clients. A section of code was revised to fix this problem in V6.1.3.

SBXA-7989 In V6.1.0 or later, the SB/XA cache was unable to handle long resource names. To
address this issue, V6.1.3 implements an index for local file names. The file name
can now contain a maximum of 52 bytes. This includes up to 32 bytes from the
start of the resource name, plus a “.” and a unique counter (a long number). The
index is kept in a file called localfile.idx. A cached copy of the index is stored in
memory for quick access to the file names.
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SBXA-7992 In multivalued grids in the XUI clients, entering @(-3) to clear the screen from
the current position to the end of the screen did not work as designed. The
code has been amended so it now overwrites text with spaces, clearing the text
correctly.

As a related problem, the XUI clients ignored the Line mode attribute when
clearing the screen. If you set a Reverse attribute (for reverse video) at the
beginning of the line and then used @(-3) to clear the screen from the middle
of the same line, the entire screen was displayed in reverse video. When using
@(-3) to clear the screen in Line mode, the program now puts a Normal attribute
at the beginning of the next line.

SBXA-7993 A “not found” error message was displayed when executing the primary
screen of two tabbed screens in XUI mode. When running the input screen
I*S7895*MT100.1, SB/XA returned the message, “MT101.1 not found,” before
the primary screen was displayed. The form screen was MT100.1, rather than
MT101.1 as indicated in the message.

SBXA-8021 A new field in SB Control Parameters (/SB.PARMS) enables you to specify the
number of seconds of delay for starting phantom processes. If you leave this
field blank, SB/XA uses the default value of 3 seconds.

SBXA-8039 If you defined an auxiliary (Aux) printer in Port Configuration (/TERM.CONFIG)
and specified a different Aux printer for a user in User Security Setup (/
SEC.USER.SETUP), the user’s Aux printer setting did not override the default Aux
printer setting for the port.

To address this issue in V6.1.3, the Port Configuration settings are used only if
no Aux printer is specified in the user security record. In addition, the fallback
printers have been changed. If no Aux printer is defined in the user security
record or in /TERM.CONFIG, the Aux printer defaults to LOGICAL.PRINTER
rather than DEFAULT.PRINTER. For XPS printing, the XPS printer defaults to
XPS.PRINTER.

SBXA-8080 A type 1 menu with coordinates of 1 caused the XUI clients to fail. A fix has been
applied to prevent this problem in V6.1.3.

SBXA-8094 In some cases, display fields in a multivalued grid did not display data in the XUI
clients. This issue has been corrected.

SBXA-8121 When running a program from the command line to display text in reverse video
on an HP Itanium server, the reverse video was not turned off correctly and
the next menu option on the selected menu was displayed in reverse video in
SBClient with Wyse 50/60 emulations. The code has been amended to fix this
problem in V6.1.3.

SBXA-8131 After resizing an intuitive help form, the column sizes were not stored. With a
change to the code in V6.1.3, column sizes are saved as expected.

SBXA-8141 In the XUI clients, right-click menus were displayed briefly and then
disappeared. This behavior has been corrected in V6.1.3, and right-click menus
are displayed as designed.
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SBXA-8142 In SBClient, the /CHANGE.PWD process failed if the user attempted to change
the password on initial login. The password process failed due to two separate
problems in related areas:

▪ The passwords of users created in the GUI client in previous builds were
corrupted.

▪ The /CHANGE.PWD process encountered problems if the user’s original
password contained lowercase characters.

Both problems have been resolved in V6.1.3, and changing the password in the
SBClient no longer produces an error.

SBXA-8155 In forms displayed in the XUI clients, the labels of radio buttons failed to change
after setting attributes with the /SETATTR function, and the client returned an
error. The fix for this issue also required a change to character layout processing
to get the correct size for vertical radio buttons when the definition included
only validation codes.

SBXA-8174 A bug in V6.1.2 prevented the ability to print a range of pages in the XPS Viewer.
This issue has been resolved in V6.1.3, and users can print a specified page range
from the File menu of the XPS Viewer.

SBXA-8192 In V6.1.2, each server session from the XUI client attempted to read the socket
every two milliseconds (ms) when idle, resulting in high CPU utilization. As
of V6.1.3, you can configure the socket time-out in SB Control Parameters (/
SB.PARMS) > Socket Options > Socket Timeout. In addition, the default value of
this time-out has been changed from 2ms to 1000ms. The default setting applies
if no value is specified in the Socket Timeout parameter in the /SB.PARMS
record.

SBXA-8227 If you used the resizer grip in the lower right corner of a tabbed input form to
make the form window smaller, horizontal and vertical scroll bars were not
generated and fields and buttons were cut off. In V6.1.3, the behavior has been
corrected so that resizing the window of a tabbed input form works the same as
it does for a non-tabbed input form.

SBXA-8242 Images on the toolbar were not de-emphasized by the SETATTR G.EMPHASIZED
command. With a fix in V6.1.3, toolbar icons are de-emphasized visually when
they are in a disabled state.

SBXA-8256 A call to TU.PC.UPLOAD caused SBClient to fail. Revisions to the file transfer
program corrects this problem in V6.1.3.

SBXA-8279 A dynamic combo box in a dependent field of a multivalued grid did not open
in the GUI client. This issue was due to the sbmvclass losing internal data for
one part of the grid when another part of the grid was set. With a code change in
V6.1.3, dynamic combo boxes open as expected.

SBXA-8282 Existing SB+ 5.x users were unable change their password from the /
CHANGE.PWD command in GUI or XUI mode in V6.1.2. This issue has been fixed.

SBXA-8333 V6.1.3 implements the ability to version SB/XA object code. The object code is
now stamped with the version number during the build process. In addition,
the /SB.INFO process has been enhanced so the center part of the screen that
formerly displayed the Patch No and Date Applied fields now contains File,
Item ID, Version, Platform, Date, and Time fields from the stamping process.
A file is stamped if its version number does not match the version number of
the installed product. With version stamping, object code patches to the SB/XA
Application Server can be easily detected and verified.
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SBXA-8347 In a multivalued grid with the cursor positioned on the last row (which was
empty), when the user scrolled to the top of the grid, the first row was not
visible. With a fix in V6.1.3, the first row is displayed on scrolling to the top of the
grid.

SBXA-8373 During login to SB/XA for UniData on the GUI client, an “unassigned variable”
message was displayed between input of user name and password. This issue
has been resolved.

SBXA-8378 The TU.FILE.INFO subroutine works only when run on the XUI clients. When
this host routine was executed on the character and GUI clients, it returned an
incorrect status code of 0, indicating that the file was found, even if the file was
not on the client computer. After a change in V6.1.3, running TU.FILE.INFO on
the character and GUI clients returns a status code of 1 and an error message
indicating that this host routine runs only on the XUI clients.

SBXA-8418 When calling phantoms from a paragraph (/PD.P) process, if the paragraph
process included a loop, some of the phantom processes did not run
successfully. This issue has been resolved.

SBXA-8449 The msmapi32.ocx Active X control that supports MAPI in SBClient was not
present on the product CD image in V6.1.2. MAPI did not work unless Active X
was already present on the client computer. The msmapi32.ocx file has been re-
added to the build scripts in V6.1.3.

SB/XA v6.1.2 release notes
Build 3226
Release Date: February 2012
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.1.2.

What’s new in SB/XA v6.1.2

Support for graph definitions
In versions 6.0.0 and later, the Graph definitions feature was not available in SB/XA Browser Client
or SB/XA Rich Client. This functionality has been implemented in the XUI clients using new Microsoft
WPF graph toolkit. Graph definitions from earlier releases now work unchanged in the XUI clients.
SBXA-1234

Ability to set up applications for a group
A new subscreen in Group Security Setup (/SEC.GROUP.SETUP) enables you to associate applications
to a group of users. This feature relies on the fundamental of inheritance, and can save time in setting
up applications for many users. SBXA-3442

Expanded functionality in SBPlusClient API
New methods have been added in the SBPlusClient API, supporting the ability to (1) call the XUI clients
from an application and pass through a process that runs in the XUI clients, and (2) log in as a different
user and application. SBXA-1632, SBXA-3609

New template for creating a basic theme
Version 6.1.2 provides a template to assist you with creating a basic theme in Visual Studio 2010.
SBXA-3985

Performance tuning
Version 6.1.2 was subject to performance improvements in several areas, resulting in quicker response
time in the XUI clients, in downloading and caching themes, and in grid handling. SBXA-4132,
SBXA-4666, SBXA-4846, SBXA-4940, SBXA-5009, SBXA-5142

Option for exporting reports to a text file
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The XPS Viewer offers a new option to export reports directly to a text file, saving you several
intermediate steps to perform this task. SBXA-4543

Improved account upgrades
At version 6.1.2, the installation program checks the version number in the account’s VOC file and
performs an upgrade if any of the first three elements (version number, release number, and patch
number) have changed. SBXA-4876

64-bit version of SBXAMAPIBridge
The SB/XA product CD now provides a 64-bit version of the COM server, named
SBXAMAPIBridge64.exe, for use with the 64-bit version of Microsoft Outlook 2010. The 64-bit version
has its own installer, named SBXAMAPIBridge64.msi. SBXA-4943

Column and row defaults
New fields have been added to the Printer Class Definition form for defining standard and condensed
column and row settings. If Stationery settings are empty, these fields act as a fail-safe to calculate
font size and number of characters to print on the page. SBXA-5036

New features, enhancements, and fixes in SB/XA v6.1.2

The following issues were addressed in this release:

Issue Number Description

SBXA-80 Running CLEAN.SBHSTATE in the XUI clients should have performed the same
function as the Clear Local Cache button, but had no result. With revisions to
version 6.1.2, the CLEAN.SBHSTATE function clears the cache as designed. As a
related change, the XUI.GUI and $XUI.GUI items are no longer transferred from
the SB+.OLD account on an upgrade, leaving only the items that contain the
correct XAML code.

SBXA-154 In the SBDEMO account, Car Rental > Hire Details > F8-Lock displays the Lock
Password dialog box. Due to the type of lock used in this demo, clicking the
Cancel button or pressing the Esc (Escape) key did not close the dialog box. In
version 6.1.2, the demo uses a different type of lock that allows you to cancel or
escape from the Lock Password dialog box.

SBXA-1156 F1 help was not available for XUI Display Defaults in SB Control Parameters (/
SB.PARMS) or for XUI Form Parameters in Screen Definitions (/SD) in versions
6.0.1 and later. F1 help has been added for these parameters in version 6.1.2.

SBXA-1188 In versions 6.0.1 and later, changes to the border_color, border_style or
border_width properties on a GUI form were not shown in the XUI clients. This
issue has been corrected in version 6.1.2.

SBXA-1234 Version 6.1.2 implements support for Graph definitions in the XUI clients.
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SBXA-1632 Several enhancements in version 6.1.2 enable you to call the XUI clients from an
application and pass through a process that runs in the XUI clients.

▪ Use the public static void
ConnectAndExecuteProcess(string application, string
sysid, string processName) method to call the XUI client from the
SBPlusClient API.
You can pass through StartSystemId=SysId and
StartProcess=ProcessName to the XUI client on the command line.

▪ Use the following URL to start SB/XA Browser Client from a web page:

http://localhost/Clients/Browser/SBXAWinFxBrowser.xbap?
StartApplication=[ApplicationName]&StartProcess=[ProcessName]&StartSystemId=[SB/
XA system ID]

▪ Use the following URL to start SB/XA Rich Client from a web page:
SBXAWinFxWindow.application?
StartApplication=[ApplicationName]&StartProcess=[SB/XA
processName]&StartSystemId=[SB/XA system id]

▪ Start an SB process from a shortcut with the following syntax:

C:\Program Files (x86)\Internet Explorer\iexplore.exe http://
localhost/Clients/Rich/SBXAWinFxWindow.application?
StartApplication=[ApplicationName]&StartProcess=[ProcessName]&StartSystemId=[SystemId]

SBXA-1633 If the administrator set up an SB user ID in uppercase in Single Sign-on, and
the user entered the SB user ID in lowercase at login, the user was able to log
in successfully, but the password was not stored. To resolve this problem, SB/
XA Communications Server no longer checks the case when comparing the
operating system user ID to the SB user ID to determine whether to update the
user’s credentials.

SBXA-3090 In previous versions, F3 Help lookups did not work in Group or User Security
Setup in the XUI clients. Pressing F3 in the Group Id Code field on the /
SEC.GROUP.SETUP screen or the User Id Code field on the /SEC.USER.SETUP
screen produced no result. This has been fixed.

SBXA-3442 A new screen called from Group Security Setup (/SEC.GROUP.SETUP) allows
you to define the applications associated with a group. If no applications are
defined for the user in User Security Setup (/SEC.USER.SETUP), applications
in the group record are used. If the group record has no applications defined,
the applications in the parent group record are used. If the parent has no
applications defined, the next level is used, all the way back to the ROOT
group. If the ROOT group has no applications defined, all the records in
DMAPPLICATIONS are used.

SBXA-3609 A ConnectToApplication method has been added to the SBPlusClient API,
supporting the ability to log in as a different user and application. The syntax is
as follows:

SBPlusClient.ConnectToApplication(UserName, Password, ApplicationName);
SBXA-3757 When viewing reports in SB/XA Browser Client, the File menu did not expand to

show options in versions 6.0.4 and later. This issue has been resolved in version
6.1.2, and the File menu expands correctly in the Browser client.

SBXA-3830 A problem with the way @RTN.FLAG passed a change focus command from the
client back to the server has been resolved.

http://localhost/Clients/Rich/SBXAWinFxWindow.application?StartApplication=
http://localhost/Clients/Rich/SBXAWinFxWindow.application?StartApplication=
http://localhost/Clients/Rich/SBXAWinFxWindow.application?StartApplication=


SB/XA v6.1.2 release notes

95

Issue Number Description

SBXA-3915 In an SB+ to DOS file transfer (/PD.LO) process that used option C, the process
created an empty folder named “xxx”. The code has been changed in version
6.1.2 to prevent creating an empty folder.

SBXA-3985 SB/XA 6.1.2 provides a template to help you create a basic theme in Visual
Studio 2010. The template is now included on the SB/XA product CD in
the following path : SBXACD3224\Extra\XAML\themes\Custom Theme
Template. To install the template on your computer, double-click the
SBXAThemeTemplate.vsix file and follow the prompts.

Complete the following steps to create an empty custom SB/XA theme: In Visual
Studio 2010, select File > New > Project. From the list of available templates,
select the SBXA Templates folder and then choose SBXACustomTheme.

SBXA-4132 SB/XA Rich Client and SB/XA Browser Client were subject to performance tuning,
improving their response time in version 6.1.2.

SBXA-4216 In SB/XA 6.1.1 and earlier, there was no version control checking to verify
whether an existing SBXAMAPIBridge component needed to be upgraded. The
TU.MAPI.LOAD routine has been modified to return error codes specifying why a
MAPI load process failed:

▪ MAP.LOGON.FAILURE (10000) - Failed to log in to the MAPI provider.

▪ MAP.NO.MAPI (10013) - MAPI is not set up on the client.

▪ MAP.NO.MAPI.BRIDGE (10014) - The correct version of the SBXAMAPIBridge
component is not registered. This usually means it needs to be installed or
upgraded to a later version.

SBXA-4265 To address a possible security issue, SB passwords passed to and from
subroutines are now encrypted on SB/XA Communications Server before being
sent to SB/XA Application Server. In addition, a login procedure has been
modified to decrypt passwords on SB/XA Application Server.

SBXA-4287 In the controlling multivalue field of a grid, GUI click menus did not work in
GUI or XUI mode. A correction has been implemented in version 6.1.2 so these
menus work as intended.

SBXA-4294 In versions 6.1.0 and 6.1.1, DISP messages showed XAML tags in the display.
Several changes have been implemented in version 6.1.2 to prevent XAML tags
from appearing in DISP messages:

▪ SB Control Parameters (/SB.PARMS) > XUI Parms now contains two XPS tag
fields:
– The Character for XPS Tags field label has been changed to Start Character
for XPS Tags, clarifying that this field defines the start character.
– An End Character for XPS Tags field has been added. If the end character is
not defined, the setting defaults to CHAR(9).

▪ XPS.CLASS and $XPS.CLASS now contain the new end character.

▪ The SB.DIALOG, SB.INTERP.O, SB.RD.RUN, and SB.SETUP.S subroutines have
been changed to use the start and end characters.

SBXA-4298 When adding a new row in the grid on the Orders > Car Maintenance/Service
screen in SBDEMO, one extra blank row was displayed in XUI mode. The fix for
another issue has resolved this problem in version 6.1.2.
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SBXA-4339 When the value of the AutoDownload Images parameter in the System
Control Record (/HK.CONTROL) was blank, SB/XA did not default to the SB
Control Parameters (/SB.PARMS) setting of No or blank. If the parameter in /
HK.CONTROL was blank and the parameter in /SB.PARMS was No, images
were downloaded automatically. After fixes in version 6.1.1, images are auto-
downloaded correctly.

SBXA-4345 The values of check boxes (toggles) in multivalued fields in a grid were not saved
correctly. If you selected all check boxes, cleared one check box, selected that
same check box again, saved the record, and then reopened the record, all
check boxes were cleared. The code has been amended to correct this problem
in version 6.1.2.

SBXA-4363 Version 6.1.2 supports the ability to change icons on submenus of type 5 menus.
SBXA-4366 A problem with missing buttons occurred when working in the Car Rental screen

of SBDEMO in XUI mode. On calling intuitive help from the Rental No field, the
Define Selection Choice screen is displayed. If the user left all fields blank and
pressed the Accept button, an error dialog box was displayed. When the user
clicked Continue in the error dialog box, the Define Selection Choice screen was
redisplayed with the buttons missing. A fix was applied in version 6.1.2, and the
buttons are now displayed as designed.

SBXA-4368 After making changes in the System Control Record (/HK.CONTROL) or SB
Control Parameters (/SB.PARMS) and clicking the Close (X) button, the GUI and
XUI clients did not display a dialog box prompting the user to save changes. A
Save Changes dialog box has been added in both forms in version 6.1.2.

SBXA-4372 If a field label contained an ampersand (&) character, the & character was not
displayed in the field label on screens in the XUI clients. This has been corrected
in version 6.1.2, and the & character is displayed in field labels in XUI mode, the
same as in GUI and character modes.

SBXA-4374 In the Physical Printer Definition screen, clicking the mouse in the Stationery
Types grid in certain circumstances caused the GUI and XUI clients to fail. This
happened if no stationery types were defined for the XPS.CLASS in Printer Class
Definitions and if the Stationery Types grid was empty. In versions 6.1.1 and
later, one stationery type is defined by default, preventing problems when
running a default installation of SB/XA. A fix has also been applied in version
6.1.2 to prevent errors if stationery types are deleted from the printer class
definition and the Stationery Types grid is empty.

SBXA-4389 The SETATTR command did not set the background color of grid cells in the
XUI clients. A code fix resolves this problem in version 6.1.2, and SETATTR now
behaves the same in XUI mode as in GUI mode.

SBXA-4433 In versions 6.1.0 and 6.1.1, it was possible to save and run a DOS to SB+ file
transfer (/PD.LI) or an SB+ to DOS file transfer (/PD.LO) with the target file name
blank. The null value was treated as an actual file name, and file transfer process
locked the record so it could not be accessed from another client session. A code
fix has been applied in version 6.1.2, and an error message is now issued if the
target file name is left blank.

SBXA-4443 When running a DOS to SB+ file transfer (/PD.LI) in GUI or character mode,
the client did not return an error message if the target Local File Name
field contained an invalid path. An error message is now displayed in these
conditions in GUI and character modes, with the same error message text
previously implemented in XUI mode.

SBXA-4445 The tilde (~) character was not displayed in DISP 4 messages within a paragraph
(/PD.P) process in the XUI clients. The code was revised in version 6.1.2, and the
tilde character is now displayed in DISP 4 messages in XUI mode.
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SBXA-4451 In versions 6.1.0 and 6.1.1, changing a setting to an invalid value in the
configuration file caused SB/XA Browser Client or SB/XA Rich Client to fail. If the
configuration file contains an invalid value in version 6.1.2, the local cache and
default values are used instead, and the client returns a warning message.

SBXA-4460 In the Global tab of the SB Control Parameters (/SB.PARMS) form, entering an
invalid number in the Form Defns to Store field produced an ambiguous error
message. The message text has been changed to, “Input must be in range 0 to
9.”

SBXA-4475 When destroying a custom form, if DestroyForm() was called a second time,
the non-custom SB/XA form on the top of the stack was destroyed. With a fix in
version 6.1.2, this problem no longer occurs.

SBXA-4486 The /PF process did not work correctly in XUI mode. In GUI mode, /P prints the
desktop to the default client printer and /PF prints the active form to the default
client printer. In the XUI clients, both /P and /PF printed the desktop to the
default client printer. With a code fix in version 6.1.2, the /PF process prints the
active form in the XUI clients, as designed.

SBXA-4518 A new dialog box has been added to support XPS printing, allowing you to name
a report file to be sent from the XPS Viewer to an e-mail address.

SBXA-4543 The XPS Viewer in version 6.1.2 provides an Export to Text option, giving you the
ability to export a report directly to a text file.

SBXA-4545 In previous versions, the screen capture (/P) process did not work to capture the
active window in the XUI clients. A fix to the /P process enables you to capture
the active window in version 6.1.2.

SBXA-4555 In versions 6.1.0 and 6.1.1, the spelling checker correctly identified misspelled
words in the XUI clients. However, if the user right-clicked a misspelled word,
selected the correct spelling from the list, and pressed F2 to save the record, the
correction was not saved. This issue has been corrected in version 6.1.2.

SBXA-4559 With an enhancement in version 6.1.2, XPS reports retain their format settings
when output to Microsoft Word. If the report is printed in landscape orientation
in the XPS Viewer, it is also formatted in Word in landscape orientation, and the
font is sized to fit the page, the same as in the XPS Viewer.

SBXA-4619 A customer reported data integrity issues arising from a screen with work fields
that used a custom theme and three @REFRESH=-2 settings. When clicking
a hyperlink, the @PARAM value was set to an incorrect value; this resulted in
incorrect data displaying in the customer's application. In version 6.1.2, the
program checks to see if the data sent in a refresh is the same as the data that is
currently in the grid, and if so, the cells in the grid are no longer updated.

SBXA-4620 In the SBDEMO account, compiling a newly created file containing a value mark
(VM) caused the XUI clients to fail. The problem stemmed from an error line
displaying the value mark. To correct this issue, the value mark is now displayed
as a character.

SBXA-4625 Resizing a grid column containing right-justified data in XUI mode truncated the
data. This has been fixed.

SBXA-4647 Depending on the performance of the XUI client, the SB/XA Client Configuration
form sometimes did not open. This issue has been resolved.
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SBXA-4653 In previous versions, the KEEPALIVE function, which prevents client sessions
from terminating, was a hard-coded feature. A new screen for socket options
has been added in SB Control Parameters (/SB.PARMS) in version 6.1.2, allowing
you to set a value for the KEEPALIVE parameter.

The following table describes the available options for setSocketOptions. These
options are case-sensitive.

Option Description

DEBUG Enable/disable recording of debug information.

REUSEADDR Enable/disable the reuse of a location address (default).

KEEPALIVE Enable/disable keeping connections alive.

DONTROUTE Enable/disable routing bypass for outgoing messages.

LINGER Linger on close if data is present.

BROADCAST Enable/disable permission to transmit broadcast
messages.

OOBINLINE Enable/disable reception of out-of-band data in band.

SNDBUF Set buffer size for output; default buffer size is 4 KB.

RCVBUF Set buffer size for input; default buffer size is 4 KB.

The following table describes the status of each return code.

Return Code Status

0 Operation was successful.

Non-zero For the status of each non-zero return code, see “Socket
Function Error Return Codes” in the UniBasic Extensions
or UniVerse BASIC Extensions manual.

SBXA-4654 In versions 6.1.0 and 6.1.1, if the site used a central configuration file defining
multiple connections, the user was prompted to enter the name of the SB/XA
Communications Server, effectively defeating the purpose of centralizing client
configuration. With changes in version 6.1.2, the central configuration file with
multiple connections works as designed.

SBXA-4655 When the central configuration file defined multiple connections, the list of
applications was cached from the first connection. If you chose a connection
to another SB/XA Communications Server, the Connect to Application window
listed the applications for the first connection. The code has been revised
in version 6.1.2, and the client presents the application list for the correct
connection.

SBXA-4665 If a field has custom validation and is defined as a toggle inside of a grid, the XUI
clients did not display the field as a check box in version 6.1.1. This behavior has
been corrected, so the field is displayed as a check box in XUI mode, the same
as in GUI mode. However, be aware that the behavior of a toggle with custom
validation is not identical to that of a toggle without custom validation.

SBXA-4666 Switching between tabs in XUI mode was significantly slower than in GUI mode
in version 6.1.1. Performance tuning in several related areas improves the XUI
client response times for displaying tabs in version 6.1.2.
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SBXA-4669 In multivalued fields that were defined as right-justified numeric (N) input fields,
an extraneous vertical bar was displayed in the text box in XUI mode. Version
6.1.2 contains a fix, and the vertical bar no longer appears in these fields.

SBXA-4687 By design, the F2 button on an output form does not contain a function key
reference so that SB/XA can display “OK” or other text, depending on the
language. As such, it was difficult to apply a style specific to an F2 button on
an output screen. In version 6.1.2, you can use any of four new properties
to define the button: IsHelpButton, IsSaveButton, IsIntuitiveHelpButton, or
IsDeleteButton.

SBXA-4688 If two users were logged in and had a total of five GUI and XUI client sessions
open at the same time, running the /LISTU process returned an unclear
message, “5 SB+ Users Logged In, Max Number of SB+ Users 2.” The first
segment of the message text has been changed so it now reads, “5 SB+
Sessions.”

SBXA-4695 An ampersand (&) character painted on a screen or included in a field label was
not displayed in the XUI clients. A code revision resolves this problem in version
6.1.2.

SBXA-4697 If the Auto Accept Radio Buttons parameter was set to “Remain” in SB Control
Parameters (/SB.PARMS), users were unable to click radio buttons in the XUI
clients. A code fix corrects this behavior in version 6.1.2, and radio buttons can
be clicked when the setting is “Remain.”

SBXA-4702 When running a /WORD.MERGE process in the XUI clients, no message was
displayed if the C:\TEMP directory did not exist, and it looked like the process
had stopped working. In version 6.1.2, if the C:\TEMP directory does not already
exist, a dialog box is displayed, asking if you want to create this directory.

SBXA-4714 In the XUI clients, if a check box was set to True (selected), when you placed
focus on the check box, the check box was cleared (False). When you placed
focus elsewhere, the check box was again selected (True). This behavior has
been corrected in version 6.1.2, and changes in focus no longer affect whether
the check box is displayed as selected or cleared.

SBXA-4718 After setting the Pwd Rollover Date parameter in version 6.1.1, a prompt to
change the password was displayed repeatedly in SB/XA Rich Client. This issue
has been resolved in version 6.1.2.

SBXA-4719 In XUI mode, a changed password was assigned to the wrong user ID under
certain circumstances. If a user logged on with a user ID such as “DEMO,”
changed the password of that user, set the value of New Pwd Next Login to “Y”
or left the field blank, saved changes, restarted the client, logged on again as
the DEMO user, and changed the password for the DEMO user a second time, the
new password became the password of the SB user rather than that of the DEMO
user. The code has been amended to pass the correct SB user name to SB/XA
Communications Server, preventing this problem in version 6.1.2.

SBXA-4737 The Esc (Escape) key did not behave correctly when viewing report output in the
XUI clients. The problem was due to a flaw in the Escape key binding, and has
been corrected in version 6.1.2.

SBXA-4754 The scrolling behavior in multivalued grids has been changed in version 6.1.2 so
that if no data is visible in the grid and the user presses Enter to leave the grid,
the grid scrolls to the first page containing data.
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SBXA-4758 After selecting an item from the main menu when a form is active, pressing the
Esc key more than three times in the form caused SB/XA Browser Client or SB/XA
Rich Client to fail. The code for the XUI clients has been modified to work in the
same way as SBClient. If the user selects an option from the main menu while in
a form, the form is disabled until the user presses Esc to close the menu.

SBXA-4766 In the Change Password (/CHANGE.PWD) window, passwords were not masked
in the XUI clients. This issue has been fixed.

SBXA-4776 When searching in an intuitive help window, the search results in some cases
displayed the correct record for a few seconds, but then returned to a previous
selection. The code has been changed to prevent this problem in version 6.1.2.

SBXA-4796 In User Flags (/USER.FLAGS) running in XUI mode, timeout parameters were
saved incorrectly on a subscreen. In the Define Keyboard Timeout subscreen,
if you entered the password, changed the timeout values by pressing Enter in
every field, and then closed the subscreen, the changes were saved. If you then
pressed F2 on the main User Flags screen to save changes, the changes to the
timeout settings were discarded. In version 6.1.2, an F2 (Save) button has been
added on the timeout subscreen, and the user must click the F2 button or press
the F2 key to save timeout parameters on the subscreen.

SBXA-4800 In the Communications Server Connection window, if the user clicked the Test
Connection button and the test produced an error, pressing the Esc (Escape)
key caused the XUI client to fail. The code has been amended in version 6.1.2, so
pressing Esc closes the error dialog box as designed.

SBXA-4818 A customer requested the ability to cancel a form destroy event as a measure
to prevent the user from closing the form. This functionality can be achieved by
doing the following:

First listen from the SBFormCreated event, and attach a command listener to
the SBCloseWindowCommand.

static void HandleSBFormCreated(object sender, SBFormCreatedEventArgs e)
{
SBPlusClient.LogInformation(string.Format("Form created is {0}.", e.SBObjectName));
((SBForm) e.Form).CommandBindings.Add(_SBWindowCloseCommandBinding);
// to catch all the close events.
}

After catching the command, let SB/XA close the window normally by passing
the command on to SBPlus or by swallowing the command so the window will
not be closed.

static void ExecutedSBWindowCloseCommand(object sender, ExecutedRoutedEventArgs e)
{
if (sender is SBCustomForm)
{ SBCustomForm sbForm = (sender as SBCustomForm); e.Handled = true;
// Add logic here to act on the close
//MessageBox.Show("You cannot close these Windows");
SBPlusClient.DestroyForm(sbForm); }
else
{ SBCommands.SBCloseWindowCommand.Execute(e.Parameter, SBPlus.Current);
}

SBXA-4822 A paragraph that performed field validation did not set
FieldDefinition.HasIntutiveHelp to True. This problem has been corrected.
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SBXA-4825 When configuring Communications Server Connections in the XUI clients,
the client failed if the user attempted to add a connection with the
ReliableSessionPmpt and EndpointSecurityPmpt fields blank. In version 6.1.2,
a change to the configuration code allows you to add a connection with these
fields blank.

SBXA-4829 In the UniVerse for UNIX edition, if the record ID contained a decimal point, data
in the associated field was not displayed correctly in the XUI clients. A change to
the way in which the conversion code is applied prevents this problem in version
6.1.2.

SBXA-4831 On starting SB/XA Browser Client or SB/XA Rich Client, the Connect to
Application dialog box is displayed. If you clicked Options > Communication
Server Configuration in this dialog box, and then clicked Save or Cancel, the
mouse became unresponsive, although the keyboard remained active. This
issue has been resolved in version 6.1.2, so the mouse works as expected and
the session no longer appears to be unresponsive.

SBXA-4833,
SBXA-4896

If a radio button had focus in XUI mode, keystrokes (such as pressing the Tab
key or pressing F2 to save) had no effect until focus was placed in another field.
At that point, the keystroke(s) were replayed and the action performed. This
behavior has been corrected so the client processes keystrokes when a radio
button has focus.

SBXA-4841 When working in a new group record that is a child of the ROOT group, the client
returned a “PARENT RECORD NOT FOUND ON FILE” error. Changes to the group
administration code prevent this problem in version 6.1.2.

SBXA-4843 In the UniData edition, Report Writer reports output to the XPS Viewer echoed
characters to the debug window. A code fix corrects this issue in version 6.1.2.

SBXA-4846 Downloading and caching of theme dynamic link libraries (DLLs) in a multiple-
application environment has been improved in version 6.1.2, as follows:

▪ If a theme DLL is not cached in the global file of the specific application, the
global file of the SB/XA application is checked.

▪ If the item cannot be found, the DLL is downloaded again.
SBXA-4849 In the UniVerse for UNIX edition of version 6.1.1, the Amend Licence Details (/

LICENCE.AMEND) screen contained extra fields that had been removed from
the Windows version of the screen at version 6.0.1. The extra fields have been
removed from the UNIX screen in version 6.1.2, so it now matches the Windows
screen.

SBXA-4851 In the UniVerse edition on Windows, the WORD demo program returned an error
and shut down the client session in the GUI and XUI clients. A fix prevents this
error in version 6.1.2

SBXA-4852 When an input screen with a multivalued grid had at least one tabbed screen,
SETATTR did not work to hide a column in the grid. This issue has been resolved
in version 6.1.2, and the column is hidden as expected.

SBXA-4860 SB/XA error messages from Microsoft .NET did not allow for the scroll bar in
sizing the error window, so the scroll bar partially obscured the message text.
This has been fixed.

SBXA-4861 Running a GETATTR statement on G.DRAWABLE and G.EMPHASIZED objects
returned different values in GUI mode than in XUI mode. If the object was not
found, the GUI client returned a null value, and the XUI client returned a 0. The
GETATTR function has been corrected to return “ ” when the object is not found.

SBXA-4871 The change password (/CHANGE.PWD) process did not validate the password
correctly in version 6.1.1. This has been fixed.
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SBXA-4873 If you have defined only one application, the application is intended to open
automatically at login. However, in version 6.1.1, the Connect to Application
window was displayed, prompting the user to select the application. A code fix
has resolved this problem in version 6.1.2.

SBXA-4876 Previously, an account upgrade was performed only when there was a change in
the first and second elements of the version number. The third element (patch
number) was ignored. As of version 6.1.2, the installation program reads the
first three elements (version number, release number, and patch number) from
the VOC of the application account. If these elements do not match those in
DMCONT, the program performs an upgrade. On installing version 6.1.2 for
the first time, the patch number will not be in the application account, so the
program performs an upgrade. At the end of the upgrade, the version number,
release number, and patch number are written to the application VOC.

SBXA-4894 When using the Ensign option within a selection process called from an F3
Help lookup, the umlaut character in items of the selection list triggered a
Microsoft .NET warning in the GUI and XUI clients. After a fix in version 6.1.2,
F3 lookups are able to correctly display an umlaut character in items of the
selection list.

SBXA-4902 When an output process definition (/PD.O) specified a grid to use in displaying
the screen, the screen was displayed without a grid in GUI mode. This problem
has been resolved in version 6.1.2.

SBXA-4916 If the primary screen with an interleaved grid did not have a numeric suffix and a
secondary screen with an interleaved grid had a numeric suffix, the interleaved
grid on the secondary screen did not display as an interleaved grid. This issue
has been addressed in version 6.1.2, and the interleaved grid now displays on
the secondary screen as designed.

SBXA-4926 If the system-level flag in the System Control Record (/HK.CONTROL) was set to
not use tabfolders in linked screens, the System Control Record and SB Control
Parameters (/SB.PARMS) forms did not have tabs in GUI or XUI mode. In version
6.1.2, these forms display tabs regardless of the setting in the tabfolders flag.

SBXA-4927 If a GUI object name for a button bar definition contained a dollar sign ($)
character, the XUI clients were unable to handle the object name. With a fix
in version 6.1.2, the XUI clients can now manage object names with special
symbols, and the object names no longer cause problems in Microsoft .NET in
XUI mode.

SBXA-4930 Version 6.1.2 fixes a memory leak on tabbed forms in the XUI clients.
SBXA-4940 Performance tuning in version 6.1.2 improves the system response time in

displaying default values for fields in a grid.
SBXA-4942 In GUI mode, Report Writer output to PDF was displayed with oversized, blurry

characters in version 6.1.1. A fix has been applied in version 6.1.2, and the PDF
output is now displayed correctly in the GUI client.
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SBXA-4943 The XUI clients returned an error when users directed output from the XPS
Viewer to e-mail on Microsoft Windows 64-bit operating systems running the 64-
bit version of Microsoft Outlook 2010. This error occurred because the standard
32-bit SBXAMAPIBridge COM server is unable to communicate with the 64-bit
version of Microsoft Outlook 2010.

As a solution, the product now offers a 64-bit version of the COM server, named
SBXAMAPIBridge64.exe, for use with the 64-bit version of Microsoft Outlook
2010. The 64-bit version has its own installer, named SBXAMAPIBridge64.msi.
When SB/XA uses the 64-bit COM server, it can communicate with the 64-bit
version of Microsoft Outlook 2010, and the error no longer occurs.

The 32-bit version of the COM server, named SBXAMAPIBridge.exe, is still
available. The installer for the 32-bit version is named SBXAMAPIBridge.msi.

SBXA-4947 In GUI mode, @OTHER.REC was not reinstated correctly when returning from
another process invoked using a “/” command that also used @OTHER.REC. The
code has been amended to correct this problem in version 6.1.2.

SBXA-4948 After a process or program changed the CNT variable in a multivalued field in
previous 6.x versions, the cursor was not positioned correctly in the grid. The
cursor behavior has been corrected in version 6.1.2 so it again works the same as
in 5.4.x.

SBXA-4949 The syntax @FORM.[tabno]*[fieldName] did not work to set an attribute
in a column of a standard grid on a tabbed form. This code phrase used a
mixture of G-option and standard grid syntax, and the 6.1.1 GUI client was
unable to interpret it. Version 6.1.2 adds support for this syntax to set attributes
in a standard grid.

SBXA-4951 Pressing Enter in rapid succession to advance the cursor through a grid resulted
in keystrokes being stacked and the application becoming unresponsive to
input. The stored keystrokes were then played out after clicking in the cell that
appeared to have focus. A flaw in the grid code has been addressed, preventing
this problem in version 6.1.2.

SBXA-4973 If the primary screen and subscreens were output screens, combo boxes did not
display default values in tabbed subscreens in the XUI clients. After a code fix in
version 6.1.2, the default values are displayed as expected in XUI mode.

SBXA-4976 If you created a new user with a null password, the user was able to log in the
first time, but subsequent login attempts failed. A fix is implemented in version
6.1.2, so the null password continues to work on subsequent logins.

SBXA-4983 G.COORDINATES have been implemented for GETATTR and SETATTR in SB/XA
Browser Client and SB/XA Rich Client. Differences in form sizes and form border
sizes mean that the location of the form in the XUI clients vary slightly from the
position in SBClient for a given set of coordinates.

SBXA-4985 In the XUI clients, typing very rapidly in successive cells in a grid while working
in debug mode sometimes resulted in lost values. A call to a keyboard buffer
routine has been added to correct this problem.

SBXA-4991 Under certain circumstances, function keys executed a menu option rather
than the expected function key process in the XUI clients. This issue has been
resolved in version 6.1.2.

SBXA-5009 Version 6.1.2 implements changes to improve performance when setting a value
in a field in SB/XA Browser Client and SB/XA Rich Client.

SBXA-5026 Documentation of XUIDATA has been added in General Help > Technical
Information > COMMON.
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SBXA-5030 The Socket Timeout parameter pointed to the Char for XPS Tags field in
character mode. In version 6.1.2, the Socket Timeout parameter is mapped to
SB.CONTROL<34,15>, so it points to the correct field in character mode.

SBXA-5032 New fields have been added on the File Characteristics form:

▪ In the UniVerse edition, a Type field defines the file type.

▪ In the UniData edition, Dynamic and Recoverable fields were added.
SBXA-5036 The following fields have been added to the Printer Class Definition in version

6.1.2:

▪ Standard Columns

▪ Standard Rows

▪ Condensed Columns

▪ Condensed Rows

When printing, SB/XA first checks the Stationery settings. If the Stationery
settings are empty, it uses these new fields in the printer class definition to
calculate the font size and the maximum number of characters to print across
the page.

SBXA-5037 In XUI screens created in the Form Painter, if the Border Width property is left
blank, the XUI client uses the default setting of 0, and the screen’s side borders
are displayed as expected. However, after changing the Border Width to 2
and changing it back again to 0, the screen is displayed without side borders.
When you set a Border Width value, the Form Painter has no way to remove the
setting. A forthcoming Tech Note provides a solution for creating a paragraph to
remove the Border Width property from the form definition. After this property
has been removed from the form definition, the side borders are once again
displayed.

SBXA-5038 In screens with multiple tabs that extended beyond the width of the form,
the tabs wrapped to a second row in GUI mode, but the form width increased
to accommodate all tabs on a single row in XUI mode. This issue has been
addressed so the tabs wrap in XUI mode the same as in GUI mode.

SBXA-5039 “Error from the client” messages were reported in the SROC.LOG file when
there were no apparent problems with the XUI client. These messages were
not protocol errors, but part of the normal messaging workflow. However, the
message text was misleading, and these workflow messages are no longer
reported in the log.

SBXA-5047 In previous versions, dialog boxes were centered on the main SB/XA window
(MAINWIN), not on the form to which they relate. The code has been modified in
version 6.1.2 so dialog boxes are now centered over the top form on the stack.
In addition, message dialog boxes are set to display on the same monitor as
the form to which they relate, which may not be on the same monitor as the
MAINWIN.

SBXA-5073 In version 6.1.1, if a screen process contained input-derived fields that used
@OTHER.REC, and the screen called a second screen process that also used the
same functionality, when you pressed F2 (Update process) to return to the first
screen, the common variable @OTHER.REC still contained the values from the
second screen. The code has been amended in version 6.1.2, and @OTHER.REC
is now refreshed from the stack when you press F2.

SBXA-5097 Pressing F3 to do an intuitive help lookup from a paragraph input statement
caused the XUI clients to fail. This issue was due to a column width setting of
"" (null) being interpreted as 0. A code fix prevents this problem in version 6.1.2.
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SBXA-5101 The ConfigurationPath parameter specifies the path of the central configuration
file. This parameter worked correctly on the first use. However, on closing the
XUI client, the CommunicationServerNameUser was saved in the local profile.
The next time the user passed the ConfigurationPath parameter of another
server, the XUI client did not use the data stored in the central configuration file;
it instead used the information stored in the user profile. This problem has been
resolved so the XUI client uses the data stored in the central configuration file.

SBXA-5108 After changing a user’s password and setting the New Passwd Next Login field
to Y in /SEC.USER.SETUP, the next time the user logged in, SB/XA prompted the
user to enter and confirm a new password four times. This issue has been fixed
in version 6.1.2, and the user is prompted only once to enter and confirm a new
password.

SBXA-5114 Query Report Definition (QRD) reports output to the XPS Viewer did not use
a condensed font and were truncated at 110 characters. This issue has been
addressed in version 6.1.2, and QRD now honors the printer class parameters
that control condensed font.

SBXA-5140 On the first time running a DOS to SB+ file transfer (/PD.LI) in GUI mode, the
client encountered an internal “Code 515” error , and an error message dialog
box was displayed. This error did not occur in the same process on subsequent
runs. A fix has been applied in version 6.1.2, preventing the Code 515 error in GUI
mode.

SBXA-5142 The intuitive help handler has been tuned to improve performance in grids in
version 6.1.2.

SBXA-5158 When using SBXAUserNamePassword authentication, if you entered an invalid
user name or password during the login process, the XUI clients returned a
technical error message that was difficult to interpret. This authentication
process has been altered to return a user-friendly error.

SBXA-5168 The SBXA Communications Server component is installed by default to the
following path on computers running Windows Server 2003:

C:\Documents and Settings\Default User\Local Settings\Application Data
\Rocket Software

SBXA-5176 If you call a selection process from a field, you can modify the form position,
size, column widths, and zoom factor. These settings are stored and displayed
the next time you call intuitive help on the field. However, in version 6.1.1, if
the intuitive help called a selection criteria form, the previous settings were not
displayed. The fix for another issue resolved this problem in version 6.1.2.

SBXA-5193 In previous versions, the SB User field in the Single Sign-on screen restricted
the user name to 8 characters. The length of this field has been increased to 20
characters to accommodate longer SB user names.

SBXA-5221 The output of a QRD report was empty if the data contained special characters,
such as the ampersand (&). In version 6.1.2, a subroutine replaces the special
characters in the data, and the report output is displayed without special
characters.

SBXA-5283 The regenerate expressions (/REGEN.EXP) process did not clear the RTN.FLAG
after displaying an “ERROR IN EXPRESSION” message. A fix to the regenerate
expressions corrects this problem in version 6.1.2, and the RTN.FLAG is cleared
after the error as expected.

SBXA-5319 Radio buttons with an ampersand (&) character in the button label and toggles
with a text string including spaces did not behave correctly in the XUI clients.
Both of these problems have been addressed in version 6.1.2.
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SBXA-5334 When connecting to an application, the default theme was downloaded multiple
times. A code fix has been applied, correcting this problem in version 6.1.2.

SBXA-5340 With the Autologin parameter set to 1, if one user on the client computer was set
up for Single Sign-on and another was not, the update password function failed
when the Single Sign-on user attempted to connect to an application for the first
time. The program tried to update the password for the user who was specified
for application connection, not for the Single Sign-on user. This issue has been
resolved.

SBXA-5341 After a process or program changed the CNT variable in a multivalued field in
versions 6.0.2 and later, the cursor was not positioned correctly in the grid. The
cursor behavior has been corrected in version 6.1.2 so it again works the same as
in 6.0.1.

SB/XA v6.1.1 release notes
Build 3118
Release Date: October 2011
These release notes provide information about new features, enhancements, and fixes in SB/XA V6.1.1.

Special instructions

Upgrade Requires Deleting .config File
Due to revamping of endpoints in version 6.1.1, you must delete the SBXAComServer.config file when
performing an upgrade. Ideally, you should delete the .config file before performing an upgrade.
However, you can still delete the .config file after performing an upgrade. For details, see the
description for this issue in the list below. SBXA-4858

What’s new in SB/XA v6.1.1

New Options to Customize the Client-to-Communications Server (WCF) Protocol
A new set of options has been added to the SB/XA Client Configuration form, allowing you to optimize
reliability and security of the client-to-Communications Server connection based on your needs. For
further details, see the description for this enhancement in the list below. SBXA-4299

Option to Forego Reloading Themes and Assemblies
A new parameter has been added to the SB Control Parameters (/SB.PARMS) screen, providing the
option to forego reloading themes and assemblies when logging to a different account. SBXA-4153

Enhancements to XPS Class and Printer Definition
SB/XA 6.1.1 implements a number of enhancements to the XPS class and printer definition. SBXA-4296

PrintTicket Support in XPS Viewer
The XPS Viewer implemented in SB/XA Browser Client and SB/XA Rich Client now supports Microsoft’s
PrintTicket technology.

The PrintTicket settings for the XPS.CLASS define the default print settings for report output directed
to the XPS Viewer. You can override the default PrintTicket settings for the class by specifying different
settings for report process definitions and query report definitions.

For details on defining PrintTicket settings for the XPS.CLASS, see Chapter 4, “Admin Menu,” in
Administering SB/XA.

For details on specifying PrintTicket settings for report process definitions (/PD.R) and query report
definitions (/PD.E), see Chapter 3, “Main Tools,” in the SB/XA Reference. SBXA-3649

Persistence of SBCustomForm Position



SB/XA v6.1.1 release notes

107

The position of SBCustomForm is now saved by default. If this is not the desired behavior, you can set
the IsAutoPositionEnabled property to False. SBXA-4322

Security Error Message Clarified
The generic “ACCESS DENIED” message, triggered by three different error conditions in the security
API, has been replaced with more descriptive messages. SBXA-4382

Performance Improvements
Version 6.1.1 contains enhancements to improve performance in two areas:

▪ Output of large QRD reports to the XPS Viewer. SBXA-4517

▪ Resource lookups and ease of working with resources when developing custom themes. SBXA-4531

Persistence of Changes to Intuitive Help Window
With the D (Default) option for Intuitive Help Display, changes to the intuitive help window size and
position are remembered in the next session. SBXA-4684

New Features, enhancements, and fixes in SB/XA v6.1.1

The following issues were addressed in this release:

Issue Number Description

SBXA-390,
SBXA-3434

SBClient honors the AUTOLOGOUT flag set in the U2 data server, and the client
is logged off automatically after the specified period of inactivity. However, due
to differences in the architecture of SB/XA, the AUTOLOGOUT flag in UniData or
UniVerse has no effect on SB/XA Browser Client or SB/XA Rich Client.

The following enhancements have been made in version 6.1.1 to implement
autologout functionality in the XUI clients:

▪ A new field, AUTOLOGOUT Time, has been added in Group Security Setup
(/SEC.GROUP.SETUP) for XUI only. This field allows you to set the number
of minutes of inactivity that triggers autologout. If there is no interaction
between SB/XA Application Server and the XUI client within this time, the
client is logged off automatically. If the time-out value is 0, no time-out is set
and the autologout feature is disabled.
The time-out value is stored in the common variable XUIDATA<4,1>. If the
time-out value is greater than 0, the autologout enablement parameter
stored in XUIDATA<4,2> is set to a value of 1 (true, enabled).

▪ For long-running client processes, the autologout feature
can be disabled from the XUI clients by setting the property
SBPlusClient.Current.KeepConnectionAlive = true. This flag has a Boolean
value, either true or false.

▪ If a server process needs to disable the autologout feature, it can change the
common variable @XUIDATA<5,2>. A setting of 0 disables autologout, and a
setting of 1 enables it.

SBXA-686 After using /MP to modify an execute UNIX command process (/PD.LUX), the
process was saved to xxPROCESS with an incorrect type, and a blank message
was displayed. The code has been amended to prevent this problem in version
6.1.1.

SBXA-848 When running an S:SSELECT statement to select a specified record ID, option P
did not display a message if the specified record ID existed, but the multivalued
field contained no values. This issue has been resolved so option P displays a
message under these conditions.
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SBXA-1613 In the UniData edition, if SB.CONTROL <30,18> is set to show the long name
in the locked record message, the message displayed the long name of the
current user, rather than the user who locked the record. A fix has been applied
in version 6.1.1, and the message now displays the correct user name.

SBXA-1629 In previous versions, the /LISTU process did not report active XUI sessions. This
has been fixed.

SBXA-1681 SA.TRANSFER.SBPLUS did not work properly to transfer DMLANGUAGE.XX
files. The file transfer process has been revised in version 6.1.1, and the
DMLANGUAGE.XX files are transferred as expected in all editions.

SBXA-3380 A /PD.LX process was unable to execute a DOS command in XUI mode. This issue
has been resolved.

SBXA-3391 In the UniVerse edition on AIX, it was sometimes necessary to double-click a
radio button to register focus on it. A change to the order in which processes are
executed resolves this problem in version 6.1.1, so single-clicking a radio button
changes the focus to that element.

SBXA-3556 If the terminal ID was empty for each user in User Security Setup (/
SEC.USER.SETUP), the default terminal emulation in Admin > Printers and
Terminals > Port Configuration was not inherited at the user level. As a result,
the user was prompted to enter a terminal ID at logon. The code has been
revised in version 6.1.1 so that in this situation the user is not prompted to enter
a terminal ID at logon.

SBXA-3649 The XPS Viewer implemented in SB/XA Browser Client and SB/XA Rich Client
supports Microsoft’s PrintTicket technology. A PrintTicket tab has been added
to the Printer Class Definition (/PRINTER.CLASS) form, enabling you to define
the print settings for XPS.CLASS. These settings apply to Report Writer, QRD,
and TU.SEND.TO.PRINTER output directed to the XPS Viewer. You can override
PrintTicket settings in either /PD.R or /PD.E.

SBXA-3675 Some examples in SBDEMO expect a TEMP folder in $SBTUPATH. In previous
versions, the GUI or XUI client returned an error if the TEMP folder did not exist
in $SBTUPATH. The server code has been revised in version 6.1.1 so that if the
TEMP folder does not exist, it is created.

SBXA-3823 In the XUI clients, the /DEBUG process did not display the content of the
common variable in the status line. Consequently, /DEBUG could not be used to
debug applications in XUI mode. This issue has been corrected in version 6.1.1.

SBXA-3910 In SB/XA Browser Client or SB/XA Rich Client, if the user entered a nonexistent
process name in /PD.LO and then pressed F8, a fatal error occurred. On clicking
the OK button to dismiss the error message, the XUI client closed. With a code fix
in version 6.1.1, this condition triggers a less severe error, and after dismissing
the error message the user can continue working in the session.

SBXA-4027 The /CHANGE.PWD process did not work properly in character mode. After
changing the password in character mode, validation of the new password
failed at the next logon. This issue has been resolved in version 6.1.1.
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SBXA-4028 The default password validation routine failed to enforce the rule that the user
cannot reuse any of the previous ten passwords. This has been fixed.

The validation routine that checks for a null password is working as designed,
but the U2 Developer Zone article “How to Deploy SB+ Password Validation” did
not clearly state the conditions under which this check is performed:

▪ The null password check is performed for non-ROOT group members only.
A null password is not allowed for non-ROOT users.

▪ The null password check is not performed for ROOT group members.
A null password is allowed for ROOT users.

SBXA-4050 In previous versions, TU.LAUNCH.APP was looking for a key in the Registry that
is no longer there. This subroutine has been changed so it does not look for a
nonexistent key.

SBXA-4060 When loading a form in XUI mode, the message “Downloading GUI parameters”
was not cleared from the status line after the form finished loading. With a fix in
version 6.1.1, the message is cleared from the status line as expected.

SBXA-4092 Type 3 (painted) menus are not supported in XUI mode. This is a permanent
restriction; there is no plan to add support for this functionality in the future.
However, in version 6.1.0, the XUI client failed if the application attempted
to display a Type 3 menu. This has been addressed in version 6.1.1, so a “Not
Implemented” message is displayed when a Type 3 menu is encountered, and
after dismissing the error message, the user can continue working in the client
window.

SBXA-4106 The screen editor (/SE) did not honor the setting of the RTN.FLAG in a /PD.P if
the Process Before SE Read or Process Before SE Write slot was set in the System
Control Record (/HK.CONTROL). This issue has been resolved.

SBXA-4151 With terminal emulation set to Wyse 50, SBClient displays the Esc (escape)
characters as a black box. The escape character should be displayed in the same
color as the background color definition. This has been fixed in version 6.1.1.

SBXA-4153 A new parameter, “Reload theme on Logto,” has been added to the SB Control
Parameters (/SB.PARMS) screen. With the value set to "N," assemblies and
themes are not reloaded on logging to a different account if the theme type and
assembly versions are the same.

SBXA-4209 When an account name or system description (/HK.CONTROL) included an
underscore character, the underscore was not displayed correctly in the
UniVerse edition on UNIX in the XUI clients. Rather than displaying as a separate
character, the underscore was placed under the next character. A fix corrects
this problem in version 6.1.1.

SBXA-4213 In the UniData edition on Windows, if you create an account (/
CREATE.ACCOUNT) in GUI mode. In previous versions, an extra backslash was
added at the beginning of the path in the Full Account Path name, and it was
necessary to delete the backslash before saving the new account. This issue has
been resolved, and an extra backslash is no longer added to the Full Account
Path.

SBXA-4239 For field definitions (/FD) with a conversion code such as OCONV in the F5 >
F6 conversion process slot, an incorrect value was displayed if the REFRESH
parameter was set to a value of 2 or -2. The code has been corrected to display
the correct value in all modes.
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SBXA-4262,
SBXA-4725

With focus on a combo box in the controlling multivalued field in XUI mode,
“\” did not delete the selected row. Any invalid data in the combo box deleted
the row, and selecting an item from the combo box did not place focus on the
next field. These and other related problems with combo box controls were
addressed in version 6.1.1, correcting unpredictable behaviors of combo boxes
in XUI mode.

SBXA-4296 Several enhancements to the XPS class and printer definition have been
implemented in SB/XA 6.1.1:

▪ The XPS.CLASS and XPS.PRINTER definitions shipped with the product
now define a default XPS Printer, so users are no longer required to select a
printer when printing to screen.

▪ The XPS.CLASS and XPS.PRINTER definitions now contain four predefined
stationery types:

LETTER
LETTERLAND
A4

A4LAND

▪ The XPS.CLASS and XPS.PRINTER definitions are always overwritten on an
upgrade.

▪ If page height and width are not defined for XPS printing, an error is
displayed and the output is not printed to the screen.

▪ If the character for XPS tags is not specified, the default of CHAR(8) is used.
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SBXA-4299 On the SB/XA Client Configuration form, a new set of Communications
Server Connections options have been added, allowing you to select resilient/
encrypted/non-encrypted sessions or enable/disable Windows Communication
Foundation (WCF) reliability options.  

▪ The Security drop-down list contains three options.  Not all options are
available for all connection types (see table below).

▫ Message – This option ensures a resilient and secure connection that
survives temporary disconnection from the network (for example, when
switching from LAN to wireless operation, where the client IP address
may change). This option incurs the largest overhead, with a packet size
approximately 10 times greater than that with the Transport security
option.

▫ Transport – This option ensures a connection that is confidential by
encrypting with the AES-256 algorithm to prevent intermediaries from
tampering with it. This option incurs approximately 10 percent greater
overhead than the non-encrypted packet.

▫ None – With this option, packets are not encrypted and the overhead is
about the same as the SBClient-SBXA protocol.

▪ The Reliable check box enables an additional guaranteed layer on top of the
TCP-guaranteed transport options. When using Transport-level security, this
option adds about 20 percent overhead to the packet size.

Connection Type Reliable Security Certificate
Windows True or

False
Message/Transport N/A - Part of

Windows security
WindowUserNamePassword True or

False
Message/Transport Required

SBXAUserNamePassword True or
False

Message*/Transport*/None *Required

The default settings are Connection Type = Windows, Reliable = True, and
Security = Message.

* When using SBXAUserNamePassword connection with Message or Transport
security, the cross-domain Windows credentials must be supplied by using the
Windows Credential Manager. If you do not set up these credentials first, the
connection fails and the user is not presented a logon prompt.
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SBXA-4301 Although it is not possible to place a field to the left or above the visible portion
of a form in the GUI Form Painter, the coordinates can be set by entering them
manually. In previous versions, when a control was outside the boundary of
a form, scroll bars were added automatically and parts of the form were not
visible at its default size in the XUI clients.

This issue has been addressed in version 6.1.1 as follows:

▪ If a control has a left (X) coordinate that is greater than the length of the form
or a top (Y) coordinate that is greater than the depth of the form, the Visibility
property of the control is set to Collapsed, and the form is displayed without
scroll bars at its default size in XUI mode.

▪ The GUI-to-XUI form conversion routine no longer reduces size of the GUI
form when generating the XUI form. Therefore, XUI forms are larger by
default, and this may cause scroll bars to be added automatically. The
solution is to change the zoom level. You can do this in any of several ways:
▪ by changing the default zoom factor in the centralized client

configuration file, or

▪ by changing the default zoom factor at the user level in the SB/XA Client
Configuration form, or

▪ by using the slider tool at the bottom of the main window in SB/XA
Browser Client or SB/XA Rich Client.

SBXA-4310 If the user pressed F4 to delete a record in a combo box on an input field in XUI
mode, the client did not display a confirmation dialog box. The confirmation
is now displayed in XUI mode, making the behavior the same as in GUI and
character modes.

SBXA-4314 If the owner of a custom child form was set as the SBWindow of a standard (non-
custom) form, the child form was not minimized as expected after minimizing
the main window in XUI mode. A code fix corrects this problem in version 6.1.1,
and the child form is minimized along with the main window.

SBXA-4322 As an enhancement, SBCustomForm has been changed to save its position
and reopen in the same location by default. If this is not the desired behavior,
the IsAutoPositionEnabled property can be set to False. The custom control
example project has been updated to reflect these changes.

SBXA-4326 In a /PD.P, SETATTR did not work properly to deemphasize a Toggle GUI object
in the XUI clients. This issue has been resolved in version 6.1.1, and Toggle
objects are deemphasized as expected.

SBXA-4347 After upgrading from version 5.x to 6.x, multiline grid headers displayed
“_char10_” instead of the value assigned to CHAR(10). The upgrade process has
been amended to correct this header issue.

SBXA-4377 When a function key in a screen definition (/SD) does not have an associated
process, the function key should be shown as grayed out (unavailable). In
previous versions, function keys without a process were grayed out as designed
in GUI mode, but not in XUI mode. This behavior has been corrected in the XUI
clients in version 6.1.1 .

SBXA-4382 The generic “ACCESS DENIED” message triggered by three different error
conditions in the security API has been replaced with more descriptive
messages:

▪ ONLY ROOT GROUP MEMBERS CAN CHANGE OWN RECORD

▪ PARENT GROUP IS NULL

▪ CURRENT GROUP IS NOT ROOT
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SBXA-4383 When editing a dictionary file in the text editor (/SE), the program prompts
the user for a record ID. In previous versions, if the user pressed F3 to display a
selection list of record IDs, the list was populated with data from the associated
data file. This issue has been corrected so the selection list is populated with
record IDs from the dictionary file, as expected.

SBXA-4394 The XUI clients behaved differently than SBClient on enforcing case sensitivity
of the user ID at logon. For example, if the user ID was defined in uppercase and
the user entered it in lowercase at the logon prompt, SBClient allowed the user
to log on, but SB/XA Browser Client and SB/XA Rich Client did not. The logon
program been changed in the XUI clients so the user ID field is no longer case-
sensitive in version 6.1.1.

SBXA-4398 Query report definition (QRD) output to the XPS Viewer was blank in the
UniVerse edition on UNIX. The cause of the problem was that SB/XA Browser
Client and SB/XA Rich Client do not set the terminal type during logon. When the
terminal type has not been set, the QRD output of Universe on UNIX is different
that of Universe on Windows. To prevent potential problems in all editions, if the
terminal type has not been set, a subroutine now sets the terminal type to VT220
before running the SORT command.

SBXA-4409 In XUI mode, buttons in dialog boxes were sized individually according to the
length of text in each button. This behavior was inconsistent with that in GUI
and Character modes, where buttons are sized uniformly based on the greatest
length of text in any button. In version 6.1.1, an enhancement to the XUI clients
makes button sizing consistent with other modes.

SBXA-4430 When running the TU.TO.EXCEL subroutine in the XUI client, a customer
experienced data loss during the transfer of records to Microsoft Excel. A fix
to the code that resizes the conversion buffer in the client prevents data loss
during a TU.TO.EXCEL transfer in version 6.1.1.

SBXA-4432 In the UniVerse edition on UNIX, the Physical Printer Definition (/
PHYSICAL.PRINTER) process displayed the Windows version of the form, with
prompts for Windows-specific settings. This issue has been corrected so the
UNIX version of the Physical Printer Definition form is displayed on UNIX systems
in XUI mode.

SBXA-4434 In versions 6.1.0 and 6.0.5, fields were skipped when navigating with arrow keys
in linked screens in XUI mode. A code fix resolves this problem in version 6.1.1.

SBXA-4444 The C option did not work when used with other options in /PD.LO. This issue
has been resolved in version 6.1.1, so the C option works properly alone or with
other options.

SBXA-4452 In input processes (/PD.I) with an option O (output) screen, the user was unable
to establish focus by clicking the mouse in a grid in XUI mode. Consequently, the
user was also unable to set the common variable @CNT and call another screen
using a value from the grid. A code fix corrects these grid issues in version 6.1.1.

SBXA-4453 In screen definitions (/SD) containing a CIADE grid, the user was unable to
establish focus by clicking the mouse in the grid in the XUI clients, and therefore
was unable to set the common variable @CNT and call another screen using a
value from the grid. The code has been amended to prevent these problems in
version 6.1.1.

SBXA-4464 When tabbing through fields on the SB Control Parameters screen, the focus
was placed on fields out of order. The tab order of fields on this screen has been
corrected in the current version.
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SBXA-4470 The system failed on opening terminal settings screens from either of the
following processes:

▪ /TERM (Admin > System House Keeping > Port Setup > Your Terminal
Settings), or

▪ /SET.TERM (Admin > System House Keeping > Port Setup > System Default
Term Def)

The code has been amended in version 6.1.1 so terminal settings screens open
without causing system failure.

SBXA-4476 When a user set a language code in User Security Setup and ran a process in GUI
mode, the following error was displayed:

“Couldn't create labelclass object W.QSHP1. Object Name already in use.
405,SBWIN_96_2*43*7”

The display then switched from GUI mode to character mode.

This error occurred because the GOPTIONUSED flag was not being set for multi-
language, which caused a problem with a subroutine. In addition, the number
of interleaved lines specified by the AMD.FLAG was not honored. Both of these
problems have been addressed, so this error no longer occurs in version 6.1.1.

SBXA-4478 In XUI mode, QRD output to screen was presented in the Debug window if the
Select List Name was specified in the Query Report Definition. This issue has
been resolved, and QRD output is displayed in the XPS Viewer, as expected.

SBXA-4484 During an upgrade from a previous version, the process returned the following
error after running SA.TRANSFER.SBPLUS:

“Program ‘SB.DISP’: Line 488, Nonnumeric data when numeric required. Zero
used.”

The upgrade process has been amended, preventing this error in version 6.1.1.
SBXA-4487 In a tabbed form, pressing F2 in the second tabbed page did not save and close

the form in the XUI client. Instead, it left the form visible and displayed the
menu. With a correction in version 6.1.1, F2 properly saves and closes the form.

SBXA-4490 The XUI client failed if a screen process was called from a type 1 menu that was
called from a tabbed screen. A fix prevents this problem in version 6.1.1.

SBXA-4498 The keyboard shortcut “\” + Enter did not work to clear the field in the XUI
clients. The code has been amended so this key sequence clears the field as
expected in XUI mode.

SBXA-4504 In process definitions, using SETATTR to disable @MAINWIN menus
did not work in the XUI clients. A fix was applied in version 6.1.1 so the
phraseSETATTR(@MAINWIN,"menu_disabled",1) now works properly to
disable menus in the main window in XUI mode.

SBXA-4512 TU.SCRIPT.CREATE worked properly in GUI mode, but not in XUI mode. This
issue has been fixed.

SBXA-4517 In version 6.1.0, output of large QRD reports to the XPS Viewer was slow. The
code has been revised to improve performance of QRD output to screen in
version 6.1.1.

SBXA-4521 Setting the Conversion Source flag to G in the System Control Record (/
HK.CONTROL) or in the SB Control Parameters (/SB.PARMS) screen caused
corruption of generated pre-select screens. This problem no longer occurs in
version 6.1.1.



SB/XA v6.1.1 release notes

115

Issue Number Description

SBXA-4531 Version 6.1.1 improves performance of resource lookups in SB/XA and makes
it easier to work with resources when developing custom themes. These
improvements were accomplished by flattening resources for resource lookup,
removing unused resources, and reorganizing resources as needed.

SBXA-4532 DISP 4 did not work as expected to disable MainWin menus and toolbars in the
XUI clients. The code was revised in version 6.1.1 to disable both menus and
toolbars in the main window in XUI mode.

SBXA-4535 In the UniVerse edition on UNIX, record locks did not display the user name in
lock messages in XUI mode. As a related problem, long PIDs were not supported
on UNIX systems. Both of these issues have been resolved in version 6.1.1.

SBXA-4544 The default font is different on various platforms, and variations in the run-
time font pose a form control issue for screen developers. Previously, SB/XA did
not offer a way to set the default font for an application running in XUI mode.
In version 6.1.1, three new properties have been added for this purpose to the
SBPlus class: DefaultFontFamily, DefaultFontSize, and DefaultFontWeight. If the
DefaultFontFamily property is set to null (the default), the font falls back to the
system desktop font.

SBXA-4548 Running the generate source code (/GC) process to compile a Report Writer
report caused an error. A code fix prevents this problem in version 6.1.1.

SBXA-4552 When an account was moved to the “Accounts with restrictions” list in Group
Security Setup (/SEC.GROUP.SETUP) and the user added an option to the
SBSYSMENU, the new option was not displayed on the menu at logon. This issue
has been corrected, and newly added options are displayed on the menu at the
next logon.

SBXA-4560 In selection process definitions (/PD.S), using the W and H options together
corrupted the selection process headings. This issue has been fixed in version
6.1.1.

SBXA-4563 If the Autologin flag was not set to Y in /SB.PARMS, and the default terminal was
set to GUI in /TERM.CONFIG , and no terminals were defined for the user, the
logon screen was not displayed in GUI mode. After changes to correct this issue,
the logon screen is displayed in GUI mode, as designed.

SBXA-4567 When using centralized client configuration, deploying SB/XA Browser Client or
SB/XA Rich Client with an SBXAConfiguration.xml file did not work properly. The
user clicked the .application file in the central location to start the XUI client,
and the SB/XA Communications Server host name was populated, but the SB/
XA Communications Server Connection window appeared behind the Connect
to Application window, and the user was unable to connect. With a fix in version
6.1.1, centralized client configuration works as documented and the user is able
to connect to an application.

SBXA-4580 In version 6.1.0, AutoComplete combo boxes were not refreshed in tabbed forms
in the XUI clients. This issue has been fixed in version 6.1.1.

SBXA-4581 When QRD output was directed to the XPS printer with a landscape stationery
setting, the output was displayed in portrait page orientation. A code fix corrects
this issue so the output is displayed properly in landscape orientation.

SBXA-4589 In forms created in the GUI Form Painter, radio button labels displayed an
ampersand (&) before the keyboard shortcut character for the label, such as
“b&lue”. Note that keyboard shortcuts are not supported in radio buttons. This
issue has been fixed in version 6.1.1, so if the button label is defined with an
ampersand in the GUI Form Painter, the ampersand character is not displayed in
the button label on the form at run time.



SB/XA v6

116

Issue Number Description

SBXA-4624 This issue covers improvements to security in copying a user record to create a
new user record.

SBXA-4629 In GUI mode, a derived field did not display its value in an Output type screen
if the G (Non-grid) option was enabled on the process or in /HK.CONTROL. A fix
resolves this problem in version 6.1.1.

SBXA-4630 On executing @REFRESH=-2 in a Process After slot in a multivalued field, the
values in derived fields that use the G option were cleared. After a correction
to the code, the process works as designed and the derived fields are no longer
cleared.

SBXA-4636 In some selection processes, when the user pressed F3 in a grid cell, focus left
the grid and there was no way to return focus to the grid. A fix corrects this
problem in version 6.1.1.

SBXA-4637 The “Close Form” ToolTip on the Close button was not translatable. With
changes made in version 6.1.1, the ToolTip text can be translated.

SBXA-4638 The language translation file for German, de-CH, was not included in the
RichClient folder on the product CD image. The file now resides in this folder in
version 6.1.1.

SBXA-4643 When a selection process (/PD.S) contains a single field that is right-justified,
the display fills up all of the space in the main window in GUI mode. In the same
circumstances, the display was centered in the main window in XUI mode. This
was due to a difference in the minimum width of grid displays between GUI and
XUI modes. The code has been revised to adjust the minimum width of grids in
XUI mode, so the display closely resembles that in GUI mode.

SBXA-4644 When executing a screen containing a multivalued field that was set to N (Non-
updatable), the hourglass appeared and no further input was allowed. A fix has
been applied in version 6.1.1, and this function is now working properly.

SBXA-4648 If the user changed the size and positioning of a selection process (/PD.S)
window, these changes did not persist to the next session. In version 6.1.1, if
the Intuitive Help Display parameter in /USER.FLAGS > GUI User Preferences
is set to D (Default), the size and positioning of selection process windows are
remembered.

SBXA-4651 Using GETATTR in a paragraph process (/PD.P) to get the title of the MainWin
resulted in an error message in the XUI clients. The code has been amended and
the error no longer occurs in version 6.1.1.

SBXA-4652 In selection processes (/PD.S), grids displayed fewer rows by default in XUI
mode than in GUI mode. The developer can now control the depth of a selection
process grid in XUI mode by setting the Depth element in the Window Co-Ords
field in /PD.S.

SBXA-4656 Resolved a problem with switching from Windows authentication to
SBXAUserNamePassword authentication.

SBXA-4660 In a tabbed screen, if the user entered a record key in the first tab, pressed Enter
to read in the record, and then clicked the second tab to open it, the record key
was missing from the second tabbed page. This issue has been fixed.

SBXA-4668,
SBXA-4821

Various keyboard buffering issues have been addressed to prevent unexpected
behaviors in version 6.1.1.
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SBXA-4677,
SBXA-4722

A problem occurred when using two monitors if Center GUI Screens was
set to “No” in User Flags (/USER.FLAGS) > F6-GUI Prefs, so form position is
remembered. If the user opened a form on the second monitor, closed the
form, disabled display on the second monitor via Screen resolution, and then
reopened the form, the form was displayed outside the visible bounds of the
main monitor. The code has been amended so that if the user disables the
second monitor in this situation, forms are displayed on the main monitor.

SBXA-4679 Previously, the width of XUI screens was based on the width of the screen title,
while in GUI mode this was not a factor. In version 6.1.1, the width of XUI screens
is no longer determined by the width of the screen title, so XUI screens look
similar to their GUI counterparts.

SBXA-4684 The Intuitive Help Display setting in /USER.FLAGS > GUI User Preferences
controls the position of the intuitive help window. In previous versions, the
XUI clients disregarded this setting, and the intuitive help window sometimes
appeared partially off the monitor. SB/XA Browser Client and SB/XA Rich Client
now honor the GUI setting. As an enhancement, if the user chooses the D
(Default) option for Intuitive Help Display, changes to the intuitive help window
size and position persist in the next session.

SBXA-4700 This issue adressed two problems with WORD.MERGE in DEMOBP:

▪ When running the program WORD.MERGE in DEMOBP, the first file was
downloaded to the PC, but the second file was not. The program stopped
responding between the first download and the second download.

▪ The dictionary item for COLOUR in CARS could not be listed. LIST CARS
COLOUR did not work.

Both problems have been resolved in version 6.1.1.
SBXA-4732 In the XUI clients, if the /HTML process was called with a nonexistent directory,

the client failed. This issue has been resolved in version 6.1.1.
SBXA-4753 When a Smart Query was imported to QRD, an error occurred and the report

was not created if QRD encountered an invalid character. The code has been
changed so QRD replaces invalid characters with an underscore. After replacing
invalid characters, if the first character of the key would then be an underscore
(such as “_ABC”), the key is constructed of the characters that follow the
underscore (“ABC”).

SBXA-4828 If the G.DRAWABLE property was set to 0 (hidden) on the field after a G-option
grid, the XUI client failed when attempting to leave the grid. With a correction in
version 6.1.1, a hidden field after a G-option grid no longer causes this problem.

SBXA-4838 When executing an input screen containing a button object with an in-line
expression in the XUI clients, the client returned an error, “Line 1 - error in
expression.” The code has been fixed to prevent this error in version 6.1.1.
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SBXA-4858 The XUI clients report an error and fail to connect if SB/XA Communications
Server has been upgraded or reinstalled on a machine on which any version
prior to 6.1.1 GA was installed, including pre-release builds or beta versions. This
is because SB/XA Communications Server uses the configuration from the older
version, which does not include endpoint information.

This issue will be resolved by a code fix in version 6.1.2. Until then, perform the
following steps as a workaround:

1. Close SB/XA Browser Client or SB/XA Rich Client.
2. From Start > Control Panel > Administrative Tools > Services, stop the

SB/XA Communications Server service.
3. Delete the SB/XA Communications Server configuration file, named

SBXAComServer.config. The location of this file depends on the operating
system:
Windows 7
C:\Windows\System32\config\systemprofile\AppData\Local\Rocket
Software\SBXAComServer.config
Windows XP/2003
C:\Documents and Settings\LocalService\Local Settings\Application Data
\Rocket Software\SBXAComServer.config
or
C:\Windows\system32\config\systemprofile\Local Settings\Application
Data\Vendor\Rocket Software\SBXAComServer.config
or
C:\Documents and Settings\Default User\Local Settings\Application Data
\Rocket Software\SBXAComServer.config

4. Restart the SB/XA Communications Server service so deletion of the .config
file takes effect. A new .config file with the required endpoint information is
created automatically when the service restarts.

SB/XA v6.0.5 release notes
Build 2501
Release Date: January 2011
These release notes provide information about fixes in SB/XA v6.0.5.

Fixes in SB/XA v6.0.5

The following issues were addressed in this release:

Issue Number Description

SBXA-1645 Form Feed Missing from Reports Printed from XUI Clients

In versions 6.0.2 and later, CHAR(12) (the form feed) was missing from reports
printed to a system printer from SB/XA Browser Client and SB/XA Rich Client on
UniData. This issue has been resolved in version 6.0.5.

SBXA-3847 Issue with Toggles Is Resolved

Toggle controls did not work properly in version 6.0.4. If the user changed a
toggle setting, the new setting was not saved. For example, if the user cleared
a check box, saved the record, and opened the same record again, the check
box displayed a check mark even though it had been cleared. A fix corrects this
problem in version 6.0.5, and toggles now work as designed.
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Issue Number Description

SBXA-3857 Corrections to /REGEN.EXP

In version 6.0.4, the /REGEN.EXP process produced errors when regenerating
expressions for certain files in the SBDEMO and SB accounts. The application
code for the /REGEN.EXP process has been amended, preventing these errors in
version 6.0.5.

SB/XA v6.0.4 release notes
Build 2422
Release Date: December 2010
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.0.4.

What's new in SB/XA v6.0.4

Increase in number of driver steps per screen
The limit on the number of driver steps per screen has been increased from 700 to 1400. This
enhancement allows for more fields in a set of linked or tabbed screens. SBXA-813

New process to generate XUI forms
Version 6.0.4 implements a new process named REGEN.XUI to generate XUI forms. This process
performs a similar function as the /REGEN.GUI process, but for XUI forms. SBXA-1689

Keyboard buffer fixed
Problems with the keyboard buffer in the XUI clients have been fixed. SBXA-2095

New process to clear drivers
A new process named CLEAR.DRIVERS has been added in version 6.0.4, enabling users to clear the
xxDRIVERS for the current system. SBXA-2528

Option to regenerate only data files
An enhancement to the regenerate expressions process (/REGEN.EXP) allows you to regenerate only
data files and not the xxDEFN and xxPROCESS files. SBXA-3526

Enhancements and fixes in SB/XA v6.0.4

The following issues were addressed in this release:

Issue Number Description

SBXA-41 Process After Grid Display Removed from Non-Output Screens

The Process After Grid Display slot is relevant only to output screens (in /PD.O >
F5 - GUI Parameters), but it was implemented in /PD.I input screens, /PD.H shell
wrapper processes and /PD.T transaction processes in previous versions. This
slot has been removed from all screens except /PD.O output screens.

SBXA-57 Style Edits in GUI Form Painter Carry through to XUI Mode

In version 6.0.1 or later, if you removed a XAML style from a button in the GUI
Form Painter (/SD), saved changes, and then ran the form in XUI mode, the
button was displayed in the original style in the XUI form. With a correction in
version 6.0.4, changes to styles in GUI mode are also applied in XUI mode.
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Issue Number Description

SBXA-159 Fix to Prevent Looping Password Prompt in XUI Clients

In versions 6.0.2 and 6.0.3, if the Autologin flag was set to 0 or 2 and New Pwd
Next Login was set to Y in the user security record, the prompt to enter a new
password was displayed repeatedly when the user attempted to log on to SB/
XA in the XUI clients. A fix in version 6.0.4 resets the password, preventing the
looping prompt in XUI mode.

SBXA-161 Restrictions Now Apply to F3 List of Available Printers

If available printers were defined for a user in User Security Setup (/
SEC.USER.SETUP > F7-Term/Prnt) and the user pressed F3 to see a list of
available printers when logging on in GUI or XUI mode, the F3 display list was not
limited to include only those printers defined for the user. In version 6.0.4, the F3
list is limited to the printers that have been defined for the user in User Security
Setup.

SBXA-166 New Slot for Styling a Dialog Box

SB/XA versions 6.0.3 and earlier did not provide a means to style a single dialog
box. At version 6.0.4, a slot for the XAML style name has been added to the
DIALOG.DEFN screen.

SBXA-168 Failed Logon through Remote Process Returns License Information to UO

When a user attempts to connect to SB/XA through UniObjects (UO) using a
remote process, the logon fails if there is an insufficient number of licenses
available for the remote process. SB/XA did not return information to the UO
session to indicate that logon was denied because there were not enough
licenses available. With an enhancement in version 6.0.4, SB/XA returns this
information for all types of remote process connections.

SBXA-169 Phrases in Selection Process Now Return Correct Fields

If you created two phrases, each to display multiple fields, and then created a
selection process to display those two phrases as the output fields, the phrases
did not return the correct fields. This issue has been resolved in version 6.0.4 so
each phrase returns the correct fields in their proper order.

SBXA-176 Report after Running /RELEASE.LICENSES Now Shown as DISP 4

When running the /RELEASE.LICENSES process, if you entered a response of Yes
to release invalid licenses, the list of invalid ports was shown as a DISP 3. if you
responded with No, the list was shown as a DISP 4, as expected. The code has
been corrected in version 6.0.4 so the list of invalid ports is consistently shown as
a DISP 4.

SBXA-179 /SB.INITIATE Process Creates Pointer to SROC.LOG

If you ran the /SB.INITIATE process to Initiate SB in an account and create an
initial system ID, the process did not create a pointer to SROC.LOG, and the user
was unable to log on to the account until the pointer was created manually.
The /SB.INITIATE process has been fixed in version 6.0.4 to create a pointer to
SROC.LOG, as designed.

SBXA-184 Correction of Typographical Error in XAML Code Snippets

A typographical error in a field label on the XAML Code Snippets Foreground
screen has been corrected from "Foregorund" to "Foreground".

SBXA-187 Increased Width of /FD Combo Boxes

In the Global Field Definition screen (/FD), three combo boxes were not wide
enough to display values properly in GUI or XUI mode. This has been fixed.
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Issue Number Description

SBXA-194 Image Access in XPS Viewer

When printing reports with images to the screen with the XPS Viewer, an
error sometimes occurred, stating that "The process cannot access the file
[image_filename] because it is being used by another process." The problem
was caused by XPS documents keeping images locked while the XPS Viewer was
still in memory. As there can be a delay between the XPS Viewer being closed
and the image memory being released, the code was modified to load images
into memory so the image file is not locked after the image is loaded. In addition,
the XPS Viewer instance is now disposed of on closing, so image memory is
always released.

SBXA-202 Functionality of License Details Button Is Reinstated

When logging on to SB/XA, the license reminder window is displayed if the user
has not yet entered license information. On clicking the License Details button
to enter license information in versions 6.0.2 and 6.0.3, SB/XA did not open the
License Details screen and continued loading, the same as if the user had clicked
the Continue button. After a code fix in version 6.0.4, this button again works as
expected.

SBXA-226 @CNT Value Now Set Correctly on Deleting MV with Alternative Character

In GUI mode, if a screen contained a controlling field with a process after and the
user deleted a multivalue using an alternative delete character, the @CNT value
was set incorrectly. A code fix resolves this problem in version 6.0.4.

SBXA-275 Grid Column Heading on Car Maintenance Screen

In the SBDEMO account UniData Windows edition, the heading for the Date
column of the Service History grid on the Car Maintenance screen (Maintenance
> Cars) was missing. This problem has been fixed and the Date heading is
displayed as normal.

SBXA-318 File Description Cleared after /FDEL Process Completes

After running the /FDEL (file delete) process in XUI mode, the file description
was not cleared after the process completed. This issue has been fixed, so the
description is cleared in XUI mode, the same as in character and GUI modes.

SBXA-397 Scroll Bar in Grids with Fixed Footer Row

If you add a fixed footer row to a grid, the initial grid size is one line plus the
footer. Due to a flaw in versions 6.0.1 and later, a scroll bar was never displayed
after sufficient records were added to the grid, so the bottom of the grid was
eventually off the screen. The code for displaying the scroll bar has been revised
in version 6.0.4.

SBXA-400 Fix for Sending Office Messages from XUI Clients

In version 6.0.1 or later, sending an Office message from a XUI client caused
the client to fail. A correction to the Office messaging code has been applied,
preventing this problem in version 6.0.4.

SBXA-524 Uninstall Program Altered

The uninstall program no longer deletes the application data directory
automatically.

SBXA-755 Copy Group Function Fixed to Copy $ Items

In SB/XA 6.0.3 and earlier, the Copy Group function (Admin > Security > Group
Security Setup > F10-Action > Copy Group) did not copy relevant $ items in
DMSECURITY. This issue has been resolved in version 6.0.4.
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SBXA-813 Increased Number of Driver Steps Per Screen

With this enhancement, the limit on the number of driver steps per screen has
been increased from 700 to 1400.

SBXA-972 Fix to Display Data in Correct Grid Columns

Under certain conditions, data was not displayed in the appropriate grid
columns in GUI mode in versions 5.3.4 and later. The code has been amended in
version 6.0.4 so the data displays in the proper columns.

SBXA-1016 Transaction Locking Inside SB Routines

When running transactions inside SB routines in version 5.2.4 or later, the
routine encountered problems with transaction locking and produced the error,
"The locks necessary for database operations at the current isolation level (0)
are not held by this process. Rolling back uncommitted transactions begun
within this execution environment." The transaction locking logic has been
overhauled in version 6.0.4, and this problem no longer occurs.

SBXA-1149 Display of Controls in Windows Aero Theme

In previous versions, buttons and other controls did not display properly in GUI
mode on Vista/Windows 7 when the Aero theme was selected. The Aero theme
uses larger fonts by default, causing menus to wrap and buttons to be cut off at
the bottom of the screen. The size of input screens (/PD.I) and output screens (/
PD.O) has been increased in version 6.0.4 so buttons, menus, and other controls
are displayed correctly.

SBXA-1187 Issue with Tag Text in Dialog Box Title or Description

In SB/XA Rich Client or SB/XA Browser Client, if a dialog box title or description
contained a line break, the tag "</LineBreak>" was displayed as text in the title
or description, rather than being executed as a action. A fix corrects this issue in
version 6.0.4.

SBXA-1213 Cleanup of 3D Grid Example

Various issues with the 3D grid example in the XAML Examples (XA) application of
the SBDEMO account have been cleaned up in version 6.0.4.

SBXA-1238 Behavior of X Button Altered in SB/XA Rich Client

In both SB/XA Rich Client and SB/XA Browser Client, the behavior of the X (Close)
button in the upper right corner of the window was different than in GUI mode.
Clicking the X button in either XUI client closed the session, rather than return
to the previous menu. A new user preference named SendEscOnClose has been
added in version 6.0.4. If this flag is set True (or 1), clicking the X button in SB/
XA Rich Client returns to the previous menu, the same as in GUI mode. However,
the behavior of the X button in the SB/XA Browser Client is controlled by the
internet browser, so clicking this button performs the standard action of closing
the window, which ends the session.

SBXA-1310 Remote Process Returns Error Message to App

If the SB.REMOTE.PROCESS was executed when no SB/XA licenses were
available, it did not return a meaningful and trappable error code and message
to the invoking application. The code has been amended to return a predefined
error message to the application if a dialog box is called by a remote process.
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Issue Number Description

SBXA-1327 New Process /REGEN.XUI Rebuilds XUI Forms

After running the /REGEN.GDS process to regenerate GUI default settings, the
process rebuilt only GUI forms, and changes were not applied in XUI forms. As of
version 6.0.4, the new process /REGEN.XUI process rebuilds the XUI definition in
the file dictionary.

SBXA-1381 Width of Date Fields Increased in Logon Times

In the Group Security Setup /SEC.GROUP.SETUP > F7-Logon Times screen, the
From Day and Up to Day fields were not wide enough to show the month, day,
and year in mm/dd/yyyy format in the XUI clients. The width of these fields has
been increased in version 6.0.4.

SBXA-1465 Adjustments to Column Widths of Tables in XUI Mode

The column widths in tables were not the same between GUI and XUI modes.
In GUI mode, (a) the column header row is displayed regardless of whether
the T option is used in the S: statement to include the column header; (b) the
column header is displayed even if the column contains no data, allowing users
to manually increase the width of the column; and (c) a scroll bar is generated
automatically. This same functionality has been implemented in the XUI clients
in version 6.0.4, so tables behave the same XUI mode as in GUI mode.

SBXA-1480 Autologin Error No Longer Loops

If a user who was set up for autologin (Autologin = 1) logged on to the UNIX
operating system under one user ID (such as TEST) and then attempted to log on
to SB/XA under a different user ID (such as DEMO), an error message regarding
the failed autologin was displayed in an infinite loop. The only way to escape
from the error was to close the client. Version 6.0.4 corrects this issue, so the
error message is displayed only once.

SBXA-1533 "Editable" Attribute Supported in XUI Clients

When users set the "Editable" attribute on a control such as SBToggle in a GUI
form and ran the form in XUI mode, SB/XA returned a message similar to the
following: "An error occurred calling editable on type 'SBToggle'. Failed to
invoke the method 'SBEditable' in the class 'SBToggle'." To prevent this error,
the Editable attribute is implemented in XUI mode in version 6.0.4.

SBXA-1562 Correction of Report Writer Output to PDF Email Option

In version 5.4.4 or later, email parameters entered in the report process
definition (/PD.R) for a Report Writer report were ignored at run-time when
output to PDF. The PDF output function has been amended to parse email
parameters correctly in version 6.0.4.

SBXA-1585 Updates Made Using Toggle in MV Field Are Saved in XUI Clients

When a toggle was set on a multivalued field, updates to records in the
multivalued field by using the toggle were saved in GUI mode, but not in XUI
mode. A code fix in version 6.0.4 corrects this issue so changes are saved in both
GUI and XUI modes.

SBXA-1593 New Parameter for Inhibiting User's Ability to Change Security Record

A new flag called "Change Own User Security Record" has been added in SB
Control Parameters (/SB.PARM > F5-System Defaults). This parameter provides
the ability to inhibit users from changing their own user security record. The flag
does not apply to members of the ROOT group; these users always retain the
ability to change their own user security records.
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Issue Number Description

SBXA-1594 Security API Supports Menu and Process Restrictions for Groups

The SB/XA security API has been extended to allow SB developers to create
and update restrictions to the menu and process restrictions in group security
through a UniBasic or UniVerse BASIC program.

SBXA-1597 Job Schedule Process Runs Properly with Multilanguage On

In version 6.0.x with the Multilanguage option on, if a user called a process
that first displayed a dialog box and then ran a /JSD job schedule process, the
process terminated with the errors "DATE/TIME HAS ALREADY PASSED" and
"Schedule Terminated [process_name]". A code fix corrects this issue in version
6.0.4.

SBXA-1605 Improvements to XUI Crash Handling

When SB/XA issued the error message, "Object reference not set to an instance
of an object," the XUI client became unresponsive after the user accepted the
error. The user was unable to run any process via a menu or slash (/) process call.
The code has been amended to improve the way the XUI clients handle failure
and subsequent user response.

SBXA-1610 Correction to Enforce Field Length in XUI Mode

The XUI clients allowed entry of any length of data in a field defined as A (alpha),
even when the user flag AutoExtend Field Length was set to N. The /USER.FLAGS
AutoExtend functionality was corrected in version 6.0.4 to enforce length
limitations set on both single- and multivalued fields in XUI mode.

SBXA-1617 Theme Set in /USER.FLAGS Not Executed as Default

If the user set a default theme in /USER.FLAGS, that theme was not loaded as the
default theme. Instead, System Control Record (/HK.CONTROL) settings were
used. The specified theme was used in the current session after the user saved /
USER.FLAGS in the XUI client, but the next time the user logged on to SB/XA in
the XUI client, the theme again was not loaded. These issues with the default
theme set in /USER.FLAGS occurred because this field should have been read-
only, as it represents the last theme used. It has been made read-only in version
6.0.4.

SBXA-1618 Focus Retained on Escape from F1 Help in Tabbed/Linked Screens

After escaping from F1 help in tabbed or linked screens, focus was lost and the
tabbed/linked screen was inoperable. The user had to press Esc to escape from
the tabbed/linked screen and regain control in the parent screen. Version 6.0.4
corrects this problem; focus is returned to the field from which F1 help is called.

SBXA-1620 Alpha Data in Numeric Display Field in /PD.S

When running a selection process (/PD.S) that included a display field defined
as numeric and the data contained alpha characters, the selection process
terminated the GUI client session. With a correction in version 6.0.4, the
selection process runs as expected in GUI mode. The numeric field displays
alpha data as '0' (zero).

SBXA-1621 Fix for F3 Intuitive Help in MV Fields in XUI Clients

In version 6.0.3, F3 intuitive help returned nothing when called from a
multivalued field with a data value in the XUI clients. After a code fix, F3 help
works as expected: a selection list is presented when the user presses F3 from a
multivalued field that contains data. The functionality is now consistent with GUI
mode.
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SBXA-1624 Issues with Setting Report Locations in /SEC.GROUP.SETUP

In the Group Security Setup /SEC.GROUP.SETUP>F8-Locations screen, F3
intuitive help did not return any report locations to the selection list. If the user
entered a location name, this information was not retained after a save. These
issues with the Locations screen have been resolved in version 6.0.4.

SBXA-1627 Resolution of Corruption Issue when Typing Ahead with Data Stacking

In SB/XA Rich Client, typing ahead in screens with data stacking caused
corruption of data in version 6.0.3. A code fix prevents this problem in version
6.0.4.

SBXA-1628 Error Handling of /PD.S with Option E Headings Containing Value Marks

When executing a selection process (/PD.S) with option E (Display Ensign
heading text), the output was displayed incorrectly if the heading text had an
embedded value mark.

In character and GUI modes, executing the /PD.S did not cause the client to fail.
The heading text was displayed but the detail data was not. Part of the heading
text was displayed in the first row of data.

In XUI mode, the client returned the message, "Windows error: RocketSoftware
U2 SB/XA has encountered a problem and needs to close. We are sorry for any
inconvenience," and the client was closed.

These issues have been corrected in version 6.0.4. The SB language converter
has been changed to process exceptions such as an embedded value mark. If the
heading text contains illegal symbols, the client logs an error message, and no
dialog box is displayed.

SBXA-1639 Null Password Is Now Allowed

A new flag called "Allow Null Password" has been added in SB+ Control
Parameters (/SB.PARMS > F5-System Defaults). This parameter provides the
ability to set the password as null. If the Allow Null Password flag in SB.PARMS
is set to Yes, the Password field in User Security Setup (/SEC.USER.SETUP) can
be left null, and the user will not be prompted to enter a new password at first
logon. By default, the Allow Null Password flag is set to No.

SBXA-1642 Empty Lines Cleared when Refreshing Grid in XUI Mode

When the user ran a subroutine that cleared the RECORD portion of a grid and
then used @REFRESH=-2 , the data was updated but the empty lines were not
cleared from the grid in XUI mode. For example, if the number of lines in the
grid decreased from three to one, the second and third lines still displayed their
previous values. The code has been amended in version 6.0.4; changing the data
in the grid and then using @REFRESH=-2 to refresh it works as expected in XUI
mode.

SBXA-1649 Fix to Start Background Phantoms in UniData UNIX Edition

When running a phantom process in the UniData UNIX edition with the
background option set to Y, the message "Starting phantom..." was displayed.
but the phantom process was not started. The job schedule process has been
amended to properly start phantoms that run in the background on UNIX
platforms in version 6.0.4.



SB/XA v6

126

Issue Number Description

SBXA-1653 Scroll Bar Added for Type 1 Menus in XUI Forms

If a type 1 menu was too long to fully display within the area of a XUI form, a
scroll bar was not added and users were unable to access options beyond the
bottom of the form. In version 6.0.4, type 1 menus are now presented with a
scroll bar if all menu options do not fit within the XUI form.

SBXA-1658 LFK Style Is Now Applied to XUI Forms

If /SB.CONTROL <30,4> was set to 1 to use the new Load Function Keys (LFK)
style for replacing function key buttons on forms in GUI mode, and /SB.PARMS
flag "Use New LFK Style Buttons" was set to Y, the new LFK style was not applied
to XUI forms. The function keys were loaded In the action bar of the main
window. With these /SB.CONTROL and /SB.PARMS settings in version 6.0.4,
function keys are presented as buttons within XUI forms as expected.

SBXA-1663 Fix to Tag All Option in MV Fields in XUI Clients

In versions 6.0.2 and 6.0.3, using the F9-Select Tag > Tag All option on a
multivalued field did not return all the data to the multivalued field in XUI mode.
This issue has been fixed in version 6.0.4.

SBXA-1678 Drill-down Process Slot Populated with @KEY Common Variable

When using the drill-down feature in a selection process (/PD.S> F6-Addit), the
@KEY common variable was not passed to the process specified in the Drill-
down Process slot. A fix corrects this problem in version 6.0.4.

SBXA-1680 Default Printer Assigned by SETPTR in UniVerse UNIX Edition

SETPTR was not executed properly to assign a default printer when logging on to
SB/XA in the UniVerse UNIX edition, using the AIX operating system. The code has
been amended to correct this problem in version 6.0.4.

SBXA-1683 Self-Contained Forms Flag Now Interpreted Correctly in XUI Mode

In previous versions, when the self-contained forms flag was set to Y in /
SB.PARMS, /HK.CONTROL, or /USER.FLAGS, status lines were displayed outside
of the main window in the XUI clients. This issue has been corrected so if the
setting is Y, status lines are displayed on the bottom line of the form, the same as
in GUI mode.

SBXA-1689 New /REGEN.XUI Process

Version 6.0.4 implements a new process named REGEN.XUI to generate XUI
forms. This process performs a similar function as the /REGEN.GUI process, but
for XUI forms.

SBXA-1691 Changes to SETATTR in Tabbed Screens in XUI Mode

If you used SETATTR to change the title in a screen definition for a tabbed
screen, SB/XA returned the following error message when the screen was run
in XUI mode: "An error occurred calling parent on type SBForm Failed to invoke
the method 'parent' in the class 'SBForm'." This issue is partially addressed by a
code fix in version 6.0.4. However, the user must make a change in the paragraph
code to determine whether the XUI form is tabbed. Formerly, the property
USER_DATA was checked for a value. In SB/XA, this property is not populated
and therefore the property IsTabForm must be queried.
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SBXA-1692 Field Value Mark in User Data No Longer Produces Error

If the User Data parameter in Additional Parameters contained a value mark for
a field on a screen, the screen reported an error similar to the following when
run in XUI mode: "Calling the Value property when there are more than 1 values
in SbString is invalid. The string was ABC:@VM:DEF." The value mark had to be
removed from the User Data field so the screen could be run in XUI mode. A fix is
implemented in version 6.0.4, so User Data now stores value marks and does not
throw an exception.

SBXA-1698 New Flag to Prevent Overwriting Images

In previous versions, if an image did not exist in xxRESOURCE, the XUI client
overwrote any image that existed on the client. A new flag has been added that
allows the developer to decide if images should be downloaded from the server
to the client, and if the image does not exist on the server, the server does not
attempt to download the image to the client.

SBXA-1703 Fix for XPS Viewer Issue in UniData UNIX Edition

After upgrading to version 6.0.2 or 6.0.3, the XPS Viewer did not appear when
sending report output to the XPS printer in the UniData UNIX edition. To resolve
this problem, the XPS.CLASS shipped with the product is now used when
performing an upgrade, and is not overwritten by the XPS.CLASS from the
customer's SB account.

SBXA-1704 Display of Ampersand in Label in XUI Clients

The XUI clients stripped one ampersand from labels as follows: If a single
ampersand character (&) was used as text in a label, the ampersand was
displayed in GUI mode, but not in XUI mode. If two ampersand characters
(&&) were used in a label, both were displayed in GUI mode, but only one was
displayed in XUI mode. A fix corrects this issue in version 6.0.4.

SBXA-1708 Toggle Description Displays in XUI Mode

In versions 6.0.2 and 6.0.3, if a toggle box had a length of 1, the description
for the toggle was not shown in XUI mode. This issue has been resolved in
version 6.0.4, so the toggle description is now shown in XUI mode, the same as in
character and GUI modes.

SBXA-1725 Changing Function Key Set via Subroutine Supported in XUI Mode

Changing the function key set programmatically via a subroutine worked with no
problem in character and GUI modes, but placed the new buttons in the toolbar
in XUI mode. This issue was related to the Load Function Keys (LFK) problem
reported in SBXA-1658, and the fix for that issue resolved this one as well.

SBXA-1873 SB.REMOTE.PROCESS Supports DISP 4 Dialog Boxes

Version 6.0.4 implements an enhancement that allows DISP 4 dialog boxes to be
processed by SB.REMOTE.PROCESS.

SBXA-1942 Expression as Output Filename

With this enhancement, users can enter an SB expression as the output filename
for Report Writer reports output to HTML or PDF through Process Defn - Report (/
PD.R).

SBXA-2095 Keyboard Buffer Fixed

Problems with the keyboard buffer in the XUI clients have been fixed.
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SBXA-2394 Title Bar of PDF Parameters Subscreen Fixed

The title bar of the Process Defn - Report (PD.R) > F6 - PDF Parameters subscreen
was displayed out of position and contained a bad character on some platforms.
This has been fixed in version 6.0.4.

SBXA-2408 Correction of Hot Keys on Buttons in XUI Mode

Hot keys on buttons were not the same in the XUI clients as in GUI. For example,
on Hire Details screen in the Car Rental System application of SBDEMO, the F5-
Cars button had hot key C in GUI mode, but hot key "r" in XUI mode. The code
has been amended to correct this issue in version 6.0.4, so XUI hot keys are the
same as in GUI mode.

SBXA-2460 Error Prevented on Escaping from Tools or General Help Menu

In General Help > Technical Information > GUI Features > SBExplorer (SBX), if
you selected the Tools option, clicked the Tools link, and then escaped from the
Tools menu, an error message "No Help HTMLControl available for focus!" was
displayed. The same error also occurred with links to the General Help menu.
In version 6.0.4, if normal processing does not find a help form, SBX checks the
global form stack to find the form and display it.

SBXA-2467 Correction to SB Help Submenu

In the F1 General Help > SB+ Readme's > Release 3 submenu, a menu item
contained an ampersand (&) character. This has been fixed.

SBXA-2497 Error Message in SB+ Host Name Field Is Now the Same in All Clients

In the SB+ Control Parameters (/SB.PARMS)>F8-Display Defaults>F5-GUI Display
Defaults subscreen, if you enter an invalid character in SB+ Host Name, SB/XA
returns the following error message in character and GUI modes: "NAME MAY
NOT CONTAIN CHARACTERS +-...". However, in XUI mode, the error message
was "Name cannot begin with the '>' character, hexadecimal value 0x3E. Line 1,
position 418." In version 6.0.4, the text of the error message is now the same in
XUI mode as in character and GUI modes.

SBXA-2528 New /CLEAR.DRIVERS Process

A new process named CLEAR.DRIVERS has been added in version 6.0.4, enabling
users to clear the xxDRIVERS for the current system.

SBXA-2530 Fix for Object Error in /TERM.DEFN>F5-CUI Colors

In the Terminal Definition (/TERM.DEFN) screen in the XUI clients, if you opened
the SGUI record, selected F5-CUI Colors, and then pressed Enter when the
focus was on the Default Menu field or another field in the right column, SB/
XA displayed the error, "Object SBWIN_101_3*13*5 does not exist!" A code fix
prevents this error in version 6.0.4.

SBXA-2575 Ask Option Added in Send to PDF Prompt

As an enhancement in version 6.0.4, the "Send to PDF (Y/N)" prompt in the
Report Parameters screen has been changed to "Send to PDF (Y/N/A)" so SB/XA
asks the user if the report is to be sent to PDF at run-time. With this change, it is
not necessary to build and maintain one report for PDF and another for output
to a physical printer.
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Issue Number Description

SBXA-2717 Buttons Displayed in Preview Selection Screen in XUI Client

In the Enquiry> Car Models screen of the SBDEMO Car Rental System, if you
press F3 on Model Code and select multiple models, the Selection Preview
screen allows you to resequence the multiple selection. However, the buttons for
resequencing, including Resequence and Goto, were missing in XUI mode. This
issue has been corrected in version 6.0.4.

SBXA-2727 Enhancements to /TRANSLATE Process

For customers who want to fully enable multilanguage support, the /TRANSLATE
process has been enhanced to allow editing of DMCONT records. A new process
named ML.MESSAGE in /TRANSLATE calls a screen for entering multilanguage
translations for each of the following DMCONT items: MESSAGE, ERROR,
DIALOG, PROMPT, GENERAL.TEXT, QUES.OPTS, STATUS.LINE, SCR.TEXT, and
CALENDAR.TEXT.

SBXA-2864 Video Button Not Implemented in XUI Clients

If you clicked the F8-Video button in I*CARS*S1 in SBDEMO in XUI mode, SB/
XA returned the following error: "An error occurred calling gui_run_command
on type SBPlus Failed to invoke the method "gui_run_command" in the class
'SBPlus'." The video feature is not yet available for the XUI clients, so a "Not
implemented" message is displayed if the user clicks the Video button in version
6.0.4.

SBXA-2908 F3 Intuitive Help for Super Search +

In versions 6.0.0 and later, F3 intuitive help did not work in Tools > Other Tools
>Super Search +. F3 functionality has been fixed in version 6.0.4.

SBXA-3280 New Log for Tracking Changes to HTML Template

An enhancement in version 6.0.4 enables customers to produce a log that tracks
changes to the HTML template if the template is downloaded to the workstation,
modified, and then uploaded. When the template is uploaded, SB/XA attempts
to call HTML.UPLOAD.LOG as a log process. If HTML.UPLOAD.LOG is not found,
SB/XA calls GLOBAL.LOG. The ORIG.REC contains the original HTML, and RECORD
contains the new record. MAINFILE is the file that SB/XA writes to, and the key is
contained in KEY.

SBXA-3334 Multilanguage Text Copied along with Screen Definition

In versions 5.4.4 and later, multilanguage text was not copied when the
user copied a screen definition. The text for other languages is stored
in DMLANGUAGE.xx, where xx is the language code. An enhancement
is implemented in version 6.0.4 to copy the text for other languages in
DMLANGUAGE.xx.

SBXA-3376 Support for Loading Action Bar Items on XUI Forms

If a function key set that has action bar items was loaded on a XUI form, the
action bar items were loaded as function keys. In GUI mode, the action bar items
are loaded across the top of the form as a menu. This same functionality has
been implemented in XUI mode in version 6.0.4.

SBXA-3389 Fix for Subvalue Marks in TU.FORM.OPENDOS

The TU.FORM.OPENDOS subroutine was not treating subvalue marks correctly,
using a semicolon character (;) rather than a pipe (|) for the subvalue mark.
Due to this problem, customers were unable to call a Windows-style Open DOS
File dialog box from the XUI clients. The TU.FORM.OPENDOS code has been
amended to use the | character for subvalue marks in version 6.0.4, and the Open
DOS File dialog box is displayed in XUI mode as expected.
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SBXA-3401 Pointer to DMCRITERIA Added for SB-Enabled Accounts

When running SAPROGS FIX.SBPLUS.POINTERS or when setting up a new
account as an SB-enabled account, the pointer to DMCRITERIA was not added to
the VOC file. This issue has been corrected in version 6.0.4.

SBXA-3406 Fix to Display All MV Data in Output Screens with G-Option Grid

In output screens with a G-option grid containing a multivalue derived field that
uses square brackets [], only the first line of multivalued data was displayed.
A code fix resolves this problem in version 6.0.4, and all multivalued data is
displayed properly.

SBXA-3410 Audit Record Generated on Copying User or Group Record

In SB/XA 6.0.x, the security API failed to create an audit record when a user or
group record was created by copying it from the Security menu's user or group
copy function. This defect has been corrected in version 6.0.4 so an audit record
is created as expected.

SBXA-3417 Data Sorted Correctly with "MR2," Conversion Code

If a selection process (/PD.S) contained dictionary item with a conversion code of
"MR2," the data did not sort correctly in a grid. A fix resolves this issue in version
6.0.4, and the data is sorted in numeric order as designed.

SBXA-3423 Correction of Autologin Issue

An issue with the autologin feature has been fixed.
SBXA-3439 Performance Improved for /REGEN.EXP in Quiet Mode

Running the regenerate expressions process (/REGEN.EXP) in quiet mode was
slow because the log file was written to a hashed file. To increase performance,
the log is written to a directory file in version 6.0.4, increasing performance of /
REGEN.EXP in quiet mode.

SBXA-3441 XUI Clients Refresh Data Correctly with @REFRESH = 7

Using @REFRESH = 7 to refresh a grid did not refresh data as expected in the
XUI clients, leaving fields blank. The code has been amended so @REFRESH = 7
refreshes data in grids in XUI mode, the same as in GUI mode.

SBXA-3448 File Upload Issue Resolved

In version 6.0.3, using the XUI clients to upload a file to the server intermittently
resulted in client failure. This has been fixed.

SBXA-3454 Moved Screens No Longer Minimized in Aero Theme

In previous versions, moving screens caused them to minimize in Vista/Windows
7 when the Aero theme was selected. This issue was related to SBXA-1149, and
multiple fixes for the problem that caused menus to wrap and buttons to be cut
off corrected the minimizing behavior as well.

SBXA-3465 Copy Group Function Fixed to Copy $ Items

The Copy Group function (Admin > Security > Group Security Setup > F10-Action
> Copy Group) did not copy relevant $ items in DMSECURITY. This issue has been
resolved in version 6.0.4.

SBXA-3495 SROC.LOG Pointer Created with Correct Value

In UniData editions, the pointer for SROC.LOG created by running
FIX.SBPLUS.POINTERS was created with an F instead of DIR in attribute 1. This
issue has been corrected in version 6.0.4, and attribute 1 is created with a value
of DIR, as designed.
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SBXA-3496 Autologin Flag Added to SB+ Control Parameters

As an enhancement in version 6.0.4, the Autologin flag has been added to SB
+ Control Parameters (/SB.PARMS), which allows you to enable the autologin
feature at the SB instance level.

SBXA-3498 SB.DISP Displays Message for Invalid Type

If the user passed an alpha TYPE to SB.DISP, the variable TYPE was set to zero
and SB/XA did not display a message to inform the user that an invalid type was
passed. In version 6.0.4, a DISP 3 message is displayed if a nonnumeric TYPE is
passed to SB.DISP, or if the TYPE is greater than 49.

SBXA-3499 Adding Buttons to XPS Viewer Toolbar

Adding a button to the XPS Viewer toolbar to call an SB process overrode the
BaseSBXPSViewerStyle, and the button produced various errors. These issues
have been resolved so buttons added to the toolbar do not override the base
style and work properly in version 6.0.4.

SBXA-3512 Port Number Is Provided for Locked Records

In versions 5.4.1 and later, the "Record locked" error message did not include
the port number, and customers were unable to use the unlocking feature
without this information. The port number is displayed in this error message
once again in version 6.0.4.

SBXA-3516 Paper Size Options for PDF Output

In the Process Defn - Report /PD.R > F6-PDF Parameters screen, the Paper Size
options on the Direct to PDF tabbed page were listed vertically rather than
horizontally, causing display issues in subsequent fields on this page. This has
been fixed in version 6.0.4.

SBXA-3517 Correction of Display Issues when Deleting Last Subvalue

In GUI mode, if you deleted the last subvalue in multivalued data using the
Delete key rather than a backslash (\), display issues occurred if process slots
were used. The code has been amended in version 6.0.4 so the last subvalue can
be deleted via the Delete key without causing unexpected results.

SBXA-3523 Correction of /RELEASE.LICENSE to Parse Output of LISTUSER in UniData for
UNIX Edition

The SB /RELEASE.LICENSE process relies on the database command LISTUSER
to determine who is logged on to UniData. The output from LISTUSER contains
the user’s IP address for Windows, but not for UNIX. The /RELEASE.LICENSE
process in the UniData for UNIX edition has been changed to parse the output
from LISTUSER correctly on UNIX, so the process now works as designed.

SBXA-3524 Correction to FIX.SBPLUS.POINTERS Prevents Corruption

Under a specific set of conditions, FIX.SBPLUS.POINTERS corrupted application
data pointers. This issue has been resolved in version 6.0.4.

SBXA-3526 /REGEN.EXP Provides Option to Regenerate Only Data Files

In version 6.0.4, an enhancement to the regenerate expressions process (/
REGEN.EXP) allows you to regenerate only data files and not the xxDEFN and
xxPROCESS files.

SBXA-3528 TUBP Routines Run without FRW Error

In the UniData UNIX edition, the error message "FRW not a verb" sometimes
occurred when using TUBP routines. This issue has been fixed in version 6.0.4,
and TUBP routines now run without triggering this error.
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SBXA-3529 File Create Process Returns Error

In previous versions, the File Create process became unresponsive if the user
attempted to create a file with the same name as an existing file in the opposite
case (upper or lowercase). With no other way to end the process, the user had to
close the client session and then restart it. Code has been added in version 6.0.4
to issue an error message in this error condition, and the File Create process no
longer renders the client session unresponsive.

SBXA-3533 De-emphasized Fields Retain De-emphasis Properties on Primary Screen

In XUI mode, customers experienced a problem with de-emphasized fields on
a primary screen that had tabbed subscreens. If a paragraph process (/PD.P)
de-emphasized a field on the primary screen, the field was initially displayed
as de-emphasized. However, when the user clicked on a tabbed subscreen and
returned to the primary screen, the de-emphasized field was enabled for input.
With a fix in version 6.0.4, de-emphasized fields on the primary screen retain de-
emphasis properties after the user goes to a tabbed subscreen and returns to the
primary screen.

SBXA-3544 Porting Codes Made Available to Prevent /SMART.QUERY Error

Due to missing porting codes in version 6.0.3, running /SMART.QUERY in the
UniData Windows edition resulted in a blue screen with error messages. The
porting codes are present in version 6.0.4, preventing this error condition.

SBXA-3545 Change to Theme Loading After Changing System ID

Multiple applications (system IDs) in the same account may use the same XAML
theme. Changing to a different system ID caused the theme to reload, even
though both system IDs used the same theme. The code has been amended
so that when switching to a different system ID, the theme is loaded only if it is
different from the theme used by the previous system ID.

SBXA-3548 User-Defined Delimiter for Remote Processes

A problem was found using an attribute mark as delimiter when passing
parameters to a remote process on the Universe UNIX edition for DataVu.
The attribute mark was being converted to CHAR(221). A new field named
"SBREMOTE Delimiter" has been added to SB+ Control Parameters (/SB.PARMS),
allowing users to define a character to be used as a delimiter in remote
processes.

SBXA-3558 Fix for Issue with Pressing Enter when Button Is Not in Focus

When a dialog box displayed an error/warning message, if the user tabbed
through fields in the dialog box and pressed Enter when focus was not on a
button, the application became unresponsive. This issue has been resolved in
version 6.0.4.

SBXA-3562 Dialog Box with Bitmap Displays without Error

In version 6.0.3, if a dialog box contained a bitmap, SB/XA issued the error
message, "Invalid Socket Handle" when run in GUI mode. A fix prevents this error
in version 6.0.4.

SBXA-3563 Up and Down Arrow Keys Fixed in XUI Mode

In some cases, the up and down arrow keys did not move the cursor from one
field to another in the XUI clients in version 6.0.3. The code has been revised to
address this issue in version 6.0.4.
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SBXA-3567 File Transfer Process Improved

Under certain conditions, the client failed during the SB/XA file transfer upload
operation in versions 6.0.0 and later. The SbFtTrans process has been changed
from a one-way function to a two-way function to prevent this problem in
version 6.0.4.

SBXA-3571 XUI Clients Successfully Load Images in Cars Form

In SBDEMO, if the images for the I*CARS*S1 form do not exist on the client
machine, the files are downloaded from the SB/XA Application Server machine.
During the process of loading images for this form, SB/XA Rich Client and SB/XA
Browser Client failed. A code fix prevents this problem in version 6.0.4.

SBXA-3585 Pointer Error Prevented in Upgrade

On upgrading the UniData Windows edition, SB/XA issued the error message,
"Unable to open Pointer to Old Sauser." The upgrade program has been fixed to
set up a file pointer as a DIR type rather than an F type, preventing this error in
upgrades to version 6.0.4.

SBXA-3641 Supporting Files for ClickOnce Deployment

At version 6.0.4, the release directories are shipped in the \Extra\Rich Client
folder on the product CD. Customers can copy the application and deployment
manifest files from this folder to build their own ClickOnce deployment of the
SB/XA Rich Client component to client machines.

SBXA-3669 Changes to Calendar Control in XUI Clients

The calendar control did not display dates properly when switching from one
month to the next in XUI mode. The calendar display area has been adjusted to
accommodate up to six rows of dates per month, resolving this issue in version
6.0.4.

SBXA-3696 Fix to Prevent Failure of XUI Clients in /PD.S

Pressing Enter through multiple prompts in a selection process (/PD.S) caused
the XUI clients to fail. A code fix corrects this problem in version 6.0.4.

SB/XA v6.0.3 release notes
Build 2304
Release Date: June 2010
These release notes provide information about enhancements and fixes in SB/XA v6.0.3.

What's new in SB/XA v6.0.3

Correction of display issue in derived and non-input fields
A problem with the display of values in derived and non-input fields in the XUI clients affected
functionality of SB/XA 6.0.2, and a product quality alert was issued. This issue has been corrected in
Version 6.0.3. 12977*AUS, 12978*AUS

Updated/rebranded documentation set
The SystemBuilder documentation set has been updated to reflect changes in the product, and the
rebranding of path names and namespaces is now complete.

Enhancements and fixes in SB/XA v6.0.3

The following issues were addressed in this release:
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6453*UK Correction to cpio Commands for Linux in Getting Started Guide

The cpio commands for Linux have been corrected in Chapter 4, "Installing SB/
XA Application Server on UNIX," in SB/XA Getting Started.

9325*USA Create/Update Account Screen Shots Replaced

The screen shots of the Create An Account screen showed an option that was
removed in a previous version, and have been replaced in Chapter 1, "Getting
Started," and Chapter 4, "Admin Menu," in Administering SB/XA.

In addition, the screen shot of the Update An Account screen was replaced. It
now shows the F7-Themes option, and instructions for the Themes screen have
been added in Chapter 4, "Admin Menu," in Administering SB/XA.

12171*AUS Single Sign-On Credentials Are Case-Sensitive

The instructions for the Single Sign-on screen in Chapter 6, "Setting Up
Application Connections and Configuring Clients," in SB/XA Getting Started now
state that the user's Windows identity credentials are case-sensitive.

12807*USA Notation Removed for Single Sign-On in Cross-Domain Environment

Chapter 6, "Setting Up Application Connections and Configuring Clients," in
SB/XA Getting Started listed cross-domain logons as a reason not to use single
sign-on. Our tests demonstrate that single sign-on can be configured for cross-
domain logons, so that statement has been removed from the list.

12810*USA New Fields in SB+ Control Parameters Documented

The screen shot of SB+ Control Parameters (/SB.PARMS) has been replaced, and
three fields recently added to this screen (Database Code Page, OEM or ANSI,
and Character for XPS Tags) are documented in Chapter 4, "Admin Menu," in
Administering SB/XA.

12977*AUS,
12978*AUS

Fix to Display Values in Derived and Non-Input Fields in XUI Clients

In version 6.0.2, the first time a record was displayed in the XUI clients, values
were populated in derived and non-input fields as expected. After escaping from
the record and displaying it again, values were not populated in these fields.

As a related issue, values in derived and non-input fields on tabbed screens
were displayed the first time the tab was opened, but were empty after clicking
another tab and then returning to the same tab in the XUI clients.

The code has been amended to resolve these issues with the display of derived
and non-input fields in version 6.0.3.

12985*AUS GUI Form Painter F3 Font Strings Produced Errors in Character Mode

Using F3 to build font strings in the GUI Form Painter generated strings that
were not compatible with character mode, and resulted in errors on saving the
form. The validation routine for character forms has been changed so that if
font strings do not pass validation, the font strings are stripped out and no error
occurs.

40776*USA Path Names Updated in Documentation

The default installation path was changed from C:\IBM to C:\U2, and "IBM" was
removed from other path names in the product in version 6.0.2. Accordingly,
the path names have been changed in text and in screen shots throughout the
version 6.0.3 SystemBuilder documentation set. Note that the Getting Started
guides still contain instructions for removing older versions of the product in
their C:\IBM locations.



SB/XA v6.0.2 release notes

135

Issue Number Description

40960*USA Updates to Documentation on Specifying Default Styles

Screens for specifying the default XAML style at the system level (/HK.CONTROL),
at the account level (/UPDATE.ACCOUNTS), and at the instance level (/
SB.PARMS) were added or updated in version 6.0.2. Documentation on system-
level, account-level, and instance-level styles has been added or updated in
Chapter 4, "Admin Menu," in Administering SB/XA, and in Chapter 5, "Other
Utilities," and Chapter 9, "XAML Styles and Themes," in the SB/XA Application
Server Reference.

40961*USA Function Key/Button Screen Updated in Reference Manual

A XAML Style Name field was added to the GUI Form Painter (/SD) Function Key/
Button Screen, allowing you to specify a style for a specific button. The screen
shot has been replaced and the new field has been documented in Chapter 7,
"Graphical User Interface," in the SB/XA Application Server Reference.

41011*USA,
41117*USA

Namespace Changed in Documentation

The namespace in XAML style definitions was changed from "IBM.SBPlus" to
"SBXA.SBPlus" in version 6.0.2. The SystemBuilder documentation set has been
updated to show the new namespace in XAML style definitions.

41186*USA Updates to Screen Parameters Documentation

An option for specifying XUI parameters was added to the GUI Form Painter (/SD)
> F6-Screen Parameters screen. The screen shot has been replaced to show the
new F7-XUI Params option, and documentation for Screen XAML Parameters has
been added in Chapter 3, "Main Tools," in the SB/XA Application Server Reference.

41443*USA Step for Setting Up Theme for an Account Is Noted as Optional

The step for setting up the available themes and default theme for an account
has been noted as optional in Chapter 6, "Setting Up Application Connections
and Configuring Clients," in SB/XA Getting Started.

The step for verifying and entering the user's Windows identity in the Single
Sign-on screen has been updated to cover both standard and cross-domain
logons in Windows XP, Windows 7, and Windows Vista environments. Look
for these changes are in Chapter 6, "Setting Up Application Connections and
Configuring Clients," in SB/XA Getting Started.

SB/XA v6.0.2 release notes
Build 2230
Release Date: May 2010
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.0.2.

What's new in SB/XA v6.0.2

Recompiling/recataloging programs after 5.x to 6.x upgrade
When upgrading from SB version 5.x to SB/XA version 6.x, it is necessary to recompile and recatalog all
UniBasic or UniVerse BASIC programs and run /REGEN.EXP to regenerate expressions on all accounts.
For detailed information, please see the following tech note:
https://u2tc.rocketsoftware.com/documentation/PDF/1410003.pdf
12820*USA

Disabling third-party revision tracking tools during upgrades
If you are using a third-party revision tracking tool (such as PRC from SJ+ Systems Assoc., Inc.) that
integrates into SB/XA, the tool must be turned off/disabled in accounts that you intend to upgrade.

https://u2tc.rocketsoftware.com/documentation/PDF/1410003.pdf
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Please contact your revision tracking software vendor for instructions on how to disable/uninstall the
revision tracking tool before an account upgrade, and then enable/reinstall the tool after the account
upgrade. Note that you may have to upgrade the third-party product for SB/XA; to avoid installation
and upgrade failures, please consult your vendor before proceeding. 12821*USA

Support for VBScript in XUI clients
SB/XA Browser Client and SB/XA Rich Client have been enhanced to support VBScript functionality
in version 6.0.2. The SBDEMO XAML Examples (XA) application now contains a VBScript example
that demonstrates how a graph program written in VBScript is displayed by Microsoft Excel. SB/
XA supports all the same functionality of the TUBP library that is available in SBClient except for
TU.SCRIPT.ADDOBJECT. 41008*USA, 41180*USA

Namespace changes in XAML style definitions
In version 6.0.2, "IBM.SBPlus" has been changed to "sbxa" in the namespace in default XAML styles.
To see the new namespace definitions in the default XAML styles, open the DefaultStyles.xaml file in
the \SBDEMO\XATHEMES folder in the SB/XA installation directory. The default directory is C:\U2\SBXA
\ApplicationServer\UniData\SBDEMO\XATHEMES or C:\U2\SBXA\ApplicationServer\UniVerse\SBDEMO
\XATHEMES. You can use the screen editor process to view the XAML code in this file by entering the
following: /SE XATHEMES DefaultStyles.xaml.
If you wrote a custom XAML theme, you will need to update the namespace definitions in the
same way, substituting "sbxa" for all occurrences of "IBM.SBPlus". Any references to "http://
schemas.IBM.SBPLUS.com/WPFControls" should be changed to "http://schemas.sbxa.com/
WPFControls".
All occurrences of "xmlns:sbc", "xmlns:sbp", "xmlns:sbs", and "xmlns:sbs" should be changed to
"xmlns:sbc". For example:
xmlns:sbc="http://schemas.sbxa.com/WPFControls"
41011*USA, 41117*USA

MAPI support for email messaging in XUI clients
The same electronic mail functionality available in SBClient is now supported in SB/XA Browser Client
and SB/XA Rich Client. All clients use Microsoft's Messaging Application Program Interface (MAPI).
MAPI allows client programs to become email messaging aware; it interfaces SB messaging- based
services to Microsoft Outlook. 41014*USA

Remove prior versions of SB/XA Presentation Components
The installation program for SB/XA Presentation Components does not work properly to upgrade
previous versions of SB/XA Browser Client or SB/XA Rich Client to version 6.0.2. You must uninstall the
old versions of these components from Control Panel > Add or Remove Programs before installing the
SB/XA Presentation Components from the SB/XA 6.0.2 product CD. You should back up or move the SB
and SB.DEFN accounts to SB.OLD and SB.DEFN.OLD before running the uninstall process if you intend
to preserve security records, printer definitions, and other settings. 41539*USA

Enhancements and fixes in SB/XA v6.0.2

The following issues were addressed in this release:

Issue Number Description

5957*USA Escaping from Print Manager No Longer Places Data in @ORIG.REC

In versions 5.2.4 and later in character mode only, if the user entered /P to print
the screen and pressed Esc or F4 to escape from the Print Manager, the printer
data was placed incorrectly in @ORIG.REC. Version 6.0.2 implements a fix so the
variable contains the stored printer data as expected.

6671*USA New Combo Box Slot in /FD

An optional slot to preload combo box options has been added in the Field
Definitions (/FD) screen. -
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7300*USA Fix for Index Error in Date Field

In versions 5.3.3 and later for UniData only, if the user entered a character such
as "+", "-", or "." in a date field and pressed F3 for help, the error message "index
1:1,index 2:7 to two dimensional matrix is out of range" was displayed. The
client failed, and the cursor was returned to the ECL prompt. This issue has been
resolved in version 6.0.2, so pressing F3 in a date field containing a character no
longer produces the index out of range error or causes the client to fail.

7568*USA New Process Logs Changes to First-Level Help

Version 6.0.2 implements a new process to record changes to first- level help
(OH1). Changes to the RECORD, KEY, and MAINFILE are supplied to the FD.LOG
process. Note that changes to second- and third-level help are made in the
Screen Editor (/SE process) and are written to the editor log file. For further
information on the editor log, see issue 12427*USA.

8866*USA Improved Help for /SEC.USER.SETUP Password Field

Second-level help on the password field in /SEC.USER.SETUP has been revised
to clarify differences in the behavior of the SB password depending on how you
set it up. If the password is set up in uppercase, entry in uppercase or lowercase
is accepted. If you set up the password in lowercase or mixed case, the password
is case-sensitive and must be entered exactly as it was set up.

9071*USA Correction of Cursor Behavior in /PD.I Option F

In GUI tabbed screens, /PD.I option F incorrectly advanced the cursor to the first
field on the next screen, instead of placing the cursor in the first input field of the
current screen after the key field. The first screen starts with the key field, and
pressing Return on the key field caused the record to be read again, removing
any changes to data that had been changed. This issue has been resolved in
version 6.0.1 so option F returns the cursor to the first field of the current screen,
as designed.

9076*USA /PD.I Option F Now Supported in Character Mode

/PD.I option F functionality was previously not implemented in character mode
linked screens. An enhancement in version 6.0.2 enables option F to work the
same in character mode as in GUI mode, placing the cursor in the first field of the
current linked screen.

9466*UK Fix Allows Auto Logon as Different User

In the UNIX version with Autologin set to 1 (On), if the user logged on to UNIX as
one user and then auto logged on to SB as a different user, an autologin error
occurred and repeated in a loop, requiring the user to end the session. A code fix
in version 6.0.2 prevents this error.

9494*USA Option to Disable Error Message Box when No Items Returned for HTML
Report

SB.CONTROL record <30,13> has been added in DMCONT. This parameter
provides the ability to disable the "No Items Present" error message dialog box
that appears when no items are returned for a Report Writer report that is output
to HTML.

9541*USA Support for DISP 4 Calls from SB.REMOTE.PROCESS

The SB command DISP 4, which is called inside a paragraph process to display
a message in a dialog box, has been enhanced so it can now be called from
SB.REMOTE.PROCESS.
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9965*USA Use of XAML Styles to Create Menus Resembling Types 3 and 4

SB/XA Browser Client and SB/XA Rich Client support menu types 1, 2, and 5
natively. You can use XAML styling to create menus that are similar to menu
types 3 and 4 in appearance and behavior for use in the XUI clients. We will
publish a tech note on styling menu types 3 and 4 shortly after SB/XA 6.0.2 is
released at https://u2tc.rocketsoftware.com > U2 Knowledge Base.

10465*USA Copy Text from Report Writer .TXT Record to Alternative Language Item

Text typed directly in a Report Writer report is stored in the .TXT record
for the report definition within the dictionary of the file the report is run
against. With this enhancement in version 6.0.2, the text stored in the
report_name.TXT item can be copied to create an alternative language item,
such as report_name.TXT.FR (or any other language code), and the alternative
language item can then be edited.

10676*USA Help Coordinates Screen Displayed in XUI Mode

F1 More Help was implemented in SB/XA Browser Client and SB/XA Rich Client in
version 6.0.1, but the screen to define Help coordinates was not displayed. This
issue has been resolved in version 6.0.2.

10731*USA No Comment Generated for Empty Lines in HTML Output

If a Report Writer report contained a conditional field that produced skipped
(empty) lines in HTML output, a "<!--Skip-->" comment was generated for
each empty line, increasing the size of the HTML file. The code has been changed
so that the comment is no longer generated for empty lines in HTML report
output.

10758*USA Correction for Applying Custom Style to Button

In versions 6.0.0 and 6.0.1, a custom XAML style applied to a button on a form in
the GUI Form Painter did not override the system default button style. This issue
has been fixed in version 6.0.2 so the custom XAML style is applied to the button,
as expected.

10769*USA Display of Admin Menu in New Accounts

The Admin menu was missing in newly created accounts in version 6.0.1. A fix
corrects this problem in version 6.0.2.

11006*USA Selection Process with Option H Displays Results Correctly

If a selection process used option H to hide the key field from display, the
selection results did not display correctly in GUI mode. This has been fixed in
version 6.0.2.

11008*USA Fix Prevents Failure of Paragraph Process That Changes @CNT

In versions 5.3.8 and later, if a paragraph process changed the value of
@CNT (allowing you to go to a different line in a controlling multivalue field),
the process failed in some cases, depending on how it was executed. If the
paragraph process was executed from a function key slot or as a slash command
from any prompt, it worked correctly. If executed from an action bar slot, the
process failed. This issue has been resolved so a paragraph process that changes
the value of @CNT works correctly when executed by any of these means.

11010*USA Fix for Report Writer PDF Process Error

When the user was preparing to output a report and pressed F3 for help at
the "Output to Screen/Printer/Aux..." prompt, the error "2]PDF PROCESS NOT
FOUND" was displayed. Version 6.0.2 implements a code fix to prevent this error.
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11175*USA Support for Styling Buttons Not Associated with Function Key

When a button was added to a form using the GUI /SD (Screen Designer) tool and
the button was not associated with a function key, it was not possible to apply
a style to the button in versions 6.0.0 and 6.0.1. A new field has been added to
the button definition screen within the Screen Designer, allowing you to specify a
XAML style for the button.

11190*USA Leading Zeros Shown in Combo Box Display

Combo boxes displayed the wrong description for numeric values. Leading zeros
were stripped from the numeric value, so "02" and "002" were displayed as "2".
With a correction to the code in version 6.0.2, the leading zeros are displayed as
expected.

11254*USA Unknown Exception Prevented in Default Date/Money Conversion

In versions 6.0.0 and 6.0.1, on the SB+ Control Parameters > F5 System Defaults
screen, F3 help on the Default Date Conversion or Default Money Conversion
field displayed an unknown exception error. A code fix prevents this problem in
version 6.0.2.

11279*USA Macro Lead-in Character Works in All Accounts

When the user defined a macro lead-in character in User Security Setup (/
SEC.USER.SETUP) when logged on to an account, the macro lead-in character
worked only in that account, and not after logging to another account. This issue
has been resolved in version 6.0.2 so the macro lead-in character is recognized in
all of the user's accounts.

11320*USA DS Type Dictionary Item Removed to Support UniData ESEARCH

In versions prior to 6.0.2, all DM files in the SB account have a DS type dictionary
item with the same name as the associated file. The DS items have a location
number of 30000 or higher, which caused the UniData ESEARCH tool to fail.
To resolve this problem, the DS type dictionary item has been removed from
the following files in version 6.0.2 for UniData: DMSYSDEFN, DMSECURITY,
DMACCOUNTS, DMPROCESS, DMHELPTEXT, DMRUNTIME, DMCONTACTS,
DMDIARY, DMSH, DMSTATFILE, and DMUSERLOG.

11488*USA Fix for Sorting MV Records in Selection Process Grids

In selection processes displayed in GUI mode, if the user sorted multivalue
records in a grid, the return value was corrupted. This problem has been
corrected in version 6.0.2.

11489*USA SB/XA Supports U2 Data Server Phrases

Version 6.0.2 implements support for U2 data server Phrases. This includes a new
option to maintain Phrases in dictionary items, enhancements to ARD/QRD to
support Phrases, and enhancements to selection processes to support Phrases.

11524*USA Support for HTML Output in XUI Clients

With this enhancement, version 6.0.2 provides the ability to output HTML reports
in SB/XA Browser Client and SB/XA Rich Client. Images for an HTML report must
be stored on the client machine.

11542*USA Group Summary Report Fixed to Display Correct Data in XUI Mode

In Security > Security Reports, the Group Summary Report displayed different
data in XUI mode than in GUI and character mode. The code for this report has
been amended so it displays the same data in all modes.
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11565*USA Login Times Accepts "T" for Today's Date

In Group Security > F3 Login Times > F7 Login Times, the date field did not accept
entry of "T" to fill in today's date in a grid. An enhancement now supports the "T"
entry in this date field, making the functionality the same as in other date fields
throughout SB.

11642*USA Clicking when Splash Screen Is Displayed Causes Rich Client to Fail

Clicking on another application while the SB/XA splash screen is displayed
in SB/XA Rich Client sometimes causes the client to fail. This problem is due
to a known defect in the Microsoft .NET Framework 3.5 Service Pack 1. The
workaround is for users to be aware of the problem and avoid clicking the mouse
button while the splash screen is displayed.

11675*USA Screen Position/Size Remembered with 'Center GUI Screens' Off

If you repositioned or resized a screen in XUI mode and the USER.FLAGS > F6 GUI
Prefs > Center GUI Screens option was turned off, SB/XA Browser Client and SB/
XA Rich Client did not remember the new position or size of the screen the next
time you opened it. This has been fixed in version 6.0.2 so that if the Center GUI
Screens option is turned off, the position and size of the screen are remembered.
Note that if the Center GUI Screens option is turned on, the last position of the
screen is not remembered.

11832*USA TU.TO.EXCEL Works with Non-English Versions of Microsoft Excel

In previous versions, TU.TO.EXCEL did not function with non- English versions
of Microsoft Excel. Support has been added in version 6.0.2 for SBClient only
as follows: If you use more than one language version of Excel, you can create
a version of EXCEL.MACRO for each language (such as EXCEL.MACRO.FR or
EXCEL.MACRO.SP) and store it in TUDEFN. TU.TO.EXCEL will then select the
required version of the EXCEL.MACRO. Note that SB/XA Browser Client and SB/XA
Rich Client do not yet provide support for Microsoft Office products.

11849*USA TU.IMAGE Successfully Displays Image from Action Bar

Calling TU.IMAGE to display an image from an action bar resulted in a .NET error,
"Calling the Value property when there are more than 1 values in SbString is
invalid." This issue has been resolved in version 6.0.2 to successfully display an
image from an action bar.

11861*AUS Issue with Calls to SB.DISP.BOXTEXT Resolved

In version 6.0.1 and earlier, subroutine calls to SB.DISP.BOXTEXT produced the
error, "Index and length must refer to a location within the string. Parameter
name: length." A flaw in the code has been fixed to prevent this error. Note that
the first two parameters of SB.DISP.BOXTEXT are item ID and file handle. If the
item ID is one word, a file handle is required.

11922*USA Copies of GUI Screen Stack Correctly

In previous versions, when running the same process repeatedly to call a GUI
screen, copies of the screen did not stack correctly if the Self-contained Forms
parameter was disabled in /HK.CONTROL. This issue has been resolved so
that screens stack correctly regardless of whether the Self-contained Forms
parameter is enabled or disabled in /HK.CONTROL.

11967*USA Restriction on Position of Data in MV Fields with Side Prompt in GUI

In multivalued fields in a grid, if the display prompt is set to S (Side) and you
move the data area below the field label, the label is not displayed in GUI mode.
This is the expected behavior, due to way in which dimensions are set on rows
and labels in the GUI layout.
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11980*USA VOC Pointer for DMRESOURCES Created in Upgrades

In versions 6.0.0 and 6.0.1, the VOC pointer for DMRESOURCES was missing in
accounts that were upgraded from version 5.x or earlier. This issue has been
fixed so that accounts upgraded to version 6.0.2 contain the VOC pointer for
DMRESOURCES.

12023*USA Correction of Misspelling on Multiple Screens

The word 'Separator' was misspelled as 'Seperator' in the XUI Display Defaults
screen, /HK.CONTROL, and /SB.PARMS. This has been corrected in version 6.0.2.

12037*USA F2 and F4 Corrected to Work as Designed in Output Screens

When creating a screen, the F2 (Save) and F4 (Del) buttons are included by
default. These buttons did not work in output screens from the /PD.O process,
and if the buttons were removed and replaced by other buttons, the new buttons
did not display correctly or work as intended. In version 6.0.2, the F2 button is
replaced with an OK button, the F4 button is grayed out (unavailable), and any
other buttons added to output screens work correctly.

12043*USA Fix for Navigation Issues in Output Screens with a Grid

The Page Up/Page Down keys and Prev/Next buttons on /PD.O output screens
were handled differently in XUI clients than they were in GUI mode in SBClient.
In version 6.0.2, the behavior in XUI mode is consistent with that of GUI mode
in SBClient, as follows: Page Up/Page Down keys do not work in output screens
in any mode because it is not possible to place focus on the field. Prev/Next
buttons are displayed in output screens in GUI mode only if the G option is
enabled. XUI mode always uses a grid and works the same as grids in GUI mode:
Prev and Next buttons are not displayed on output screens that use a grid.

12045*USA Data Reloaded Properly After Using Scroll Bar in Output Screen

When you used the scroll bar in a /PD.O output screen in GUI mode, the data was
not reloaded correctly in version 6.0.1. This issue has been corrected in version
6.0.2.

12046*AUS Toolbar Images Downloaded Only at Logon

In version 6.0.1, toolbar images were downloaded each time the user logged
on. This occurred when a toolbar, such as WINTB, was set to load from a menu
definition, such as SBMENU. This issue has been fixed in version 6.0.2 so toolbar
images are downloaded only the first time the user logs on.

12055*USA Flag for Displaying 'Call SB Process' Button

In version 6.0.1, the Call SB Process button was displayed in XPS reports when
the 'Inhibit /Process calls' option was enabled. To address this issue, the flag
named SBUserStatus has been added in /SEC.USER.SETUP. If the flag is set to
D (Developer), the Call SB Process button is enabled; otherwise, the button is
disabled.

12069*AUS SB.DISP String with '<' or '>' No Longer Results in Error

In version 6.0.1, using SB.DISP to display a string that contained the '<' or '>'
character produced an error. A code fix corrects this problem in version 6.0.2 so
strings containing the '<' or '>' character can be displayed without error.

12080*AUS SETATTR Sets Background Color of Grid Column without XUI Error

If you used SETATTR to set the background color of a grid column in a form,
the form caused SB/XA Browser Client and SB/XA Rich Client to fail. A code fix
prevents this problem in the XUI clients in version 6.0.2.
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12081*AUS DISP 9 Messages Display Properly

In version 6.0.1, DISP 9 messages sent to the status bar were obscured by SB/XA
messages displayed on the same line. In version 6.0.2, DISP 9 internal messages
are no longer sent to the status bar, so SB/XA messages are displayed on the
status bar with no interference.

12094*AUS Correction to Spelling Checker Style

The spelling checker SBFieldWithSpellCheckStyle did not work in multivalued
fields in version 6.0.1. A code fix enables spell check display when the field is in
edit mode in version 6.0.2.

12119*USA PRINT.BMP Bitmap Included in DMRESOURCES

The bitmap PRINT.BMP used by the WINTB toolbar was missing from
DMRESOURCES in version 6.0.1. This bitmap has been added to DMRESOURCES
in version 6.0.2.

12122*UK DOS File Transfer No Longer Inserts Blank Lines

When passing data to a Windows application via DOS file transfer in versions
5.4.2 and later, blank lines were inserted in the resulting file. A code fix resolves
this problem in version 6.0.2.

12151*USA Updates to Style Tag Templates

The Style_Tag_Templates_GA2.txt item in the XATHEMES file has been updated
with information on styling the SBForm object.

12169*USA Fix to Display of Multivalued Fields in Input and Output Screens

When a Char screen was converted to GUI, data in multivalued fields on the right
side of the form was not displayed correctly in the XUI clients. On input screens,
data in multivalued fields on the right side of the form was truncated. On output
screens, data in multivalued fields on the right side of the form was displayed
below the buttons. This issue has been resolved in version 6.0.2 so the data in
multivalued fields displays correctly in XUI mode.

12170*AUS Cleanup of 3D Grid Example

Various issues with the 3D grid example in the XAML Examples (XA) application of
the SBDEMO account have been cleaned up in version 6.0.2.

12180*USA Display of Connect to Application Dialog Box Suppressed

If the user had set up only one application, the Connect to Application dialog
box was presented during single sign-on in the XUI clients, requiring the user to
select the application from a drop-down list. In this same situation in version
6.0.2, single sign-on connects to the application without displaying the Connect
to Application dialog box.

12198*USA Scroll Bars Added in SB/XA Browser Client Window

Forms were truncated in SB/XA Browser Client if the screen resolution was
small (for example, 800 by 600 pixels). In version 6.0.2, vertical and horizontal
scroll bars have been added if the form is not completely visible in the browser
window.

12233*USA Fix to Center GUI Screens

If the /USER.FLAGS > F6 GUI Prefs > Center GUI Screens option was turned off,
screens appeared outside the border of the client window in the XUI clients.
Fixes to correct a resizing problem and an issue with the screen window not
being positioned relative to the main window resolve this issue in version 6.0.2.
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12249*USA Enhancement Provides Ability to Style Scroll Bars

Version 6.0.1 did not provide the ability to style a scroll bar. Version 6.0.2
supports this functionality, allowing you apply a XAML style to a scroll bar. For
information on styling scroll bars in SB/XA, please see tech note SBXA-15 at
https://u2tc.rocketsoftware.com > U2 Knowledge Base.

12254*USA Correction of Heading Line Wrap

In some cases, the heading line wrapped incorrectly in interleaved multivalue
grids displayed in the XUI clients in version 6.0.1. This issue has been corrected in
version 6.0.2.

12266*USA Custom Theme Displays Graphic on Fields with Intuitive Help

When using a custom theme that was designed to display a graphic on fields
with F3 help available, the graphic did not display on fields in an interleaved
multivalue grid. A fix to set the HasIntuitiveHelp property correctly for grid fields
resolves this issue in version 6.0.2.

12268*USA Screen Flashing Issue Resolved

In some cases when users pressed F3 to get help on a field, the screen flashed
before the F3 help content was displayed. This problem has been addressed and
no longer occurs in version 6.0.2.

12315*USA Background Stretches Along with MPX Menu

If the user stretched the MPX menu by dragging the black bar at the side of the
menu, the white background did not stretch with the menu. A code change
resolves this problem in 6.0.2 so the background now extends along with the
MPX menu.

12354*USA Fix Prevents SB.GEN.DRIV.I from Overwriting Records

If the Multilanguage option was on and a driver record did not exist, records
were overwritten in subroutine calls from SB.GEN.DRIV.I. This issue has been
resolved in version 6.0.2.

12369*USA Secondary Function Keys Placed on Separate Line of Grid

In converting the column and row coordinates of a character screen to a XAML
grid, the secondary function keys were placed on the same line as the primary
function keys. The code has been fixed in version 6.0.2 so the secondary function
keys are placed on a separate line.

12370*USA Field Validation in Form Metadata

With this enhancement, field validation information has been added to form
metadata. Mandatory fields can be identified by interrogating the value of
the Mandatory flag in the screen definition, so these fields can be displayed
differently to indicate that data is required.

12371*USA Current Tab Repainted Properly

If the user pressed F3 to select data on a tabbed screen in the XUI clients, SB/XA
first displayed tab 1 before repainting the current tab. A code change fixes this
problem in version 6.0.2 so the current tab is repainted after pressing F3.
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12373*USA GUI Tabbed Screen Position Remembered with 'Center GUI Screens' Off

If you moved a GUI tabbed screen and the USER.FLAGS > F6 GUI Prefs > Center
GUI Screens option was turned off, the form did not remember its new position
the next time you opened it. This has been fixed in version 6.0.2 so if the Center
GUI Screens option is off, the tabbed screen opens in its new position. Note that
if the Center GUI Screens option is turned on, the last position of the tabbed
screen is not remembered.

12384*USA SETATTR Supports New Syntax for G.DRAWABLE Attribute

In version 6.0.1, using SETATTR to set the G.DRAWABLE attribute did not work to
hide a XUI grid column. SETATTR supports the following two syntaxes to hide a
XUI grid column in version 6.0.2:

SETATTR("[fieldName]", G.DRAWABLE, VAL)
or
SETATTR("[fieldName]*label", G.DRAWABLE, VAL)

12390*USA INVOKE.TEXT.ED Issues Resolved

Two problems arose in INVOKE.TEXT.ED in XUI mode in version 6.0.1: (1) All
content in a field was highlighted when the field was in focus, so typing any value
overwrote the existing data, and (2) The text box was not sized correctly if the
screen was converted from character mode. These issues have been resolved in
version 6.0.2 so the cursor is placed in the field in focus without highlighting the
entire content and the text box is sized to the correct dimensions.

12397*USA Password Rollover Expression Field Moved in Login Times

The behavior of the Password Rollover Expression field in Group Security > F3
Login Times > F7 Login Times was confusing to users in versions 5.4.2 and later.
When the user first opens the screen, the field is blank if a date setting was not
saved previously. When the cursor is positioned in the field, if the value was
null, SB displays a suggested default date expression. This behavior works as
designed. However, the field has been moved from the first field on the screen to
the last so it will be more apparent that the field is blank initially, and a default
setting is displayed when the cursor advances into the field.

12401*USA Fix Enables Multiple Column Dividers in Grids

Version 6.0.1 did not provide the ability to insert more than one column divider
in a grid. This issue has been fixed in version 6.0.2 so that multiple column
dividers can be inserted in a grid.

12406*USA Metadata Populated on FieldDefinition

The properties HasIntuitiveHelp, IntuitiveHelp, MandatoryField, and Validation
were not populated in grid fields in version 6.0.1. This metadata is populated
correctly on FieldDefinition in grids in version 6.0.2.

12409*USA Application Name Combo Box Resized to Fit

In version 6.0.1, the Application Name combo box was too long to fit in the
Connect to Application dialog box on Windows 7 and Windows Vista operating
systems. This issue has been corrected in version 6.0.2.

12410*USA Intuitive Help Implemented in Screens Converted from Char to GUI

F1 intuitive help did not work in screens that were converted from character
column and row layout to XUI. A fix has been implemented in version 6.0.2 so F1
help works correctly in the XUI screens.
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12413*USA Changing Theme in Grid Display No Longer Causes Client to Fail

Changing the theme when a grid was currently displayed on a form caused the
client to fail. This issue has been resolved in version 6.0.2.

12415*USA SETATTR Changes Grid Background Properties Correctly

If you did not set the background properties with SETATTR on the first page
of data in a grid, but did so on subsequent pages, SETATTR did not take effect
on subsequent pages. In addition, the display properties of grid rows on which
background properties had been set changed as the user scrolled through the
grid. A code fix to SETATTR corrects these problems in version 6.0.2 so changes
to background properties work correctly in grids.

12416*USA Correction of Issues with Type 1 Menus

Type 1 menus called from a screen did not close after selecting a menu option,
and focus was not returned to the menu if the screen was closed. The Esc key did
not close the menu, and the user had to close the application. These issues with
type 1 menus have been fixed in version 6.0.2.

12418*USA MCU[I Conversion Issue Resolved

The MCU[I conversion did not work for input fields on tabbed screens displayed
in XUI mode in version 6.0.1. A fix corrects this issue so the conversion works
correctly in version 6.0.2.

12423*USA 'Deselect Before Int. Help' Flag Fixed

In /USER.FLAGS > F6-GUI Prefs, if the user's preference on the Deselect Before
Int. Help flag was set to Yes, existing data in fields was not unselected before
invoking F3 intuitive help. This issue has been addressed so that with this flag set
to Yes, the existing data in the field is unselected as expected before F3 help is
displayed.

12427*USA New Process After Slots

The subroutine in the Process After Tool Read slot was not being called from
the Screen Editor or the XAML editor tool in a customer's application in version
6.0.1. To address this issue, a Process After SE/XE Read slot has been added
in the Additional System Parameters screen of the System Control Record (/
HK.CONTROL > F5-Additional). This new process slot works like Process After
Tool Read, but for the screen editor and XAML editor tools. A similar new process
slot, Process After SE/XE Write, has also been added.

12452*USA Fix Enables Changing Password in GUI and XUI Clients

Entering Autologin and New Pwd Next Login settings in User Security Setup (/
SEC.USER.SETUP) in SBClient and then logging on to SB/XA Browser Client or SB/
XA Rich Client caused problems with changing the password in the XUI clients in
certain cases. The code has been revised to enable changing the password in any
client.

12455*USA Adjustments to Width of Column in XUI Mode

After using column and row layout to convert a character form to XUI, if a column
heading in the character form was longer than the data in the column, the
column heading did not display correctly in XUI mode. This problem has been
corrected in version 6.0.2, so the width of a column is the longer of the heading
or the data.
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12456*USA Combo Boxes Display Conversion

In XUI mode, combo boxes with a conversion were initially displayed as empty,
rather than show the code concatenated with the description as in character and
GUI modes. The code has been changed so the conversion in the combo box is
displayed correctly in all modes.

12475*USA Issue with Output Screen Driver Corrected

With the Multilanguage option on, the @RECORD was corrupted the first time the
screen was displayed. A fix to the _SB.GEN.DRIV.O corrects a problem with the
output screen driver in version 6.0.2.

12489*AUS Speedbars Displayed after Loading New Theme

In version 6.0.1, a customized speedbar, such as a toolbar with the x and y start
positions set to 0, was not displayed after a new theme was loaded. The code
has been revised to resolve this issue in version 6.0.2, and customized speedbars
are displayed as expected.

12492*USA INVOKE.TEXT.ED Fixed to Save Changes in MV Fields

If the user changed data in a multivalued field that calls the INVOKE.TEXT.ED
process and then pressed F2 to save, all changes were saved except those in the
multivalued field. The code has been fixed in version 6.0.2 to save changes in
multivalued fields that use INVOKE.TEXT.ED along with all others.

12493*USA Multiple Combo Boxes Allowed in Grid

The presence of more than one combo box in a grid caused the client to fail in
version 6.0.1. A fix for the related problem reported in 12519*USA also corrected
this issue in version 6.0.2.

12495*USA Correction to Icons for Information and Error Messages

The icons for information and error messages were swapped in version 6.0.1.
This issue has been corrected in version 6.0.2 so an "i" in a blue box is displayed
for information messages and an "!" in a yellow triangle is displayed for error
messages, as designed.

12519*USA Combo Box Supported in Grids in XUI Mode

In version 6.0.1, screens with a combo box in a grid caused the XUI clients to fail
in version 6.0.1. This issue has been fixed.

12522*USA @RECORD Set Correctly on Running QRD Report with Input Screen Active

On UniVerse only, if you ran a QRD report while an input screen was active
in character or XUI mode, the @RECORD value was set to '0' after the report
finished running. A fix resolves this issue in version 6.0.2.

12540*USA Problem with Printer Selection Resolved

If the user has defined multiple printers, a printer selection dialog box prompts
the user to select a printer when logging on to SB/XA. In GUI or XUI mode, if the
user entered "*" or pressed F3 to display a list of printers, the printer selection
dialog box closed and the Connect to Application dialog box was redisplayed.
The only way to select a printer was to type the printer name and press Enter.
This issue has been resolved in version 6.0.2 so the user can select a printer by
any of these methods.
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12542*USA Screens with Grid Display Issues Are Now Generated from GUI Forms

In certain SBDEMO forms and other forms converted from character column and
row layout to XUI, if a multivalued data set had a window size of 1, the grid did
not display correctly in the XUI clients. In version 6.0.2, the Link Char and GUI
Field Positions flag for these forms has been reset so the XUI screen is generated
from the GUI form rather than the character form.

12544*USA Header Displays Correctly in Interleaved Grid

If an interleaved multivalue grid had a field that was not included on the first line
of the grid, the size of the grid header was increased and covered up fields above
the grid. The XAML code for grid display has been corrected in version 6.0.2 so
the header displays normally.

12548*USA Fix to Prevent Error on MCU[I Conversion in Memo Field

If the MCU[I conversion was included in a memo field, SB/XA produced the
following error if the user entered more than one line of data in the memo field:
"SB.String.AddValuesFromByteArray trying to copy 5 bytes from an array 1 bytes
long, starting at 0." The code has been amended to prevent this error in version
6.0.2.

12558*USA Record in OTHER(2) Cleared Before Secondary File Update

In the /PD.F (periodic file update) process, OTHER(2) contains the record to be
written on a secondary file update. The file update process was not clearing
OTHER(2) for a new record before updating the secondary file. A fix corrects
this problem in version 6.0.2 so the record in OTHER(2) is cleared before the
secondary file is updated.

12582*USA SB Common Variables Populated in @RECORD of /TH.C Log

When the /TH.C (Compile Theme) process is invoked, it calls the GLOBAL.LOG
process or another defined log process for revision tracking. In version 6.0.1, the
SB common variables were not visible when performing debugging in /TH.C. The
code has been revised in version 6.0.2 so that when /TH.C is invoked and a log
process has been defined, the parameters that have been passed to /TH.C are
populated in @RECORD.

12584*USA F3 Intuitive Help on Process Names Implemented in GUI and XUI Modes

Using the /REGEN.GUI process in character mode, if you typed a partial name in
the PROCESSES field and pressed F3 for intuitive help, all processes containing
the specified string were listed. This same functionality was not supported in
GUI or XUI mode in version 6.0.1. Two new methods have been implemented
in version 6.0.2 to provide F3 intuitive help on process names in GUI and XUI
modes.

12588*USA GLOBAL.LOG Requires Version Number in /HK.CONTROL

When running the /TH.C process in SB/XA Browser Client or SB/XA Rich Client,
the GLOBAL.LOG process was executed even if the version number was not
set in the System Control Record (/HK.CONTROL). A correction to the logic has
been made, so GLOBAL.LOG is not executed if there is no version number in /
HK.CONTROL.

12604*USA XAML Style on Button Saved in XUI Screen Definition

If you added XAML style on buttons in Screen Defn > F7-Function keys > F6-XUI
and saved the screen definition, the XAML style entered for the button was not
saved. This defect has been fixed in version 6.0.2.
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12608*USA Display Property Applied to All Objects Subject to SETATTR Call

When the emphasis property was set on multiple buttons with one call to
SETATTR, emphasis was applied only on the last button when the form was
displayed in the XUI clients. The code has been corrected in version 6.0.2 so the
display property is applied to all objects subject to the SETATTR call.

12612*AUS Fix Prevents Nonnumeric and Array Index Errors in Linked Screens

In previous versions, linked screens with REFRESH set to -2 and a process
defined in the Process Before Screen slot produced "Nonnumeric data when
numeric required" and "Array index out of bounds" errors. A fix has been made
to prevent occurrence of these errors in version 6.0.2.

12614*USA Field Widths Corrected for Selection Processes in XUI Clients

Selection process (/PD.S) window coordinates and field width parameters
were not applied correctly in XUI mode. For example, a selection defined with
columns of varying widths displayed correctly in GUI mode, with each column at
its specified width. However, the same selection displayed with all columns of
equal width in XUI mode. With a code fix in version 6.0.2, fields are displayed at
their correct widths in XUI mode.

12615*USA /PD.S "by-exp" Option X Displays All Available Rows in XUI

In a selection process (/PD.S) that uses by-exp option X, the screen displayed
all available rows in character and GUI modes, but only one row in XUI mode.
Version 6.0.2 corrects this problem, and the screen now displays all available
rows in XUI mode, as expected.

12624*USA Available Themes Saved in Account Update

If the user entered available themes in /UPDATE.ACCOUNT > F7-XUI and saved
changes to the account, the specified theme names were not saved. A fix has
been made to resolve this problem in version 6.0.2.

12626*AUS /REGEN.EXP Processes Expressions Defined in /PD.R > F5-HTML

In version 6.0.1, /REGEN.EXP did not process expressions that were defined in
Report Process Definitions /PD.R > F5-HTML. With a code fix in version 6.0.2, /
REGEN.EXP processes expressions defined in this manner as expected.

12629*USA Print Job Starts on Sending Report to Printer in XUI Clients

When attempting to print a report to the host printer in XUI mode, the report did
not print until the user exited from SB/XA Browser Client or SB/XA Rich Client.
This issue has been addressed in version 6.0.2 so the print job starts when the
report is sent to the printer, rather than after closing the XUI client.

12634*USA Background Output Process Amended

In previous versions, if the user ran a Report Writer report with the output set to
B (Background) and the Display Print Select option set to N, the output process
was unresponsive and the user had to cancel the batch job from the command
line. Changes to the background output process resolve this issue in version
6.0.2.

12638*USA Themes in DMSYSDEFN Tagged with Revision Control Information

When using /THEME.DEFN, theme records in DMSYSDEFN were not updated with
revision control information in version 6.0.1. The code has been amended in
version 6.0.2 to tag themes in DMSYSDEFN with revision control information.
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12645*USA Function Keys Displayed in Specified Orientation

In the XUI clients, function keys were always displayed horizontally across the
bottom of screens even if the Function Key Placement option was set to Vertical.
Revisions to the code correct this issue in version 6.0.2 so function keys are
displayed in the orientation specified by the Function Key Placement setting.

12652*USA XUI Grids Provide Blank Row

Clicking in a grid creates a new empty row in GUI mode, but not in XUI mode. In
version 6.0.2, the grid has been improved for the XUI clients so it always contains
at least one blank row, and there is no need to click the mouse to create an
empty row in XUI mode.

12653*USA Function Key Labels with Apostrophe Display Properly in XUI Mode

If you created a named function key set in /FKEY.DEFN with at least three
functions and the XAML style for one of the function keys contained an
apostrophe ('), the XAML code was displayed on the function key when viewing
the form in SB/XA Browser Client or SB/XA Rich Client. The code has been fixed in
version 6.0.2 to display function key labels correctly in XUI mode when the XAML
style contains an apostrophe.

12667*USA Values Display in Combo Boxes with Conversion Code and Validation

Combo boxes did not display values if there was a conversion code as well as a
validation on the field. This issue has been corrected in version 6.0.2 so values
display in combo boxes under these conditions, as expected.

12678*UK Fix to Return Correct Values in Right-Justified /PD.S Grid Fields

In previous versions, right-justified grid fields in /PD.S forms returned incorrect
values for some numbers in GUI mode. The grid internal type for the affected
numbers has been changed from dttSingleFloat (132) to dttDoubleFloat (133) to
resolve this problem in version 6.0.2.

12679*USA SETATTR on Fields in Interleaved Grids No Longer Triggers Error

If you used SETATTR to set the attributes on a field in an interleaved multivalue
grid, the screen produced an error when it was displayed in the XUI clients. A fix
prevents this error in version 6.0.2.

12708*USA XPS Viewer Fixed for UniData on UNIX Platform

When users sent reports to the XPS printer in the UniData edition on UNIX, the
XPS Viewer did not appear. This problem has been resolved in version 6.0.2.

12717*USA Fix for Combo Box Causing Grid Failure in Converted Forms

In interleaved multivalue grids converted from a character mode form, selecting
a value in a combo box and then pressing Tab or Enter to leave the field caused
the grid to fail. A code fix has been implemented to correct this problem in
version 6.0.2.

12742*USA Behavior of TU.CHECK.DIRECTORY Corrected in XUI Mode

TU.CHECK.DIRECTORY behaved differently in XUI mode than in GUI and
character modes when the path ended in a backslash (\) character. The code
has been amended in version 6.0.2 so that when the path ends with a "\", the
paragraph returns 1 (directory does not exist) in all modes.
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12755*USA New Style for Interleaved Grid Not Converted from Character Form

The SBXCharacterInterleavedGridViewStyle checks the form's conversion
flag and works only in interleaved multivalue grids that were converted
from a character-based form. A new standard XAML style named
SBXCharLayoutGridViewStyle is available in version 6.0.2. This style can be
applied to the controlling multivalue field in a grid or in the System Control
Record (/HK.CONTROL) in the CardView slot. With this style, the interleaved grid
is laid out using the character layout methodology, regardless of whether the
form's conversion code is set to C (character) or G (GUI).

12778*USA Changes Fix Navigation in Non-Grid Interleaved MV Sets

Navigation of non-grid interleaved multivalue sets in subscreens of input screens
with an Output option did not work correctly in character or GUI mode in version
6.0.1. Users got unexpected results when navigating with the Down Arrow,
Page Down, and Enter keys. Changes to the input screen drivers correct these
navigation issues in version 6.0.2.

12808*USA Initial Value Displayed in SB Instance 'Default Fail Value' Field

In the SB Instance Setup screen (/SBINSTANCE.SETUP), a value is required in the
Default Fail Value field, but the field was initially blank on opening the screen. It
did not display a value until the cursor advanced to that field. The Default Fail
Value is the decimal value for the ASCII character to store in the database for
any unrecognized character entered. In version 6.0.2, the field initially displays
the default decimal value of 63, for the ASCII character "?", on opening the SB
Instance Setup screen.

12813*USA Line Break Character Interpreted Correctly in XUI Clients

In a selection process (/PD.S), if a column heading contained the right square
bracket character "]" to insert a line break in the heading, the data in that
column was not displayed in XUI mode. The code has been fixed in version 6.0.2
so the right square bracket no longer causes a display problem in the XUI clients.

12814*AUS Forward Search Fixed in F3 Help

In F3 help, the F6-Forward search function did not work correctly to find hits in
large result sets in the XUI clients. This issue has been resolved in version 6.0.2.

12815*AUS Problem with Font Size in XPS Reports Is Resolved

If you used F9 - Effects > F (Fonts) to set the font size in a report section, ran the
report in SB/XA Browser Client or SB/XA Rich Client, and printed the report to
a printer via the XPS Viewer, the affected section of the report was not legible.
A fix to the XPS printer driver resolves this display issue in version 6.0.2 for new
installs. Existing customers who have performed an upgrade from 6.0.0 or 6.0.1
should remove "Family = SB Font" if present in XPS.CLASS.

12820*USA Recompiling/Recataloging Programs After 5.x to 6.x Upgrade

When upgrading from SB version 5.x to SB/XA version 6.x, it is necessary to
recompile and recatalog all UniBasic or UniVerse BASIC programs and run /
REGEN.EXP to regenerate expressions on all accounts. For detailed information,
please see the following tech note:

https://u2tc.rocketsoftware.com/documentation/PDF/1410003.pdf

https://u2tc.rocketsoftware.com/documentation/PDF/1410003.pdf
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12821*USA Disabling Third-Party Revision Tracking Tools during Upgrades

If you are using a third-party revision tracking tool (such as PRC from SJ+
Systems Assoc., Inc.) that integrates into SB/XA, the tool must be turned off/
disabled in accounts that you intend to upgrade. Please contact your revision
tracking software vendor for instructions on how to disable/uninstall the
revision tracking tool before an account upgrade, and then enable/reinstall
the tool after the account upgrade. Note that you may have to upgrade the
third-party product for SB/XA; to avoid installation and upgrade failures, please
consult your vendor before proceeding.

12824*USA Value of FT.TRIGGER in TU.CONFIG

In SBClient 6.0.1 in GUI mode, the Logto Another Account screen (/LOGTO),
System Control Record (/HK.CONTROL), and other screens were displayed in
character mode. A code fix corrects this problem in version 6.0.2.

12833*USA SB.DISP Calls to Proc After Display Slot Run As Expected

If SB.DISP calls a process in the Proc After Display slot of the SBSYSMENU, the
process is run. In the XUI clients in version 6.0.1, if the user called SB.DISP,
the Connect to Application dialog box was displayed. A code fix prevents
this problem in version 6.0.2, and running a process no longer results in this
unexpected behavior.

12841*AUS Ability to Select Auxiliary Printer in XUI Clients

In versions 6.0.0 and 6.0.1, there was no way to direct output to the auxiliary
printer of choice in the XUI clients. As of version 6.0.2, SB/XA supports the
same TU.SELECT.PRINTER functionality that is available in SBClient. The
selected auxiliary printer, which may be the XPS printer, is recognized by
TU.SEND.TO.PRINTER, Report Writer, and QRD reports.

12855*USA Fix Prevents Uninitialized Variable Error with COMO OFF

When running a paragraph process (/PD.P) with a Basic subroutine that executed
COMO OFF, the XUI clients returned an uninitialized variable error. A code fix
prevents this error in version 6.0.2.

12861*USA F Type Validation Must Include Third Parameter

In version 6.0.2, the "Validation Code" field in Field Definitions (/FD) no longer
allows entry of "Key on Another File" (F type) validation syntax that does not
include all three parameters.

F:FileName,FieldName{Error Message} is not a valid syntax.

The third parameter for "Must Exist (Y/N/A)" is required.

F:FileName,FieldName,Y{Error Message} is a valid syntax.
12885*USA /RELEASE.LICENSE Process Fixed

Corrections have been made to the /RELEASE.LICENSE process to correctly
release inactive user IDs in version 6.0.2.

12910*AUS Output File Name for HTML Reports

In version 6.0.1, it was not possible to specify the output file name as an
expression in HTML report parameters. The Report Writer parameters have
been amended so they now support the ability to specify a literal value or an
expression as the output file name.
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12911*AUS Fix for Display Issue in Interleaved Multivalue Grids

If the user appended a line to a controlling multivalue field with no dependent
fields, saved the record and immediately re-read the record, the newly entered
value was not displayed in the correct position, so it appeared as though the
data was corrupted. In fact, this was only a display issue; if the user closed the
form and then re-read the record, the value appeared in the correct position.
This multivalue display issue has been resolved in version 6.0.2.

12913*AUS Issue with Opening Combo Boxes in SB/XA Browser Client Is Resolved

In version 6.0.1, users were unable to open combo boxes in SB/XA Browser Client
when the browser was set in windows mode, where screens are stacked in the
display. This issue has been resolved.

12941*AUS Issue with Uploading GUI Default Sets Font Table Resolved

In version 6.0.1, the GUI Default Sets (GDS) font table failed to upload in SB/
XA Browser Client or SB/XA Rich Client, and an error message dialog box was
displayed. A code fix corrects this issue in version 6.0.2 so that when users
attempt to upload the GDS font table in the XUI clients, SB/XA displays an
informational message, "This option only applies to terminal definitions with
GUI mode enabled."

34103*USA,
40924*USA

HTML Check Box Available for Ask Option

Previous versions did not support the ability to set the output device for an HTML
report at run time when the Output Device setting was A (Ask). An HTML check
box has been added to the output destination dialog box that is displayed for the
Ask option when the report is run on GUI and XUI clients.

36712*USA Global Themes Prompt Added in /HK.CONTROL

Versions 6.0.0 and 6.0.1 did not offer the ability to specify global themes in the
System Control Record (/HK.CONTROL). A Global Themes prompt has been
added in /HK.CONTROL and /SB.PARMS to specify theme files to be used as the
system's global themes in version 6.0.2. If the /TH.C or /TH.I process attempts
to download or compile a theme and does not find the theme in xxTHEMES, the
process now checks the theme files specified in Global Themes in /HK.CONTROL.

37240*USA Fixes to Tag/Untag Functions

The Tag, Untag, Tag All, and Untag All functions could not be selected from
the menu or from an F3 lookup, or by pressing the associated function key in
GUI or XUI mode in version 6.0.0 or later. In addition, Tag All tagged all fields,
rather than all records, on the line in focus. These issues have been resolved in
version 6.0.2 so tagging and untagging functions work as designed in GUI and
XUI modes.

37504*USA Global Tag/Untag Options Are Back on Menu

In the SBDEMO Car Rental System in versions 6.0.0 and 6.0.1, the Tag menu listed
only four options: Tag, Untag, Tag All, and Untag All. It was missing the Global
Tag and Global Untag options. This issue has been fixed in version 6.0.2, and the
Tag menu again lists all six options, the same as in version 5.4.x.
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37694*USA New Utility to Export SBClient Settings

Existing customers who installed SBClient 6.0.1 or earlier may have session
configurations, scripts, phone books, toolbars, and Smart Query definitions that
can be used in SBClient 6.0.2 or later. To save settings from SBClient 6.0.1 or
earlier, you can export the settings to a file before installing SBClient 6.0.2 or
later. After installing the latest version of SBClient, you can then import the files
containing settings that you saved. For instructions, see Chapter 2, "Installing
SBClient on a Standalone PC," in SBClient Getting Started.

37766*USA Error on Conflicting Output Device and Allow HTML Settings

In Report Writer reports, the conflicting settings of Output Device = H and
Allow HTML = N did not produce an error in version 6.0.0 or later. Version 6.0.2
implements code to check these settings, and an error is displayed when the
settings are in conflict.

38407*USA Implementation of Hourglass Cursor

In SB/XA Browser Client and SB/XA Rich Client, the cursor was not displayed as
an hourglass when the server was busy, so the user could continue clicking on
objects and get no response. The hourglass cursor has been implemented to
correct this problem in version 6.0.2.

38539*USA Selection Control Style Field Added

SB/XA did not provide a means to style selection forms in versions 6.0.0 and
6.0.1. A Selection Control Style field has been added in the /SB.PARMS, /
UPDATE.ACCOUNT, /HK.CONTROL, and /PD.S > F6-Additional screens, allowing
users to specify a XAML style to be applied to selection forms at the SB instance,
account, system, and screen levels in version 6.0.2.

38542*USA Default Grid Style Field Added

There was no way to specify the default style for grids at the SB instance level,
account level, or system level in versions 6.0.0 and 6.0.1. A grid style field has
been added in the /SB.PARMS, /UPDATE.ACCOUNT, and /HK.CONTROL screens in
version 6.0.2, enabling you to set the default XAML style to be applied to grids at
each level.

38543*USA Default Dialog Box Style Field Added

SB/XA did not offer the ability to specify the default style for dialog boxes at the
SB instance level, account level, or system level in versions 6.0.0 and 6.0.1. A
dialog box style field has been added in /SB.PARMS, /UPDATE.ACCOUNT, and /
HK.CONTROL, giving users the ability to set the default XAML style to be applied
to dialog boxes at each level in version 6.0.2.

38566*USA Different Methodology for Locking Grids in XUI Mode

In XUI mode, double-clicking a column heading does not lock the column to
the grid, as is the case in GUI mode. The lock column feature is implemented
differently in XUI mode than in GUI mode. Users can lock a grid column in XUI
mode by right-clicking the column heading and selecting the Lock column
option from the context menu. This allows grids to employ the standard
functionality of double-clicking the column heading to change the sort order in
the column.

38803*USA Failure Prevented after Testing Connection without Saving Details

SB/XA Browser Client failed to start if the user previously accessed the SB/XA
Communication Server Connection dialog box in another session and tested the
connection, but did not save the details. The fix to a related issue corrects this
problem in version 6.0.2.
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38815*USA Change to Default Binding Method for SBValue

In the default XAML styles, the SBValue on SBControl has been changed so the
binding is TwoWay by default. This means that any bindings to SBValue need to
specify the path. For example, what was formerly

<Setter Property="SBValue" Value="{Binding}" />

should now be

<Setter Property="SBValue" Value ="{Binding Path=Content, 
 RelativeSource={RelativeSource TemplateParent}}" />

38824*USA F3 at Expression Prompt Opens Only Build Expression Window

When running the /EE (Evaluate Expression) process in SB/XA Rich Client,
pressing F3 once at the Expression prompt opened the Build Expression window
as expected, but also displayed the F3 intuitive help list of options to build the
expression. This issue has been fixed in version 6.0.2 so pressing F3 opens only
the Build Expression window.

38883*USA F3 Intuitive Help Disabled on OS User Id Field for UNIX/Linux

In the /SEC.USER.SETUP > F9-SS (Single Sign-on) screen, F3 intuitive help is not
applicable to the OS User Id field in UNIX/Linux operating environments, but
the F3 option was not disabled. The code has been amended so the F3 option
is disabled on the OS User Id field when running SB/XA Application Server on a
UNIX or Linux machine.

38927*USA Uninstall Option Prevents Unintentional Overwrites

The Windows uninstall program for SB/XA Application Server automatically
deleted the SBDEMO account folders SB and SB.DEFN. These folders contain
the DMSYSDEFN and DMSECURITY items, which the user may want to import
into a new installation. This issue has been addressed in version 6.0.2 as follows:
If an instance of SB/XA Application is installed on the machine, the Windows
installation program displays an extra screen that prompts the user to (a) install
another instance of SB/XA Application Server, or (b) upgrade or remove an
existing instance. This option prevents the existing SB and SB.DEFN folders from
being overwritten unintentionally.

38968*USA 5.4.x to 6.0.x Upgrades Display Success Message

On upgrading from the UniVerse Windows edition of SB+ Server 5.4.x to SB/
XA Application Server 6.0.x, the upgrade program did not display a successful
completion message. The code has been amended to display this message on
successful completion of upgrades to SB/XA Application Server version 6.0.2.

39049*USA Correction of Issue with Create Account Process

In the UniData Windows edition, version 6.0.1, the SB > Admin > Account > Create
Account process failed in character and GUI modes. A code fix resolves this issue
in version 6.0.2.

39182*USA Alignment of Branch History Report Summary Lines

In the UniData UNIX/AIX edition, the Car Rental System > Reports > Branch
History Report summary lines did not align correctly. This issue has been
resolved in version 6.0.2, so the summary lines are right-justified as designed.
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39217*AUS F3 Intuitive Help on FOR/NEXT Loop

A flaw in the NEXT logic prevented the ability to use F3 intuitive help to build a
FOR/NEXT loop within an IF/THEN/ELSE condition inside a paragraph in the XUI
clients. The code has been amended in version 6.0.2 so this functionality works
the same in XUI mode as in GUI mode.

39293*USA Delete Button Disabled on Enquiries Screens

The F4-Delete button was enabled on Enquiries screens in SBDEMO in the XUI
clients. A code fix corrects this problem in version 6.0.2, so the F4-Delete button
is grayed out (unavailable) in XUI mode, the same as in GUI mode.

39312*USA Error on Detailed System Usage Screen Prevented

When running the UniData edition on UNIX/AIX, the Car Rental System > SB+ >
Admin > Detailed System Usage screen returned an error message, "An error
occurred calling gui_ceo_events on type SBPlus. Failed to invoke the method
'gui_ceo_events" in the class 'SBPlus'." The fix to a related issue also corrected
this problem, and the error no longer occurs in version 6.0.2.

39356*USA Monthly Figures - SCALC5 Report Option Removed

The SBDEMO Car Rental System > Car Rental > Reports > Monthly Figures -
SCALC5 screen produced an error stating that /CALC is not a valid directory. The
Monthly Figures - SCALC5 report used a now-obsolete third-party product, so
this option has been removed from the Reports menu in version 6.0.2.

39357*USA Monthly Figures - Lotus Report Option Removed

The SBDEMO Car Rental System > Car Rental > Reports > Monthly Figures -
Lotus screen produced an error stating that /123R24 is not a valid directory. The
Monthly Figures - Lotus report also required extra setup to work correctly, so this
option has been removed from the Reports menu in version 6.0.2.

39380*USA Focus Retained After Pressing Alt Key

If the user pressed the Alt key on a menu in the XUI clients, the menu lost focus.
The code has been revised in version 6.0.2 so focus is retained on the menu after
pressing Alt.

39499*USA Support for Displaying Images in XPS Output

With this enhancement, version 6.0.2 provides the ability to display images in
reports output to screen using the XPS printer. As with images in HTML reports,
the image for an XPS report must be stored on the client machine.

39519*USA Spelling Changed to "License" in Reminder

The spelling has been changed from "licence" to "license" in the license
reminder window displayed when users log on to SB/XA before having entered
the license number for the product.

39674*USA Keyboard Buffering Issues Addressed

In version 6.0.1, the keyboard buffer did not work correctly in SB/XA Browser
Client and SB/XA Rich Client. Users reported problems with keystrokes being
lost, placed in the wrong field, or displayed in the wrong order. In some
cases, the keyboard locked or did not allow typing ahead of the display. A
comprehensive fix has been applied and tested to correct keyboard buffering
problems in the XUI clients in version 6.0.2.
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39882*USA Correction of File Pointer Issues After Account Upgrade

After upgrading an application account from version 5.4.2 to 6.0.1 in UniData or
UniVerse on Windows, users encountered file pointer errors when attempting
to log on to the account. The account upgrade process has been overhauled in
version 6.0.2 to address the issues described here.

39889*AUS Fix for Object Error in /GC Process

When running /GC to generate source code, if the user pressed F3 on Process
Name and selected all valid processes for all process types, SB/XA produced the
error "Object SBWIN_108_3*0*2 does not exist!" before data was populated in
the selection grid. The code has been amended to prevent this error in version
6.0.2.

39918*USA Initial Sys Id Field Populated with Current System ID

In the SB administration account Admin > Accounts > Update An Account screen,
if you entered the account name (such as SB or SBDEMO), the associated system
ID (such as SA or CH) was not displayed in the Initial Sys Id field. Version 6.0.2
correct this issue to populate the Initial Sys Id field with the current system ID
associated with the account.

39919*USA Width of 'Full Account Path' Field Increased

In the SB administration account, the Full Account Path field in the Admin >
Accounts > Update An Account screen was not wide enough to display the entire
default installation path for the SB or SBDEMO account in GUI or XUI mode. The
field length has been increased sufficiently in version 6.0.2 to display the entire
default path for these accounts.

39965*AUS F1 Help on Shell Statement

In /PD.SHL (Process Definitions - Shell Statements), F1 help was missing for
the Shell Statement(s) field in GUI mode in version 6.0.1. The F1 help text is
displayed on this field as designed in version 6.0.2.

40437*USA Presentation Components Installation Creates Shortcuts

The SB/XA Presentation Components installation program has been enhanced
in version 6.0.2 to install shortcuts to SB/XA Browser Client and SB/XA Rich Client
on the user's desktop. In addition, it adds shortcuts for the XUI clients in the
Start > All Programs > Rocket U2 program group.

40475*USA Improvements to Handling of Get and Set Attributes

Maintenance work has been done in version 6.0.2 to improve handling of Get
and Set attributes for the GUI and XUI clients. An attribute map is provided for
server to client attribute mapping, and existing properties on the client have
been converted into SBGUIAttribute attached properties.

40484*USA BulletChrome Tag Error Resolved

In the UniData edition running on Windows Vista, with all SB/XA components
installed on the same machine, the following error occurred when loading
XATheme: "The tag 'BulletChrome' does not exist in XML namespace." A fix
prevents this error in version 6.0.2.



SB/XA v6.0.2 release notes

157

Issue Number Description

40515*USA XATheme Definition Shipped with Product

In the SBDEMO XAML Examples (XA) system in version 6.0.1, the System Control
Record (/HK.CONTROL) populated XATheme as the default value for Available
Themes and Default Theme. However, the product was shipped without a
theme definition for XATheme, so the theme was invalid until the user ran /
THEME.DEFN to create the XATheme definition. Version 6.0.2 ships with the
XATheme definition; it is present in DMSYSDEFN.

40660*USA Correction to Car Rentals Models > F5-Prices

In SBDEMO Car Rentals System > Car Rental > Maintenance > Models, the F5-
Prices window displayed prices for the previous model code entered. Code for
the F5 function has been fixed in version 6.0.2 to display pricing for the specified
model code.

40696*USA Width of 'Use Native OE Index' Combo Box Increased

In /FD (Field Definitions) > Xref > Define Xref Fields, the Use Native OE Index
combo box was not wide enough to accommodate the default value "<none>".
The field width has been increased to display the values in their entirety in
version 6.0.2.

40715*USA Issues with TRANSLATE Process Resolved

In previous versions, the TRANSLATE process did not function correctly and
appeared to corrupt data if the Version number was not set for the application
in the System Control Record (/HK.CONTROL). This issue has been resolved in
version 6.0.2.

40763*USA Display of Image in Car Maintenance

In SBDEMO Car Rentals System > Car Rental > Maintenance > Cars (Car
Maintenance), the image called by F7-Image did not display correctly and the
dialog box froze. The image display has been fixed to prevent these problems in
version 6.0.2.

40776*USA 'IBM' Removed from Installation Program and Default Path

The installation program has been updated to remove IBM path names and
other IBM naming. Note that the default installation path has been changed from
C:\IBM\U2\SBXA to C:\U2\SBXA. The program group has been changed from IBM
U2 to Rocket U2.

40793*USA Fix Prevents Process Error in Enquiries Screen

In SB/XA Rich Client and SB/XA Browser Client, the Help menu on the SBDEMO
Car Rentals System > Car Rental > Enquiries screens returned the error "No
Process Found". Corrections have been made to the Enquiries Help menu so this
error no longer occurs in version 6.0.2.

40802*USA Installation Revised for 64-bit Operating Systems

In version 6.0.1, the SB/XA installation program failed for all three components
on Windows 7 64-bit operating systems. The installation program has been
revised and the three SB/XA components install without error on Windows 7 64-
bit machines in version 6.0.2.

40803*USA Code Revised to Prevent G-Option Grid Error

Displaying data in a G-option grid sometimes caused an error that repeated in a
loop in the GUI and XUI clients. The code for G-option grids has been amended
and this problem no longer occurs in version 6.0.2.
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Issue Number Description

40835*USA Code Pages 1251 and 1252 Added to F3 Intuitive Help

Code pages 1251 and 1252 have been added to the F3 intuitive help on the Code
Page field in the SB Instance Setup dialog box (/SBINSTANCE.SETUP).

40841*USA Combo Box Returns MV Data in All Modes

In a customer's application, a combo box returned data from a multivalued
selection in character mode, but not in GUI or XUI mode. The fix for a related
issue corrects this problem in version 6.0.2.

40843*USA List of Default Styles Standardized

The list of default styles has been standardized to contain all of the same styles
in /SB.PARMS, /UPDATE.ACCOUNT, and /HK.CONTROL screens.

40869*USA Memory Leak in SBDEMO Forms Addressed

Performance tests revealed a memory leak when displaying the I*CARS*S1 and
I*BRANCH*S1 forms. This problem has been corrected in version 6.0.2, and the
memory usage statistics have returned to normal levels in both forms.

40891*USA Insert and Delete Functions Fixed in Converted Forms

The Ctrl-INS and Ctrl-DEL functions did not work in grids on forms that were
converted from character column and row layout to XUI. The column and row
conversion has been fixed in version 6.0.2 so these functions work as expected in
XUI mode.

40914*USA Fix for Mandatory Field Exception

Setting the GuiObjectDefinition.FieldDefinition.MandatoryField property at run
time caused an exception. The XAML code for this property has been revised so
the property can be set at run time without error in version 6.0.2.

40915*USA Example for Setting Style on Grid Row

A XAML code example demonstrates how to set a style on a grid row. This
example is available in tech note SBXA-16 at https://u2tc.rocketsoftware.com >
U2 Knowledge Base.

40941*USA XAML Styles Applied to Individual Grids in Converted Forms

In forms converted from character column and row layout to XUI, using a XAML
style to set the width of a grid worked only on the last grid on the form, and that
style was applied to all other grids on the form. A fix corrects this problem so
XAML styles are applied to grids individually on forms converted from character
to XUI. Note that this fix does not extend to forms converted from GUI to XUI.

40942*USA ProcessName Property Displays Correctly

When generating a driver from /REGEN.GUI, the ProcessName property in
GuiObjectDefinition was incorrect. The process name for the XUI driver was
displayed as "REGEN.GUI" rather than the name of the process. This issue has
been resolved so the correct process name is displayed in version 6.0.2.

40943*USA Center GUI Screens Preference Now Applies to F1 Help

The user preference for centering GUI screens was not applied to the positioning
of F1 help in version 6.0.1. F1 help text was displayed at the lower right side of
the window even if the Center GUI Screens option was set to Y (Yes). The Center
GUI Screens preference is applied to positioning of F1 help in version 6.0.2.
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Issue Number Description

40945*USA F3 Intuitive Help Available on Global Themes File Slot

The Global Themes File slot in Additional System Parameters (/
HK.CONTROL.SYSTEM) was missing F3 intuitive help in version 6.0.1. This issue
has been corrected in version 6.0.2 and F3 intuitive help is called on this slot as
designed.

40952*USA Fix for Mouse Click Issues in Grid

Clicking in a grid on an output form prevented any further mouse clicks. A fix
resolves this problem in version 6.0.2.

40954*USA Correction of Data Display in /LICENSE.AMEND

In version 6.0.1, data was displayed in the wrong fields in the /LICENSE.AMEND
dialog box in character mode. This issue has been corrected in version 6.0.2.

40966*USA Data Populated in Display-Only Fields of Tabbed Forms Before Read

In tabbed forms containing a display-only field with a sequence number
preceding a data read step, data was not displayed in the field until after the
read. The problem has been resolved so data is populated in display-only fields
preceding the read.

40967*USA F1 Help on Windows ID Field Revised

The F1 help on the Windows ID field in User Security Setup (/SEC.USER.SETUP)
> F9-SS has been revised to clarify what to enter in this field. Windows identity
is the domain name or local name AND the user name entered when logging on
to the computer. If you need to verify the user's Windows identity, press Ctrl +
Alt + Delete. This opens the Windows Security screen, where Logon Information
displays the user's Windows identity.

40977*USA Grace Period Changed to 10 Days

At version 6.0.2, the grace period for entering license information and
authorizing the product has been changed to 10 days. Evaluation licenses can be
now be authorized for a period of 60 days.

40984*USA Security API Covers Single Sign-On

The security API has been extended in version 6.0.2 to cover single sign-on. The
API enables customers to create and update the records needed for single sign-
on programmatically. For details, look for the updated DeveloperZone article
regarding the security API.

40986*USA F2 Saves Changes in Language Translation Screen

If the user pressed F2 to save changes in the Language Translation screen,
changes to field definitions were not saved. The changes were saved if the user
pressed Esc to escape from this screen. This problem has been corrected in
version 6.0.2.

41008*USA,
41180*USA

Support for VBScript in XUI Clients

SB/XA Browser Client and SB/XA Rich Client have been enhanced to support
VBScript functionality in version 6.0.2. The SBDEMO XAML Examples (XA)
application now contains a VBScript example that demonstrates how a graph
program written in VBScript is displayed by Microsoft Excel. SB/XA supports all
the same functionality of the TUBP library that is available in SBClient except for
TU.SCRIPT.ADDOBJECT.
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Issue Number Description

41011*USA,
41117*USA

Namespace Changes in XAML Style Definitions

In version 6.0.2, "IBM.SBPlus" has been changed to "sbxa" in the namespace
in default XAML styles. To see the new namespace definitions in the default
XAML styles, open the DefaultStyles.xaml file in the \SBDEMO\XATHEMES
folder in the SB/XA installation directory. The default directory is C:
\U2\SBXA\ApplicationServer\UniData\SBDEMO\XATHEMES or C:\U2\SBXA
\ApplicationServer\UniVerse\SBDEMO\XATHEMES. You can use the screen
editor process to view the XAML code in this file by entering the following: /SE
XATHEMES DefaultStyles.xaml

If you wrote a custom XAML theme, you will need to update the namespace
definitions in the same way, substituting "sbxa" for all occurrences of
"IBM.SBPlus". Any references to "http://schemas.IBM.SBPLUS.com/
WPFControls" should be changed to "http://schemas.sbxa.com/WPFControls".

All occurrences of "xmlns:sbc", "xmlns:sbp", "xmlns:sbs", and "xmlns:sbs"
should be changed to "xmlns:sbc". For example:

xmlns:sbc="http://schemas.sbxa.com/WPFControls"
41014*USA MAPI Support for Email Messaging in XUI Clients

The same electronic mail functionality available in SBClient is now supported in
SB/XA Browser Client and SB/XA Rich Client. All clients use Microsoft's Messaging
Application Program Interface (MAPI). MAPI allows client programs to become
email messaging aware; it interfaces SB messaging- based services to Microsoft
Outlook. MAPI is built into SBClient, but it must be installed as a separate add-
on for the SB/XA Presentation Components. The MAPI installation program for
the XUI clients is shipped in the Install folder on the SB/XA product CD. Open the
SBXAMAPIBridge.msi file to run the installation wizard. The SB server routines in
the TUBP library have not been changed, so existing customer email programs
work in SB/XA Browser Client and SB/XA Rich Client without modification.

41055*USA Correction to 3D Grid Example

Displaying the 3D Grid example in the SBDEMO XAML Examples (XA) application
caused the XUI clients to fail. The XAML code for this example has been amended
so the 3D Grid example displays without error.

41123*USA User Security Setup Issue Corrected

If you saved a user record in the User Security Setup screen (/SEC.USER.SETUP)
and then opened the same user record again, the screen was unresponsive. A fix
to SEC.USER.SETUP resolves this issue in version 6.0.2.

41133*USA DEBUG Statement Fixed

When executing a BASIC DEBUG statement, the debug window failed. The
debugger code has been fixed in version 6.0.2 so the DEBUG statement runs
without causing this problem.

41134*USA Upgrade of Xceed DataGrid

SB/XA 6.0.2 has upgraded from version 3.0 to version 3.6 of the Xceed DataGrid
for Windows Presentation Foundation (WPF).

41268*USA F1 Help Implemented in SB Instance Setup

The SB Instance Setup (/SBINSTANCE.SETUP) screen did not provide F1 field-
level help. F1 help has been implemented on fields in this screen in version 6.0.2.
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41278*USA Hide Column Functionality Fixed

Specifying multiple column numbers or specifying the controlling multivalue
column in the SETATTR command did not work to hide columns of the grid in XUI
mode. A fix resolves this issue in version 6.0.2.

41280*USA Namespace Updated in Default XAML Styles

The SB/XA default XAML styles have been updated with changes to the
namespace definitions (see details under 41011*USA, 41117*USA above).
The updated DefaultStyles.xaml file is located in the \SBDEMO\XATHEMES
folder in the SB/XA installation directory. The default directory is C:
\U2\SBXA\ ApplicationServer\UniData\SBDEMO\XATHEMES or C:\U2\SBXA
\ApplicationServer\UniVerse\SBDEMO\XATHEMES. You can use the screen
editor process to view the XAML code in this file by entering /SE XATHEMES
DefaultStyles.xaml.

41337*USA Upgrade Process Reports Successful Completion

SA.TRANSFER.SBPLUS did not report when an upgrade to 6.0.x succeeded. The
upgrade process has been fixed to resolve this issue in version 6.0.2.

41345*USA Width of /FD Combo Boxes Increased

In /FD (Field Definitions), combo boxes were not wide enough to display the
entire value in GUI or XUI mode in version 6.0.1. This issue has been resolved in
version 6.0.2.

41366*USA Issue with Double-Clicking Toolbar Button Resolved

Double-clicking on a toolbar button caused SB/XA Rich Client to fail. This issue
has been corrected.

41406*USA Misspelling of SB.DISP Corrected

Corrections have been made to change SB.DSIP to SB.DISP in function calls in
SH.SEC.API.

41476*USA Spelling Changed to "License" in /LICENSE.AMEND

The spelling has been changed from "Licence" to "License" in the title bar of the
Amend License Details screen (/LICENSE.AMEND).

41539*USA Remove Prior Versions of SB/XA Presentation Components

The installation program for SB/XA Presentation Components does not work
correctly to upgrade previous versions of SB/XA Browser Client or SB/XA Rich
Client to version 6.0.2. You must uninstall the old versions of these components
from Control Panel > Add or Remove Programs before installing the SB/XA
Presentation Components from the SB/XA 6.0.2 product CD.

41687*USA /XE Tool Removed

The XUI Editor (/XE) tool was problematic in version 6.0.1, and it has been
removed from version 6.0.2. The Screen Editor (/SE) tool can be used instead.
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41795*USA Version 6.0.2 Exclusions and Limitations

Following is a list of exclusions for SB/XA 6.0.2:

Future functionality

Future releases of SB/XA include plans for the following features. These features
are not included SB/XA 6.0.2.

▪ .NET control integration (Planned for 6.0.4 release)

▪ ActiveX support (Planned for 6.0.4 as part of .NET control integration release)

▪ Integration with Microsoft Office (Planned for 6.0.3 release)

▪ Internationalization (Unicode) (Planned for 6.1 release)

▪ Graphs (Not currently planned)

▪ Matrix definitions (Not currently planned)

▪ SB Calculator (Not currently planned)

▪ Screen Designer (Planned for 6.1 release. Use SBClient 6.0.2 screen designer
with SB/XA 6.0.2)

▪ Report Designer (Use SBClient 6.0.2 screen designer with SB/XA 6.0.2)

Known limitations of SB/XA Browser Client vs. SB/XA Rich Client

▪ The F4 and F10 function keys are intercepted by the Browser Client before
SB/XA can process them.

▪ The "X" (Close) button in the SB/XA Browser Client window closes the
Browser Client without updating the server (much the same as F-keys).

▪ Keyboard buffering is disabled by default in SB/XA Browser Client due to the
restrictions of its architecture.

The F4 and F10 function keys are intercepted by the Browser Client before SB/
XA can process them. The "X" (Close) button in the SB/XA Browser Client Window
closes the Browser Client without updating the server (much the same as F-
keys).

Obsolete

The following items are not included in the current version of SB/XA and will not
be included in a subsequent version:

▪ DDE API – Use SBClient 6

▪ MPX in EN mode – Use SBClient 6

▪ SBCOM – Use SBClient 6.0.1

▪ Character mode TCL/ECL – Use SBClient 6 as console

▪ SBClient Scripting – Use SBClient 6

▪ SBClient SmartQuery – Use SBClient 6 or use server-based QRD facility

▪ DataC objects – Use SBClient 6

We do not plan to implement SBOPEN commands in SB/XA. The
SBH.RUN.COMMAND attribute is dependent on SBOPEN, and therefore it is not
supported by SB/XA.

We do not anticipate implementing the following for TUBP:

▪ EXPORT.TUQUERY

▪ HOST GUI TU.FORM.XXX

▪ HOST GUI TU.INIT

▪ HOST GUI TU.MENU.XXX

▪ HOST GUI TU.RESET

▪ HOST GUI TU.SERVER

▪ HOST GUI TU.SESSION

▪ HOST GUI TU.TERMINATE

▪ HOST GUI TU.TOOLBAR.EFFECT

▪ HOST GUI TU.TOOLBAR.KILL

▪ HOST GUI TU.TOOLBAR.LOAD

▪ IMPORT.TUQUERY

▪ SMART.LIST

▪ TCL.TU.FORM.PAINTER

▪ TCL.WINEDIT

▪ TU.APPLICATION.MODE.STATE

▪ TU.CLIENT.PUT

▪ TU.COMPRESS

▪ TU.DDE.CONNECT

▪ TU.DDE.DISCONNECT

▪ TU.DDE.GET.ERROR

▪ TU.DDE.READ

▪ TU.DDE.WRITE

▪ TU.EXEC.MACRO

▪ TU.EXPORT.FILE

▪ TU.FILEFORMAT

▪ TU.FILE.MANAGER

▪ TU.FORM.PAINTER

▪ TU.GET.CONFIG

▪ TU.GET.ERROR

▪ TU.GET.TCPPAD

▪ TU.GUI.SMART.LIST

▪ TU.IMAGE

▪ TU.IMPORT.FILE

▪ TU.INPUT

▪ TU.INSTALL.ERRORCODES

▪ TU.MACRO

▪ TU.PARSE.TCL

▪ TU.QUERY.ENGINE

▪ TU.QUERY.TERMINAL.WINDOW

▪ TU.RUN.MULTIMEDIA

▪ TU.RUN.SBO.COMMAND

▪ TU.SBZ

▪ TU.SCRIPT.ADDOBJECT

▪ TU.SEND.EVENT

▪ TU.SESSION

▪ TU.SESSION.CLOSE

▪ TU.SQ.DO.QUERY

▪ TU.SQL.CONNECT

▪ TU.SQL.DISCONNECT

▪ TU.SQL.EXEC

▪ TU.SQL.MAKE.DICT

▪ TU.SQL.READ

▪ TU.TO.MONOLOG

▪ TU.VIDEO

▪ TU.WINDOW.DRAW

▪ TU.WINDOW.RESTORE

▪ TU.WINDOW.SAVE

▪ WINEDIT
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SB/XA v6.0.1 release notes
Build 2135
Release Date: November 2009
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.0.1.

What's new in SB/XA v6.0.1

Output to screen with XPS Viewer
In version 6.0.1, output from Report Writer, QRD, and TU.SEND.TO.PRINTER can be viewed on screen
in SB/XA Browser Client or SB/XA Rich Client. The new viewer implemented in the SB/XA Presentation
Components is built on Microsoft's XPS Viewer technology and uses standard Windows controls. XPS
printing allows users to modify the font size so the output fits within the screen display area. Users
can also print the output to any printer that is defined on the client computer, even if the printer is
unknown to SB/XA Application Server or SB/XA Communications Server. For further details, see the
SB/XA 6.0.1 New Features manual. 11899*USA, 38304*USA

XAML styles for interleaved multivalues
SBClient 6.0.0 and earlier support two types of grids: (1) the standard grid and (2) a quasi grid invoked
by specifying the G option in the Screen Designer > F5-Enter Field > Control (Controlling multivalue)
field. At version 6.0.1, SB/XA Browser Client and SB/XA Rich Client support XAML styles for interleaved
multivalues, offering the same flexibility as the G-option grid. For this reason, SB/XA Browser Client
and SB/XA Rich Client no longer support the G option as of version 6.0.1. For further information
about XAML styles for interleaved multivalues, see the SB/XA 6.0.1 New Features manual. 11959*USA,
37746*USA

Totals in fixed footer row of grid
SB/XA 6.0.1 provides the ability to place a derived totals field in the fixed footer row of a grid. For
information about adding a totals field in the footer row, see the SB/XA 6.0.1 New Features manual.
38018*USA

Dynamic styling with XAML code snippets
Version 6.0.1 supports dynamic styling through the use of XAML code snippets. With this feature,
you use short segments of XAML code to define the display characteristics of selected elements of
the user interface, including labels, display fields, background, and foreground. Examples of XAML
code snippets for these elements are available in the XAML Examples (XA) application in SBDEMO. For
further information about dynamic styling, see the SB/XA 6.0.1 New Features manual. 40060*USA

Column and row coordinates of character form converted to XUI rendering
When forms are converted from character mode directly to XUI mode in SB/XA 6.0.1, the size of the
form, position of fields, and size of objects in the XUI rendering closely corresponds to the column
and row coordinates of the character-based form. For more information on conversion of forms from
character to XUI, see the SB/XA 6.0.1 New Features manual. 39903*USA

Creating and using XAML themes
Version 6.0.1 introduces a number of improvements to the implementation of XAML themes, including
the following:

▪ Before SB/XA can load and use a XAML theme, you must create a theme definition using the Theme
Definition (/THEME.DEFN) tool.

▪ The names and functionality of two theme processes have changed. The /TH.C process replaces
the Compile Theme (/CT) process, and the /TH.I process replaces the Upload and Compile Theme (/
UCT).

For further information on changes to XAML themes, see the SB/XA New Features manual. 38815*USA

Support for device licensing
SB/XA version 6.0.1 implements device licensing that supports the device licensing on the U2
data servers. When a user connects from SB/XA Browser Client or SB/XA Rich Client to SB/XA
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Communications Server, the client passes along its credentials to SB/XA Communications Server. SB/
XA Communications Server then connects to the U2 data server and passes the client credentials to
the U2 data server. Device licensing allows you to run multiple sessions from a single client computer,
consuming only one data server license and one SB/XA license. 38472*USA

New features, enhancements, and fixes in SB/XA v6.0.1

The following issues were addressed in this release:

Issue Number Description

6131*UK Data Sort on F3 Help

In previous versions, if the user pressed F3 for help on date fields, numeric
values, or monetary values in GUI mode, and then tried to sort the data, the
information was sorted in ASCII left-justified mode. These fields are now sorted
by data order, which is the standard Windows behavior.

6850*UK Ability to Define Icon for Any Menu Option in SBX Tree

In previous versions, users had the ability to define an icon for any option on the
SBSYSMENU in the SystemBuilder Explorer (SBX) tree when the Multiple Sysids
option was selected. With this enhancement, users can define an icon for any
menu option on any menu in the SBX tree, regardless of whether the Multiple
Sysids or Single Sysid option is selected.

7231*USA Fix to Enforce No-Comma Rule in Password Validation

The SB password validation process did not enforce the no-comma rule in
the /CHANGE.PWD process, even though it enforced the rule when changing
passwords at login prompt. The issue was resolved in version 6.0.0, but was not
previously documented.

8814*USA File Pointers to Security Audit Logs Are Generated for New Accounts

In versions 5.4 and later, SB did not generate file pointers to the security audit
logs for newly created accounts. A code fix in version 6.0.1 corrects this problem,
and the file pointers are generated as expected.

10012*USA Port Terminal Definition No Longer Checked in GUI Mode

If the port used to connect the client to SB/XA Communications Server was
set up with a terminal definition in TERM.CONFIG, SB/XA Communications
Server failed to connect. This required a reboot of the machine running SB/XA
Communications Server. In version 6.0.1, the routine to check the port terminal
definition is no longer performed when the client is running in XUI mode.

10057*USA Fix to Call GLOBAL.LOG Process

In versions 5.4.1 and later, the GLOBAL.LOG process, which should be called
automatically when a definition of any type is updated through a tool, did not
run after the user saved a change to a definition from a secondary screen. This
issue has been corrected in version 6.0.1.

10484*USA Account Upgrade Generates File Pointers in SB Administration Account

When upgrading an account, SB did not create the file pointer
DMSECURITY.AUDIT2 to point to DMSECURITY.AUDIT in the SB administration
account. This issue has been corrected in version 6.0.1.

10578*USA Correction to Hover Help on setup.exe File

When hovering over the setup.exe file on the version 6.0.0 SB/XA product
CD image, the hover help showed an incorrect description of the file. The
information has been revised with the description "SB/XA CD Setup," and the
copyright date and version number have been updated.
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10589*USA Toolbar Downloads After Creating xxRESOURCE

If the user did not create the xxRESOURCE file for the system ID and then ran a
screen containing a toolbar, the images for the toolbar were missing, and there
was no way to correct the problem other than clear the local cache. Version 6.0.1
allows you to close the screen and then create the xxRESOURCE file. After the
xxRESOURCE file exists, the images for the toolbar are downloaded the next time
the toolbar is displayed.

10603*USA Differences in Navigating with Arrow Keys in XUI and GUI Modes

Navigation with the arrow keys does not work the same in XUI mode as it does
in GUI mode. Pressing the down arrow key in GUI mode (SBClient) advances
the cursor to the next field; in XUI mode (SB/XA Browser Client and SB/XA Rich
Client), it advances the cursor to the end of the current field. There is no plan to
change the behavior of the arrow keys in the XUI clients. When working in SB/XA
Browser Client or SB/XA Rich Client, use the Tab key and Enter key to navigate
the screen.

10621*AUS Auto Accept Combo Boxes Option Is Fixed

In SB/XA 6.0.0, the Auto Accept Combo Boxes option in SB+ Control Parameters
> F8-Display Defaults > F5-GUI Display Defaults had no effect. A fix has been
implemented in version 6.0.1 so the option works as designed.

10652*USA ToolTips Help No Longer Contains "_char10_" String

If first-level help contained two lines or more, the ToolTips help visible when
hovering over the field contained the string "_char10_". The extraneous text has
been removed from the help string in version 6.0.1.

10672*USA MPX Submenu Available in EM Mode in XUI Clients

Added support for the MPX submenu of the SBX menu tree in the SB/XA
Presentation Components (SB/XA Browser Client and SB/XA Rich Client) in EM
mode.

10676*USA Support for F1 More Help in XUI Clients

F1 More Help was not available in SB/XA Browser Client and SB/XA Rich Client
in version 6.0.0. The XUI clients support this Help feature as of version 6.0.1,
providing the same functionality as in GUI and Character modes.

10685*AUS Toolbar with Nonzero Settings Properly Displays as Floating Window

If the X pixel and Y pixel positions of a toolbar (defined in the F5-Aspect
subscreen) are not zero, the toolbar should be displayed as a floating window. In
version 6.0.0, toolbars with nonzero settings were rendered as a speedbar, fixed
to the main menu. This has been corrected in version 6.0.1, so a toolbar with
nonzero settings is rendered as a floating window, as designed.

10686*USA Report with Output to Hold File No Longer Produces Error

In the 6.0.0 version for UniData only, generating a report with output to the Hold
file resulted in an "Uninitialized variable" error. A fix has been implemented in
version 6.0.1 to prevent this error.
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10688*USA Single Sign-On Instructions Changed to Include Non-Single Sign-On Setup

Users who do not want to enable Single Sign-On must still complete most of
the same setup steps required for Single Sign-On. The title of Chapter 6 of the
SB/XA Application Server Reference Manual has been changed to "Setting Up
Application Access and Configuring Clients". The chapter now covers steps to
enable application connections for both Single Sign-On and non-Single Sign-On
customers. This chapter also contains steps on a new feature for configuring the
SB/XA clients.

10689*USA Fix to Set @MAINFILE to Proper Value

The COMMON variable @MAINFILE was set to null if a tool read was present in
the Process After slot in a selection process definition (/PD.S). A code change in
version 6.0.1 corrects the problem so @MAINFILE is set to the proper value.

10693*USA Change to Display Tabs in Multiple Rows in XUI Clients

In GUI mode, tabbed screens display multiple rows of tabs so they fit within the
required width of the screen. However, in XUI mode in version 6.0.0, all tabs
were displayed on a single row, and the size of the screen was increased to
accommodate the width of the tabs. This issue has been addressed in version
6.0.1 so tabbed screens display tabs on multiple rows, and the width of tabs has
been decreased to accommodate more tabs per row.

10696*USA Double-Click Selects List Item in XUI Clients

In SB/XA Browser Client and SB/XA Rich Client, double-clicking an item in a
selection list did not automatically select the item. The behavior has been
corrected in version 6.0.1.

10700*USA Support for UT.COMDLG.S File Path Selection Process

The file path selection process UT.COMDLG.S, which allows users to drill down
to a path and return that path in a field as the @VALUE, was not supported in
version 6.0.0. Entering UT.COMDLG.S displayed a "Not implemented" message.
Support for this process has been added in version 6.0.1.

10706*USA Fix for Issue with Focus on the Wrong Radio Button

In GUI Functions, if you set the default value in a field to a radio button option,
the screen showed the correct radio button as selected and the proper value
was stored, but the focus indicator was on the last radio button in the group.
In version 6.0.1, the code has been fixed so the focus is on the selected radio
button. In addition, a new property, SBFocusContentTemplate, allows the user
to control what the content looks like in the option that has focus.

10707*USA Availability of Right-Click Menus in XUI Clients

SB/XA Browser Client and SB/XA Rich Client now support right-click context
menus for fields. The behavior is similar to the right-click context menus in GUI
mode, with the following exceptions: (1) right-clicking in a field that does not
have focus displays a dummy context menu, indicating that the user must first
give focus to the control, and (2) right-clicking in a field in a grid gives focus to
that cell, and the appropriate context menu is displayed.

10709*USA Enhanced Form Control

After resizing and moving a main form in SB/XA Browser Client or SB/XA Rich
Client, the new size and position were remembered in the same session, but
not after closing the client and opening a new session. As a related issue, other
forms that were contained in the main form did not move with the main form.
SB/XA 6.0.1 implements an enhanced version of form control that achieves a
more intuitive behavior.
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10710*USA XUI Clients Display User's Name in Locked Record Message

When a user locked a record In SB/XA Browser Client or SB/XA Rich Client, the
user's name was not displayed in the locked record message. The behavior has
been corrected so the user's name is displayed the same as it is in SBClient.

10758*USA,
11175*USA

XAML Style for Button That Was Added in GUI Mode

Prior to version 6.0.1, when a button was added using the screen designer (/SD)
in GUI mode, and the button was not associated with a function key, a XAML
style could not be applied to the button. This issue has been resolved in version
6.0.1, and users can now specify a XAML style for buttons created in the screen
designer. The XAML style is now stored in attribute 54 of the screen definition.

10901*AUS Data Stacking to Selection Processes

In SB/XA Browser Client and SB/XA Rich Client, data entered in an input field was
not data-stacked to selection processes if the user invoked the selection process
from a multivalued field in a grid. A code change corrects the data stacking
behavior of grids in version 6.0.1.

10934*USA DISP 7 Message Is Now Cleared from Screen

The SB command DISP 7, which is called in a paragraph process to display a
message on the user's screen and clear it from the screen after a set period of
time, did not clear as expected in SB/XA Browser Client and SB/XA Rich Client in
version 6.0.0. This has been fixed.

10938*USA Error on F3 Help in Date Field on Tabbed Screens

Using F3 to get help on a date field in tabbed screens caused SB/XA Browser
Client or SB/XA Rich Client to issue an error message stating that the input was
not in a correct format, and after that to become unresponsive. This issue has
been resolved.

10944*USA Fix Prevents Problems after Modifying Button Style

If the user modified a button style, the style was not correctly applied to buttons
in the /PD.S selection process, and the mouse click event was not invoked when
the button was clicked. The code has been revised to correct this behavior in
version 6.0.1.

10945*AUS Column Headings with T Option in /PD.S Process

For /PD.S selection processes that specified the T option to display field
descriptions as column headings, the headings were not displayed when the
process was run in SB/XA Browser Client or SB/XA Rich Client. Version 6.0.1
implements a code fix to correct this problem.

10951*USA Fix to Hot Keys Assigned to Buttons

The hot keys assigned to buttons in dialog boxes did not work in SB/XA Browser
Client or SB/XA Rich Client. A fix has been implemented so hot keys work as
expected in version 6.0.1.

10954*USA Fix for "Index out of range" Error in /PD.I

In version 6.0.0, if an input process definition (/PD.I) specified a process in the
Process Before Screen Display slot, SB/XA Rich Client returned an "Index out of
range" error. A code change in version 6.0.1 prevents this error.
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10975*USA Options>> Button No Longer Causes Client to Fail

During logon, if the user clicked the Options>> button to get additional
information, clicked the Options>> button again, and then clicked the Connect
button, SB/XA Browser Client or SB/XA Rich Client would not connect and failed
to respond. This issue has been resolved.

10987*USA Warning when File Update Process Encounters a Lock

In versions 5.4 and later, if a file update process encountered a lock, the process
did not display a warning and did not respond, which led users to assume that
the process had failed. Beginning with version 6.0.1, SB/XA displays a warning
when a file update process encounters a lock, stating the file name of the locked
file, the key, and the user ID of the user who locked the file.

11016*USA Issue with SETATTR Switching Height and Width Values Is Resolved

SETATTR switched the height and width values of X and Y coordinates in grids in
SB/XA 6.0.0. The code has been revised to correct this problem in version 6.0.1.

11021*USA Criteria for Restricted Shell Verbs Expanded

In versions 5.4 and later, Group Security Setup allowed you to enter a verb in
the Restricted Shell Verbs slot only if field 1 of the VOC entry was equal to V. At
version 6.0.1, the Restricted Shell Verbs slot accepts any verb for which field 1 of
the VOC entry is equal to V or C.

11056*USA Work Field Without a Field Definition No Longer Produces Error

With the Multilanguage option set to On, creating a work field on a main screen
with no field definition and then creating a work field on a subscreen of the
main screen with no field definition resulted in an error in certain conditions
in versions 5.4.2 and later. If the user ran the main screen in GUI mode and
called the subscreen, the subscreen was displayed in Character mode and the
following error was displayed: "Couldn't create textclass object reference at X,Y.
Object name already in use. 405, w5.1". A fix has been implemented in version
6.0.1 so that work fields created with no field definition do not produce an error
and the subscreen runs correctly in GUI mode.

11059*USA INCLUDE Statement Is Now Replaced

In the compile theme process (/CT), the INCLUDE statement for the theme
entered as the ThemeName parameter was not being replaced as expected in
version 6.0.0 for UniData. A fix has been implemented in the porting routine in
version 6.0.1 to address this issue.

11066*USA Line Separator in Type 1 Menus Displayed Properly

In version 6.0.0, type 1 menus displayed an 'L' instead of a dividing line
separator. A code fix corrects this problem in version 6.0.1.

11068*USA Changes to Escape Processing in Dialog Boxes

In some situations, pressing Esc in dialog boxes resulted in the error, "The
Object 'DIALOG*nn*nn' does not exist in the object map." Dialog boxes were
performing base form escape processing in addition to their own dialog-specific
escape processing. In version 6.0.1, dialog boxes perform only their own escape
processing, preventing this problem.
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11069*USA Changes to SETATTR Background and Foreground Colors

SETATTR did not set background and foreground colors correctly in grid cells
in SB/XA Browser Client or SB/XA Rich Client. The *col*row syntax for setting
background and foreground colors in grid cells and the syntax for setting the
background and foreground colors in grid rows now works as expected, with
one exception: In GUI mode, the last-set attribute takes precedence, while in XUI
mode, the individual cell setting takes precedence.

11072*USA Resolution of Issue with REGEN.EXP Output Logs

The /REGEN.EXP process did not log output in version 6.0.0, so if the process
failed, there was no record to verify where the failure occurred. This has been
fixed.

11162*USA Sorting Allowed Only in Editable Grid Columns

In SB/XA Browser Client or SB/XA Rich Client, sorting in grid columns of input
screens could potentially cause data corruption. In version 6.0.1, sorting in grid
columns in input processes is allowed only if there are no editable columns;
otherwise, sorting is disabled.

11168*USA .LOG Process Now Supported in /TH.C and /TH.I Processes

Support for the .LOG process has been added for the /TH.C (Compile Theme)
and /TH.I (Compile and Invoke Theme) processes in version 6.0.1.

11169*USA Evaluation Licenses Validated without Security Violation

When users attempted to authorize a valid SB/XA evaluation license, a security
violation occurred. This issue has been corrected, so a valid evaluation license
can be authorized in version 6.0.1 without problems.

11185*USA Enter Key Mapped to Connect Button in Logon Dialog Box

If users pressed the Enter key after entering a password in a logon dialog box,
this did not execute the action to connect to the application. The Enter key,
which is the default action in logon dialog boxes, is now mapped to the Connect
button. To ensure that users enter the required information, the Connect button
is now disabled until a value has been entered in the User Name box.

11190*USA Leading Zeros No Longer Suppressed in Code Tables

If a code table is updated by an expression and the expression supplied a value
with leading zeros, the leading zeros were suppressed. This has been fixed.

11204*USA Fix Prevents Corruption of SB.CONTROL Record

In version 6.0.0, if you edited the SB.CONTROL record in DMCONT using /
SB.PARMS, the SB.CONTROL record was corrupted. This issue has been
corrected in version 6.0.1.

11205*USA UT.NEW.SYS Message Is Now Suppressed in /SYS Process

A UT.NEW.SYS message appeared in the terminal window when using the /
SYS process to change to a different system ID. The problem has been fixed in
version 6.0.1, so the message no longer appears when the system ID process is
called.

11212*USA Fix for Vertical Scroll Bar in Intuitive Help

The vertical scroll bar in the intuitive help screen obscured the help text in the
last column of the screen. When calculating the grid size, SB/XA did not allow
sufficient space to display the scroll bar. This has been fixed.



SB/XA v6

170

Issue Number Description

11213*USA Guidelines on Changing the SB Account Name

If you change the name of the SB account, we advise that you not use the same
name as any part of the installation path. For example, if the application path
is C:\ABCo\SBXA\ApplicationServer\UniData, do not rename the SB account to
"ABCo" or "SBXA" or any name that repeats a part of the installation path. If
you use a repeat name, do not use FIX.SBPLUS.POINTERS, as it will not fix your
pointers.

11233*USA Disabled F3 Help for Window Co-ords in XUI Clients

Pressing F3 in the Window Co-ords field of the Menu Definitions screen (/MD)
caused SB/XA Rich Client to become unresponsive. F3 help on Window Co-ords
has been disabled in XUI mode in version 6.0.1 to prevent the client from failing.

11244*USA Property Added to Prevent Failure After /LOGTO and F3 Sequence

Running the /LOGTO process and then pressing F3 caused SB/XA Browser Client
or SB/XA Rich Client to fail. A new property was added in version 6.0.1 to prevent
client failure in this sequence of actions.

11248*USA Message Indicates F7 - Layout Is Unavailable in XUI Clients

In SB/XA Browser Client or SB/XA Rich Client, pressing F7 - Layout in Menu
Definitions for a type 3 or type 4 menu opened a character screen to define the
menu layout. The Menu Definitions process then became unresponsive. This
issue has been addressed in version 6.0.1, so after pressing F7 - Layout in the XUI
clients, a message indicates that this feature is not implemented.

11254*USA Support Added for F3 Help on Date and Money Fields

In SB/XA Rich Client, pressing F3 in the Default Date Conversion or Default Money
Conversion field of the System Defaults screen (Admin > SB+ Setup > SB+ Control
Parameters > F5 System Defaults) resulted in an error that required closing and
restarting the client. Support for F3 help on the date and money fields has been
added in version 6.0.1.

11282*USA Issue with Paragraph Lines Constructed Using F3 Help Is Resolved

Paragraph lines constructed using F3 intuitive help were not inserted correctly
into the paragraph, and the previously inserted lines were overwritten. This
problem has been resolved in version 6.0.1.

11285*USA Account Upgrade Creates Security Audit File Pointers

Account upgrades in versions 5.4.2 through 6.0.0 did not create pointers to
DMSECURITY.AUDIT2 or QDMSECURITY.AUDIT. The pointers are created as
expected during account upgrades to SB/XA 6.0.1.

11300*USA $USER Record Retained in Application Account Upgrade

Upgrading an application account deleted the $USER record, which
consequently forced the user to re-license SB/XA. A fix in version 6.0.1 corrects
this issue so the $USER record is no longer deleted in an application account
upgrade.

11302*USA Fix to Prevent Error on First Run of Input Process Screen

SB/XA produced an error when running an input process screen for the first time
only. This issue has been resolved in version 6.0.1.

11316*USA Numeric Sorting in Read-Only Grids Enabled

The ability to perform numeric sorting in columns of read-only grids has been
enabled in version 6.0.1.
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11318*USA Fix to Tabbed Screens with Derived, Dependent Multivalues

When tabbed screens contained derived, dependent multivalued data, the
screen definition sent to the client for the second and subsequent forms was
incorrect, which caused SB/XA to fail. Version 6.0.1 implements a fix that
prevents this problem.

11330*USA Alignment of Labels in Derived Output Fields

The field labels in derived output fields did not line up correctly with input fields.
SBLabel has been modified in version 6.0.1 to center the field label vertically.

11341*USA Corrected Behavior of Up Arrow Key in XUI Clients

In SB/XA Browser Client and SB/XA Rich Client, the behavior of the Up Arrow key
in the first field of a grid was inconsistent, placing the cursor in various positions
in the field depending on where it had been placed prior to entering the grid.
This problem has been resolved so the Up Arrow now behaves consistently with
the CUA standards for arrow movement.

11351*USA Display of Interleaved Multivalues

In version 6.0.0, SB/XA Browser Client and SB/XA Rich Client returned errors on
screens with interleaved multivalues. Version 6.0.1 introduces XAML styles for
interleaved multivalues, which resolves this issue.

11353*USA Add Separator Lines Using a XAML Style

An enhancement in version 6.0.1 enables you to add a separator line between
columns of a grid using a XAML style. For an example XAML style that adds a
separator between grid columns, see the "Style_Tag_Templates_GA2.txt" item
in the XATHEMES file.

11355*USA Data in Grids Right- or Left-Justified Based on Type

Data in grid columns was not right- or left-justified based on the data type
defined for the field. This issue has been resolved in version 6.0.1 so the data in
grids is now justified based on the defined data type:

▪ Alpha: Left-justified

▪ Dates: Right-justified

▪ Monetary: Right-justified

▪ Numeric: Right-justified
11357*USA XAML Style to Remove Shadowing

Some users found that a shadowing effect caused the appearance of fields and
screens to change in different areas of the form. Using a XAML style to remove
the shadowing resolves this issue.

11377*UK Safety Margin for Calculating Horizontal Scroll Bar

If a field in a grid was one pixel too wide, SB/XA generated a horizontal scroll bar
for the field. A safety margin of one pixel has been built into the horizontal scroll
bar calculation in version 6.0.1, so a horizontal scroll bar is no longer generated
in this case. However, note that if a field consumes the one-pixel safety margin,
the screen layout may yield undesired results.

11383*UK Fix for Dragging Resize Arrow of Tabbed Screen

Dragging the resize arrow of a tabbed screen to make the screen larger worked
only to a certain limit, when the resize arrow detached from the box. This issue
has been fixed in version 6.0.1.
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11385*UK Default Values Loaded in Input Screens

On certain input screens in version 6.0.0, the fields did not display the default
values in SB/XA Browser Client and SB/XA Rich client. This problem has been
corrected in version 6.0.1 so the fields are loaded with default values as
designed.

11387*UK XUI Clients Support Highlighted Text

Code has been added in version 6.0.1 to enable the display of highlighted text in
dialog boxes in SB/XA Browser Client and SB/XA Rich Client.

11399*USA Remote Process Run within UniVerse Account

Running a remote process from within a UniVerse account returned the error
message, "Invalid password". A code fix in version 6.0.1 enables users to run
remote processes from within an application account.

11405*UK Correction to Names of Second Set of Function Keys

The names of the second set of function keys (such as SF5) were incorrect
or missing the "S" in GUI and XUI modes in SBDEMO Maintenance screens in
version 6.0.0. This issue has been corrected.

11406*UK Shadowing Removed from Field Labels

Shadowing on field labels in non-derived fields appeared untidy. In version 6.0.1,
shadowing has been removed from field labels in the default style, except in
derived fields and in output-only screens. Users can define their own custom
XAML styles for field labels if desired.

11409*UK Fix to Correctly Position Multivalue Grids with Side Heading

Multivalue grids with a heading placed at the side were positioned outside the
display area in GUI and XUI modes in version 6.0.0. A modification to the output
drivers in version 6.0.1 corrects this issue.

11419*UK Pressing Enter in Grid No Longer Causes Display Issue

Data in fields in a grid disappeared when the user pressed Enter and reappeared
when the user pressed the Up Arrow key. This issue has been resolved in version
6.0.1, so data is no longer removed from the grid display when the user presses
Enter to advance to the next row.

11434*USA @CNT Returned After Clicking in Grid Row

Clicking in a grid row did not return @CNT for use in a subsequent process call
when the C (Controlling), A (No Amend), I (No Insert), D (No Delete), and E (No
Append at End) options were set on the controlling field. This issue has been
resolved in version 6.0.1.

11435*USA Resource File Provided for Each System ID

SB/XA did not provide a global resource file for storing common bitmaps and
other image files. Version 6.0.1 implements an xxRESOURCE file for each system
ID. A new field in the HK.CONTROL file for the system ID stores the name of the
resource file. The xxRESOURCE file must be a directory.

11461*UK Corrected Behavior of Navigation Keys in F3 Help

In SB/XA Browser Client and SB/XA Rich Client, the Down Arrow, Up Arrow, Page
Down, and Page Up keys did not work correctly in the selection lists presented in
F3 help. This issue has been resolved in version 6.0.1.



SB/XA v6.0.1 release notes

173

Issue Number Description

11462*UK Pressing Esc Closes Grids in F3 Help

Pressing Esc did not close grids displayed in F3 help in SB/XA Browser Client or
SB/XA Rich Client. This issue has been resolved in version 6.0.1 so Esc closes F3
grids as designed.

11463*USA Modifications to Behavior of X Button in Client Window

In version 6.0.1, the behavior of the X button at the top of the SB/XA Browser
Client and SB/XA Rich Client has been modified so it is subject to user
preference. A new field has been added to /USER.FLAGS, allowing the user to
specify whether the X button escapes to the previous menu or closes SB/XA.

11476*USA Vertical Menus No Longer Overlay Button Bar

The button bar was overlaid by type 1 menus in SB/XA Browser Client and SB/
XA Rich Client in version 6.0.1. Vertical menus are now positioned so they are
relative to the form layout area under the button bar in SB/XA Rich Client, and so
they are centered in the form area in SB/XA Browser Client in version 6.0.1.

11478*USA Ability to Set Column Headings in Grids

SB/XA did not provide a way to set column headings in grids in version 6.0.0.
Users can now set column headings using the "FIELDNAME*label" functionality
of the SETATTR function in the same way as setting a field label.

11529*USA Validation of Process IDs Entered as Account Restrictions

In Group Security > F5 Restr Accts, SB/XA Browser Client and SB/XA Rich Client
did not perform validation when the user entered a process ID as an account
restriction and pressed Tab or Enter or clicked into the next row. If the user
entered an invalid process ID and pressed F2 to save changes to account
restrictions, SB/XA then returned an error. Version 6.0.1 resolves this issue so
validation is performed during entry of process IDs in this window.

11535*USA Fix to Display Multivalued Fields in a Grid in Group Security Subscreens

In version 6.0.0, multivalued fields in certain Group Security subscreens were not
displayed in a grid in SB/XA Browser Client and SB/XA Rich Client. A fix has been
implemented in version 6.0.1 so multivalued fields are displayed in a grid in XUI
mode, the same as they are in GUI and Character modes.

11552*UK Parent Menu Option Highlighted on Escape from Type 1 or Type 2 Menu

When escaping from a type 1 or type 2 menu back to another type 1 or type 2
menu, the parent menu option was not highlighted. The behavior has been
corrected in version 6.0.1 so the parent menu option is highlighted as expected.

11553*UK Dialog Box to Confirm File Deletion

In SB/XA Browser Client or SB/XA Rich Client, the /FDEL (File Delete) process
did not offer a Select Processes for Deletion dialog box to allow users to
confirm a file deletion. This issue has been fixed, so the XUI clients display the
confirmation dialog box as expected in version 6.0.1.

11617*USA Pressing Esc in Input Fields of Multipart Key Displays Values in XUI Mode

When working with input screens in XUI mode, pressing Esc in the input fields
of a multipart key did not display the values. A code fix corrects this problem in
version 6.0.1 so the values are displayed in XUI mode the same as they are in GUI
and character modes.
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11619*USA Fix to Prevent Input String Error in /PD.O Process

When using a multi-part key built from a work field in an output process (/PD.O)
with @REFRESH=2 in the Process Before slot of the second part of the key, SB/XA
returned an error message, "A problem occurred parsing a server message. Input
string was not in a correct format." The /PD.O process has been fixed so it works
like the PD.I process, and the error no longer occurs in this situation.

11625*USA Calling Remote Process from Phantom No Longer Fails

Calling SB.REMOTE.PROCESS from a phantom process failed, returning the error
message, "Access denied." A code change in version 6.0.1 prevents this problem.

11631*USA Clients Now Handle @REFRESH in Process After Read Slot

In the screen designer (/SD), placing @REFRESH=2 or @REFRESH=-2 in the
Process After Read slot resulted in an error and caused the client to become
unresponsive. This issue has been resolved in all clients (Character, GUI, and XUI
modes) in version 6.0.1.

11669*USA SELECT Statement Is Not Interpreted as Process ID

In versions 5.3.4 and later, if a paragraph process contained a SELECT statement
and the Multilanguage option was On, SB interpreted the SELECT statement
as a process ID and attempted to read the process. This issue has been fixed in
version 6.0.1.

11681*USA Corrected Label of Data Server Credentials Group Box

Fixed the label of the Data Server Credentials group box in the Connect to
Application > Options > General tab in SB/XA Browser Client and SB/XA Rich
Client.

11727*AUS Fix for Problem with Corrupt Multivalues in QRD Reports Output to Excel

In versions 5.4.2 and later, QRD reports that were output to Microsoft Excel could
contain corrupt multivalues if the last multivalued fields in the data were null. In
some cases, the null values were replaced with the last non-null value. This issue
has been resolved in version 6.0.1 so multivalues are no longer corrupted in QRD
output to Excel.

11735*USA Display of Multilanguage Grid Headings

Multilanguage grid headings were not displayed when running a screen in an
alternate language if the "Display Prompt" for the field was set to "N" in versions
5.4.2 and later. This issue has been resolved.

11818*USA Correction to /TRANSLATE Function

Fixed an issue with the /TRANSLATE function that caused data corruption when
translating GUI field labels in a grid.

11834*USA Fix to Prevent Function Key from Displaying on Action Bar

If a function key was defined to call the TOGGLE or ACTION process, the function
key was displayed on the action bar in SB/XA Browser Client and SB/XA Rich
Client. A modification to action bar parsing in version 6.0.1 prevents function
keys with the TOGGLE or ACTION process from being displayed as a button on
the action bar.

11835*USA Correction to Display Action Bar in XUI Screens

The action bar did not appear in all screens in SB/XA Browser Client and SB/XA
Rich Client in version 6.0.0. A fix has been implemented in version 6.0.1 to correct
this problem.
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11837*USA Issue with Interleaved Multivalues Displaying in Grid when Option Was
Turned Off

In GUI mode, interleaved multivalues were displayed in grids even when the
grid option was switched off in /SB.PARMS. Due to this issue in GUI mode,
multivalues were also displayed in grids in XUI mode. The code has been
amended in version 6.0.1 to prevent this problem.

11899*USA,
38304*USA

Output to Screen with XPS Viewer

In version 6.0.1, output from Report Writer, QRD, and TU.SEND.TO.PRINTER
can be viewed on screen in SB/XA Browser Client or SB/XA Rich Client. The
new viewer implemented in the SB/XA Presentation Components is built on
Microsoft's XPS Viewer technology and uses standard Windows controls. XPS
printing allows users to modify the font size so the output fits within the screen
display area. Users can also print the output to any printer that is defined on
the client computer, even if the printer is unknown to SB/XA Application Server
or SB/XA Communications Server. For further details, see the SB/XA 6.0.1 New
Features manual.

11954*USA Page Down/Page Up Functionality in F3 Help

If an F3 intuitive help list in XUI mode was long enough for Page Down/Page Up
usage, the focus on the field did not always stay on the screen, and the active
line was not always shown on the page. This issue has been resolved in version
6.0.1.

11959*USA,
37746*USA

XAML Styles for Interleaved Multivalues

SBClient 6.0.0 and earlier support two types of grids: (1) the standard grid and
(2) a quasi grid invoked by specifying the G option in the /SD (Screen Designer)
> F5-Enter Field > Control (Controlling multivalue) field. At version 6.0.1, SB/
XA Browser Client and SB/XA Rich Client support XAML styles for interleaved
multivalues, which offer the same flexibility as the G-option grid. For this reason,
SB/XA Browser Client and SB/XA Rich Client no longer support the G option
as of version 6.0.1. For further information about XAML styles for interleaved
multivalues, see the SB/XA 6.0.1 New Features manual.

In parallel to the introduction of XAML styles for interleaved multivalues in the
XUI clients, the code in version 6.0.1 has been enhanced to support multiple G
option grids in GUI mode. This gives GUI screens the same capability to display
interleaved multivalues as in XUI mode.

11967*USA Issue with Title of Multivalue when Display Prompt Is "S"

When a multivalue field has a Display Prompt of "S", and the data area is moved
below the title, the title will not display. This does not occur if the Display
Prompt is set to "A", and we recommend using the "A" setting in this situation.

11975*USA Check for BUILTIN Administration Group on Non-English Windows Systems

When setting up SB/XA administration details on a Windows computer,
SB/XA performs a check to see if the user is a member of the BUILTIN
\Administrators group. The name of that group is different on non-English
Windows operating systems, so users of those operating systems were unable to
enter administration details. A fix has been implemented in version 6.0.1 so SB/
XA also checks for the user under the name of the BUILTIN administration group
in non-English languages.



SB/XA v6

176

Issue Number Description

11997*USA Compiled Code in /PD.I and /PD.O Processes No Longer Supported

As of version 6.0.1, SB/XA no longer supports the use of compiled code in the /
PD.I and /PD.O processes. If the user attempts to runs an input or output process
that calls compiled code, a message warns that the code will run in interpreted
mode. Also, if the user attempts to compile code in an input or output process, a
warning is displayed.

12036*USA Display of Buttons in Output Screens

Output (/PD.O) screens did not correctly display OK, Prev, and Next buttons in
GUI or XUI mode. A fix in version 6.0.1 corrects the problem so these buttons are
displayed on output screens as designed.

12044*USA Fix to Scroll Bars in /PD.O Screen

Scroll bars in the /PD.O screen did not work correctly in XUI and GUI modes in
version 6.0.0. This issue has been corrected in version 6.0.1.

12049*AUS Steps to Configure SB/XA Communications Server for Cross-Domain Logons

After initially installing SB/XA Communications Server, you may need to
configure the software to enable cross-domain logons. This additional task is
required only if users on client PCs need to connect to SB/XA Communications
Server from a domain outside the Windows domain of which SB/XA
Communications Server is a member. The instructions for configuring cross-
domain logons were formerly in Chapter 3, "Installing SB/XA Components
on Windows" of SB/XA Getting Started. Since many customers do not need to
perform these steps, they have been moved to Chapter 7, "Configuring and
Managing SB/XA Communications Server" so they are outside the main flow of
required installation and configuration tasks.

12058*USA Fix to Hot Key Characters

If you used a character as a hot key in menus and the character was not part
of the description of the menu line item, SB/XA Browser Client and SB/XA Rich
Client produced an error.

12084*USA Menu Options Unavailable when Submenu Is Open

In previous versions, if a user changed screens in XUI mode by selecting an
option from a Type 1 menu, the selections on the original menu still appeared
to be available. This issue has been resolved, and menu options are now grayed
out when a submenu is open.

12115*USA Modify Process Returns the Correct Process ID

When working in SB/XA Browser Client or SB/XA Rich Client, if you selected a
menu option and ran the Modify Process (/MP) on this option, SB/XA returned
the process ID of the last-executed menu option. This issue has been fixed so /
MP returns the process ID of the selected menu option.

12122*UK Blank Lines No Longer Inserted in Data from DOS File Transfer

On Windows only, when passing data to a Windows application via a DOS file
transfer, blank lines were inserted in the resulting file. This issue has been
resolved in version 6.0.1.

12144*USA Fix to Label Alignment Attribute

If you defined a label in GUI mode as centered or right- justified, the same label
was displayed left-justified in XUI mode. A code fix in version 6.0.1 correct this
issue so the alignment attribute is applied correctly in XUI mode.
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12148*USA Issue with SROC.LOG File Pointer Resolved

In the UniData version only, the SROC.LOG file pointer was not created when
upgrading an account from version 5.4.x to version 6.0.0. A fix has been
implemented in version 6.0.1 to correct this problem.

12186*USA Fix for Menus without a Parent

If you changed the SBSYSMENU to a type 2 menu, the menu was not displayed in
SB/XA Browser Client or SB/XA Rich Client. A fix has been implemented in version
6.0.1 to correctly parse the code of menus without a parent. In addition, the top-
level menu now contains a Systems option, which provides a list of the available
systems, the same as in GUI.

12237*AUS Steps for Enabling Application Connections without Single Sign-On

If Single Sign-On was not enabled for a user, SB/XA did not allow the user to log
to any application other than the SB admin (SA) account. This issue has been
corrected in version 6.0.1 so users without Single Sign-On can access systems
in any application with connections enabled. For instructions on setting up the
user's application connections with or without Single Sign-On, see Chapter 6,
"Setting Up Application Connections and Configuring Clients," in SB/XA Getting
Started.

12245*USA Fix to Make F3 Help Columns Sortable in XUI Mode

In version 6.0.0, the columns in F3 intuitive help were sortable in GUI mode,
but not in XUI mode. Clicking on an F3 column heading had no effect in the XUI
clients. A fix resolves this issue in version 6.0.1, so F3 help columns can be sorted
in SB/XA Browser Client and SB/XA Rich Client as expected.

12250*USA /GC Uninitialized Variable Error Prevented

Running /GC to generate source code for a report with the "D" output device
produced an uninitialized variable error. This issue has been resolved in version
6.0.1.

12269*USA Drill Down Option Fixed

The F6-Drill Down option within a selection process caused SB/XA Browser Client
or SB/XA Rich Client to fail. This issue has been corrected in version 6.0.1.

12309*USA Support for Sorting in G-Option Grids

Prior to this release, G-option grids in an output process were not sortable. This
issue is resolved in version 6.0.1.

12313*USA Correction to Sizing of Grid Columns

In XUI mode, the grid columns all appeared to be the same size, regardless of
their settings. This issue has been fixed, and all columns now appear correctly.

12328*USA Fields No Longer Overlap Raised Box

In XUI mode, some of the fields overlapped the raised box area on the XUI
screen. This issue has been resolved and all fields now appear correctly.

12330*USA Error in Calling Subroutine from Shell Process

In previous versions, calling a subroutine from a shell process sometimes caused
an error to occur if the subroutine was called from the menu. This issue is fixed
in version 6.0.1.

36505*USA Expiration Date Field Added in License Info Screen

An Expiry Date field has been added to the Display License Info screen (/
LICENCE.INFO) to display the expiration date of the SB/XA license.
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36712*USA New Parameter Supports Global Themes File

In version 6.0.1, the HK.CONTROL file and SB.PARMS file have been modified
with a new parameter to support a global themes file. The global themes file
allows you to store styles and themes for use in multiple SB applications. When
compiling or downloading screens, if a theme is not found in the xxTHEMES file
for the system ID, SB/XA searches for it in the global themes file.

37188*USA Focus on Secondary Menus

In the SB admin account, secondary menus were displayed but were not given
focus. For example, if you ran the /TM process to open the Tools Menu, and then
selected File Create/Delete, the secondary menu was displayed, but the cursor
was not positioned in it. In version 6.0.1, focus is placed on the first option of the
selected secondary menu.

37240*USA Fix for Tag Functions in F3 Help

In SBDEMO screens, the Tag functions in F3 intuitive help screens were not
working as designed in XUI or GUI mode; pressing F5 (Tag) or F9 (Tag All) had no
effect. This issue has been fixed in version 6.0.1.

37247*USA Correction to Behavior of Radio Buttons in Parts Review Screen

When working in the SBDEMO Car Rentals (CH) application Enquiries > Car Parts
option in SB/XA Browser Client or SB/XA Rich Client, the radio buttons in the
Parts Review screen were not disabled as expected after selecting a Part No
record. The behavior of the radio buttons has been corrected in version 6.0.1 so
the buttons are disabled after the form is populated with the selected record.

37427*USA Toolbars Download Is No Longer Case-Sensitive

In the UNIX versions for UniData and UniVerse, toolbars did not download
correctly because the toolbar file transfer utility looked for case sensitivity in the
file name. This issue has been resolved in version 6.0.1.

37499*USA Cut, Copy, and Paste Buttons Reinstated in SBDEMO

In the SBDEMO account in version 6.0.0, the Cut, Copy, and Paste buttons on the
toolbar were nonfunctional. A code fix resolves this issue in version 6.0.1.

37500*USA Fix to Execute Double-Click Process in GUI Click Process Slot

In version 6.0.1, SB/XA Browser Client and SB/XA Rich Client did not execute the
double-click process specified in the /SD F5 > F6 GUI Click Process slot. This issue
has been addressed so the double-click process is executed as expected.

37503*USA Correction to F3 Search Options

In the Car Rental > Maintenance > Cars > Car Maintenance screen of the Car
Rental System in SBDEMO, the F3 > Search > Forward/Backward/Repeat search
options did not work in version 6.0.0. This has been fixed in version 6.0.1.

37595*USA ToolTips Help Added for Toolbars

ToolTips help was not implemented for toolbars in version 6.0.0. ToolTips are
now available when hovering over the buttons on all SB/XA toolbars.

37802*USA Client Now Processes Logon Data

If the user did not enter the operating system user ID or password during
logon and then pressed the Enter key, SB/XA failed to respond. The Enter key
attempted to send data to SB/XA Application Server instead of processing it
locally. The code has been changed so the client processes the logon data
locally.
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37826*USA Fix to Call Change Password Screen in GUI and XUI Modes

The Change Password screen, which is accessed from User Flags > F9-Password,
did not work in GUI or XUI mode in version 6.0.0. This issue has been fixed in
version 6.0.1, so the Change Password screen again works as designed.

38018*USA Totals in Fixed Footer Row of Grid

SB/XA 6.0.1 implements the ability to place a derived totals field in the fixed
footer row of a grid. For information about adding a totals field in the footer row,
see the SB/XA 6.0.1 New Features manual.

38085*USA License Details Not Copied in Upgrade

At version 6.0.1, license details are no longer copied when upgrading SB/XA
Application Server. You must enter license information after performing an
upgrade.

38097*USA Line Numbers Added in Edit Values Screen

An enhancement to the screen editor (/SE process) in SB/XA 6.0.1 adds line
numbers in the Edit Values screen, which enables users to edit specific values of
a multivalued attribute.

38136*USA Fix for Return Value in TU.CHECK.APP

TU.CHECK.APP did not return a value of 1 when the application was running
in SB/XA Browser Client or SB/XA Rich Client. This function has been fixed in
version 6.0.1 so it returns a value of 1 when the application is running in either
client. However, note that TU.CHECK.APP is only able to find an application if it
has an entry in the Registry.

38137*USA TU.CLOSE.APP Now Closes Applications Correctly

TU.CLOSE.APP did not work correctly to close applications in Version 6.0.0. A
change to the BASIC code has been implemented in version 6.0.1 to correct the
behavior of TU.CLOSE.APP to close applications as designed.

38161*USA Issue with Clear Local Cache Button Resolved

After configuring the Communications Server Connection from SB/XA Browser
Client or SB/XA Rich Client, clicking the Clear Local Cache button in Options
> Client Configuration did not clear the Communications Server details. This
button now clears the server details from the local cache, as designed.

38165*USA Closing Clients Locked SB/XA Communications Server .log Files

In version 6.0.0, on closing SB/XA Browser Client or SB/XA Rich Client, an
internal function of the client was not always called to disconnect from SB/XA
Application Server. As a result, the .log files created by SB/XA Communications
Server in that session remained locked and could not be deleted. The internal
function call in the client has been corrected to prevent the problem in version
6.0.1.

38189*USA Create Account Option Disabled in XUI Clients

In SB/XA Browser Client and SB/XA Rich Client, the Create Account option
opened a character screen. This option has been disabled in the new clients until
support for a XUI version of the Create Account feature is available in a future
version.

38190*USA Selecting Admin Menu in New Account No Longer Produces Error

In a newly created account, selecting the Admin menu resulted in an error in
version 6.0.0. This has been fixed.
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38195*USA Entry of Variables in Runtime Option "?Wn" Is Enabled in XUI Clients

In SB/XA Browser Client or SB/XA Rich Client, if a screen with selection criteria
contained a runtime option "?Wn" in the selection process, the screen opened
but did not allow entry of details. This issue has been resolved in SB/XA 6.0.1, so
"?Wn" runtime variables are processed as designed and now work the same as in
SBClient.

38196*USA Dialog Box to Verify Removal of Component Now Closes Properly

If you install SB/XA Communications Server and subsequently run the
installation program, a dialog box opens with the message "Do you want to
completely remove the selected application and all its features?" In version
6.0.0, a response of "No" did not close the dialog box. The installation program
has been fixed, so selecting "No" closes the dialog box in version 6.0.1.

38223*USA Selecting PDF Option in /PD.R No Longer Results in Error

If you selected the PDF option in a Report Writer definition (/PD.R), an error
occurred in both SB/XA Browser Client and SB/XA Rich Client. A change has been
implemented in the XUI drivers in version 6.0.1 to correct the problem.

38233*USA Fix to Prevent Fatal Error in Action Bars Option

The Tools > Other Tools > House Keeping > Default Function Keys/Action Bars
option caused a fatal error in both SB/XA Presentation Components (SB/XA
Browser Client and SB/XA Rich Client) and also in SBClient. This issue has been
resolved in version 6.0.1.

38255*USA Security Audit Reports Now Available on UNIX Servers

The security audit reports were not available on UNIX in SB/XA version 6.0.0 for
UniData and UniVerse. These reports are supported on UNIX servers in version
6.0.1.

38259*USA UniData Create File Option Corrected to Open Same Screen as /FC

In the UniData version only, the Admin > Files > Update Processes > Create File
option opened a different screen than the /FC process call. This issue has been
corrected in SB/XA 6.0.1 so the Create File option calls the FC process and opens
the same screen.

38284*USA Correction to Default Location of .log Files

Instructions in Chapter 3 of the SB/XA Getting Started manual for deleting .log
files before installing SB/XA components contained an incorrect path for the
default location of old .log files. On page 3-4, the default location of the SB/
XA Communications Server .log files should be C:\Documents and Settings
\LocalService\Application Data\IBM\SBXALogs\ComServer. The default location
of the SB/XA Presentation Components .log files should be C:\Documents and
Settings\<<UserName>>\Application Data\IBM\SBXALogs\Client. Note that you
must first change your settings in Windows Explorer to show hidden files and
folders. The manual has been corrected.

38326*USA Style Changed in TOGGLE2 Field

In the TOGGLE screen contained in the XAML.EXAMPLES file, we have removed
the XAML code for "RoundToggleStyle" from the TOGGLE2 field and set the GUI
property style to "mscircle". This alters the appearance of the toggle in version
6.0.1.

38330*USA B:SH.TERM.S,12 Porting Issue Resolved

Version 6.0.1 fixes a porting issue that makes it no longer necessary to run the
B:SH.TERM.S,12 process after installing SB/XA Application Server.
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38338*USA Fix Enables Ability to Save Changes in /SEC.GROUP.SETUP

In Group Security Setup (/SEC.GROUP.SETUP), an issue with the screen drivers in
version 6.0.0 prevented the ability to save changes to the group security record,
so it was not possible to set restrictions to limit menu access or inhibit process
calls for a group. With changes to the driver code, the group security record can
be saved as normal in version 6.0.1.

38472*USA Support for Device Licensing

SB/XA version 6.0.1 implements device licensing that supports the device
licensing on the U2 data servers. When a user connects from SB/XA Browser
Client or SB/XA Rich Client to SB/XA Communications Server, the client passes
along its credentials to SB/XA Communications Server. SB/XA Communications
Server then connects to the U2 data server and passes the client credentials to
the U2 data server. Device licensing allows you to run multiple sessions from a
single client computer, consuming only one data server license and one SB/XA
license.

38499*USA /TH.I Process Checks for Case-Sensitivity of Theme Name

The Upload and Compile Theme (/UCT) process did not check case-sensitivity
of the theme name when reading records in xxTHEMES in version 6.0.0.
A modification to the /TH.I process, which replaces /UCT in version 6.0.1,
implements case-sensitivity when reading records in xxTHEMES.

38565*USA Fix for Issue with Paging Up or Down in Grid

In version 6.0.0, it was not possible to page up or page down in a grid without
first clicking into the white space of the grid (which removed focus from fields
of the grid). This issue has been resolved in version 6.0.1 so you can click, tab, or
press Enter to place focus in a grid and page up or page down as expected.

38585*USA Modification to C# Classes

In version 6.0.1, the C# classes have been modified so they no longer require the
use of triggers in writing styles.

38603*USA Fix to Maintain Focus in Process ID Window

If the user selected a type 1 menu and entered "/" at any prompt, the Process
ID window appeared as expected, but focus returned immediately to the menu
rather than staying in the Process ID window. This issue has been corrected in
version 6.0.1.

38620*USA Communications Server Configuration Screen Now Placed at Top of Stack

When running the SB/XA Communication Server Configuration from an
application screen, the screen that you were using disappeared and would not
reopen. This issue has been fixed so the configuration screen is placed on the
top of the stack, above the current screen.

38691*USA Drawable Attribute Implemented in XUI Clients

The ability to use a drawable attribute to hide a column or field has been
implemented in the new clients in version 6.0.1 using the "FIELDNAME*label" or
"FIELDNAME" syntax of the SETATTR function.

38749*USA TU.SEND.TO.PRINTER Supports Aux Printing in XUI Mode

The TU.SEND.TO.PRINTER function has been enhanced to support auxiliary
(Aux) printing from SB/XA Browser Client and SB/XA Rich Client. The user can
define the Aux printer as the XPS printer, so this enhancement enables the
ability to print TU.SEND.TO.PRINTER output to screen using the XPS printer.
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38815*USA Enhancements to Implementation of XAML Themes and Styles

▪ Before SB/XA can load and use a XAML theme, you must create a theme
definition. To do so, use the Theme Definition (/THEME.DEFN) tool. For
details, see the SB/XA New Features manual.

▪ The names and functionality of two theme processes have changed in
version 6.0.1. The /TH.C process replaces the Compile Theme (/CT) process,
and the /TH.I process replaces the Upload and Compile Theme (/UCT). For
further information, see the SB/XA New Features manual.

▪ In the ISBField in XAML code, the Scrollbar property has been changed to
ScrollBar.

▪ The UIController property has been removed from SBForm. The SBPlus
property should be used instead.

▪ VerticalMenuTemplate, HorizontalMenuTemplate, and NestedMenuTemplate
have been added to SBMenu in order to eliminate the need for a trigger to
test for the menu type in user styles.

Previously the code to change the template for a type 5 menu was:

 <Style x:Key=TreeMenuStyle 
        BasedOn="{StaticResource BaseSBMenuStyle}"
        TargetType="{x:Type SBC:SBMenu}" >
   <Style.Triggers>
     <!-- *********************************** -->
     <!--     turn type 5 menu into a tree     -->
     <!--  *********************************** -->
     <DataTrigger Binding="{Binding Path=MenuDefinition.MenuType,
                            RelativeSource={RelativeSource Mode=Self},
                            Converter={StaticResource SBMenuTypeConverter}}"
                            Value="HorizontalWithLinkedSubMenus">
     <Setter Property="Template"  Value="{StaticResource TreeMenuTemplate}"/>
   </DataTrigger>
   </Style.Triggers>
</Style>

Now the code to change the template for a type 5 menu is:

 <Style x:Key="TreeMenuStyle" 
        BasedOn="{StaticResource BaseSBMenuStyle}" 
        TargetType="{x:Type sbc:SBMenu}" >
     <Setter Property="NestedMenuTemplate" 
             Value="{StaticResource TreeMenuTemplate}" />
 </Style>

▪ In the SBControl style, the SBStyleName property is now inherited from the
AttachedDependency property. We have removed the DependencyProperty
from the SBContentControl, SBXGridControl, and SBToolBar styles.

▪ Switching of themes has been improved so the new theme is now applied
immediately. This is particularly noticeable if you have changed the layout of
the main window or the style on a menu.

▪ The SBToolbar style has been renamed SBToolBar.
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38816*USA New Cache for Client Forms

A cache for forms was added in version 6.0.1 to improve the client's performance
in retrieving and displaying forms. Users can specify the maximum number of
forms to be cached by setting a parameter in the Client Configuration form. By
setting the number of forms cached to 0, the cache is disabled.

38817*USA Enhancements to Upgrade Grid Support

▪ SB/XA 6.0.1 has upgraded to version 3.0 of the Xceed DataGrid for Windows
Presentation Foundation (WPF).

▪ The Client Configuration form has been enhanced to use a grid.
38818*USA Enhancements to Improve .NET Integration Capabilities

▪ SB/XA 6.0.1 enables users to create and interact with .NET types.

To support this functionality, the assembly name, which references an
assembly definition, has been added to the User Class Registration (UCR)
form. This form also contains a prompt to specify the tier in which the .NET
type is to be created.
A new assembly definitions (/ASD) process allows you to define and upload
a .NET assembly. Before an assembly can be used, the definition must exist
and the assembly must be uploaded. If a class exists in an SB/XA assembly,
the assembly name SBShared, SBRuntime, or SBControls can be used.

▪ A new variable, @SBHANDLER, has been added. This variable is supported in
XUI mode only.

▪ Version 6.0.1 implements the ability to execute commands in .NET. For
example:

LOCAL HANDLE, RESULT
STR.VAL = "string"
HANDLE = OBJCREATE("TEST.NET",@FORM,"TestObject","PropertyOne","ValueOne")
IF HANDLE # "" THEN
   DISP 3, "Object 1 created with handle ":HANDLE
*    Test execute command
      RESULT = GETATTR
("@SBHANDLER","(SBExecuteCommand,DisplayFormCommand,":HANDLE:",SB.HANDLER.99)")
     DISP 3, "RESULT after setting TestMethod1: ":RESULT
*  Destroy the object 
   RESULT = OBJDESTROY(HANDLE)
   IF RESULT # 1 THEN
      DISP 3, "Object was not destroyed : ":RESULT
   END
ELSE
   DISP 3, "Object was not created."
END

▪ New subroutines SB.WAIT.ON.INPUT() and SB.PROCESS.EVENT() have been
added, enabling SB/XA Application Server to put user objects into an event
loop.

38819*USA Enhancements to the .NET Framework Infrastructure

▪ The namespace of the .NET Framework assembly that is a collection for
XAML controls has been changed from http://schemas.IBM.SBPLUS.com/
winfxControls to http://schemas.IBM.SBPLUS.com/WPFControls.

▪ At version 6.0.1, SB/XA has upgraded to Microsoft .NET Framework 3.5
Service Pack 1.
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38859*USA Regenerate Expressions Prompts Accept Lowercase Entries

In the Regenerate Expressions dialog box, the Regenerate 'Global' Expressions
and Quiet Mode text boxes did not accept a lowercase Y or N. The code has been
amended so entries can be made in uppercase or lowercase in these text boxes.

38877*USA Pressing Esc Closes Process ID Window in XUI Clients

After entering '/' to open the Process ID prompt in SB/XA Rich Client or SB/XA
Browser Client, pressing the Esc key to cancel this action did not close prompt
window as expected. This behavior has been corrected.

38881*USA Description Added to F3 Help for Application Name Field

In the Application Setup screen, the F3 help for the Application Name field did
not provide a description of each existing application in the list. In SB/XA 6.0.1, a
description of the application has been added in F3 help for this field.

38886*USA Fix to U2 Administration Server Password Text Box

When setting up Single Sign-On on SB/XA Browser Client or SB/XA Rich Client
on Windows Vista, the U2 Administration Server Password text box in the SB/
XA Administration Server Configuration dialog box was displayed at half of its
normal height. This issue has been fixed in version 6.0.1.

38895*USA Office > Diary Option Displays Informational Message

The Office > Diary feature has not yet been implemented in SB/XA; it may be
available in a future version. When the user selects the Office > Diary option in
version 6.0.1, SB/XA displays an informational message stating that the feature
is currently not implemented.

38897*USA Paragraph Data No Longer Duplicated

When creating a paragraph in version 6.0.0, if you pressed F3 on a new line,
selected the Assign option from the menu, and then pressed the Esc key from
the screen used to build the assignment statements, all of the paragraph data
was duplicated. This issue has been resolved in version 6.0.1.

39001*USA Copy Button Added in SB/XA Error Message Window

With this enhancement, a Copy button has been added in the SB/XA Error
Message window, allowing users to copy the details of an error message to a text
file created in an external application such as Notepad.

39029*USA Display of Host Library Version

When running the /SB.INFO process in SB/XA Browser Client or SB/XA Rich Client,
the Host library information field displayed a question mark. This issue has been
resolved in version 6.0.1, so /SB.INFO displays the host library version and build
number in XUI mode, as expected.

39085*USA Fix for Issue with SROC.LOG Pointer

In SB/XA for UniData, the UPDATE.ACCOUNT process created a bad SROC.LOG
pointer that incorrectly led to SB.DEFN. Subsequently running LIST SROC.LOG
on the account resulted in an open failed message. A fix in version 6.0.1 corrects
this issue.

39128*USA Help for Valid Applications Field in Application Access Setup

In User Security Setup > F9 Single Sign-On, the F3 help for the Valid Applications
field did not provide a description of each existing application in the list. A
description of the application has been added in F3 help for this field in version
6.0.1.
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39132*USA Blink-Formatted Text Displayed in Balance Field

In the /CUST.ENQ (Customer Enquiry) screen of the Car Rental (CH) application
in SBDEMO, the Balance field contained an escape sequence instead of
displaying the balance using blink-formatted text when running the UniData
version of the product on Windows or Linux. A fix corrects this problem in version
6.0.1.

39161*USA Validation Checking for Duplicate Application Names

If a user defined duplicate application names within the same SB instance in /
SEC.USER.SETUP > F9 - Single Sign-On, the user was unable to log on in the XUI
clients. The client displayed the error, "Failed to get the list of applications from
the SB/XA Communications Server [hostname] on port [nnnn]. An item with
the same key has already been defined." In version 6.0.1, the F9 - Single Sign-
On option runs validation checking to prevent the user from defining duplicate
application names within the same instance, precluding the issue at logon.

39192*USA SBDEMO Reports No Longer Send Control Characters

When running an SBDEMO report in character or GUI mode in version 6.0.0, the
report sent control characters that affected the display of menus in character
mode and sent a message to the screen at the end of the report in GUI mode.
This problem has been resolved in version 6.0.1.

39216*USA Vertical Lines Display Properly in XUI Clients

In the screen designer (/SD), when a vertical line was painted on a screen in
character mode or when a character that looks like a vertical line was created
using a separator class in GUI mode, the vertical line was displayed as the
horizontal "-" character when running the screen in XUI mode. This problem
occurred if the Screen Parameters > F6-GUI Params > Link Char to GUI Field
Positions option was set to R (Rebuilt). The code has been amended to display a
vertical line in SB/XA Browser Client and SB/XA Rich Client in version 6.0.1.

39269*USA Fix to Initiate New System

In the Car Rental (CH) application of the SBDEMO account, the /ADMIN > SB+
Setup > Initiate New System option did not execute the system initiate routine
when running the UniData version of the product on an AIX or Linux platform.
On selecting this menu item, the cursor returned to the main menu. This issue
has been resolved in version 6.0.1 so this option initiates the new system as
designed.

39311*USA List Available Disk Space Now Displays Correct Value

In SBDEMO, the SB+ > Admin > System Enquiries > List Available Disk Space
option returned a value that was approximately two times larger than the actual
amount of available disk space. This issue has been resolved in version 6.0.1 so
the List Available Disk Space option returns the correct value.

39674*USA Keyboard Buffering Disabled by Default in SB/XA Browser Client

In SB/XA Browser Client version 6.0.1, buffering of keyboard entries has been
disabled by default. The architecture of the Browser Client does not support
the ability to buffer keystrokes typed ahead in the same manner as SB/XA Rich
Client.
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39704*USA Version 6.0.1 Exclusions and Limitations

Following is a list of exclusions for SB/XA 6.0.1:

Future functionality

Future releases of SB/XA include plans for the following features. These features
are not included SB/XA 6.0.1.

▪ HTML Reports (Planned for 6.0.2 release)

▪ .NET control integration (Planned for 6.0.2 release)

▪ ActiveX support (Planned for 6.0.2 release)

▪ Integration with Microsoft Office (Planned for 6.0.2 release)

▪ MAPI API (Planned for 6.0.2 release)

▪ Internationalization (Unicode) (Planned for 6.0.2 release)

▪ VBScript (Not currently planned)

▪ Graphs (Not currently planned)

▪ Matrix definitions (Not currently planned)

▪ SB Calculator (Not currently planned)

▪ Screen Designer (Use SBClient 6.0.1 screen designer with SB/XA 6.0.1)

▪ Report Designer (Use SBClient 6.0.1 screen designer with SB/XA 6.0.1)

Known limitations of SB/XA Browser Client vs. SB/XA Rich Client

The F4 and F10 function keys are intercepted by the Browser Client before SB/
XA can process them. The "X" (Close) button in the SB/XA Browser Client Window
closes the Browser Client without updating the server (much the same as F-
keys). Keyboard buffering is disabled by default in SB/XA Browser Client due to
the restrictions of its architecture, as detailed in 39674*USA above.

Obsolete

The following items are not included in SB/XA 6.0.1 and will not be included in
subsequent version:

▪ DDE API – Use SBClient 6.0.1

▪ MPX in EN mode – Use SBClient 6.0.1

▪ SBCOM – Use SBClient 6.0.1

▪ Character mode TCL/ECL – Use SBClient 6.0.1 as console

▪ SBClient Scripting – Use SBClient 6.0.1

▪ SBClient SmartQuery – Use QRD

▪ DataC objects – Use SBClient 6.0.1

We do not plan to implement SBOPEN commands in SB/XA. The
SBH.RUN.COMMAND attribute is dependent on SBOPEN, and therefore it is not
supported by SB/XA.

We do not anticipate implementing the following for TUBP:

▪ TU.FILE.MANAGER

▪ TU.FORM.PAINTER

▪ WINEDIT

▪ TU.DDE.CONNECT

▪ TU.DDE.DISCONNECT

▪ TU.EXEC.MACRO

▪ TU.DDE.GET.ERROR

▪ TU.DDE.READ

▪ TU.DDE.WRITE

▪ TU.TO.MONOLOG

▪ TU.WINDOW.DRAW

▪ TU.WINDOW.RESTORE

▪ TU.WINDOW.SAVE

▪ TU.SQL.CONNECT

▪ TU.SQL.DISCONNECT

▪ TU.SQL.EXEC

▪ TU.SQL.MAKE.DICT

▪ TU.SQL.READ

▪ TU.IMAGE

▪ TU.MACRO

▪ TU.RUN.SBO.COMMAND

▪ TU.SESSION

▪ TU.SESSION.CLOSE

▪ TU.VIDEO

▪ HOST GUI TU.FORM.XXX

▪ HOST GUI TU.INIT

▪ HOST GUI TU.RESET

▪ HOST GUI TU.SERVER

▪ HOST GUI TU.SESSION

▪ HOST GUI TU.TERMINATE

▪ HOST GUI TU.TOOLBAR.EFFECT

▪ HOST GUI TU.TOOLBAR.KILL

▪ HOST GUI TU.TOOLBAR.LOAD

▪ HOST GUI TU.MENU.XXX

▪ TU.SCRIPT.XXX

▪ TU.SQ.DO.QUERY

▪ TU.SEND.EVENT

▪ TU.SBZ

▪ TU.RUN.MULTIMEDIA

▪ TU.QUERY.TERMINAL.WINDOW

▪ TU.QUERY.ENGINE

▪ TU.PARSE.TCL

▪ TU.MACRO

▪ TU.INSTALL.ERRORCODES

▪ TU.INPUT

▪ TU.GUI.SMART.LIST

▪ TU.GET.TCPPAD

▪ TU.GET.ERROR

▪ TU.GET.CONFIG

▪ TU.FILEFORMAT

▪ TU.EXPORT.FILE

▪ TU.IMPORT.FILE

▪ TU.COMPRESS

▪ TU.CLIENT.PUT

▪ TU.APPLICATION.MODE.STATE

▪ TCL.WINEDIT

▪ TCL.TU.FORM.PAINTER

▪ SMART.LIST

▪ IMPORT.TUQUERY

▪ EXPORT.TUQUERY
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Issue Number Description

39717*USA Correction to Behavior of Unlimited License Flag in Logon

In version 6.0.0, the unlimited license flag did not bypass the ps-ef call in the
logon process. The code in version 6.0.1 has been modified to correct this issue.

39784*USA SB/XA Admin Account Field Default Changed

In the Application Setup screen (/APPLICATION.SETUP),, the default value for the
SBXA Admin Account field has been changed to N (No) in version 6.0.1.

39841*USA Use of Local Storage by XUI Clients

The SB/XA Presentation Components (XUI clients) use local storage to
cache bitmaps and server definitions. If you previously installed the SB/XA
Presentation Components, you may want to delete the local storage folder
for the currently installed version to free up disk space before installing a new
version. To find the location of the local storage folder for the currently installed
version, open SB/XA Browser Client or SB/XA Rich Client and select Options >
Client Configuration. In the SB/XA Client Configuration window, the local storage
folder is displayed in the Application Data Path field.

39873*USA Deleting an Application Now Removes Associated Password

Deleting an application from the Valid Applications list in /SEC.USER.SETUP
(User Security Setup) > Single Sign-On did not remove the password associated
with the account. When attempting to connect to the next application in the
list, SB/XA prompted the user to enter the user name and password. The code
has been corrected so that when the user deletes an application, the associated
password is also deleted, and the Single Sign-On feature works for other
applications as designed, without prompting for a user name and password.

39900*AUS Commit Fail Process Is Fixed

The entry in the "Commit Fail Process" process slot in a subscreen of the SB+
> Tools > Process Definitions > File Update option was converted to uppercase
after pressing Enter. This has been fixed in version 6.0.1.

39902*AUS Form Painter and Report Designer Options Disabled in XUI Clients

In the /PD.I and /PD.O processes, the F8 option no longer attempts to open the
Form Painter in SB/XA Browser Client or SB/XA Rich Client. If the user presses F8,
SB/XA displays a message indicating that the screen designer is not available in
the XUI clients. In the /PD.R process, the F8 option no longer attempts to open
the Report Designer in SB/XA Browser Client or SB/XA Rich Client. Pressing F8
results in a message indicating that this feature is not implemented in the XUI
clients.

39903*USA Column and Row Coordinates of Character Form Converted to XUI
Rendering

When forms are converted from character mode directly to XUI mode in SB/
XA 6.0.1, the size of the form, position of fields, and size of objects in the XUI
rendering closely corresponds to the column and row coordinates of the
character-based form. For further information on conversion of forms from
character to XUI, see the SB/XA 6.0.1 New Features manual.

39948*USA Style to Format Interleaved Multivalues in Standard Grid

SB/XA 6.0.1 supports a new XAML style named SBXInterleavedGridViewStyle to
format interleaved multivalues as a standard grid instead of a CardView layout.
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Issue Number Description

39963*USA F2 Key Saves Changes in Form Painter

In the Form Painter in GUI mode, users were unable to save changes to the
Controlling/Dependent Options screen using the F2 key. This issue has been
resolved in version 6.0.1.

39974*USA Correction of Issue with Receive and Send Message Options

The Office > Receive Message and Send Message options in SBDEMO did not
work in SB/XA Browser Client or SB/XA Rich Client. A fix in version 6.0.1 corrects
this problem in the XUI clients.

39975*USA Enter Key Enabled in F3 Help

In SB/XA Browser Client and SB/XA Rich Client, version 6.0.1 supports the ability
to use the Enter key to select a value in F3 help.

39989*USA Escape at Connect to Application Dialog Box

When pressing Esc repeatedly to close SB/XA Browser Client or SB/XA Rich
Client, pressing Esc at the Connect to Application dialog box caused the client to
fail. This issue has been fixed in version 6.0.1.

40054*USA Port Configure Option Fixed

Selecting the Admin > Printers and Terminals > Port Configure option caused SB/
XA Rich Client to fail in version 6.0.0. This issue has been fixed in version 6.0.1, so
the option opens the Port Configuration screen the same as in GUI mode.

40055*USA Fix to Prevent Failure on Selecting OH Process Scope Control

In version 6.0.0, the XUI clients failed when the Admin > SB+ Setup > SB+
Configuration Options > OH Process Scope Control menu item was selected. This
problem has been addressed in version 6.0.1 so the OH Process Scope Control
screen opens as expected.

40060*USA Dynamic Styling with XAML Code Snippets

Version 6.0.1 supports dynamic styling through the use of XAML code snippets.
With this feature, you use short segments of XAML code to define the display
characteristics of selected elements of the user interface, including labels,
display fields, background, and foreground. Examples of XAML code snippets for
these elements are available in the XAML Examples (XA) application in SBDEMO.
For further information about dynamic styling, see the SB/XA 6.0.1 New Features
manual.

40129*USA Clear Button Added to SB/XA Administration Server Configuration

In the SB/XA Administration Server Configuration screen, a Clear button has
been added in version 6.0.1, allowing you to clear the Administration Server
details.

40170*USA Correction of Issue with Backslash Character in DISP 4 Message

The SB command DISP 4 is called inside a paragraph process to display a
message in a dialog box. In version 6.0.0, if a DISP 4 message contained a
"\" (backslash) character, SB/XA Browser Client and SB/XA Rich Client cut off
display of the message in the dialog box at the "\" character. A fix has been
implemented in version 6.0.1 so the message is displayed in its entirety in the
XUI clients.

40175*USA DISP 4 Command Supports XAML Code in Messages

An enhancement in version 6.0.1 enables the DISP 4 command to include the
XAML code from the TERM.DEFN in messages displayed in dialog boxes.
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Issue Number Description

40198*AUS Fix Made to System Control Record

In GUI mode, if "Use grids for multivalued fields" was set to No in the System
Control Record (/HK.CONTROL), but was set to "Yes" in the process definition for
a screen, the grid was rendered unusable. A modification to the code in version
6.0.1 now handles these settings so that the grid works as designed.

40341*USA Enhancements to RPC.HOSTDEBUG.INFO Program

In version 6.0.1, BASIC program RPC.HOSTDEBUG.INFO has been enhanced
to improve the usability of the output. The output now includes the
attribute number for each value displayed, the field name for each value
displayed, and a table of multivalued attributes with attribute number,
multivalue position, and field name. In addition, a new SB process named
HOSTDEBUG.INFO invokes RPC.HOSTDEBUG.INFO and writes the result to
RPC.HOSTDEBUG.INFO.VALUE:@PORT on the file xxWORK, where xx is the two-
character system ID.

40382*USA TUINSERT File Pointer Created in Upgrade

When upgrading SB/XA version 6.0.0, the TUINSERT file pointer was not created.
This issue has been corrected in version 6.0.1 so the upgrade process creates the
TUINSERT file pointer as designed.

40474*USA Support for FONT Attribute

The FONT attribute was not implemented in SB/XA 6.0.0. If you entered a FONT
attribute for an element in a screen definition, or if you entered a FONT as a
set/get attribute, the attribute was ignored. SB/XA 6.0.1 provides support for
the FONT attribute, with the following differences from its implementation
in SBClient: (1) the underline is available for labels only, and (2) you can
set a font on a control without having previously defined the font in the
GuiObjectDefinition.

40489*USA Fix for Changing Toolbars when Switching Systems

If two systems had a toolbar of the same name, switching from one system
to the other took extra time to download the toolbar, which was treated as a
different toolbar since it had a different timestamp. A change in version 6.0.1
allows you to switch from one system to the other without downloading toolbars
of the same name.

40500*USA DMTHEMES File Now Created Automatically

On upgrading an account, SB/XA produced an error if the account did not
contain the DMTHEMES file. This issue has been addressed in version 6.0.1 so the
upgrade process creates the DMTHEMES file if it did not exist in the account.

40514*USA Fix for Problem with Selecting Multiple Printers

In /SEC.USER.SETUP > F7 Term/Print > Aux Printer ID, if you selected multiple
printers, SB/XA Browser Client or SB/XA Rich Client could not connect to an
application when the user attempted to log on. The code has been amended to
prevent this problem in version 6.0.1.

40571*USA Create and Apply a XAML Style to a Grid Field

With this enhancement, users can create and apply a XAML style to a field in a
grid. For an example XAML style that can be applied to fields in a grid, see the
"Style_Tag_Templates_GA2.txt" item in the XATHEMES file.
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Issue Number Description

40634*USA Grids Now Handle Multiple Conversion Codes

In version 6.0.0, SB/XA reported an error if a field in a grid had more than one
conversion code. This issue has been resolved in version 6.0.1 so SB/XA handles
multiple conversion codes without error.

40635*USA,
40650*USA

Licensing Screens Streamlined

All optional fields have been removed from the Licence Details screen and the
Amend Licence Details screen in version 6.0.1.

40643*USA New Fields Added to Additional Fields Parameters Screen

New fields for entering XAML Style and Grid Footer Field have been added to the
Additional Fields Parameters screen (/SD > F5 Enter Field > F6 Addit) in version
6.0.1.

40676*USA Bar Chart Example

In SB/XA 6.0.1, the XAML Examples (XA) system contains an example of a bar
chart defined by XAML code.

40749*USA Fix for DISP 3 Message Using CPU Capacity

When a Basic subroutine called a process that displayed a DISP 3 message in SB/
XA Rich Client, the DISP 3 message display used 80 to 97 percent of CPU capacity
on the client machine. A code change has been implemented in version 6.0.1 to
correct this problem.

40752*USA Labels Displayed Properly on Subsequent Rows of Interleaved Grip

The Car Hire History dialog box in SBDEMO was missing the labels for the Rental
Amount and Deposit fields in the second row. The code has been changed
in version 6.0.1 so that labels on subsequent rows of an interleaved grid are
displayed correctly.

40764*USA Goto Line Issue Corrected

In the screen editor (/SE), choosing Edit > Goto Line and entering a line number
caused SB/XA Browser Client to fail. This issue has been fixed in version 6.0.1.

40768*USA Fix to Allow Logging Off and On with EM Navigation

Logging off and then logging on to SB/XA Browser Client in Windows mode with
Navigation set to EM caused the client to fail. A fix prevents this problem in
version 6.0.1.

40772*USA Display of MPX Submenu

The MPX submenu of the SBX menu tree was disabled in SB/XA Browser Client
and SB/XA Rich client if the start system ID and menu were set in the Start
Sys,Menu,Opt field in User Security Setup (/SEC.USER.SETUP). A correction in
version 6.0.1 prevents the start system ID and menu from disabling the MPX
submenu.

SB/XA v6.0.0 release notes
Build 2069
Release Date: August 2008
These release notes provide information about new features, enhancements, and fixes in SB/XA v6.0.0.

What's new in SB/XA v6.0.0

New product name
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At version 6.0.0, SB+ Server has been incorporated into a multi-component product, IBM U2
SystemBuilder Extensible Architecture for UniData and UniVerse (SB/XA). The new product is an
application development tool for building client applications that run on SB accounts on the UniData
or UniVerse data server. It consists of the following components:

SB/XA Application Server (Windows or UNIX)
This component is the functional equivalent of SB+ Server.

SB/XA Communications Server (Windows only)
The middleware software that enables communications between the client and SB/XA Application
Server on the U2 data server.

SB/XA Presentation Components (Windows only)
The clients that present the SB developed application to users in a Web browser window or as a
rich client application.

For illustrations of the new product architecture and descriptions of the SB/XA Components, see
Chapter 1, "Components of IBM U2 SB/XA," in SB/XA Getting Started. For help with planning where
to install components of SB/XA on Windows and UNIX computers on your network, see Chapter 2,
"Planning Your Implementation of IBM U2 SB/XA," in SB/XA Getting Started.

New installation
Given that the architecture of the SystemBuilder product family has changed significantly at version
6.0, the installation program has also changed to handle multiple components. To implement SB/XA,
you need to install the three SB/XA components listed above. All are available on the SB/XA product
CD. The version of all SB/XA 6.0 components must be an exact match, from the same version, major
release, point release, and build number. To be certain that you have matching versions of SB/XA
software, we advise you to install all SB/XA 6.0 components from the same SB/XA product CD image.
For step-by-step installation instructions, see Chapter 3, "Installing SB/XA Components on Windows,"
and Chapter 4, "Installing SB/XA Application Server on UNIX," in SB/XA Getting Started.

Supplemental support in SBClient 6.0.0
SB/XA version 6.0.0 GA 1 does not support certain functionality that you need for application
development work:

▪ Developing screens in character or GUI mode

▪ Developing reports

▪ Printing reports to screen

These features will be available in a later version of SB/XA. In the meantime, SBClient 6.0 provides
support for the functionality that is not yet available in SB/XA. SBClient 6.0 is also required to
complete the script portion of the SB/XA Application Server installation. SBClient 6.0 is not sold as
a separate product; it is included on the SB/XA 6.0 product CD and is covered by the same product
license. SBClient 6.0 does not run with SB+ Server version 5.4 or earlier; it is compatible only with
SB/XA 6.0. SBClient 6.0 is installed from the SB/XA product CD menu. For instructions, see Chapter 2,
“Installing SBClient on a Stand-alone PC,” in SBClient Getting Started. SBClient software authorizes
automatically.

ClickOnce deployment
Microsoft’s ClickOnce technology simplifies the work of deploying Windows-based client applications.
SB/XA supports ClickOnce as an option for distributing the SB/XA Presentation Components (SB/XA
Browser Client and SB/XA Rich Client files) to client computers. For a brief introduction to the use
of ClickOnce and pointers to more information about this technology, see Chapter 5, “Methods of
Deploying SB/XA Presentation Components,” in SB/XA Getting Started.

Single Sign-On feature
Single Sign-On is an optional security feature of SB/XA that reduces the number of steps required to
sign on to your SB developed applications and connect them to SB/XA Application Server. Without
Single Sign-On, the user may complete up to four logons. With Single Sign-On enabled, the user
need only log on to the PC. This feature offers convenience and time savings for users who log on
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numerous times throughout the workday. For detailed instructions on setting up single sign-on on SB/
XA Application Server and on the client computer, see Chapter 6, “Setting Up Single Sign-On,” in SB/XA
Getting Started.

New screen editor
SB/XA Application Server provides a new screen editor from the /SE process. This tool helps you edit
code in a visual interface using several advanced capabilities:

▪ Displays code in color cued chroma-code

▪ Displays nonprintable characters

▪ Can expand the display of multivalues

For more information and an example screen, see Chapter 2, "Highlights of SB/XA New Features," in
SB/XA 6.0 New Features.

Styles and themes
SB/XA allows you to build a state-of-the-art user interface for your SB developed applications using
XAML-based graphic design in your presentation layer. With XAML, you can apply styles to elements of
the UI and build a theme to customize your product. For more information on XAML and concepts of
styles and themes, see Chapter 2, "Highlights of SB/XA New Features," in SB/XA 6.0 New Features.

New file transfer protocol
SB/XA 6.0 supports a new file transfer protocol that offers advantages over the protocols supported by
SBClient.SBClient 6.0 can be configured to use one of the following three file transfer protocols:

▪ SBZ
This is the default protocol that works with all connection methods and system environments.
Other than setting up the connection, no additional configuration is necessary to use SBZ. SBZ
protocol has a few drawbacks: It is slower than standard network protocols, and it does not
transfer binary files reliably. The advantage of SBZ over other file transfer options is its ability to
secure the data in transit using SSL telnet connections.

▪ Network Copy (Windows file sharing protocol or UNIX Samba facility)
This protocol can be used where SB/XA Application Server can share a network drive with
SBClient. This option uses either the native Windows network file sharing protocol or the UNIX
Samba facility, which emulates Windows file sharing on UNIX. Since this protocol requires SB/XA
Application Server to share a network drive, additional server and network security configuration
must be enabled outside of the SB/XA environment. Because of these additional requirements,
not all system environments can support this protocol. The advantage of Network Copy is a much
faster transfer than SBZ (important for large items) and support for binary file types.

▪ FTP
This option can be used where SB/XA Application Server on UNIX is configured to allow the FTP
protocol to move files from a predetermined directory. As in the Network Copy option, additional
server and security configurations must be administered outside of SB/XA. Because of these
additional requirements, not all system environments can support this protocol. The advantage of
FTP is a much faster transfer than SBZ (important for large items) and support for binary file types.

SBXA 6.0.0 comes with only one supported native file transfer protocol. This new protocol addresses
all of the limitations of the three protocols used by SBClient 6.0: It is secure by default, it can transfer
binary files, it is much faster than SBZ (comparable to Windows file sharing and FTP), and it requires
no special network or security setup.

New features, enhancements, and fixes in SB/XA v6.0.0

The following issues were addressed in this release:
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Issue Number Description

7231*USA CHANGE.PWD Enforces No-Comma Rule

The CHANGE.PWD process in versions 5.3.4 and later did not enforce the
password validation rule that the password cannot contain a comma. The issue
has been corrected in version 6.0 so CHANGE.PWD no longer accepts passwords
containing a comma.

9513*UK Change to Correct Issue with PD.S Rounding

A code change in version 6.0 fixed an issue with grid control that caused the PD.S
process to round values incorrectly in GUI mode.

9817*USA Fix to Prevent Failure of SB.REMOTE.PROCESS

If SB.REMOTE.PROCESS used COMMON action 0, the process failed when it was
run outside of SB in versions 5.3.8 and later. This issue has been corrected.

9975*USA Logs Capture Output from REGEN.EXP and REGEN.GUI

An enhancement in version 6.0 captures output from the regenerate expressions
(REGEN.EXP) and regenerate GUI (REGEN.GUI) processes to a log file in
xxCONTROL when the processes are run in quiet mode. The log file produced
by REGEN.EXP is named REGEN.EXP.LOG; the log file produced by REGEN.GUI is
named REGEN.GUI.LOG.

10357*AUS Fix for Problem with Preferred Heading

In previous versions, the preferred heading in query reports was corrupted if (a)
the preferred heading contained 'L' to include a line break, and (b) the selection
criteria included pre-run questions, and (c) the report output was directed to a
printer. A change to the Query Report Definitions code in version 6.0 corrects the
problem.

10406*USA Mouse Click between Memo Field and Grid No Longer Causes Data Integrity
Issue

Clicking the mouse between a Memo field and a grid caused data corruption
if both the Memo field and the grid were work fields and did not have a field
definition. A fix corrects the problem in version 6.0.

10617*USA VOC SBSYSMENU<1> Now Contains Expected Value

In version 5.4.2, VOC SBSYSMENU attribute 1 in the SB admin account was blank
after installing the product. This issue has been corrected in version 6.0 so
attribute 1 contains the value 'M' as designed.

10689*USA Correction of Issue in MAINFILE with Process After Tool Read

In process definitions in version 5.4.2, MAINFILE was set to null in PD.S if a
Process After Tool Read was present. This issue has been fixed.

10723*USA Resolution of Issues with REGEN.EXP Functionality

In versions 5.4.2 and earlier, REGEN.EXP did not regenerate the global process
file if attribute 1 of the global process record contained a 'G'. Also, validation
processes were not regenerated if they were an expression. A change in version
6.0 resolves both of these problems.

35100*USA Change to Product Licensing Model

The product licensing model has been changed at version 6.0 to require
authorization through U2 Business Controls (U2BC). All parts of the
SystemBuilder product family, including SB/XA 6.0 and SBClient 6.0, are now
covered by a single product license.
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SB+ Server v5
The release notes in this section provide information about changes in SB+ Server v5.

SB+ Server v5 release notes

SB+ Server v5.5.3 release notes
Build 5301
Release Date: February 2012
These release notes provide information about SB+ Server v5.5.3.

What’s new in SB+ Server v5.5.3

Changes to SB+ Server v5.x
There are no fixes or enhancements in SB+ Server v5.5.3. The version number has been incremented,
and SB+ Server v5.5.3 has been tested for compatibility with SBClient v5.5.3.

SB+ Server v5.5.2 release notes
Build 5200
Release Date: December 2011
These release notes provide information about fixes in SB+ Server v5.5.2.

What’s New in SB+ Server v5.5.2

Changes to SB+ Server v5.x
SB+ Server v5.5.2 is a maintenance release, and contains no new features. This release consists of one
bug fix to address an issue, as detailed in the table below.

Fix in SB+ Server V5.5.2

The following issue was addressed in this release:

Issue Number Description

SBXA-5011 In version 5.5.1, if a screen process contained input-derived fields that used
@OTHER.REC, and the screen called a second screen process that also used
the same functionality, when the user pressed F2 (Update process) to return to
the first screen, the common variable @OTHER.REC still contained the values
from the second screen. The code has been amended in version 5.5.2, and
@OTHER.REC is now refreshed from the stack when the user presses F2.

SB+ Server v5.5.1 release notes
Build 5104
Release Date: November 2011
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These release notes provide information about enhancements and fixes in SB+ Server v5.5.1.

What’s new in SB+ Server v5.5.1

Updates to V5.x Features
SB+ Server 5.5.1 is a maintenance release, and contains no new features. Updates include several
enhancements and bug fixes to address issues and improve functionality, as detailed in the table
below.

Enhancements and fixes in SB+ Server v5.5.1

The following issues were addressed in this release:

Issue Number Description

SBXA-843 When Report Writer output was sent to DIF, a blank line was inserted into the
created xxWORK record, regardless of the setting specified in the SB.RD.DIFF
flag. This problem has been corrected in version 5.5.1, and output to DIF no
longer contains extra blank lines.

SBXA-1687 In GUI mode only, right-justified fields in a selection process (/PD.S) returned
incorrect values for some numbers. With a fix in version 5.5.1, derived and
default values are calculated correctly in right-justified fields.

SBXA-3538 The copyright statement was partially cut off at the bottom and right sides of
the SB+ logon screen. The bitmap is now displayed at a higher resolution so the
entire copyright statement is shown within the window.

SBXA-3901 In the UniVerse edition, focus did not switch properly between multivalued grids
if the cursor was in a blank, controlling multivalue field in one grid and the user
clicked in the other multivalued grid containing no data. The focus appeared to
switch, but any data entered in the empty grid was ignored. The SB.INTERPRET.I
code controlling focus has been amended, correcting this problem in version
5.5.1.

SBXA-3933 The GOTO.MVLINE process selected an incorrect multivalue when used in a
screen. This issue was related to the problem reported in SBXA-3930 and was
addressed by the same fix.

SBXA-3936 In multivalued grids for which the “Use Grids for MultiValued fields” option was
set to N, scroll bars in the grid behaved erratically. This issue was related to the
problem reported in SBXA-3901, and the fix for that issue corrected this one as
well.

SBXA-3982 After a process or program changed the CNT variable in a multivalued field in
version 5.5.0, the cursor was not positioned correctly in the grid. The cursor
behavior has been corrected in version 5.5.1 so it again works the same as in
5.4.x.

SBXA-4078 On entering “/”at any prompt, F3 process lookups did not return the correct
process if the selection list was sorted by Description. This issue has been
resolved.

SBXA-4151 With terminal emulation set to Wyse 50, SBClient displayed Esc (escape)
characters as a black box. The escape character should be displayed in the same
color as the background color definition. This has been fixed in version 5.5.1.

SBXA-4187 When running a Smart Query, directing the output to Microsoft Excel resulted in
an uninitialized variable error. The code has been corrected in version 5.5.1, and
the data is transferred from Smart Query to Excel without error.

SBXA-4325 New installations and upgrades to SBClient 5.5.1 require entering an
authorization key issued specifically for version 5.5.1. The 5.5.1 authorization
key cannot be used to authorize SBClient 5.5.0 or earlier versions.
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Issue Number Description

SBXA-4446 If the terminal ID was empty for each user in User Security Setup (/
SEC.USER.SETUP), the default terminal emulation in Admin > Printers and
Terminals > Port Configuration was not inherited at the user level. As a result,
the user was prompted to enter a terminal ID at logon. The code has been
revised in version 5.5.1 so that in this situation the user is not prompted to enter
a terminal ID at logon.

SBXA-4480 Compiling a Report Writer report using the generate source code (/GC) process
produced a syntax error. This issue has been resolved in version 5.5.1, and the /
GC process finishes successfully without error.

SBXA-4515 After upgrading from version 5.2.x or later to 5.5.0, multiline grid headers
displayed “_char10_” instead of a line feed (ASCII character 10). The upgrade
process has been amended to delete an item that was causing this problem in
grid headers.

SBXA-4520 At version 5.5.1, the Registry keys for SBClient have been changed as follows:
..\ROCKET SOFTWARE\SBCLIENT has been changed to ..\ROCKET SOFTWARE
\SBC5\SBCLIENT
..\ROCKET SOFTWARE\Runtime has been changed to ..\ROCKET SOFTWARE
\SBC5\RUNTIME

SBXA-4542 In the UniVerse edition on AIX, it was sometimes necessary to double-click a
radio button to register focus on it. A change to the order in which processes are
executed resolves this problem in version 5.5.1, so single-clicking a radio button
changes the focus to that element.

SBXA-4635 In previous versions, the TU.LAUNCH.APP subroutine was looking for a key in the
Registry that is no longer there. This subroutine has been changed so it does not
look for a nonexistent key.

SBXA-4641 The DEMOBP file has been added in SB.DEFN at version 5.5.1.
SBXA-4824 In character mode only, deleting or moving data in a multivalued field that was

painted on the form resulted in corruption of the data display. This issue has
been resolved in version 5.5.1.

SBXA-4874 In GUI mode, @OTHER.REC was not reinstated properly when returning from
another process invoked using a “/” command that also used @OTHER.REC. The
code has been amended to correct this problem in version 5.5.1.

SB+ Server v5.5.0 release notes
Build 5011
Release Date: September 2010
These release notes provide information about enhancements and fixes in SB+ Server v5.5.0.

What's new in SB+ Server v5.5.0

Installation upgrade/rebranding
The InstallShield program for Windows has been upgraded and the product has been rebranded.

Updated/rebranded documentation set
The SystemBuilder documentation set has been updated to reflect changes in the product, including
the product name and default path names.

Enhancements and fixes in SB+ Server v5.5.0

The following issues were addressed in this release:
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Issue Number Description

SBXA-41 Process After Grid Display Removed from Non-output Screens

The Process After Grid Display slot is relevant only to output screens (in /PD.O >
F5 - GUI Parameters), but it was implemented in /PD.I input screens, /PD.H shell
wrapper processes, and /PD.T transaction processes in version 5.4.x. This slot
has been removed from all screens except /PD.O output screens.

SBXA-113 Grace Period Changed to 10 Days

At version 5.5.0, the grace period for entering license information and
authorizing the product has been changed to 10 days. Evaluation licenses can be
now be authorized for a period of 60 days.

SBXA-186 Upgrades to Windows Installation/Rebranding

The InstallShield program for Windows has been upgraded and the product has
been rebranded.

SBXA-524 Uninstall Program Altered

The uninstall program no longer deletes the application data directory
automatically.

SBXA-755 Copy Group Function Fixed to Copy $ Items

In SB+ Server 5.4.4 and earlier, the Copy Group function (Admin > Security >
Group Security Setup > F10-Action > Copy Group) did not copy relevant $ items in
DMSECURITY. This issue has been resolved in version 5.5.0.

SBXA-1395 Resolution of Issue with F3 Intuitive Help Lookups

In F3 intuitive help lookups in GUI mode, selecting the first row from the intuitive
help list returned no data. This problem has been resolved in version 5.5.0 so F3
intuitive help lookups return data as expected.

SBXA-1449 Issue with Output Screen Driver Corrected

With the Multilanguage option on, under a specific set of conditions the common
variable @RECORD was corrupted the first time the screen was displayed. A fix to
the _SB.GEN.DRIV.O corrects a problem with the output screen driver in version
5.5.0.

SBXA-1458 Fix Prevents SB.GEN.DRIV.I from Overwriting Common Variable @RECORD

If the Multilanguage option was on and a driver record did not exist, the common
variable @RECORD was overwritten in subroutine calls from SB.GEN.DRIV.I. This
issue has been resolved in version 5.5.0.

SBXA-1513 Record in OTHER(2) Cleared Before Secondary File Update

In the /PD.F (periodic file update) process, OTHER(2) contains the record to be
written on a secondary file update. The file update process was not clearing
OTHER(2) for a new record before updating the secondary file. A fix corrects
this problem in version 5.5.0 so the record in OTHER(2) is cleared before the
secondary file is updated.

SBXA-1582 Audit Record Generated on Copying User or Group Record

In version 5.4.2 and later, the security API failed to create an audit record when a
user or group record was created by copying it from the Security menu's user or
group copy function. This defect has been corrected so an audit record is created
as expected.
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Issue Number Description

SBXA-1593 Parameter for Inhibiting User's Ability to Change Security Record

A new flag called "Change Own User Security Record" has been added in SB+
Control Parameters (/SB.PARMS > F5-System Defaults). This parameter provides
the ability to inhibit users from changing their own user security record. The flag
does not apply to members of the ROOT group; these users always retain the
ability to change their own user security records.

SBXA-1594 Security API Supports Menu and Process Restrictions for Groups

The SB+ security API has been extended to allow SB developers to create and
update restrictions to the menu and process restrictions in group security
through a UniBasic or UniVerse BASIC program.

SBXA-1597 Job Schedule Process Runs Correctly with Multilanguage On

In version 5.4.x with the Multilanguage option on, if a user called a process
that first displayed a dialog box and then ran a /JSD job schedule process, the
process terminated with the errors "DATE/TIME HAS ALREADY PASSED" and
"Schedule Terminated [process_name]". A code fix corrects this issue in version
5.5.0.

SBXA-1672 /RELEASE.LICENSE Process No Longer Releases Active User Licenses

In previous versions, a flaw in the /RELEASE.LICENSE process caused it to release
licenses of active users. This issue has been resolved in version 5.5.0, so the
process releases only the licenses for inactive user sessions.

SBXA-1718 Fix to Display Last Column in Multivalued Grids

In version 5.4.4, the last column in multivalued grids was displayed separately
from other columns if there was only one multivalue set and there were no other
objects on the screen. This issue has been corrected in version 5.5.0.

SBXA-1857 /PD.I Option F Now Supported in Character Mode

/PD.I option F functionality was previously not implemented in character mode
linked screens. An enhancement in version 5.5.0 enables option F to work the
same in character mode as in GUI mode, placing the cursor in the first field of the
current linked screen.

SBXA-2309 UniData Edition on UNIX/Linux Uses Lowercase updatevoc Command

When installing SB/XA Application Server for UniData on UNIX or Linux, the
error "sh: UPDATEVOC not found" occurred because the UNIX/Linux command
is lowercase. The install program has been modified to use the lowercase
command, so this error no longer occurs.

SBXA-3004 Copy Text from Report Writer .TXT Record to Alternative Language Item

Text typed directly in a Report Writer report is stored in the .TXT record
for the report definition within the dictionary of the file the report is run
against. With this enhancement in version 5.5.0, the text stored in the
report_name.TXT item can be copied to create an alternative language item,
such as report_name.TXT.FR (or any other language code), and the alternative
language item can then be edited.

SBXA-3047 File Update Process Displays Lock Warning

With this enhancement, if a file update process encounters a lock, it displays a
warning to the user in version 5.5.
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Issue Number Description

SBXA-3069 Problem with Preferred Heading Corrected

In previous versions, the preferred heading in query reports was corrupted if (a)
the preferred heading contained 'L' to include a line break, and (b) the selection
criteria included pre-run questions, and (c) the report output was directed to a
printer. A change to the Query Report Definitions code in version 5.5.0 corrects
the problem.

SBXA-3354 Support for Multilanguage Text on GUI Buttons

When adding buttons on GUI screens with the Multilanguage option on, the /
TRANSLATE process offers a GUI Screen Labels and Push Button Strings option
that allows you to enter multilanguage text for button labels in version 5.5.0.

SBXA-3394 No Report Heading for Controlling Multivalue

If the controlling multivalue field in a grid did not have a Report Heading value,
the grid failed to work in version 5.4.4. The functionality of earlier versions has
been restored, so the Report Heading can be left blank in version 5.5.0 without
causing the grid to fail.

SBXA-3421 Fix for "1 INVALID TYPE" Error in Output to PDF

If the printer name in the Physical Printer Definition was set to a value of "1," SB
+ Server returned a "1 INVALID TYPE" error when any report was output to PDF.
Fixes have been made in the driver generation process and in the program that
runs reports, preventing this error in version 5.5.0.

SBXA-3426 Correction of Autologin Issue

An issue with the autologin feature has been fixed.
SBXA-3436 New Utility to Export SBClient Settings

Existing customers who installed SBClient 5.4.4 or earlier may have session
configurations, scripts, phone books, toolbars, and Smart Query definitions that
can be used in SBClient 5.5.0 or later. To save settings from SBClient 5.4.4 or
earlier, you can export the settings to a file before installing SBClient 5.5.0 or
later. After installing the latest version of SBClient, you can then import the files
containing settings that you saved. For instructions, see Chapter 2, "Installing
SBClient on a Standalone PC," in SBClient Getting Started.

SBXA-3449 Multivalued Data No Longer Cleared after Deleting Controlling Multivalue

In multivalued grids in GUI mode, pressing the Delete key to remove the last
controlling multivalue (excluding the backslash) yielded unexpected results if
process slots were used. The behavior varied depending on whether the Process
Before slot, Process After slot, or both slots were used, but in each case data
was cleared unexpectedly. The code has been amended to resolve this issue in
version 5.5.0.

SBXA-3523 /RELEASE.LICENSE Fixed to Parse Output of LISTUSER

The SB+ /RELEASE.LICENSE process relies on the database command LISTUSER
to determine who is logged on to UniData. The output from LISTUSER contains
the user’s IP address for Windows, but not for UNIX. The /RELEASE.LICENSE
process in the UniData for UNIX edition has been changed to parse the output
from LISTUSER correctly on UNIX, so the process now works as designed.
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Notices
Edition

Publication date: April 2016
Book number: SBX-641-ALL-RN-01
Product version: Version 6.4.1

Copyright
© Rocket Software, Inc. or its affiliates 1989-2016. All Rights Reserved.

Trademarks

Rocket is a registered trademark of Rocket Software, Inc. For a list of Rocket registered trademarks go
to: www.rocketsoftware.com/about/legal. All other products or services mentioned in this document
may be covered by the trademarks, service marks, or product names of their respective owners.

Examples

This information might contain examples of data and reports. The examples include the names of
individuals, companies, brands, and products. All of these names are fictitious and any similarity to
the names and addresses used by an actual business enterprise is entirely coincidental.

License agreement

This software and the associated documentation are proprietary and confidential to Rocket Software,
Inc. or its affiliates, are furnished under license, and may be used and copied only in accordance with
the terms of such license.

Note:  This product may contain encryption technology. Many countries prohibit or restrict the
use, import, or export of encryption technologies, and current use, import, and export regulations
should be followed when exporting this product.

http://www.rocketsoftware.com/about/legal
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Corporate information
Rocket Software, Inc. develops enterprise infrastructure products in four key areas: storage, networks,
and compliance; database servers and tools; business information and analytics; and application
development, integration, and modernization.

Website: www.rocketsoftware.com

Rocket Global Headquarters
77 4th Avenue, Suite 100
Waltham, MA 02451-1468
USA

To contact Rocket Software by telephone for any reason, including obtaining pre-sales information
and technical support, use one of the following telephone numbers.

Country Toll-free telephone number

United States 1-855-577-4323
Australia 1-800-823-405
Belgium 0800-266-65
Canada 1-855-577-4323
China 800-720-1170
France 08-05-08-05-62
Germany 0800-180-0882
Italy 800-878-295
Japan 0800-170-5464
Netherlands 0-800-022-2961
New Zealand 0800-003210
South Africa 0-800-980-818
United Kingdom 0800-520-0439

Contacting Technical Support

The Rocket Customer Portal is the primary method of obtaining support. If you have current support
and maintenance agreements with Rocket Software, you can access the Rocket Customer Portal and
report a problem, download an update, or read answers to FAQs. To log in to the Rocket Customer
Portal or to request a Rocket Customer Portal account, go to www.rocketsoftware.com/support.

In addition to using the Rocket Customer Portal to obtain support, you can use one of the telephone
numbers that are listed above or send an email to support@rocketsoftware.com.

http://www.rocketsoftware.com
http://www.rocketsoftware.com/support
mailto:support@rocketsoftware.com
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